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3 1. Présentation

Configuration du système

Tuner de diversité synthétisé UHF 
URX-S03D
Récepteur sans fil numérique 
DWR-S02DN

Système de 
microphone 
sans fil 
UWP-D21 
UWP-D22 
UWP-D26 
(Récepteur : 
URX-P40)

Récepteur 
de 
microphone 
sans fil 
URX-P03D

Adaptateur de 
griffe à 
interfaces 
multiples 
SMAD-P3D

Adaptateur de griffe 
à interfaces multiples 
SMAD-P5

Adaptateur de 
monture de type A 
LA-EA3 
LA-EA4

Adaptateur de monture 
LA-EB1

Objectif à monture E

Microphone 
ECM-VG1 
ECM-MS2

Unité de 
télécommande 
RM-30BP

Télécommande de 
poignée (fournie)

PXW-FX9V/PXW-FX9VK
PXW-FX9T/PXW-FX9TK

Adaptateur d’épaule 
VCT-FS7

Kit adaptateur 
XLR 
XLR-K2M 
XLR-K3M

Lampe vidéo 
HVL-LBPC

Carte mémoire XQD 
Série S/N/M/H/G

Pack batterie 
BP-U35, BP-U70, 
BP-U100

Adaptateur CA 
(fourni)

Module 
d’extension 
XDCA-FX9

Lecteur de carte XQD 
MRW-E80, MRW-E90

Chargeur de batterie 
BC-U1A, BC-U2A

* Un adaptateur de monture est requis pour les objectifs autres que les objectifs à monture E.

Mélangeur 
Multicaméras Live 
MCX-500
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Localisation et fonctions des pièces

Côté gauche, avant et poignée

11
12

16

14
13

15

17
18
19

2120 22 23 24

1

4

6

5

3

2

7

9
8

10

1. Poignée (page 5)

2. Antenne Wi-Fi (page 61)

3. Sortie d’air

[Remarque]

Ne couvrez pas la sortie d’air.

4. Fiche du viseur (page 21)

5. Connecteur REMOTE
Permet la connexion à l’accessoire à prise 
LANC à usage général.

6. Connecteur Multi/USB (page 25)

7. Commutateur INPUT1 (LINE/MIC/
MIC+48V) (page 46)

8. Épaulière (page 25)

9. Commutateur INPUT2 (LINE/MIC/
MIC+48V) (page 46)

10. Fixation de la poignée (page 24)

11. Crochet pour mètre à ruban
Le crochet pour mètre à ruban se trouve au 
même niveau que le capteur d’image. Pour 

mesurer la distance entre le caméscope et le 
sujet de manière précise, utilisez ce crochet 
comme point de référence. Vous pouvez fixer 
l’extrémité d’un mètre à ruban au crochet pour 
mesurer la distance à partir du sujet.

12. Témoin d’enregistrement/de signalisation 
(avant) (page 34)

Clignote lorsque la capacité restante de la 
batterie ou du support est faible.

13. Butée de la bague de verrouillage de 
l’objectif (page 23)

14. Capteur d’image

15. Molette multifonction (page 48)
Lorsque vous visualisez l’image sur le viseur, 
appuyez pour afficher et actionner le menu 
direct .
Lorsqu’un menu est affiché sur le viseur, 
tournez la molette pour déplacer le curseur 
vers le haut/bas et sélectionner des éléments 
ou des réglages de menu. Appuyez pour 
appliquer l’élément sélectionné.
Lorsque le menu n’est pas affiché, vous 
pouvez aussi utiliser la molette comme 
molette personnalisable.

16. Contacts de signal de l’objectif
Fixez un objectif à monture E.

17. Touche WB SET (réglage de l’équilibre des 
blancs) (page 45)

18. Goupille de verrouillage de l’objectif 
(page 23)

19. Bague de verrouillage de l’objectif 
(page 23)

20. Antenne du module GPS
L’antenne GPS et les circuits périphériques 
sont intégrés.

21. Griffe pour accessoire (page 4)

22. Touche d’enregistrement START/STOP de 
la poignée

La touche d’enregistrement ne peut pas être 
actionnée lorsque le levier de verrouillage est 
en position verrouillée.

23. Levier de zoom sur la poignée 
(page 119)

24. Griffe à interfaces multiples

Pour plus de détails sur les accessoires pris 
en charge par la griffe à interfaces multiples, 
prenez contact avec votre représentant 
commercial.

Fixation de la griffe pour accessoire

1 Soulevez l’avant de la plaque à ressort de 
la griffe et poussez la plaque à ressort 
dans la direction opposée à la flèche 
gravée sur la plaque.

Plaque à ressort de la griffe

Griffe pour accessoire

1

2 Positionnez la griffe pour accessoire sur le 
dispositif de montage de griffe pour 
accessoire, en alignant les saillies de la 
griffe sur les points correspondants du 
dispositif de montage, puis serrez les 
quatre vis.
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3 Insérez la plaque à ressort de la griffe 
dans la direction de la flèche, de manière 
à ce que la partie en forme de U 
s’enclenche au fond de la griffe pour 
accessoire.

3 22

Griffe pour 
accessoire

Plaque à ressort 
de la griffe

Retrait de la griffe pour accessoire

Retirez la plaque à ressort de la griffe comme 
indiqué à l’étape 1 de « Fixation de la griffe 
pour accessoire », desserrez les quatre vis et 
retirez la griffe pour accessoire.

Retrait de la poignée

Dévissez les quatre vis de fixation de 
la poignée, puis retirez la poignée du 
caméscope.

Fixation du capuchon protecteur du 
connecteur de la poignée (fourni)

Lorsque vous utilisez le caméscope sans la 
poignée, protégez le connecteur en utilisant le 
capuchon protecteur fourni.

Protection des bornes du connecteur

Fixez le cache sur les connecteurs non utilisés 
pour protéger les bornes du connecteur.

Côté supérieur

1

3

2

1. Orifices de vis d’extension (3/8 de pouce)
Compatible avec les vis 3/8-16 UNC (longueur 
de 10,0 mm ou moins).

2. Orifices de vis d’extension (1/4 de pouce)
Compatible avec les vis 1/4-20 UNC (longueur 
de 7,0 mm ou moins).

3. Connecteur de poignée
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Côté droit (avant/haut/bas)

1
2
3
4
5

7

9

11
13
15

18

6
8

10

12
14
16

17

19

2422
21

20 23 25

Côté droit (arrière) 
(page 7)

1. Haut-parleur intégré (page 34)

2. Touches VOLUME (réglage du volume du 
moniteur)

Permettent de régler le volume du moniteur et 
celui de l’alarme.

3.  (Marque N)
ˎˎ Mettez en contact un smartphone équipé de 
la fonction NFC avec l’unité pour établir une 
connexion sans fil (page 61).  
Certains smartphones compatibles avec les 
systèmes de paiement sans fil ne prennent 
pas forcément en charge la technologie 
NFC. Pour plus de détails, reportez-vous au 
manuel d’utilisation du smartphone.
ˎˎ La technologie NFC (Near Field 
Communication) est un protocole de 
communication international pour la 
communication sans fil entre des objets 
proches.

4. Commutateur HOLD (page 119)
Désactive le fonctionnement de l’unité (état 
de maintien).

5. Indicateur/Touche d’enregistrement 
START/STOP (page 34)

6. Molette ND VARIABLE (page 43)

7. Commutateur ND PRESET/VARIABLE 
(page 43)

8. Touches haut/bas ND FILTER POSITION 
(page 43)

9. Indicateur CLEAR ND (page 43)

10. Touche ND VARIABLE AUTO (page 43)

11. Touche STATUS (page 14)
Affiche les réglages principaux de l’appareil. 
Les réglages de certains éléments peuvent 
être modifiés.

12. Indicateur FOCUS AUTO (page 36)

13. Commutateur FOCUS (page 36)

14. Touche PUSH AUTO FOCUS (page 40)

15. Touche de fonction IRIS (page 42)

16. Touche PUSH AUTO IRIS (page 42)

17. Touche de fonction ISO/GAIN (page 42)

18. Commutateur ISO/GAIN (sélection du 
gain) (page 42)

19. Touche ASSIGN (personnalisable) 9 
(page 48)

20. Touche de fonction WHT BAL (équilibre 
des blancs) (page 45)

21. Commutateur WHT BAL (sélection de 
mémoire d’équilibre des blancs) 
(page 45)

22. Touche de fonction SHUTTER (page 43)

23. Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

24. Indicateur POWER (page 34)

25. Commutateur POWER (page 34)



1. Présentation : Localisation et fonctions des pièces7

Côté droit (arrière)

MENU

THUMBNAIL

EXT

MI SHOE MAN

INT AUTO

SLOT SELECT  

AUDIO LEVEL

CANCEL/
BACK

DISPLAY

S&Q

1

3

EXT

MI SHOE MAN

INT AUTO

7 8

CH-1

CH-2

CH-3

CH-42

1 2

1415 13

6

3
5

7
89

10

1112

4

1. Touches ASSIGN (personnalisables) 1 à 3 
et 7 à 8 (page 48)

2. Touche SLOT SELECT (sélection de carte 
mémoire XQD) (page 34)

3. Commutateur de sélection CH1 INPUT 
(page 46)

4. Commutateur CH1 (AUTO/MAN) 
(page 46)

5. Molette AUDIO LEVEL (CH1) (page 46)

6. Molette AUDIO LEVEL (CH3) (page 46)

7. Commutateur de sélection CH2 INPUT 
(page 46)

8. Commutateur CH2 (AUTO/MAN) 
(page 46)

9. Molette AUDIO LEVEL (CH2) (page 46)

10. Molette AUDIO LEVEL (CH4) (page 46)

11. Touche CANCEL/BACK (page 78)

12. Flèches (///) et touche SET 
(page 78)

13. Touche MENU (page 80)

14. Touche THUMBNAIL (page 77)

15. Touche DISPLAY (affichage de l’écran) 
(page 11)
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Logement de carte, arrière et bornes

18
19

7

8
9
10
11

14

12
13

23 21
22 20

15

17
16

6

1
2

3
4

5

1. Logement pour carte mémoire XQD A 
(page 30)

2. Indicateur d’accès XQD (A) (page 31)

3. Logement pour carte mémoire XQD B 
(page 31)

4. Indicateur d’accès XQD (B) (page 31)

5. Prise casque (page 34)

6. Indicateur d’accès à la carte SD 
(page 33)

7. Logement pour carte UTILITY SD/MS 
(page 33)

8. Connecteur du module d’extension 
(interne) (page 26)

9. Connecteur DC IN (page 20)

10. Témoin d’enregistrement/de signalisation 
(arrière) (page 34)

11. Touche BATT RELEASE (page 19)

12. Batterie (page 19)

13. Fixation du pack batterie (page 19)

14. Entrée d’air

[Remarque]
Ne couvrez pas l’entrée d’air.

15. Microphone interne (page 46)
Microphone de narration pour 
l’enregistrement du son d’ambiance.

16. Connecteur SDI OUT 1 (page 134)

17. Connecteur INPUT1 (entrée audio 1) 
(page 46)

18. Connecteur INPUT2 (entrée audio 2) 
(page 46)

19. Connecteur SDI OUT 2 (page 134)

20. Commutateur de sélection IN/OUT 
(page 135)

21. Connecteur TC IN/TC OUT (entrée/sortie 
de code temporel) (page 135)

22. Connecteur GENLOCK IN (entrée de 
verrouillage de synchronisation)/REF OUT 
(sortie de signal de synchronisation) 
(page 135)

23. Connecteur HDMI OUT (page 134)

Côté inférieur

1

1. Orifices de vis pour trépied (1/4 de pouce, 
3/8 de pouce)

Attachez à un trépied (en option, vis de 
5,5 mm ou moins) qui prend en charge les vis 
1/4-20 UNC ou 3/8-16 UNC.

Viseur

Pour plus de détails sur la fixation du viseur 
(fourni), consultez page 21.

1
2
3

4 65

1. Touche PEAKING

2. Touche ZEBRA

3. Touche ASSIGN (personnalisable) 10 
(page 48)

4. Commutateur MIRROR

5. Crochets de fixation de l’oculaire

6. Panneau tactile
Les opérations tactiles peuvent être 
désactivées à l’aide d’une touche 
personnalisable ou à l’aide du menu 
(page 10).
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Oculaire

Pour plus de détails sur la fixation de l’oculaire 
(fourni), consultez page 23.

1 2

1. Bouton d’ajustement de dioptrie

2. Œilleton

Télécommande de poignée

Pour plus de détails sur la fixation de la 
télécommande à poignée (fournie), consultez 
page 24.

1
2
3

4

5
6
7
8

1. Levier de zoom

2. Touche ASSIGN (personnalisable) 4

3. Molette personnalisable

4. Touche ASSIGN (personnalisable) 6

5. Levier de rotation de la poignée

6. Touche d’enregistrement START/STOP

7. Sélecteur multiple (touches 8 voies D-pad 
et SET)

8. Touche ASSIGN (personnalisable) 5 

Module d’extension XDCA-FX9 (en 
option)

Pour plus de détails sur la fixation d’un 
module d’extension XDCA-FX9 (en option), 
consultez page 26.

Avant

1

2
3

1. Logement d’insertion du récepteur sans 
fil

Attachez un tuner sans fil portatif lors de 
l’utilisation d’un microphone sans fil.

2. Connecteur DC OUT (type arrondi 4 
broches)

Connecteur de sortie d’alimentation CC 12 V.

3. Connecteur LIGHT (2 broches)
Connecteur de sortie d’alimentation CC 12 V.

Arrière

2

1

4

6

3

5

8 97

1. Connecteurs USB (type A)

2. Levier de sortie de la batterie

3. Prise de fixation de la batterie

4. Connecteur TC OUT (type BNC)

5. Connecteur REF OUT (type BNC)

6. Connecteur DC IN (type XLR, 4 broches)

7. Témoin d’enregistrement/de signalisation 
(arrière) (page 34)

8. Connecteur RAW OUT (type BNC)

9. Connecteur LAN
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Précautions d’utilisation du 
panneau tactile

Le viseur de l’appareil est un écran tactile, que 
vous actionnez directement en le touchant 
avec le doigt.
ˎˎ Le panneau tactile est conçu pour être 
touché légèrement avec votre doigt. 
N’appuyez pas sur le panneau avec force et 
ne le touchez pas avec des objets pointus 
ou tranchants (clou, stylo à bille, épingle, 
etc.).
ˎˎ Le panneau tactile risque de ne pas 
répondre s’il est touché dans les 
circonstances suivantes. Notez également 
que cela risque de provoquer un 
dysfonctionnement.
ˎˎ Fonctionnement en utilisant le bout des 
ongles
ˎˎ Fonctionnement alors que d’autres 
objets touchent la surface
ˎˎ Fonctionnement avec une feuille ou un 
autocollant de protection
ˎˎ Fonctionnement avec des gouttelettes 
d’eau ou de la condensation sur l’écran
ˎˎ Fonctionnement en utilisant des doigts 
mouillés ou moites
ˎˎ Fonctionnement dans l’eau

Gestes propres au panneau tactile

Toucher
Touchez légèrement un élément, tel 
qu’une icône, avec votre doigt, puis retirez 
immédiatement votre doigt.

Faire glisser
Touchez l’écran et faites glisser votre doigt 
jusqu’à la position souhaitée de l’écran, puis 
retirez votre doigt.

Saisir en glissant/Balayer
Touchez l’écran et saisissez en glissant/
balayez rapidement votre doigt vers le haut, le 
bas, la gauche ou la droite.

[Conseil]
Si le contenu de l’affichage continue au-delà des bords 
de l’écran, vous pouvez le faire glisser ou le faire défiler.

Configuration du panneau tactile

Les opérations du panneau tactile peuvent 
être activées/désactivées à l’aide de Touch 
Operation (page 83) dans le menu 
Technical.

Utilisation du panneau tactile
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Affichage de l’écran
Pendant la prise de vue (enregistrement/veille) et la lecture, l’état du caméscope et ses réglages 
sont superposés sur l’image affichée dans le viseur.
Vous pouvez afficher/masquer ces informations en utilisant la touche DISPLAY.
Vous pouvez également choisir d’afficher/masquer chaque élément de manière indépendante 
(page 112).

Informations affichées sur l’écran pendant la prise de vue

5 62

8

3 4

10

11 1297

13
16 14 1517
18
19

20
21
22

23 24 25 26 27 28 29 30 31 32 33

34
35
36
37
38
39
40
41
42

143

1. Indicateur d’état du réseau (page 13)
Affiche l’état de connexion au réseau sous 
forme d’icône.

2. Indicateur de téléchargement/indicateur 
de fichiers restants (page 67)

3. Indicateur d’état du mode client réseau 
(page 14)

Affiche l’état de connexion en mode client 
réseau.

4. Indicateur de l’état de diffusion continue

5. Indicateur de zone de mise au point 
(page 37)

Affiche la zone de mise au point pour la mise 
au point automatique.

6. Mode d’enregistrement, fente A/B, 
indicateur d’intervalle d’enregistrement 
Interval Rec (page 51)

Affichage Signification

Rec Enregistrement

Stby Veille d’enregistrement

7. Indicateur de profondeur de champ

8. Indicateur du mode Imager Scan 
(page 28)

Un repère  s’affiche en cas d’incohérence 
entre la taille du cercle d’image de l’objectif 
et le réglage en vigueur pour le mode Imager 
Scan de taille d’image.

9. Indicateur d’état de fonctionnement de la 
sortie RAW (page 60)

Affiche l’état de sortie du signal RAW.

10. Indicateur d’état de la série UWP-D 
(page 14)

Affiche l’intensité du signal de niveau RF 
sous forme d’icône lorsqu’un appareil de 
série UWP-D est connecté à une griffe MI 
configurée pour le transfert audio numérique.

11. Indicateur de fréquence d’images de 
prise de vue en ralenti et accéléré 
(page 50)

12. Indicateur de capacité restante de la 
batterie/de tension DC IN (page 19)

13. Indicateur de mode de mise au point 
(page 40)

Signification Affichage

Mode Focus Hold Focus Hold

Mode MF MF

Mode AF AF

Mode AF de suivi en temps 
réel

Détection des visages/yeux AF (AF/ /Only/ /
)

Icône de détection des 
visages/yeux

Icône de détection des 
visages/yeux AF

Only

Icône de visage de suivi 
enregistré

 

Icône de pause AF lors de 
la détection des visages/
yeux AF1)

1) Affiché lorsqu’il n’y a aucun visage de suivi enregistré 
et aucun visage détecté, ou lorsqu’il y a un visage 
de suivi enregistré, mais le visage de la cible de suivi 
n’est pas détecté.

14. Indicateur de position de mise au point
Affiche la position de mise au point.

15. Indicateur de marqueur de mise au point 
(page 37)

Affiche la différence par rapport à la position 
de référence de mise au point dans une plage 
de –99999 à +99999.

16. Indicateur de position de zoom
Affiche la position du zoom dans une plage 
de 0 (grand angle) à 99 (téléobjectif) (si un 
objectif prenant en charge l’affichage du 
réglage de zoom est fixé).
Vous pouvez régler l’affichage sur un 
indicateur à barre ou sur un indicateur de 
distance de mise au point (page 121).

17. Indicateur d’état du GPS (page 56)
Affiche l’état du GPS.

18. Indicateur de mode de stabilisation 
d’image

19. Indicateur du statut Rec Control de sortie 
SDI/sortie HDMI (page 134)

Affiche le statut de sortie du signal de contrôle 
REC.

20. Indicateur de mise au point (page 36)

21. Indicateur de capacité restante du 
support

22. Indicateur du mode de balance des 
blancs

Affichage Signification

Mode automatique

 Hold Mode automatique en pause

W:P Mode prédéfini

W:A Mode de mémoire A

W:B Mode de mémoire B

23. Indicateur de verrouillage externe du 
code temporel/affichage des données 
temporelles (page 34)

Affiche « EXT-LK » en cas de verrouillage sur le 
code temporel d’un dispositif externe.

24. Indicateur de filtre ND (page 43)

25. Indicateur de fichier de scène 
(page 131)
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26. Indicateur de diaphragme
Affiche la position du diaphragme (valeur F 
ou valeur T) si un objectif prenant en charge 
l’affichage du réglage du diaphragme est 
attaché.

27. Indicateur d’avertissement du niveau de 
vidéo

28. Indicateur de gain (page 42)
Affiché comme une valeur EI lorsque Base 
Setting >Shooting Mode (page 96) dans le 
menu Project est réglé sur Cine EI.

Affichage Signification

Mode automatique

H Mode de préréglage H

M Mode de préréglage M

L Mode de préréglage L

Mode d’ajustement provisoire

29. Affichage des noms de plans (page 77)

30. Indicateur d’obturateur (page 43)

31. Indicateur du mode AE/niveau AE 
(page 42)

32. Indicateur de niveau à bulle
Affiche le niveau horizontal en incréments de 
±1° à ±15°.

33. Vumètre audio
Affiche le niveau audio de CH1 et CH2 ou de 
CH3 et CH4.
Les éléments suivants s’affichent en fonction 
du réglage Audio Output >Monitor CH 
(page 116) dans le menu Audio.

Réglage Monitor CH Canal d’affichage

CH1/CH2 CH1/CH2

CH3/CH4 CH3/CH4

MIX ALL CH1/CH2

CH1 CH1/CH2

CH2 CH1/CH2

CH3 CH3/CH4

Réglage Monitor CH Canal d’affichage

CH4 CH3/CH4

Le niveau audio peut être contrôlé sur l’écran 
d’état.

34. Moniteur de signal vidéo (page 54)
Affiche une forme d’onde, un vecteurscope et 
un histogramme.
Le type Monitor LUT du signal en cours de 
surveillance s’affiche lorsque Base Setting 
>Shooting Mode (page 96) dans le menu 
Project est réglé sur Cine EI.

35. Indicateur de format d’enregistrement 
(codec) (page 96)

Affiche le nom du format pour 
l’enregistrement sur des cartes mémoire XQD.

36. Indicateur de sensibilité de base/
indicateur ISO de base (page 42)

Lorsque Base Setting >Shooting Mode 
(page 96) dans le menu Project est réglé 
sur SDR ou HDR, cela affiche la sensibilité de 
base réglée à l’aide de ISO/Gain/EI >Base 
Sensitivity dans le menu Shooting.
Lorsque Base Setting >Shooting Mode 
(page 96) dans le menu Project est réglé 
sur Cine EI, cela affiche la sensibilité ISO de 
base réglée à l’aide de ISO/Gain/EI >Base ISO 
dans le menu Shooting.

37. Indicateur d’aide pour l’affichage 
gamma/de moniteur LUT

Affiche le statut d’aide pour l’affichage 
gamma. Vous pouvez activer/désactiver la 
fonction d’aide pour l’affichage gamma en 
affectant Gamma Display Assist à une touche 
personnalisable (page 48).
Affiche le réglage du moniteur LUT 
(page 93) lorsque Base Setting >Shooting 
Mode (page 96) dans le menu Project est 
réglé sur Cine EI.

38. Indicateur gamma (page 105)
Affiche le réglage gamma de l’image 
enregistrée sur des cartes mémoire XQD.

39. Indicateur d’état proxy

Affichage Signification

Enregistrement proxy activé

Enregistrement proxy

 
(clignotement)

Enregistrement proxy non 
prêt

Enregistrement proxy par 
fragments activé

Enregistrement proxy par 
fragments

 
(clignotement)

Enregistrement proxy par 
fragments non prêt

40. Indicateur d’enregistrement 4K & HD 
(Sub)

41. Indicateur de format d’enregistrement 
(fréquence d’images et méthode de 
balayage)

42. Indicateur du format d’enregistrement 
(taille d’image) (page 96)

Affiche la taille d’image pour l’enregistrement 
sur des cartes mémoire XQD.

43. Touche d’arrêt AF de suivi en temps réel 
(page 41)
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Informations affichées sur l’écran pendant la lecture

Les informations suivantes sont superposées sur l’image de lecture.

1

11 12 13 14 15 16

2 3 4 5 6 7 8 9 10

1. Indicateur d’état du réseau

2. Indicateur de téléchargement/indicateur 
de fichiers restants

3. Numéro de plan/nombre total de plans

4. Indicateur d’état de la lecture

5. Indicateur de format de lecture 
(fréquence d’images et méthode de 
balayage)

6. Indicateur d’état du mode client réseau

7. Indicateur de l’état de diffusion continue

8. Indicateur de format de lecture (taille 
d’image)

9. Indicateur de capacité restante de la 
batterie/de tension DC IN

10. Indicateur de format de lecture (codec)

11. Indicateur de support
L’icône  s’affiche si la carte mémoire est 
protégée en écriture.

12. Affichage de données temporelles

13. Affichage des noms de plans

14. Indicateur d’aide pour l’affichage gamma

15. Vumètre audio
Affiche le niveau audio de l’enregistrement.

16. Indicateur Gamma

Affichage d’icône

Affichage d’icônes de connexion au réseau

Mode réseau État de connexion Icône

Mode de point d’accès Fonctionnement en tant que point 
d’accès

Erreur de fonctionnement du point 
d’accès

Mode de station Connexion Wi-Fi
L’icône change selon l’intensité du signal 
(4 incréments)

   

Wi-Fi déconnecté (y compris pendant 
l’établissement d’une connexion)

Erreur de connexion Wi-Fi

Modem/smartphone 1) L’icône change selon l’intensité du signal 
de connexion 3G/4G (5 incréments)
L’icône de l’intensité de signal 3 s’affiche 
pour les modems n’indiquant pas 
l’intensité du signal.

Connexion 3G

 – 

Connexion 4G

 – 

Connexion réseau où il est 
impossible de faire une 
distinction 3G/4G

 – 

3G/4G déconnecté (y compris pendant 
l’établissement d’une connexion)

Erreur de connexion 3G/4G

Intensité du signal inconnue (intensité 
non indiquée par le modem/smartphone 
ou autre dispositif connecté)

1) Vous pouvez connecter deux modems lorsqu’un XDCA-FX9 (en option) est fixé au caméscope. Lorsque deux 
modems sont connectés, les icônes changent en fonction de l’état de ceux-ci, comme indiqué ci-dessous.

État de connexion Icône

Deux modems connectés, uniquement modem 1 en 
service

 

Deux modems connectés, uniquement modem 2 en 
service

 

Deux modems connectés, les deux en service  
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Affichage d’icône du mode client réseau

État de la connexion en mode client réseau Icône

État du mode client réseau connecté

État de veille de la connexion en mode client réseau

État d’erreur de la connexion en mode client réseau

Affichage de l’icône de la série UWP-D

État de l’émetteur État de réception Icône

Hors tension Pas de réception

État de transmission normal Réception en cours
 –   

(niveau de réception 
(4 incréments))

État silencieux Réception en cours 
(silencieux)

État d’avertissement de la capacité 
restante de la batterie

Réception en cours
 (Icône clignotante)

État d’avertissement de la capacité 
restante de la batterie et de silencieux

Réception en cours
 (Icône clignotante)

Ecran d’état

Vous pouvez vérifier les réglages et l’état du 
caméscope sur l’écran d’état. Les réglages des 
éléments marqués d’un astérisque (*) peuvent 
être modifiés.
L’écran d’état prend en charge les opérations 
tactiles.

Pour afficher l’écran d’état
ˎˎ Appuyez sur la touche STATUS.

[Conseil]
Vous pouvez afficher/masquer chaque écran d’état à 
l’aide de Status Page On/Off (page 120) dans le menu 

Technical.

Pour commuter l’écran d’état
ˎˎ Tournez la molette multifonction.
ˎˎ Appuyez sur les touches fléchées /.
ˎˎ Balayez l’écran d’état vers le haut/le bas.

Pour masquer l’écran d’état
ˎˎ Appuyez sur la touche STATUS.

Pour modifier un réglage

Lorsque l’écran d’état est affiché, appuyez 
sur la molette multifonction ou le sélecteur 
multiple pour permettre la sélection d’un 
élément de configuration dans une page. 
Sélectionnez un numéro de page et appuyez 
pour changer de page. Vous pouvez 
également sélectionner des éléments 
directement à l’aide d’une opération tactile.

[Conseil]
Vous pouvez désactiver les modifications à partir de 
l’écran d’état en réglant Menu Settings >User Menu Only 
(page 119) dans le menu Technical sur On.

Écran Main Status

Affiche les principales fonctions de la caméra 
et l’espace disponible sur le support.

Elément affiché Description

S&Q Frame Rate* Réglages de prise de vue et 
de fréquence d’image en 
ralenti et accéléré

Frequency/Scan* Réglages de la fréquence du 
système et de la méthode 
de balayage

Imager Scan* Mode de numérisation du 
capteur d’image

Media Remain 
(A)

Espace libre restant sur le 
support dans la fente A

ND Filter Réglage du filtre ND

ISO/Gain/EI Réglage d’indice ISO/Gain/
Exposition

Base ISO/
Sensitivity*

Réglage ISO/Sensibilité de 
base

Codec* Codec pour l’enregistrement 
et le réglage de l’activation/
désactivation de la sortie 
RAW

Media Remain (B) Espace libre restant sur le 
support dans la fente B

Scene File* Réglage du fichier de scène 
utilisé et de son identifiant 
de fichier

Monitor LUT* Réglage du moniteur LUT

Shutter Réglage de la vitesse 
d’obturation ou de l’angle 
d’obturation

Iris Réglage du diaphragme

Video Format* Taille d’image pour 
l’enregistrement sur des 
cartes mémoire XQD

RAW Output 
Format*

Taille d’image de la sortie 
RAW

White Balance Réglage de la balance des 
blancs
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Écran Camera Status

Affiche l’état de nombreux préréglages de la 
caméra.

Elément affiché Description

White Switch<B> Réglage de la mémoire B de 
balance des blancs

White Switch<A> Réglage de la mémoire A de 
balance des blancs

White Switch<P> Réglage de blanc prédéfini

ND<Preset> Réglages du filtre ND Preset1 
à 3

ISO / Gain 1) <L>* Réglage d’ISO/Gain 1) <L>

ISO / Gain 1) <M>* Réglage d’ISO/Gain 1) <M>

ISO / Gain 1) <H>* Réglage d’ISO/Gain 1) <H>

Base ISO/
Sensitivity*

Réglage ISO/Sensibilité de 
base

Zebra1* Réglage Zebra1 On/Off et 
niveau

Zebra2* Réglage Zebra2 On/Off et 
niveau

VF Gamma/
Gamma

Catégorie et courbe gamma

Scene File* Réglage du fichier de scène 
utilisé et de son identifiant 
de fichier

1) Indice de pose lorsque Shooting Mode est réglé sur 
Cine EI.

Écran Audio Status

Affiche le réglage d’entrée, le vumètre audio 
et le réglage du moniteur de volume pour 
chaque canal.

Elément affiché Description

CH1 Level Control État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence 
d’entrée

Wind Filter* Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH2 Level Control État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence 
d’entrée

Wind Filter* Réglage du filtre de 
réduction du bruit du vent 
du microphone

CH3 Level Control* État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence 
d’entrée

Wind Filter* Réglage du filtre de 
réduction du bruit du vent 
du microphone

Elément affiché Description

CH4 Level Control* État d’activation/
désactivation du réglage 
automatique

Level Meter Vumètre audio

Source* Source d’entrée

Reference* Niveau de référence 
d’entrée

Wind Filter* Réglage du filtre de 
réduction du bruit du vent 
du microphone

Audio Input Level* Réglage du niveau 
d’entrée audio maître

HDMI Output CH* Réglage de canal audio 
de sortie HDMI

Headphone Out* Réglage du type de sortie 
casque

Monitor CH* Réglage de canal de 
contrôle

[Remarque]
Les réglages Source pour CH1 et CH2 sont sélectionnés 
à l’aide du commutateur de sélection CH1 INPUT 
(page 7) et du commutateur de sélection CH2 
INPUT (page 7) sur le côté droit de l’appareil. Vous 
pouvez régler Source pour CH1 et CH2 lorsque vous 
utilisez un tuner sans fil portatif (page 26). Vous 
pouvez également régler Source pour CH2 lorsque le 
commutateur de sélection CH2 INPUT est réglé sur EXT.

Écran d’état Project

Affiche les réglage de base liés au projet de 
tournage.

Elément affiché Description

Frequency/Scan* Réglages de la fréquence du 
système et de la méthode 
de balayage

Codec* Réglage de codec pour 
l’enregistrement

Rec Function* Réglage d’activation/
désactivation et réglages 
principaux de la fonction 
d’enregistrement spécial

Elément affiché Description

Simul Rec* Réglage et état d’activation/
de désactivation de la 
fonction d’enregistrement 
simultané sur 2 fentes

Title Prefix 1) / 
Reel 2)

Réglages de la portion de 
titre du nom de plan/des 
réglages Camera ID et Reel 
Number

Imager Scan* Mode de numérisation du 
capteur d’image

Video Format* Taille d’image pour 
l’enregistrement sur des 
cartes mémoire XQD

Picture Cache 
Rec*

État et réglage de 
l’activation/la désactivation 
de la fonction 
d’enregistrement en cache 
d’image

Number 1) / Shot 2) Valeur du suffixe numérique 
du nom de plan/numéro de 
prise de vue

Shooting Mode* Réglage du mode de prise 
de vue

RAW Output 
Format*

Taille d’image de la sortie 
RAW

4K & HD (Sub) 
Rec*

État d’activation/
désactivation de la fonction 
enregistrement 4K & HD 
(Sub)

Proxy Rec* État et réglage de 
l’activation/la désactivation 
de la fonction 
d’enregistrement proxy

Genlock État de verrouillage de la 
synchronisation

1) Lorsque Auto Naming est réglé sur Plan
2) Lorsque Auto Naming est réglé sur Cam ID+Reel#
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Écran Monitoring Status

Affiche les réglages de sortie SDI, HDMI et 
vidéo.

Elément affiché Description

SDI1 Signal* Taille d’image de sortie

Info. Disp* Réglage d’activation/
désactivation de 
l’affichage de sortie

Color 
Gamut*

Réglage d’espace de 
couleur/Statut Monitor 
LUT

SDI2 Signal* Taille d’image de sortie

Info. Disp* Réglage d’activation/
désactivation de 
l’affichage de sortie

Color 
Gamut*

Réglage d’espace de 
couleur/Statut Monitor 
LUT

HDMI Signal* Taille d’image de sortie

Info. Disp* Réglage d’activation/
désactivation de 
l’affichage de sortie

Color 
Gamut*

Réglage d’espace de 
couleur/Statut Monitor 
LUT

Stream Signal Taille d’image de sortie

Info. Disp Affichage de sortie (Off 
(fixe))

Color 
Gamut*

Réglage d’espace de 
couleur/Statut Monitor 
LUT

RAW Taille d’image de la 
sortie RAW

Monitor LUT* Réglage du moniteur 
LUT

VF* Réglage d’aide pour 
l’affichage gamma/
Statut Monitor LUT/
Réglage d’espace de 
couleur

[Remarque]
Le réglage du moniteur LUT est lié à tous les systèmes 
de sortie, y compris le viseur. Seul le réglage de l’aide 
pour l’affichage gamma est disponible pour l’affichage 
du viseur.

Écran Assignable Button Status

Affiche les fonctions attribuées à chacune des 
touches attribuables.

Elément affiché Description

1 Fonction attribuée à la 
touche ASSIGN 1

2 Fonction attribuée à la 
touche ASSIGN 2

3 Fonction attribuée à la 
touche ASSIGN 3

4 Fonction attribuée à la 
touche ASSIGN 4

5 Fonction attribuée à la 
touche ASSIGN 5

6 Fonction attribuée à la 
touche ASSIGN 6

7 Fonction attribuée à la 
touche ASSIGN 7

8 Fonction attribuée à la 
touche ASSIGN 8

9 Fonction attribuée à la 
touche ASSIGN 9

10 Fonction attribuée à la 
touche ASSIGN 10

Focus Hold 
Button

Fonction attribuée à la 
touche Focus Hold de 
l’objectif

Multi Function 
Dial

Fonction attribuée à la 
molette multifonction

Assignable Dial Fonction attribuée à la 
molette personnalisable

Écran Battery Status

Affiche des informations à propos de la 
batterie et de la source DC IN.

Elément affiché Description

Detected Battery Type de batterie

Remaining Capacité restante (%)

Charge Count Nombre de charges

Capacity Capacité restante (Ah)

Voltage Tension (V)

Manufacture 
Date

Date de fabrication de la 
batterie

Video Light 
Remaining

Affiche la capacité restante 
de la batterie de la lampe 
vidéo.

Power Source Source d’alimentation

Supplied Voltage Tension de la source 
d’alimentation

Écran Media Status

Affiche la capacité restante et la durée 
d’enregistrement restante du support 
d’enregistrement.

Elément affiché Description

Informations du 
support A

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement A.

Mesure de la 
capacité restante 
du support A

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement A, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support A

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement A, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.

Elément affiché Description

Informations du 
support B

Affiche l’icône de support 
lorsque le support 
d’enregistrement est inséré 
dans le logement B.

Mesure de la 
capacité restante 
du support B

Affiche la capacité restante 
du support d’enregistrement 
inséré dans le logement B, 
exprimée en pourcentage 
sur un graphique en barres.

Durée 
d’enregistrement 
restante du 
support B

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement B, en 
minutes et sous les 
conditions d’enregistrement 
actuelles.

Informations de 
la carte SD

Affiche l’icône de support 
lorsque le support est inséré 
dans le logement de carte 
UTILITY SD/MS.

Protection de 
carte SD

Affiche l’icône de verrou 
lorsque le support inséré 
dans le logement de carte 
UTILITY SD/MS est protégé 
(verrouillé).

Mesure de la 
capacité restante 
de la carte SD

Affiche la capacité restante 
du support inséré dans le 
logement de carte UTILITY 
SD/MS, exprimée en 
pourcentage sur un 
graphique en barres.

Capacité restante 
de la carte SD

Affiche une estimation de la 
durée d’enregistrement 
restante sur le support 
d’enregistrement inséré 
dans le logement de carte 
UTILITY SD/MS, en minutes, 
ou affiche la capacité 
restante en Go.
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Écran GPS Status

Affiche les informations et l’état du 
positionnement du GPS.

Elément affiché Description

GPS État du positionnement et 
du signal de GPS

Dilution of 
Precision

Informations sur la précision 
du positionnement

Latitude Informations de latitude

Longitude Informations de longitude

Altitude Informations d’altitude

Positioning date 
and time

Date et heure du 
positionnement

Current date and 
time

Date et heure actuelles

Time Zone Réglage de fuseau horaire

Écran Network Status

Affiche l’état de connexion au réseau.

Elément affiché Description

Wireless LAN Réglages du réseau sans fil 
et état de connexion

Wired LAN Réglages du réseau LAN 
filaire et état de connexion

Modem 1 Réglages du réseau sans fil 
et état de connexion du 
modem (en option)

Modem 2 Réglages du réseau sans fil 
et état de connexion du 
modem (en option)

Écran NCM/Streaming Status

Affiche l’état de connexion en mode client 
réseau et l’état de la diffusion continue.

Elément affiché Description

Network Client 
Mode Status

État du mode client réseau

Elément affiché Description

CCM Name Nom du CCM connecté en 
mode client réseau

CCM Address Adresse du CCM connecté 
en mode client réseau

QoS Streaming1 
Bit Rate

Débit binaire de diffusion 
continue 1

QoS Streaming2 
Bit Rate

Débit binaire de diffusion 
continue 2

Streaming Status État de la diffusion continue

Streaming Type Type de diffusion continue 
actuellement sélectionné

Écran File Transfer Status

Affiche les informations de transfert de 
fichiers.

Elément affiché Description

Auto Upload État On/Off de la fonction 
Auto Upload

Auto Upload 
(Proxy)

État On/Off/Chunk de la 
fonction Auto Upload (Proxy)

Total Transfer 
Progress

Progression du transfert de 
toutes les tâches

Default Upload 
Server

Nom du serveur de 
destination pour Auto 
Upload/Auto Upload (Proxy)

Job Status 
(Remain / Total)

Nombre de tâches restantes 
et nombre total de tâches

Current File 
Transfer Progress

Progression du transfert du 
fichier actuel

Current 
Transferring File 
Name

Nom du fichier en cours de 
transfert

Server Address Adresse du serveur de 
destination de transfert de 
fichiers

Destination 
Directory

Répertoire de destination du 
serveur de destination de 
transfert de fichiers

Utilisation des écrans de réglages tactiles

Disposition de l’écran

Élément Touche Set

Marque 
indiquant le 
réglage actuel

Curseur de sélection de 
réglage (cadre orange)

Nom d’élément

Options de sélection

Fonctionnement

1 Touchez un élément de configuration.

Toucher

Les options de sélection pour la valeur 
apparaissent.

2 Touchez directement une valeur ou faites 
glisser/saisissez en glissant pour déplacer 
la valeur souhaitée à la position du 
curseur.

Saisir en glissant

3 Touchez la touche Set ou le curseur de 
sélection de la valeur.
La valeur est appliquée, et l’affichage 
revient à l’écran précédent.

[Conseils]
ˎˎ Vous pouvez également appuyer sur la touche 

fléchée  pour appliquer la valeur.
ˎˎ  Appuyez sur la touche CANCEL/BACK pour retourner à 

la valeur précédente.
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ˎˎ  Vous pouvez également utiliser la molette 
multifonction ou le sélecteur multiple.
ˎˎ  Les opérations tactiles peuvent également être 

désactivées (page 10).
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Alimentation
Vous pouvez utiliser un pack batterie ou une 
alimentation CA à partir d’un adaptateur CA.
Pour des raisons de sécurité, utilisez 
uniquement les packs de batteries et les 
adaptateurs CA Sony listés ci-dessous.

Pack batterie au lithium-ion
BP-U35 (fourni)
BP-U70
BP-U100

Chargeurs de batterie
BC-U1A (fourni)
BC-U2A

Adaptateur CA (fourni)

Vous pouvez utiliser une batterie à griffe en V 
quand un module d’extension XDCA-FX9 est 
installé.
Pour des raisons de sécurité, utilisez 
uniquement les packs de batteries et les 
adaptateurs CA Sony listés ci-dessous.

Pack batterie au lithium-ion
BP-GL95B

Adaptateur CA
AC-DN10A

[ATTENTION]

Ne rangez pas les packs batteries dans des 
endroits exposés aux rayons directs du soleil, 
aux flammes ou à des températures élevées.

[Remarques]
ˎˎ Lors du fonctionnement avec une source 

d’alimentation CA, utilisez l’adaptateur CA fourni.
ˎˎ Réglez toujours le commutateur POWER sur la 

position Off avant de retirer ou d’installer un pack 
batterie ou un adaptateur CA. Si le caméscope est 
retiré ou installé avec le commutateur POWER en 
position On, il est possible, dans certains cas, qu’il 
ne puisse pas démarrer. Si le caméscope ne peut 
pas être démarré, réglez le commutateur POWER 
sur la position Off et enlevez le pack batterie ou 
l’adaptateur CA de manière temporaire, puis attendez 

environ 30 secondes avant de les installer à nouveau. 
(Si l’adaptateur CA est retiré ou installé pendant que 
le caméscope fonctionne sur le pack batterie, ou vice 
versa, il peut être retiré ou installé sans problème 
avec le commutateur POWER en position On.)
ˎˎ Lorsque vous utilisez un adaptateur AC-DN10A et 

que des périphériques sont fixés au caméscope, 
vérifiez que la consommation d’énergie totale des 
périphériques ne dépasse pas 25 W.

Utilisation d’un pack batterie

Pour raccorder un pack batterie, branchez le 
pack batterie dans la prise (page 8), en 
l’enfonçant le plus loin possible, puis abaissez-
le pour le verrouiller en place.

Pour enlever un pack batterie, maintenez la 
touche BATT RELEASE (page 8) enfoncée, 
faites glisser le pack batterie vers le haut et 
retirez-le de sa fixation.

Touche BATT 
RELEASE

[Remarques]
ˎˎ Avant de raccorder un pack batterie, chargez la 

batterie en utilisant le chargeur de batterie BC-U1A ou 
BC-U2A dédié.
ˎˎ Charger un pack batterie alors qu’il est encore chaud 

(par exemple, immédiatement après son utilisation) 
risque de ne pas le recharger complètement.

Vérification de la capacité restante

En cas de prise de vue/lecture à l’aide 
d’un pack batterie, la capacité restante 
de la batterie est affichée dans le viseur 
(page 11).

Icône Signification

91% à 100%

71% à 90%

51% à 70%

31% à 50%

11% à 30%

0% à 10%

Le caméscope indique la capacité restante 
en calculant l’autonomie du pack batterie si 
l’appareil continue de fonctionner selon son 
niveau de consommation électrique actuel.

Lors de l’utilisation d’un module 
d’extension

Lors de l’utilisation du module d’extension 
XDCA-FX9, la tension de batterie ou la capacité 
restante de la batterie est affichée, en fonction 
de la batterie utilisée.

[Remarque]
Le pack batterie du caméscope ne peut pas être utilisé 
quand un module XDCA-FX9 est fixé au caméscope. 
Vous devez raccorder un pack batterie au XDCA-FX9 
ou brancher l’appareil sur une source d’alimentation 
externe.

Si le niveau de charge du pack batterie 
devient faible

Si le niveau de charge restant de la batterie 
tombe au-dessous d’un certain niveau au 
cours du fonctionnement (état Low Battery), 
un message de batterie faible s’affiche, le 
témoin d’enregistrement/de signalisation 
commence à clignoter et un signal sonore 
vous avertit.
Si la charge restante de la batterie tombe au-
dessous du niveau auquel le fonctionnement 
ne peut pas continuer (état Battery Empty), un 
message de batterie vide s’affiche.
Remplacez pack par un pack batterie chargé.

Modification des niveaux de tension 
d’avertissement

Par défaut, le niveau Low Battery est réglé 
sur 10% de la charge de batterie complète 
et le niveau Battery Empty est réglé sur 3%. 
Vous pouvez changer les réglages de niveau 
d’avertissement en utilisant Camera Battery 
Alarm (page 121) dans le menu Technical.
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Utilisation de l’alimentation CA

Le raccordement du caméscope à une source 
d’alimentation CA vous permet de l’utiliser 
sans avoir à vous inquiéter de recharger le 
pack batterie.

Connecteur DC IN

Adaptateur CA

Cordon d’alimentation

Connectez l’adaptateur CA au connecteur 
DC IN du caméscope et branchez le cordon 
d’alimentation (fourni) à une source 
d’alimentation CA.

Si la tension de sortie de l’adaptateur CA 
devient faible

Si la tension de sortie de l’adaptateur CA 
tombe au-dessous d’un certain niveau au 
cours du fonctionnement (état DC Low 
Voltage1), un message vous informant que 
la tension de sortie de l’adaptateur CA a 
chuté s’affiche, le témoin d’enregistrement/
de signalisation commence à clignoter et un 
signal sonore est émis.
Si la tension de sortie de l’adaptateur CA 
tombe au-dessous du niveau auquel le 
fonctionnement ne peut pas continuer (état 
DC Low Voltage2), un message vous informant 

que la tension de sortie de l’adaptateur CA est 
trop faible s’affiche.
Si cela se produit, l’adaptateur CA peut être 
défectueux. Vérifiez l’adaptateur CA, le cas 
échéant.

[Conseil]
Si une source d’alimentation CA est utilisée alors 
que la batterie est installée, le caméscope passe 
automatiquement à l’alimentation sur batterie si la 
tension de sortie de l’adaptateur CA chute.

Modification des niveaux 
d’avertissement

Le niveau DC Low Voltage1 est réglé sur 
16,5 V et le niveau DC Low Voltage2 est réglé 
sur 15,5 V par défaut. Vous pouvez changer 
les réglages de niveau d’avertissement en 
utilisant Camera DC IN Alarm (page 121) 
dans le menu Technical.

Adaptateur CA

ˎˎ Ne connectez pas et n’utilisez pas un 
adaptateur CA dans un espace confiné, 
comme par exemple entre un mur et des 
meubles.
ˎˎ Connectez l’adaptateur CA à la 
source d’alimentation CA la plus 
proche. Si un problème se produit 
lors du fonctionnement, débranchez 
immédiatement le cordon d’alimentation de 
la source d’alimentation CA.
ˎˎ Ne court-circuitez pas les pièces métalliques 
de la fiche de l’adaptateur CA. Cela 
entraînerait un dysfonctionnement.
ˎˎ La batterie ne peut pas être chargée 
lorsqu’elle est fixée au caméscope, même si 
l’adaptateur CA est branché.



2. Préparatifs21

Fixation de dispositifs

Fonctionnement de la manette de 
serrage

Utilisez les manettes de serrage lors de la 
fixation/du retrait ou du réglage de la position 
du microphone et du viseur.
Lors de la fixation, tournez la manette de 
serrage dans le sens des aiguilles d’une 
montre pour fixer la tige.
Lors du retrait ou du réglage de la position, 
tournez la manette de serrage dans le sens 
contraire des aiguilles d’une montre pour 
desserrer la manette de serrage.
Si la manette de serrage est difficile à tourner 
en raison de sa position, retirez la manette de 
serrage et tournez-la à un angle qui facilite 
l’opération. Replacez ensuite la manette de 
serrage.

Manette de serrage

Réglage de la position du support 
de microphone

Desserrez la manette de serrage et tournez le 
support de microphone pour le déplacer vers 
l’avant/l’arrière afin de régler la position.

Manette de serrage

Support de microphone et orientation 
du microphone

Procédez à la fixation de manière à ce que 
le support de microphone et le microphone 
soient orientés de la manière indiquée sur le 
schéma suivant.

Remplacement de la tige de 
microphone

[Remarques]
ˎˎ La tige de microphone est fixée dès l’envoi depuis 

l’usine.
ˎˎ Fixez/retirez la tige de microphone lorsque le 

caméscope est hors tension.
ˎˎ Fixez/retirez la tige de microphone avec le capuchon 

de boîtier fixé afin de ne pas endommager le capteur 
d’image.

1 Desserrez la vis.

2 Retirez la tige de microphone.

3 Fixez la tige de microphone dans l’ordre 
inverse.

Fixation du viseur

[Remarque]
Fixez/retirez le viseur lorsque le caméscope est hors 
tension. Si vous retirez le viseur alors que le caméscope 
fonctionne, ce dernier redémarre automatiquement.

1 Desserrez la manette de serrage du viseur 
et insérez le viseur sur la tige de 
microphone.

Manette de 
serrage

 [Remarque]
Lorsque vous attachez le viseur, fixez l’attache de la 
tige à la tige du microphone de manière à ce que 
les pièces soient positionnées comme indiqué dans 
le schéma suivant.
 – Manette de serrage bloquante positionnée entre 

la tige du viseur et la poignée
 – Tige du viseur positionnée au-dessus de la tige 

du microphone

Poignée

Manette de 
serrage 

bloquante

Tige du 
viseur

Tige du 
microphone

Attache 
de tige
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2 Ajustez le positionnement gauche/droit 
du viseur, serrez l’attache, connectez le 
câble du viseur au connecteur de viseur 
du caméscope, puis fixez bien le câble du 
viseur dans l’attache de câble.

Entretoise 
d’attache

 [Remarques]
ˎˎ  Attachez le viseur de manière à ce que la tige du 

viseur soit positionnée au-dessus de la manette 
de serrage bloquante de l’attache de viseur.

Tige du viseur

Manette de serrage 
bloquante

Attache de viseur

Viseur

ˎˎ Vérifiez que le viseur est bien fixé. Le viseur peut 
tomber pendant la prise de vue si la manette de 
serrage est desserrée.

Ajustement de l’orientation du viseur

Inclinez le viseur vers le haut/bas pour ajuster 
l’angle du viseur.

Vous pouvez ajuster l’angle de sorte que le 
viseur fasse face au sujet. Le fait de régler 
le commutateur MIRROR sur la position B/T 
inverse les côtés gauche et droit de l’image 
sur l’écran LCD, mais l’image est enregistrée 
dans l’orientation correcte.

Ajustement de la position du viseur

Ajustement selon un angle de 90°
Si une entretoise d’attache carrée est fixée 
au joint de connexion de la tige, vous pouvez 
ajuster la position du viseur par incréments de 
90°.
Retirez temporairement le viseur pour ajuster 
l’angle, puis rattachez le viseur.

Ajustement selon un angle arbitraire
Si une entretoise d’attache ronde est fixée au 
joint de connexion de la tige, vous pouvez 
tourner le viseur sur la tige pour ajuster la 
position du viseur.

Si le viseur est tourné à 180° comme indiqué 
sur le schéma suivant, réglez le commutateur 
MIRROR sur la position ROT pour renverser 
l’affichage de l’image et l’affichage du texte 
horizontalement et verticalement.

[Remarque]
Lors de la fixation d’une entretoise d’attache ronde, 
attachez-la à une tige commerciale de ø15 mm.

[Conseil]
Une entretoise d’attache ronde est fixée par défaut.

Changement de l’entretoise d’attache

Retirez l’entretoise d’attache comme indiqué 
sur le schéma suivant, alignez la saillie sur 
l’entretoise carrée ou l’entretoise ronde avec 

la cannelure située sur l’attache, puis insérez 
l’entretoise.

Saillie

Saillie

Cannelure

Cannelure

[Remarque]
Placez toujours une rondelle. Si aucune rondelle 
n’est placée, la force de serrage sur la tige peut être 
insuffisante et peut provoquer la chute du viseur.

Vous pouvez déterminer la forme de 
l’entretoise, comme indiqué sur les schémas 
suivants.

Entretoise d’attache carrée

Repère carré
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Entretoise d’attache ronde

Repère rond

Retrait du viseur

Détachez la manette de serrage du viseur et 
utilisez la procédure inverse de celle utilisée 
pour la fixation du viseur.

Fixation de l’oculaire

[Remarque]
Fixez/retirez l’oculaire lorsque le caméscope est hors 
tension.

1 Fixez le crochet situé sur le haut de 
l’oculaire au crochet situé sur le haut du 
viseur puis fixez l’attache métallique 
située en bas de l’oculaire au crochet situé 
en bas du viseur.

Crochets de fixation

2 Appuyez sur la plaque de verrouillage 
situé sous l’oculaire dans la direction de la 
flèche pour verrouiller l’oculaire.

Plaque  
de verrouillage

Ouverture de l’oculaire

Appuyez sur le bouton indiqué par la flèche.

Ouvrez l’oculaire vers le haut après avoir 
déverrouillé la pièce. Le viseur est directement 
visible lorsque l’oculaire est ouvert.

Retrait de l’arrière de l’oculaire

L’oculaire ouvert vers le haut, retirez le verrou 
de l’oculaire dans le sens de la flèche () et 
glissez l’arrière de l’oculaire dans le sens de 
la flèche pour le retirer (). Lorsque vous 
avez retiré l’arrière de l’oculaire, vous pouvez 
utiliser la face avant de l’oculaire à la place 
d’un pare-soleil.

Fixation de l’arrière de l’oculaire
Lorsque vous fixez l’arrière de l’oculaire, 
alignez la saillie de la charnière sur la rainure 
de guidage et poussez-la dans le sens de la 
flèche, comme indiqué sur le schéma suivant, 
jusqu’au verrouillage.

Rainure de 
guidage

Saillie

Retrait de l’oculaire

Retirez le verrou de l’oculaire puis retirez 
l’oculaire du viseur.

Fixation d’un objectif

[ATTENTION]
Ne laissez pas l’objectif orienté en plein soleil. Les 
rayons directs du soleil peuvent entrer par l’objectif, se 
concentrer dans le caméscope et provoquer un incendie.

[Remarques]
ˎˎ Fixez/retirez l’objectif lorsque le caméscope est hors 

tension.
ˎˎ Un objectif est un composant de précision. Ne 

placez pas l’objectif sur une surface avec le côté 
de la monture d’objectif tourné vers le bas. Fixez le 
capuchon de la monture d’objectif fourni.

[Conseil]
Pour de plus amples informations concernant les 
objectifs pouvant être utilisés avec le caméscope, 
contactez votre technicien Sony.

Fixation d’un objectif à monture E

1 Retirez le cache de l’objectif.

2 Déverrouillez la butée de la bague de 
verrouillage de l’objectif, tournez la bague 
de verrouillage de l’objectif dans le sens 
des aiguilles d’une montre et retirez le 
capuchon de boîtier du caméscope.



2. Préparatifs : Fixation de dispositifs24

Bague de 
verrouillage 
de l’objectif

Butée de la 
bague de 
verrouillage 
de l’objectif

3 Alignez le repère de monture d’objectif 
(blanc) avec le caméscope, insérez 
prudemment l’objectif, puis tournez 
lentement l’objectif dans le sens contraire 
des aiguilles d’une montre pour fixer 
l’objectif.

Repères de monture (blancs)

[Remarques]
ˎˎ Si la butée de la bague de verrouillage de l’objectif 

ne revient pas en position de verrouillage lorsque 
l’objectif est fixé, placez manuellement la butée en 
position de verrouillage.
ˎˎ Lors de la fixation d’un objectif, alignez le repère 

de monture (blanc) sur la bague de verrouillage 
de l’objectif avec le repère de monture (blanc) du 
caméscope.

Fixation d’un objectif à monture A

Pour utiliser un objectif à monture A, fixez un 
adaptateur de monture d’objectif (optionnel), 
puis fixez l’objectif à monture A.

[Remarque]
Lorsque vous utilisez un objectif à monture A, le 
diaphragme se règle manuellement et la mise au point 
est paramétrée sur MF.

Retrait d’un objectif

Retirez un objectif en suivant la procédure 
suivante.

1 Déverrouillez la butée de la bague de 
verrouillage de l’objectif et tournez la 
bague de verrouillage de l’objectif dans le 
sens des aiguilles d’une montre en tenant 
fermement l’objectif.

2 Tirez l’objectif vers l’avant pour l’extraire.

[Remarques]
ˎˎ Lors du retrait d’un objectif, alignez le repère de 

monture sur la bague de verrouillage de l’objectif 
avec le repère de monture du caméscope.
ˎˎ Saisissez fermement l’objectif à la main pour 

empêcher qu’il ne tombe.
ˎˎ Si un autre objectif n’est pas immédiatement fixé, 

replacez toujours le capuchon de boîtier.

Réglages de diaphragme pour les 
objectifs dotés d’un commutateur Auto 
Iris

ˎˎ Quand l’objectif Auto Iris est réglé sur 
AUTO, le diaphragme est automatiquement 
ajusté et peut également être ajusté 
manuellement depuis le caméscope.
ˎˎ Quand l’objectif Auto Iris est réglé sur 
MANUAL, le diaphragme peut uniquement 
être ajusté grâce à la bague d’objectif. 
L’utilisation du diaphragme depuis le 
caméscope n’a aucun effet.

Réglages de mise au point pour les 
objectifs avec commutateur de mise au 
point

ˎˎ Quand le commutateur de mise au point de 
l’objectif est réglé sur AF/MF ou AF, la mise 
au point est automatiquement ajustée et 
peut également être ajustée manuellement 
depuis une télécommande.
ˎˎ Quand le commutateur de mise au point de 
l’objectif est réglé sur MF, la mise au point 
est ajustée à l’aide de la bague d’objectif et 
peut également être ajustée manuellement 
depuis une télécommande.

 [Remarque]
Lorsque vous utilisez un objectif à monture A, il se 
peut que vous ne puissiez pas utiliser le réglage 
manuel depuis une télécommande.

ˎˎ Quand le commutateur de mise au point 
de l’objectif est réglé sur Full MF, la mise au 
point peut uniquement être ajustée grâce à 
la bague d’objectif. L’utilisation de la mise 
au point depuis le caméscope n’a aucun 
effet.

Fixation à un trépied

Utilisez les orifices de vis du trépied sur le 
caméscope lorsque vous fixez un trépied. 
Utiliser la monture pour trépied sur l’objectif 
pourrait provoquer des dommages.

Objectifs anamorphoseurs

Pour plus de détails sur la procédure pour 
l’affichage de décompression dans le viseur 
de l’appareil, consultez la page 55.

Fixation de la télécommande à 
poignée

[Remarque]
Fixez/retirez la télécommande à poignée lorsque le 
caméscope est hors tension.

1 Fixez le bras sur la fixation de poignée, 
puis serrez la vis.
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2 Branchez le câble de télécommande de 
poignée sur le connecteur Multi/USB du 
caméscope et fixez le câble grâce à 
l’entretoise d’attache.

Dispositif 
de fixation

[Remarques]
ˎˎ Lorsque vous installez le câble de télécommande 

de poignée, fixez-le dans l’entretoise d’attache pour 
éviter de l’endommager.
ˎˎ Vérifiez que le bras est bien fixé au caméscope. Le 

caméscope peut tomber au cours de la prise de vue si 
la vis est desserrée.
ˎˎ Ne soutenez pas le poids du caméscope en tenant 

uniquement la télécommande à poignée.
ˎˎ Après avoir connecté le câble de télécommande de 

poignée, verrouillez toujours le câble dans l’attache. 
Si vous tirez trop fort sur le câble pendant l’utilisation, 
vous risquez d’endommager le connecteur.
ˎˎ Si le câble de poignée vous gêne, fixez-le à l’aide de 

l’attache de câble au centre du bras.

Ajustement de la position de la 
télécommande à poignée

ˎˎ Desserrez la vis de montage du bras, ajustez 
l’angle du bras (1), puis serrez la vis.

ˎˎ Desserrez la vis d’extension du bras, ajustez 
la longueur du bras (2), puis serrez la vis.
ˎˎ Appuyez sur le levier de rotation de la 
poignée (page 9) pour ajuster l’angle de 
la télécommande de poignée (3).

2

3

1

Fixation de la poignée à proximité du 
caméscope

1 Retirez la vis de montage du bras (1).

2 Desserrez la vis d’extension du bras (2) et 
allongez le bras jusqu’à ce qu’un orifice 
devienne visible (3).

1

2

3

 [Remarque]
Après avoir allongé le bras, serrez fermement la vis.

3 Branchez le câble de télécommande de 
poignée sur le connecteur Multi/USB du 
caméscope.

4 Alignez la saillie sur le bras avec la 
cannelure située sur le point de fixation 
de la poignée et bloquez le tout en 
position à l’aide de la vis retirée à l’étape 
1.

Ajustement de la position de 
l’épaulière

Vous pouvez faire glisser l’épaulière vers 
l’avant ou vers l’arrière. Ajustez la position 
de l’épaulière de manière à pouvoir utiliser 
facilement le caméscope lorsque vous le 
placez sur l’épaule.

2

1 3

1 3 1 3

Épaulière

1 Desserrez les trois vis de l’épaulière.

2 Faites glisser l’épaulière vers 
l’avant/l’arrière jusqu’à la position 
souhaitée.

3 Serrez fermement les vis.
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Fixation du XDCA-FX9

Vous pouvez ajouter des fonctions au 
caméscope, comme une batterie à griffe 
en V ou un LAN filaire, en fixant un module 
d’extension XDCA-FX9 (en option) au 
caméscope.

[Remarques]
ˎˎ Le pack batterie du caméscope ne peut pas être 

utilisé quand un module XDCA-FX9 est fixé au 
caméscope. Vous devez raccorder un pack batterie 
au XDCA-FX9 ou brancher l’appareil sur une source 
d’alimentation externe.
ˎˎ Fixez/retirez le module XDCA-FX9 pendant que le 

caméscope est hors tension.

1 Enlevez le pack batterie (page 19) fixé 
au caméscope.

2 Retirez les deux vis et le couvercle du bloc 
de connecteur de module d’extension du 
caméscope.

3 Alignez les saillies du XDCA-FX9 avec les 
cannelures gauche et droite du 
caméscope et faites-les glisser 
entièrement, jusque dans le bloc de 
connecteur.

Cannelures Saillies

4 Serrez les deux vis sur le dessus du XDCA-
FX9 pour fixer le XDCA-FX9.

Retrait du module XDCA-FX9

Desserrez les deux vis sur le dessus du XDCA-
FX9 et enlevez le XDCA-FX9 du caméscope.

Fixation d’une batterie à griffe en 
V

Insérez la batterie à griffe en V dans la fixation 
du pack batterie sur le module XDCA-FX9.

Retrait d’une batterie à griffe en V

Retirez la batterie à griffe en V de la fixation 
de pack batterie sur le XDCA-FX9 tout en 
maintenant enfoncé le levier de sortie de la 
batterie.

Raccordement des protecteurs de 
clé électronique

Vous pouvez raccorder un protecteur de clé 
électronique pour protéger un modem ou 
un autre périphérique USB connecté à un 
connecteur USB.
Raccordez le protecteur de clé électronique et 
le support de montage du protecteur de clé 
au module d’extension et fixez-le solidement 
en position à l’aide des vis du support de 
montage.

Plaque de montage 
du protecteur de clé 
électronique

Raccordement à l’aide d’une sangle de 
fixation

Raccordez la sangle de fixation au protecteur 
de clé électronique pour fixer solidement un 
périphérique USB en place.
Raccordez la boucle de la sangle à l’arrière 
du protecteur de clé électronique et passez 
la sangle au-dessus du protecteur de clé 
électronique comme indiqué ci-dessous.

Sangle de fixation

Boucle

Fixation au tuner sans fil portatif 
(lors de l’utilisation d’un 
microphone sans fil)

Vous pouvez raccorder l’un des tuners sans 
fil portatifs suivants, une fois le caméscope 
éteint, lorsque vous utilisez un microphone 
sans fil.
ˎˎ Tuner de diversité synthétisé UHF URX-S03D
ˎˎ Récepteur sans fil numérique DWR-S02DN

Reportez-vous au manuel d’instructions du tuner sans fil 
portatif.

[Remarque]
Les tuners sans fil pris en charge varient en fonction de 
la région et de la bande de fréquence correspondante. 
Consultez votre revendeur Sony ou votre représentant 
commercial Sony pour connaître les tuners sans fil qui 
peuvent être utilisés avec cet appareil.
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1 Retirez les quatre vis fixant le couvercle de 
la fente d’extension, puis retirez le 
couvercle.

2 Insérez le DWR-S02DN ou URX-S03D dans 
le logement, puis revissez les quatre vis.

DWR-S02DN ou 
URX-S03D

3 Réglez l’une des options suivantes.
Pour l’entrée CH1 : réglez le commutateur 

de sélection CH1 INPUT sur MI SHOE, et 
réglez Audio Input >CH1 MI SHOE Input 
Select dans le menu Audio sur 
Wireless.

Pour l’entrée CH2 : réglez le commutateur 
de sélection CH2 INPUT sur MI SHOE, et 
réglez Audio Input >CH2 MI SHOE Input 
Select dans le menu Audio sur 
Wireless.

Pour l’entrée CH3/CH4 : réglez Audio Input 
>CH3 Input Select ou CH4 Input Select 
dans le menu Audio sur Wireless.
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Configuration des opérations de base du caméscope
L’écran de réglages initiaux s’affiche dans le 
viseur la première fois que le caméscope est 
mis sous tension ou après le déchargement 
total de la batterie de secours.
Réglez la date et l’heure de l’horloge interne 
en utilisant cet écran.
Avant la prise de vue, configurez les 
opérations de base du caméscope pour les 
adapter à l’application nécessaire.

Time Zone
La fonction Time Zone définit le décalage 
horaire par rapport au temps universel. 
Changez le réglage si nécessaire.

Réglage de la date et de l’heure

Utilisez les touches fléchées (page 7) ou 
la molette multifonction (page 4) pour 
sélectionner des éléments et des réglages, 
puis appuyez sur la touche SET ou la molette 
multifonction pour appliquer les réglages et 
lancer le fonctionnement de l’horloge.
Une fois que l’écran de réglages est fermé, 
vous pouvez changer la date, l’heure et 
le fuseau horaire à l’aide de Clock Set 
(page 129) dans le menu Maintenance.

[Remarques]
ˎˎ Si le réglage d’horloge est perdu pour cause de 

déchargement complet de la batterie de secours suite 
à une longue déconnexion de l’alimentation (pas de 
pack batterie et pas de source d’alimentation DC IN), 
l’écran de réglages initiaux s’affiche lors de la mise 
sous tension suivante du caméscope.
ˎˎ Pendant que l’écran de réglages initiaux est affiché, 

aucune autre opération n’est possible, sauf la 
mise hors tension, jusqu’à ce que vous finissiez les 
réglages sur cet écran.
ˎˎ Le caméscope possède une batterie rechargeable 

intégrée afin de stocker la date, l’heure et d’autres 
réglages, même lorsque le caméscope est éteint. Pour 
en savoir plus sur la batterie rechargeable intégrée, 
consultez page 137.

Mode de prise de vue

Vous pouvez commuter le mode de prise 
de vue, entre le « SDR mode » (pour créer 
une souplesse d’images sur place), « HDR 
mode » (pour la prise de vue avec un espace 
colorimétrique et une plage dynamique plus 
vastes), et le « Cine EI mode » (pour lequel le 
caméscope fonctionne comme une caméra 
de film, les métrages étant développés en 
postproduction).
Sélectionnez le mode à l’aide de Base Setting* 
>Shooting Mode (page 96) dans le menu 
Project.
* Pouvant également être configurés sur l’écran d’état.

[Remarques]
ˎˎ Le mode Cine EI comporte les limites suivantes.

ˎˎ Fonctions ne pouvant pas être ajustées 
automatiquement (suivi)
 – Equilibre des blancs
 – Gain
 – Obturateur

ˎˎ Fonctions ne pouvant pas être configurées
 – Sensibilité ISO/gain (réglé sur la sensibilité ISO 

de base (fixe))
 – Réglages du menu Paint (ils sont tous 

désactivés)
 – Scene File (désactivé)

ˎˎ Les fonctions suivantes sont uniquement disponibles 
en mode Cine EI.

ˎˎ Exposure Index
ˎˎ Monitor LUT

Lorsque vous réglez le mode de prise 
de vue sur le mode Cine EI, sélectionnez 
l’espace de couleur de base pour le signal 
d’enregistrement et le signal de sortie. 
L’espace de couleur sélectionné ici est l’espace 
de couleur de la sortie vidéo lorsque MLUT est 
réglé sur Off.
Sélectionnez l’espace de couleur à l’aide de 
Cine EI Setting >Color Gamut (page 98) 
dans le menu Project.
ˎˎ S-Gamut3.Cine/SLog3 : gamme de couleurs 
facile à ajuster pour le mode de cinéma 
numérique (DCI-P3).

ˎˎ  S-Gamut3/SLog3 : espace de couleurs 
large qui couvre l’espace de couleurs ITU-R 
BT.2020 de Sony.

Enregistrement des données LUT en 
tant que métadonnées

En mode Cine EI, les données LUT (données 
Cube) appliquées à l’image du moniteur lors 
de la prise de vue peuvent être enregistrées 
en tant que métadonnées de plan.
Réglez Cine EI Setting >Embed LUT File 
(page 98) dans le menu Project sur On.
Les données Cube LUT sélectionnées au début 
de l’enregistrement sont sauvegardées en 
tant que métadonnées. Cependant, elles ne 
pourront pas être enregistrées en tant que 
métadonnées dans les cas suivants.
ˎˎ Lorsque la mémoire interne ne contient 
aucune donnée Cube
ˎˎ Si cette situation survient alors que la 
mémoire interne contient des données 
Cube
 – Lorsque l’enregistrement démarre 
immédiatement après le changement des 
données LUT à appliquer

Les données LUT sont enregistrées lorsque 
Monitor LUT >LUT Select (page 94) dans 
le menu Shooting est réglé sur 709(800%) 
ou s709, ou lorsqu’un utilisateur 3D LUT 
enregistré dans la mémoire interne est 
sélectionné à l’aide de User 3D LUT Select 
(page 94).

[Remarques]
ˎˎ Une seule métadonnée peut être enregistrée par plan.
ˎˎ Lorsque Monitor LUT Setting >Internal Rec 

(page 94) dans le menu Shooting est réglé sur 
MLUT On, les métadonnées ne peuvent pas être 
enregistrées.
ˎˎ Si un fichier avec un symbole  à gauche de son nom 

est sélectionné à l’aide de Monitor LUT >User 3D LUT 
Select (page 94) dans le menu Shooting, alors les 
données Cube ne seront pas sauvegardées. Chargez 
une nouvelle fois les données d’utilisateur 3D LUT et 
sélectionnez-les.

Fréquence du système

Sélectionnez la fréquence à l’aide de Rec 
Format >Frequency* (page 96) dans le 
menu Project. Le caméscope peut redémarrer 
automatiquement après avoir commuté, selon 
la valeur sélectionnée.
* Pouvant également être configurés sur l’écran d’état.

[Remarque]
Vous ne pouvez pas commuter la fréquence du système 
pendant l’enregistrement ou la lecture.

Mode de numérisation par 
imageur

Vous pouvez régler la taille d’image effective 
et la résolution du capteur d’image.
Sélectionnez le mode à l’aide de Rec Format 
>Imager Scan Mode* (page 96) dans le 
menu Project.
* Pouvant également être configurés sur l’écran d’état.

ˎˎ FF 6K : taille plein format avec une 
résolution 6K.
ˎˎ FFcrop 5K : taille de l’image entière recadrée 
à environ 83% pour une résolution 5K.
ˎˎ S35 4K : taille Super 35mm avec une 
résolution 4K.
ˎˎ FF 2K : taille plein format avec une 
résolution 2K.
ˎˎ S35 2K : taille Super 35mm avec une 
résolution 2K.
ˎˎ S16 2K : taille Super 16mm avec une 
résolution de 2K.

[Conseil]
Vous pouvez commuter rapidement le mode Imager 
Scan sans modifier le format vidéo à l’aide d’une touche 
personnalisable (page 48) attribuée avec la fonction 
Crop Select.
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[Remarques]
ˎˎ Vous ne pouvez pas commuter le mode Imager Scan 

pendant l’enregistrement ou la lecture.
ˎˎ Lorsque vous réglez le mode Imager Scan sur 

FF 2K, S35 2K ou S16 2K, le réglage du format 
d’enregistrement est limité à une résolution 
1920×1080.

Codec

Sélectionnez le codec à l’aide de Rec Format 
>Codec* (page 96) dans le menu Project.
* Pouvant également être configurés sur l’écran d’état.

[Remarque]
Vous ne pouvez pas commuter le codec pendant 
l’enregistrement ou la lecture.

Format vidéo

Vous pouvez régler le format vidéo pour 
l’enregistrement. Sélectionnez un format 
à l’aide de Rec Format >Video Format* 
(page 96) dans le menu Project.
* Pouvant également être configurés sur l’écran d’état.

[Remarques]
ˎˎ Vous ne pouvez pas commuter le format vidéo 

pendant l’enregistrement ou la lecture.
ˎˎ Des restrictions peuvent s’appliquer au signal des 

connecteurs SDI OUT et HDMI OUT, selon le réglage 
du format vidéo.
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Utilisation de cartes mémoire XQD
Ce caméscope permet d’effectuer des enregistrements audio et vidéo sur des cartes mémoire 
XQD (disponibles séparément) insérées dans les logements pour cartes.

A propos des cartes mémoire XQD

Utilisez les cartes mémoire XQD Sony suivantes dans le caméscope.
Pour plus de détails sur le fonctionnement avec des supports provenant d’autres fabricants, 
reportez-vous au mode d’emploi du support ou consultez les informations du fabricant.
Cartes mémoire XQD de série S (QD-S64E/S32E/S64/S32)
Cartes mémoire XQD de série H (QD-H32/H16)
Cartes mémoire XQD de série N (QD-N64)
Cartes mémoire XQD de série M (QD-M128A/M64A/M32A)
Cartes mémoire XQD de série G (QD-G240F/G120F/G256E/G128E/G64E/G32E/G128A/G64A/
G32A)
L’utilisation de cartes mémoire autres que des cartes mémoire Sony XQD n’est pas garantie.

[Conseil]
Pour de plus amples informations concernant l’utilisation des cartes mémoire XQD et les précautions d’utilisation les 
concernant, reportez-vous au mode d’emploi de la carte mémoire XQD.

Support recommandé

Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et 
Recording.
Oui : Fonctionnement pris en charge
Non : Le fonctionnement normal n’est pas garanti

Format d’enregistrement Série G
Série S
(QD-S64E/S32E)

Série N
Série M

Série H
Série S
(QD-S64/S32)

XAVC Intra 
422

4096×2160 Mode 
normal ou 
S&Q (60P ou 
moins)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P/ 
24P

Oui Non Non

3840×2160 Mode 
normal ou 
S&Q (60P ou 
moins)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Oui Non Non

1920×1080 Mode 
normal ou 
S&Q (60P ou 
moins)

59.94P/ 
50P

Oui Non Non

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Oui Oui Non

S&Q 
(supérieur à 
60P)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Oui Non Non
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Format d’enregistrement Série G
Série S
(QD-S64E/S32E)

Série N
Série M

Série H
Série S
(QD-S64/S32)

XAVC Long 
422

3840×2160 Mode 
normal ou 
S&Q (60P ou 
moins)

59.94P/ 
50P/ 
29.97P/ 
25P/ 
23.98P

Oui Oui Non

1920×1080 Mode 
normal ou 
S&Q (60P ou 
moins)

59.94P/ 
50P/ 
59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Oui Oui Oui

S&Q 
(supérieur à 
60P)

59.94P/ 
50P

Oui Oui Non

29.97P Oui 50 Mbps : Non
35 Mbps : Oui

Non

25P/ 
23.98P

Oui Non Non

MPEG2 HD 
422

1920×1080 Mode 
normal

59.94i/ 
50i/ 
29.97P/ 
25P/ 
23.98P

Oui Oui Oui

Insertion de cartes mémoire XQD

1 Ouvrez le cache du support de la section 
de logements pour carte.

2 Insérez une carte mémoire XQD avec 
l’étiquette XQD tournée vers la gauche.
L’indicateur d’accès (page 8) est 
allumé en rouge, puis passe au vert si la 
carte est utilisable.

3 Fermez le cache du support.

[Remarques]
ˎˎ La carte mémoire, le logement de carte mémoire et 

les données d’images sur la carte mémoire peuvent 
être endommagés si la carte est enfoncée de force 
dans le logement dans le mauvais sens.
ˎˎ Lorsque vous enregistrez sur des supports situés dans 

les logements .pour carte XQD A et B, insérez dans 
ces deux logements des supports recommandés pour 
être utilisés avec le format devant être enregistré.

Ejection de cartes mémoire XQD

Ouvrez le cache du support de la section de 
logements de carte et appuyez légèrement 
sur la carte mémoire XQD pour l’éjecter.

[Remarques]
ˎˎ Si le caméscope est arrêté ou la carte mémoire 

enlevée pendant que le système accède à la carte 
mémoire, l’intégrité des données sur la carte ne peut 
pas être garantie. Toutes les données enregistrées 
sur la carte peuvent être supprimées. Assurez-vous 
toujours que l’indicateur d’accès est vert ou éteint 
avant d’arrêter le caméscope ou d’enlever la carte 
mémoire.
ˎˎ Si une carte mémoire XQD est retirée immédiatement 

après l’enregistrement, elle peut être chaude, mais 
cela n’indique pas un problème.

Formatage (initialisation) de cartes 
mémoire XQD

Si une carte mémoire XQD non formatée ou 
une carte mémoire XQD formatée selon une 
spécification différente est insérée, le message 
« Media Needs to be Formatted » s’affiche 
dans le viseur.
Formatez la carte en utilisant la procédure 
suivante.

1 Sélectionnez Format Media (page 111) 
dans le menu TC/Media.

2 Sélectionnez Media(A) (logement A) ou 
Media(B) (logement B), puis sélectionnez 
Execute.
Un message de confirmation apparaît.

3 Sélectionnez Execute.
Un message s’affiche pendant le 
formatage et le voyant d’accès est allumé 
en rouge.
Une fois le formatage terminé, un 
message indiquant la fin de l’opération 
s’affiche. Appuyez sur la touche SET ou la 
molette multifonction pour ignorer le 
message.

[Remarque]
Le formatage d’une carte mémoire efface toutes les 
données, y compris les données vidéo et les fichiers de 
configuration enregistrés.

En cas d’échec du formatage

Les cartes mémoire non prises en charge par 
le caméscope ne peuvent pas être formatées.
Un message d’avertissement est affiché. 
Suivez les instructions pour remplacer la carte 
par une carte mémoire XQD prise en charge.
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Vérification de la durée 
d’enregistrement restante

Lors d’une prise de vue (enregistrement/
veille), vous pouvez surveiller la capacité 
restante de la carte mémoire XQD dans 
chacun des logements à l’aide des indicateurs 
de capacité restante du support des 
logements A/B dans le viseur (page 11).
Le temps d’enregistrement restant est calculé 
à partir de la capacité restante du support de 
chaque logement et du format vidéo actuel 
(débit binaire d’enregistrement) et est affiché 
en unités de minutes.

Synchronisation de remplacement de 
carte mémoire XQD

ˎˎ Quand le temps d’enregistrement total 
restant sur les deux cartes mémoire 
devient inférieur à 5 minutes, le message 
« Media Near Full » s’affiche, le témoin 
d’enregistrement/de signalisation 
commence à clignoter et un signal sonore 
(émis à partir du casque) vous avertit.  
Remplacez les cartes par un support ayant 
de l’espace libre.
ˎˎ Si vous continuez d’enregistrer jusqu’à ce 
que le temps total d’enregistrement restant 
atteigne 0, le message passe à « Media Full » 
et l’enregistrement s’arrête.

[Remarque]
Un maximum de 600 plans environ peut être enregistré 
sur une carte mémoire XQD.
Si le nombre de plans enregistrés atteint la limite, 
l’indicateur de temps d’enregistrement restant passe à 
« 0 » et un message s’affiche.

Restauration des cartes mémoire 
XQD

Si, pour quelque raison que ce soit, une erreur 
se produit dans une carte mémoire, celle-ci 
doit être restaurée avant l’utilisation.
Lorsque vous insérez une carte mémoire XQD 
devant être restaurée, un message apparaît 
sur l’écran du viseur pour vous demander si 
vous souhaitez effectuer la restauration.

Restauration d’une carte

Avec les touches fléchées (page 7) 
ou la molette multifonction (page 4), 
sélectionnez Execute, puis appuyez sur la 
touche SET ou sur la molette multifonction.
Un message s’affiche pendant le formatage et 
le voyant d’accès est allumé en rouge.
À la fin de la restauration, un message 
indiquant la fin de l’opération s’affiche.

En cas d’échec de la restauration

ˎˎ Les cartes mémoire XQD sur lesquelles des 
erreurs de mémoire se sont produites ne 
peuvent pas être restaurées. Un message 
d’avertissement est affiché. Suivez les 
instructions pour remplacer la carte 
mémoire XQD.
ˎˎ Les cartes mémoire XQD sur lesquelles 
des erreurs de mémoire se sont produites 
peuvent être utilisables si vous les 
reformatez.
ˎˎ Dans certains cas, certains plans peuvent 
être restaurés et d’autres non. Les plans 
restaurés peuvent être lus normalement.
ˎˎ Si le message « Could not Restore Some 
Clips » continue à apparaître après plusieurs 
tentatives de restauration, il peut être 
possible de restaurer la carte mémoire XQD 
à l’aide de la procédure suivante.

1 Copiez les plans requis sur une autre 
carte mémoire XQD à l’aide de Copy Clip 
(page 117) dans le menu Thumbnail.

2 Formatez la carte mémoire XQD 
inutilisable sur le caméscope.

3 Copiez de nouveau les plans requis sur 
la carte mémoire XQD venant d’être 
formatée.

[Remarques]
ˎˎ Pour la restauration du support enregistré sur ce 

caméscope, assurez-vous d’utiliser ce caméscope.
ˎˎ Il se peut qu’un support enregistré avec un dispositif 

autre que ce caméscope ou avec un autre caméscope 
d’une version différente (même du même modèle) ne 
soit pas restauré à l’aide de ce caméscope.
ˎˎ Les plans de moins de 2 secondes ne peuvent pas 

être restaurés.
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Utilisation d’une carte UTILITY SD/MS
La carte UTILITY SD/MS est utilisée pour 
l’enregistrement proxy et pour stocker et 
charger des réglages. Elle est également 
utilisée pour de futures mises à niveau (mise à 
jour logicielle).

Cartes SD/MS prises en charge

Cartes mémoire SDXC*
Cartes mémoire SDHC*
Cartes mémoire SD*
« Memory Stick PRO-HG Duo »**
« Memory Stick PRO Duo »**
* Désignées collectivement sous le nom de « Cartes 

SD » dans ce manuel.
** Désignés sous le nom de support « Memory Stick » 

dans ce document.

[Remarque]
L’enregistrement proxy n’est pas pris en charge par les 
supports « Memory Stick ».

Insertion d’une carte SD/MS

1 Ouvrez le cache du support de la section 
de logements pour carte.

2 Insérez la carte SD ou le support 
« Memory Stick » dans le logement de 
carte avec l’étiquette orientée vers la 
droite.
L’indicateur d’accès (page 8) est 
allumé en rouge, puis s’éteint si la carte 
est utilisable.

3 Fermez le cache du support.

Éjection d’une carte SD/MS

Ouvrez le cache du support de la section de 
logements de carte et appuyez légèrement 
sur la carte SD ou le support « Memory Stick » 
pour l’éjecter.

[Remarques]
ˎˎ Si le caméscope est éteint ou si la carte SD ou le 

support « Memory Stick » est retiré alors que l’accès 
est en cours sur ces éléments, l’intégrité des données 
n’est pas garantie. Toutes les données enregistrées 
sur la carte peuvent être supprimées. Assurez-vous 
toujours que l’indicateur d’accès est éteint avant 
d’arrêter le caméscope ou d’enlever la carte SD ou le 
support « Memory Stick ».
ˎˎ Prenez des précautions pour éviter que la carte SD ou 

le support « Memory Stick » ne soit expulsé lors de 
l’insertion/éjection de la carte.

Formatage (initialisation) de 
cartes SD/MS

Les cartes SD et le support « Memory Stick » 
doivent être formatés lors de leur première 
utilisation dans le caméscope.
Il est obligatoire de formater une carte SD 
ou un support « Memory Stick » à utiliser 
avec ce caméscope à l’aide de la fonction de 
formatage de ce caméscope.

1 Sélectionnez Format Media (page 111) 
dans le menu TC/Media.

2 Spécifiez Utility SD/MS, puis sélectionnez 
Execute.
Un message de confirmation apparaît.

3 Sélectionnez Execute.
Un message et l’état de progression 
s’affichent pendant le formatage et 
l’indicateur d’accès est allumé en rouge.

Une fois le formatage terminé, un 
message indiquant la fin de l’opération 
s’affiche. Appuyez sur la touche SET ou la 
molette multifonction pour ignorer le 
message.

[Remarque]
Le formatage d’une carte SD ou d’un support « Memory 
Stick » efface toutes les données. Les données ne 
peuvent pas être restaurées.

Vérification de la capacité restante

Vous pouvez vérifier la capacité restante sur 
une carte SD ou un support « Memory Stick » 
sur l’écran Media Status (page 16).
Lors d’une prise de vue (enregistrement/
veille) avec l’enregistrement proxy sur On, 
vous pouvez surveiller la capacité restante de 
la carte SD à l’aide des indicateurs de capacité 
restante du support sur l’écran du viseur 
(page 11).

[Remarque]
Un repère  s’affiche si la carte SD est protégée.

Pour utiliser une carte SD formatée sur 
le caméscope dans la fente d’un autre 
dispositif

Effectuez d’abord une copie de sauvegarde 
de la carte, puis reformatez la carte dans le 
dispositif à utiliser.
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Procédure d’opération de base
La prise de vue de base s’effectue à l’aide de 
la procédure suivante.

1 Connectez les dispositifs nécessaires et 
vérifiez que l’alimentation est branchée.

2 Insérez la/les carte(s) mémoire.

3 Réglez le commutateur POWER sur on.
L’indicateur POWER s’allume et l’image de 
la caméra apparaît sur le viseur.

4 Appuyez sur l’indicateur/la touche 
d’enregistrement START/STOP 
(page 6).
Le témoin d’enregistrement/de 
signalisation s’allume et l’enregistrement 
commence.

5 Pour arrêter l’enregistrement, appuyez à 
nouveau sur la touche d’enregistrement 
START/STOP (page 6).
L’enregistrement s’arrête et le caméscope 
passe au mode STBY (veille).

[Remarque]
Si la touche d’enregistrement START/STOP est actionnée 
dans les quelques secondes suivant la mise sous 
tension du caméscope, le témoin d’enregistrement/
de signalisation s’allume pour indiquer que l’unité est 
en état d’enregistrement, mais l’enregistrement sur le 
support peut ne pas se déclencher pour les premières 
secondes, en fonction du format d’enregistrement 
sélectionné.

Passage d’une carte mémoire XQD 
à l’autre

Lorsque deux cartes mémoire XQD sont 
chargées, appuyez sur la touche SLOT SELECT 
(page 7) pour passer d’une carte à l’autre.
L’enregistrement passe automatiquement 
à la seconde carte mémoire juste avant que 
la capacité restante sur la première carte 
atteigne zéro (enregistrement relais). Lorsque 
vous basculez d’une carte mémoire à l’autre, 
vous pouvez poursuivre l’enregistrement 
continu en remplaçant la carte mémoire pleine 
par une nouvelle.

[Remarque]
Vous ne pouvez pas passer d’une carte mémoire à 
l’autre en mode de lecture. En outre, la lecture continue 
d’un plan situé sur plusieurs supports dans la fente A et 
la fente B n’est pas prise en charge.

Plans (données enregistrées)
Quand vous cessez l’enregistrement, la vidéo, 
l’audio et les données correspondantes 
du début à la fin de l’enregistrement sont 
sauvegardées sous forme de « plan » unique 
sur une carte mémoire XQD.

Noms de plans
Le nom de chaque plan enregistré avec le 
caméscope est attribué automatiquement à 
l’aide du format réglé sous Clip Name Format 
(page 109) du menu TC/Media.

Durée maximum d’un plan
Jusqu’à 6 heures par plan.
La durée maximum d’un enregistrement 
continu est identique à la durée maximum 
d’un plan. Si la durée d’enregistrement 
dépasse la durée maximum d’un plan, un 
nouveau plan est créé automatiquement et 
l’enregistrement se poursuit. Le nouveau plan 

apparaît comme un plan séparé sur l’écran des 
miniatures.

Les plans multiples sont enregistrés 
successivement pendant l’enregistrement 
relais, mais l’enregistrement s’arrête 
automatiquement après environ 24 heures.

[Remarques]
ˎˎ N’éjectez pas une carte mémoire pendant que des 

données y sont en cours d’enregistrement. Lors de 
l’enregistrement, remplacez uniquement les cartes 
mémoire des logements pour lesquels l’indicateur 
d’accès de logement est éteint.
ˎˎ Quand la capacité restante sur la carte mémoire en 

cours d’enregistrement descend au-dessous d’une 
minute et qu’une carte mémoire enregistrable est 
insérée dans l’autre logement, un message « Will 
Switch Slots Soon » s’affiche. Le message disparaît 
après l’échange de logement de carte mémoire.
ˎˎ L’enregistrement relais peut ne pas fonctionner 

si l’enregistrement est lancé alors que la capacité 
restante de la carte mémoire est inférieure à une 
minute. Pour un enregistrement relais correct, 
vérifiez que la capacité restante de la carte mémoire 
est supérieure à une minute avant de commencer 
l’enregistrement.
ˎˎ La vidéo créée à l’aide de la fonction d’enregistrement 

relais du caméscope ne peut pas être lue sans 
problème sur le caméscope.
ˎˎ Pour combiner la vidéo créée en utilisant la fonction 

d’enregistrement relais du caméscope, utilisez le 
logiciel « Catalyst Browse ».

Surveillance de l’audio

Vous pouvez surveiller l’audio en cours 
d’enregistrement grâce au casque.
En connectant un casque sur la prise 
casque (page 8), vous pourrez surveiller 
l’audio qui est en cours d’enregistrement. 
Vous pouvez également surveiller l’audio 
lu (page 78) en utilisant le haut-parleur 
intégré (page 6) ou le casque.
Réglez le volume de l’audio contrôlé à l’aide 
des touches VOLUME (réglage du volume de 
surveillance de l’audio) (page 6).

Vous pouvez sélectionner le canal audio à 
surveiller à l’aide de Audio Output >Monitor 
CH* (page 116) dans le menu Audio.
Le réglage Monitor CH peut être changé 
(page 55) en attribuant Audio Monitor 
CH ou Audio Mon. CH Switch à une touche 
personnalisable (page 48).
* Pouvant également être configurés sur l’écran d’état.

Spécification des données 
temporelles

Réglage du code temporel

Réglez le code temporel à enregistrer à l’aide 
de Timecode (page 109) dans le menu TC/
Media.

Réglage des bits utilisateur

Vous pouvez ajouter un nombre hexadécimal 
à 8 chiffres à l’image enregistrée en tant que 
bits utilisateur. Vous pouvez également régler 
les bits utilisateur sur l’heure actuelle. Réglez 
à l’aide de Users Bit (page 109) dans le menu 
TC/Media.

Affichage des données temporelles

Réglez le code temporel à afficher à l’aide de 
TC Display (page 109) >Display Select dans le 
menu TC/Media.
L’activation d’une touche personnalisable 
(page 48) à laquelle DURATION/TC/U-BIT 
est assigné commute l’affichage entre le code 
temporel, les bits d’utilisateur et la durée, dans 
l’ordre.
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Commutation de l’entrée/sortie de code 
temporel

Vous pouvez commuter l’entrée/la sortie de 
code temporel en utilisant le commutateur de 
sélection IN/OUT (page 8).
Pour plus de détails, consultez page 135.

Passage en revue de 
l’enregistrement (Rec Review)

Vous pouvez revoir le dernier plan enregistré 
sur l’écran (révision d’enregistrement).

[Remarque]
Rec Review n’est pas pris en charge si le format vidéo 
est modifié après l’enregistrement d’un plan.

Méthode de révision d’enregistrement

Attribuez au préalable Rec Review à l’une des 
touches personnalisables.
Quand l’enregistrement est arrêté, appuyez 
sur la touche personnalisable (page 48) à 
laquelle Rec Review est assigné. La lecture du 
dernier plan enregistré commence.
Le plan est lu jusqu’à la fin, Rec Review prend 
fin et le caméscope revient en mode STBY 
(veille).

Pour arrêter Rec Review

Pressez la touche personnalisable à laquelle 
Rec Review est attribué ou pressez la touche 
CANCEL/BACK.

Réglages de la révision 
d’enregistrement

Vous pouvez configurer la position de départ 
de la lecture sur l’un des paramètres suivants 
à l’aide du réglage Rec Review (page 119) du 
menu Technical.
ˎˎ Les 3 dernières secondes du plan
ˎˎ Les 10 dernières secondes du plan
ˎˎ Début du plan

[Conseil]
Si vous souhaitez examiner un plan spécifique après 
avoir enregistré plusieurs plans, appuyez sur la touche 
THUMBNAIL pour afficher l’écran des miniatures et 
sélectionnez le plan pour lancer la lecture.
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Réglage de la mise au point
Vous pouvez régler automatiquement ou 
manuellement la mise au point, selon les 
conditions de prise de vue.

Réglage manuel de la mise au 
point (Manual Focus)

Pour ajuster manuellement la mise au point, 
réglez le commutateur FOCUS (page 6) sur 
« MAN ».
Ceci vous permet d’ajuster manuellement la 
mise au point en fonction des conditions de 
prise de vue.
La mise au point manuelle est utile pour les 
types suivants de sujets.
ˎˎ Sujets de l’autre côté d’une fenêtre couverte 
de gouttelettes d’eau
ˎˎ Sujets avec un contraste faible par rapport à 
l’arrière-plan
ˎˎ Sujets plus éloignés que les sujets proches

Mise au point à l’aide d’une opération 
tactile (Spot Focus)

En mode de mise au point manuelle, vous 
pouvez spécifier la position où vous voulez 
régler la mise au point par une opération 
tactile.
Pour utiliser la mise au point sur un point, 
réglez Focus >Touch Function in MF 
(page 93) dans le menu Shooting sur Spot 
Focus.
Un repère de mise au point sur un point 
s’affiche lorsque vous appuyez sur la position 
où vous voulez régler la mise au point.

[Conseils]
ˎˎ En mode de mise au point sur un point, vous 

pouvez appuyer sur une touche personnalisable 
(page 48) attribuée avec Push AF/Push MF pour 
arrêter temporairement la mise au point sur un point 
et activer la mise au point automatique pendant que 
la touche est enfoncée. La mise au point repasse en 
mode manuel quand vous relâchez la touche.
ˎˎ La fonction Spot Focus ne fonctionne pas si l’objectif 

est réglé pour la mise au point manuelle.
ˎˎ La position de mise au point sur un point ne peut 

pas être spécifiée pendant que la mise au point est 
agrandie ou lorsque Touch Operation (page 119) 
dans le menu Technical est réglé sur Off.

Utilisation temporaire de la mise au 
point automatique (Push Auto Focus 
(AF))

Lorsque Focus >Push AF Mode (page 93) 
du menu Shooting est réglé sur AF, appuyez 
sur la touche PUSH AUTO FOCUS (page 6) 
pendant la mise au point manuelle pour 
effectuer la mise au point automatiquement 
alors que la touche est enfoncée.
La mise au point s’effectue dans la zone de 
mise au point à l’aide de Focus >Focus Area 
(page 93) dans le menu Shooting.
La mise au point repasse en mode manuel 
quand vous relâchez la touche.
Ceci est utile lorsque vous voulez régler 
lentement la mise au point d’un sujet à un 
autre lors de la mise au point manuelle.

[Conseils]
ˎˎ La même opération est possible avec une touche 

personnalisable (page 48) à laquelle vous avez 
attribué Push AF/Push MF.
ˎˎ Vous pouvez également attribuer Push AF Mode à 

une touche personnalisable (page 48).

[Remarque]
La fonction Push Auto Focus ne fonctionne pas si 
l’objectif est réglé pour la mise au point manuelle.

Utilisation de la mise au point 
automatique à prise de vue unique 
(Push Auto Focus (AF-S))

Réglez Focus >Push AF Mode (page 93) 
dans le menu Shooting sur Single-shot 
AF(AF-S), puis réglez la zone de mise au 
point à l’aide de Focus >Focus Area(AF-S) 
(page 93) dans le menu Shooting.
Appuyez sur la touche PUSH AUTO FOCUS 
en mode de mise au point manuelle pour 
effectuer automatiquement la mise au point à 
vitesse élevée. La mise au point cesse dès que 
vous relâchez la touche.
L’indicateur de mise au point vous informe sur 
l’état de la mise au point.
ˎˎ On : la mise au point reste sur la position de 
mise au point.
ˎˎ Clignotant : pas de mise au point. Puisque 
la mise au point n’est pas automatique, 
modifiez les réglages de composition et de 
mise au point pour réaliser la mise au point.

La mise au point repasse en mode manuel 
quand vous relâchez la touche.
Cela est utile lorsque vous voulez faire 
rapidement la mise au point sur un sujet avant 
de lancer une prise de vue.

[Conseils]
ˎˎ La même opération est possible avec une touche 

personnalisable (page 48) à laquelle vous avez 
attribué Push AF/Push MF.
ˎˎ Vous pouvez également attribuer Push AF Mode à 

une touche personnalisable (page 48).
ˎˎ Vous pouvez également attribuer Focus Area(AF-S) à 

une touche personnalisable (page 48).

ˎˎ Vous pouvez afficher/masquer le cadre de la zone de 
mise au point à l’aide de Display On/Off >Focus Area 
Ind.(AF-S) (page 112) dans le menu Monitoring.
ˎˎ Pendant l’agrandissement de la mise au point, la mise 

au point se règle pour correspondre à la position 
d’affichage agrandie.

[Remarques]
ˎˎ La fonction Push Auto Focus ne fonctionne pas si 

l’objectif est réglé pour la mise au point manuelle.
ˎˎ Le cadre de la zone de mise au point n’est pas 

masqué lorsque vous utilisez la touche DISPLAY.

Mise au point à l’aide de 
l’agrandissement de la vue (Focus 
Magnifier)

Par défaut, la fonction Focus Magnifier ×3/×6 
est affectée à la touche ASSIGN 4 sur la 
télécommande de poignée et à la touche 
ASSIGN 10 sur le viseur (page 48).
Appuyez sur la touche ASSIGN 4 ou la 
touche ASSIGN 10 pour passer à l’écran 
d’agrandissement de la mise au point, avec 
le centre agrandi environ trois fois. Appuyez 
de nouveau sur la touche pour augmenter 
l’agrandissement jusqu’à environ six fois. Cette 
fonction est utile pour vérifier la mise au point.
Appuyez de nouveau sur la touche pour 
revenir à l’écran normal.
Vous pouvez déplacer la position à élargir 
pendant l’agrandissement de la mise au point 
à l’aide des touches fléchées (page 7) 
ou du sélecteur multiple (page 9). 
Vous pouvez revenir à la position centrale 
en maintenant enfoncée la touche SET 
(page 7) ou le sélecteur multiple.
Lorsque vous utilisez la mise au point 
automatique par pression (AF) lors de 
l’agrandissement de la mise au point, la mise 
au point se produit dans la zone de mise au 
point définie à l’aide de Focus >Focus Area 
(page 93) dans le menu Shooting.
Si vous utilisez la mise au point automatique 
par pression (AF-S) pendant l’agrandissement 
de la mise au point, la mise au point se règle 
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pour correspondre à la position d’affichage 
agrandie.

[Remarques]
ˎˎ L’image enregistrée ou l’image de sortie SDI/HDMI 

n’est pas agrandie lorsque la mise au point est 
agrandie.
ˎˎ Pendant l’agrandissement de la mise au point, la 

touche STATUS et les touches MENU sont désactivées.
ˎˎ La position agrandie revient au centre de l’écran 

lorsque le caméscope est mis hors tension.

Mise au point manuelle par l’affichage 
d’un marqueur de mise au point

Pendant la mise au point manuelle, vous 
pouvez vérifier numériquement la différence 
par rapport à une position de mise au point de 
référence.
Le stockage préalable d’une position de mise 
au point spécifique est utile lors de la prise de 
vue, par exemple, lorsque vous voulez régler 
un changement de l’ampleur du bokeh à l’aide 
d’une valeur numérique en tant que guide 
ou lorsque vous voulez revenir à la position 
d’origine.

1 Réglez Display On/Off >Focus Marker 
(page 112) dans le menu Monitoring sur 
On.

2 Attribuez Focus Zero Marker à une touche 
attribuable (page 48).

3 Lorsque vous vous trouvez à une position 
de mise au point que vous souhaitez 
définir comme référence, appuyez sur la 
touche Focus Zero Marker.
La valeur de l’indicateur du marqueur de 
mise au point est définie sur 0.

4 Réglez la position de la mise au point en 
utilisant la valeur de l’indicateur du 
marqueur de mise au point comme guide.

[Remarque]
La valeur varie en fonction des conditions de prise de 
vue et de l’objectif utilisé. Vérifiez l’opération avant 
l’utilisation. 

Réglage automatique de la mise 
au point (Auto Focus)

Le caméscope utilise l’AF à détection de phase 
pour une mise au point ultra rapide et l’AF de 
contraste pour une mise au point ultra précise.
La combinaison de ces deux méthodes AF 
permet une mise au point automatique à 
vitesse rapide et haute précision.
Pour ajuster automatiquement la mise 
au point, réglez le commutateur FOCUS 
(page 6) du caméscope sur « AUTO ». 
Si l’objectif est pourvu d’un commutateur 
de sélection de mise au point, réglez le 
commutateur sur la position « AF/MF » ou 
« AF ». Si le commutateur est réglé sur la 
position « Full MF » ou « MF », la mise au point 
de l’objectif ne peut pas être réalisée depuis le 
caméscope (page 24).
En mode AF, la LED FOCUS AUTO s’allume.

[Conseil]
Lorsque vous réglez Focus >AF Assist (page 93) sur 
On dans le menu Shooting, vous pouvez encore utiliser 
la bague de mise au point de l’objectif pendant la mise 
au point automatique pour régler la mise au point.

[Remarques]
ˎˎ Un objectif prenant en charge la mise au point 

automatique est requis.
ˎˎ Vous risquez de ne pas obtenir une bonne précision 

selon les conditions de prise de vue.
ˎˎ La mise au point ne peut pas être ajustée 

automatiquement sur un objectif à monture A.
ˎˎ La mise au point automatique ne peut pas être 

utilisée lorsque VF Setting >De-Squeeze (page 114) 
dans le menu Monitoring n’est pas réglé sur Off(1.0x).

Réglage de la zone/position de mise au 
point automatique (Focus Area)

Vous pouvez régler la zone cible pour la 
mise au point automatique en utilisant Focus 
>Focus Area (page 93) dans le menu 
Shooting.

Flexible Spot :
Effectue la mise au point sur une position 
spécifique dans l’image.
Lorsque vous sélectionnez cette fonction, 
spécifiez la position à l’aide des touches 
fléchées (page 7) ou du sélecteur multiple 
(page 9).
Vous pouvez revenir à la position centrale 
en maintenant enfoncée la touche SET 
(page 7) ou le sélecteur multiple.

Zone :
Recherche automatiquement une position de 
mise au point dans la zone spécifiée.
Lorsque vous sélectionnez cette fonction, 
spécifiez la position à l’aide des touches 
fléchées (page 7) ou du sélecteur multiple 
(page 9).
Vous pouvez revenir à la position centrale 
en maintenant enfoncée la touche SET 
(page 7) ou le sélecteur multiple.

Wide :
Recherche un sujet dans un grand angle 
de l’image lors de la mise au point. Aucune 
image ne s’affiche.

[Conseil]
La même opération est possible avec une touche 
personnalisable (page 48) à laquelle vous avez 
attribué Focus Area.
Vous pouvez afficher/masquer le cadre de la zone de 
mise au point à l’aide de Display On/Off >Focus Area 
Indicator (page 112) dans le menu Monitoring.

[Remarque]
Le cadre de la zone de mise au point n’est pas masqué 
lorsque vous utilisez la touche DISPLAY.

Modification rapide de la zone de mise 
au point (Focus Setting)

Vous pouvez changer rapidement la 
position et la taille de la zone de mise au 
point automatique lors de la prise de vue 
en attribuant Focus Setting à une touche 
personnalisable (page 48).
L’opération varie selon le réglage de la zone 
de mise au point.

Lorsque Focus >Focus Area (page 93) du 
menu Shooting est réglé sur Flexible Spot ou 
Zone
Vous pouvez modifier la position de la zone 
de mise au point en appuyant sur la touche 
personnalisable à laquelle vous avez attribué 
Focus Setting et en réglant à l’aide des 
touches fléchées (page 7), du sélecteur 
multiple (page 9) ou de l’opération tactile 
(page 38).
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Vous pouvez restaurer la position de la zone 
de mise au point au centre lorsque vous réglez 
la position en appuyant sur la touche SET 
(page 7) ou le sélecteur multiple.
Vous pouvez modifier la taille de la zone de 
mise au point en maintenant enfoncée la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting.
Après avoir modifié la taille, définissez la 
position de la zone de mise au point en 
appuyant sur la touche SET ou sur le sélecteur 
multiple.
Lorsque vous avez terminé, appuyez sur la 
touche personnalisable à laquelle vous avez 
attribué Focus Setting pour revenir à l’écran 
d’origine.

Lorsque Focus >Focus Area (page 93) du 
menu Shooting est réglé sur Wide
Vous pouvez uniquement modifier la taille 
de la zone de mise au point en maintenant 
enfoncée la touche personnalisable à laquelle 
vous avez attribué Focus Setting. Vous pouvez 
aussi changer la position en modifiant d’abord 
le type sur Flexible Spot ou Zone.

[Conseils]
ˎˎ Le cadre de la zone de mise au point est affiché en 

orange lorsque la position de la zone de mise au 
point peut être modifiée.
ˎˎ Lorsque Focus >Push AF Mode (page 93) dans le 

menu Shooting est réglé sur Single-shot AF(AF-S), 
vous pouvez modifier la position de la zone de mise 
au point Focus Area(AF-S) (page 93).

Déplacement du cadre de la zone de 
mise au point à l’aide des opérations 
tactiles (zone de mise au point tactile)

Vous pouvez déplacer la zone de mise au 
point à l’aide de l’opération tactile lorsque le 
cadre de la zone de mise au point s’affiche 
en orange suite au réglage Focus > Focus 
Area (page 93) dans le menu Shooting sur 
Flexible Spot ou Zone, ou en appuyant sur la 

touche personnalisable à laquelle vous avez 
attribué la fonction Focus Setting.
Touchez l’écran pour déplacer la zone de 
mise au point, avec la zone de mise au point 
centrée sur la position touchée. Faites glisser 
sur l’écran pour déplacer la zone de mise 
au point à la position tracée par votre doigt 
(page 10).

Toucher n’importe quelle position

La zone de mise au point se déplace, avec 
la zone de mise au point centrée sur la 
position touchée.

Faire glisser pour déplacer la zone de mise au 
point, en suivant la position de votre doigt

[Remarques]
ˎˎ  Si vous touchez une position ou faites glisser la zone 

de mise au point vers une position qui dépasse la 
plage de réglage, la zone de mise au point se déplace 
vers le bord supérieur/inférieur/gauche/droit de la 
plage de réglage.
ˎˎ  Cette fonction n’est pas disponible dans les 

circonstances suivantes.
 – Lorsque Touch Operation (page 83) dans le 

menu de Technical est réglé sur Off
 – Lorsque la zone de mise au point est affichée en 

gris ou n’est pas affichée du tout

Ajustement de l’action de mise au point 
automatique (vitesse de transition AF, 
sensibilité de changement de sujet AF)

Vitesse de transition AF
Vous pouvez régler la vitesse d’entraînement 
de la mise au point pour les cas où le sujet 
change à l’aide de Focus >AF Transition Speed 
(page 93) dans le menu Shooting.
Lors d’un réglage sur une vitesse basse, la 
mise au point se déplace en douceur lorsque 
le sujet à mettre au point change, ce qui 
permet de prendre de magnifiques images.
Lors d’un réglage sur une vitesse élevée, la 
mise au point change rapidement de sujet. 
La mise au point passe immédiatement sur le 
sujet entrant dans le cadre, rendant ce réglage 
idéal pour la prise de vue documentaire 
nécessitant une mise au point rapide.
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Pendant la modification :
1(Slow) : la mise au point est 
lente
.
.
.
7(Fast) : la mise au point est 
rapide

Mise au point sur un sujet éloigné

Mise au point sur un sujet proche

Sensibilité de changement de sujet AF
Vous pouvez régler la sensibilité de 
changement de sujet à l’aide de Focus >AF 
Subj. Shift Sens. (page 93) dans le menu 
Shooting.
Lors d’un réglage sur une faible sensibilité, la 
mise au point ne change pas immédiatement 
même si un autre sujet passe devant le 
sujet de la mise au point. Lors d’un réglage 
sur une sensibilité élevée, la mise au point 
change pour donner la priorité au sujet en 
mouvement au premier plan.

[Conseil]
Si AF Speed/Sens. est attribué à une touche 
personnalisable, les barres de niveau pour l’ajustement 
des valeurs s’affichent dans l’ordre suivant à chaque fois 
que vous appuyez sur la touche, ce qui vous permet de 
modifier la vitesse de transition AF et les réglages de 
sensibilité de changement de sujet AF.
Vitesse de transition AF  Sensibilité de changement 
de sujet AF  Pas d’affichage …

AF Subj. Shift Sens. : 1(Locked On) AF Subj. Shift Sens. : 5(Responsive)

Mise au point lente sur un autre sujet Mise au point rapide sur un autre sujet
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Modification manuelle de la cible de 
mise au point (AF Assist)

Lorsque Focus >AF Assist (page 93) 
du menu Shooting est réglé sur On, vous 
pouvez sélectionner la cible de mise au 
point automatique lors d’une mise au point 
automatique effectuée à l’aide de la bague de 
mise au point de l’objectif.
L’opération de mise au point automatique est 
rétablie lorsque vous cessez d’utiliser la bague 
de mise au point.
Il est utile de régler Focus >AF Subj. Shift Sens. 
(page 93) du menu Shooting sur 1(Locked 
On) lorsque vous souhaitez que l’opération 
de mise au point automatique se poursuive 
telle quelle quand la position de mise au 
point passe à un sujet se trouvant à une autre 
distance.

Utilisation temporaire de la mise au 
point manuelle (Push Manual Focus)

Appuyez sur la touche PUSH AUTO FOCUS 
(page 6) en mode de mise au point 
automatique pour changer manuellement la 
mise au point lorsque la touche est enfoncée.
La mise au point repasse en mode 
automatique quand vous relâchez la touche.
Ceci vous permet d’arrêter temporairement la 
mise au point automatique et de l’effectuer 
manuellement lorsqu’un élément n’étant pas 
le sujet de la prise de vue passe devant le 
sujet.

[Conseil]
La même opération est possible avec une touche 
personnalisable (page 48) à laquelle vous avez 
attribué Push AF/Push MF.

Suivi à l’aide de la détection des 
visages/yeux (Face/Eye Detection 
AF)

Le caméscope peut détecter les visages et les 
yeux des personnes en tant que cible à suivre 
et ensuite ajuster la mise au point sur les 
visages et les yeux au sein de la zone de mise 
au point.
Cette fonction est uniquement disponible 
lorsque le mode de mise au point est le mode 
AF ou pendant la mise au point automatique 
par pression.
Lorsque des visages sont détectés, des 
cadres de détection des visages/yeux gris 
sont affichés. Lorsque la mise au point 
automatique est possible, les cadres 
deviennent blancs et le suivi démarre. Lorsque 
des yeux sont détectés et que la mise au point 
est ajustée, le cadre de détection des visages/
yeux s’affiche sur les yeux. Lorsque plusieurs 
personnes sont détectées, le sujet principal 
est déterminé de manière automatique.

[Conseils]
ˎˎ Lorsque vous réglez la zone de mise au point sur 

Zone ou Flexible Spot et que les visages ou les yeux 
chevauchent la zone de mise au point spécifiée, les 
cadres de détection des visages/yeux deviennent 
blancs et le caméscope effectue la mise au point sur 
ces visages/yeux.
ˎˎ Lorsque vous utilisez la mise au point automatique 

par pression (AF-S), les cadres de détection des 
visages/yeux pour les visages/yeux ciblés par la mise 
au point deviennent verts.

Réglez la fonction de détection des visages/
yeux AF à l’aide de Focus >Face/Eye Detection 
AF (page 93) dans le menu Shooting.

Face/Eye Only AF :
La caméra détecte les visages/yeux des sujets 
(personnes), et la mise au point et le suivi se 
font uniquement sur leurs visages/yeux. Tant 

qu’aucun visage ou œil n’est détecté, l’AF est 
temporairement arrêté et l’icône  (pause de 
la mise au point automatique en mode Face/
Eye Only AF) (page 11) s’affiche. Ce mode 
est utile lorsque souhaitez réaliser une mise 
au point automatique et un suivi uniquement 
sur les visages/yeux.

Face/Eye Priority AF :
La caméra détecte les visages/yeux des sujets 
(personnes) et la mise au point/le suivi se 
fait en priorité sur les visages/yeux. Si aucun 
visage ou œil n’est détecté, la mise au point 
repasse en mode AF (réglage par défaut).

Off :
La fonction de détection des visages/yeux AF 
est désactivée.

[Remarques]
ˎˎ Durant la mise au point automatique par pression, 

Face/Eye Priority AF est activé même si Face/Eye Only 
AF est actuellement sélectionné.
ˎˎ Lorsque le commutateur FOCUS est réglé sur MAN, 

la fonction de détection des visages/yeux AF est 
désactivée (sauf pendant l’opération de mise au point 
automatique par pression).
ˎˎ Si vous mettez le caméscope hors tension alors que 

Face/Eye Only AF est sélectionné, le mode passe 
automatiquement à Face/Eye Priority AF lorsque le 
caméscope est ensuite mis sous tension.

Masquer les cadres de détection des 
visages/yeux

Vous pouvez afficher/masquer les cadres 
de détection des visages/yeux à l’aide de 
Display On/Off >Face/Eye Detection Frame 
(page 112) dans le menu Monitoring.

[Remarque]
Les cadres verts de détection des visages/yeux 
s’affichent pour les visages et les yeux ciblés par la mise 
au point à l’aide de la mise au point automatique par 
pression (AF-S). Ils ne sont pas masqués par l’utilisation 
de la touche DISPLAY ni quand vous réglez Face/Eye 
Detection Frame sur Off.

Commutation de l’opération de 
détection des visages/yeux AF à l’aide 
d’une touche personnalisable

Attribuez Face/Eye Detection AF à une touche 
personnalisable (page 48). Vous pouvez 
alors commuter l’opération de détection des 
visages/yeux AF dans l’ordre Face/Eye Priority 
AF, Face/Eye Only AF, et Off à chaque pression 
de la touche.

Réglage à l’aide du menu direct

Vous pouvez également sélectionner 
l’opération de détection des visages/yeux AF 
à l’aide du menu direct (page 48).
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Suivi d’un sujet spécifié (Realtime 
Tracking AF)

Vous pouvez maintenir la mise au point sur un 
sujet en spécifiant le sujet par une opération 
tactile ou en sélectionnant un cadre de 
détection des visages.
Lorsqu’un sujet est sélectionné, un cadre de 
suivi blanc s’affiche et le suivi démarre.

[Conseils]
ˎˎ Le suivi se produit dans la zone d’image entière, 

indépendamment du réglage de la zone de mise au 
point.
ˎˎ Lorsque Focus >Touch Function in MF (page 93) 

dans le menu Shooting est réglé sur Tracking AF, 
l’AF de suivi en temps réel est pris en charge même 
lorsque le mode de mise au point est le mode MF.

Les actions suivantes se produisent pour 
la cible de suivi, en fonction du mode de 
fonctionnement AF de détection des visages/
yeux.

Face/Eye Only AF, Face/Eye Priority AF :
À utiliser pour la mise au point et le suivi d’un 
sujet spécifié.
Si la cible de suivi est une personne et un 
visage/des yeux sont détectés, la caméra 
effectue la mise au point sur ce visage/ces 
yeux.
Lorsque le visages/les yeux d’une cible de 
suivi sont détectés, le visage de la cible de 
suivi est enregistré.
Une fois qu’il est enregistré, une icône  
(visage de suivi enregistré) (page 11) 
s’affiche.

[Remarque]
Si l’AF de suivi est démarré lors de la mise au point 
manuelle, le visage de la cible de suivi n’est pas 
enregistré.

Off :
Mise au point et suivi du sujet spécifié.
La détection des visages/yeux ne se produit 
pas, même si la cible de suivi est une 
personne.

[Remarques]
ˎˎ La fonction Realtime Tracking AF ne fonctionne pas si 

l’objectif est réglé pour la mise au point manuelle.
ˎˎ Si vous mettez le caméscope hors tension alors que 

Face/Eye Only AF est sélectionné, le mode passe 
automatiquement à Face/Eye Priority AF lorsque le 
caméscope est ensuite mis sous tension.

Démarrage de l’AF de suivi en temps 
réel

Lorsqu’une cible de suivi est spécifiée sur la 
caméra, le suivi de cette cible démarre.

Spécification par une opération tactile
Appuyez sur le sujet ciblé à suivre dans l’un 
des états suivants :
ˎˎ Lorsque le mode de mise au point est 
le mode MF ou lors de la mise au point 
manuelle par pression, et lorsque Focus 
>Touch Function in MF (page 93) dans le 
menu Shooting est réglé sur Tracking AF
ˎˎ Lorsque le mode de mise au point est le 
mode AF ou pendant la mise au point 
automatique (AF) par pression

[Remarque]
La spécification d’une cible par une opération 
tactile n’est pas disponible lorsque Touch Operation 
(page 119) dans le menu Technical est réglé sur Off.

Spécification par la sélection d’un cadre de 
détection des visages
Déplacez le curseur de sélection de visage 
(soulignement orange) sur le sujet ciblé 
à suivre à l’aide des touches fléchées 
(page 7) ou du sélecteur multiple 
(page 9) et appuyez sur la touche SET 
(page 7) ou sur le sélecteur multiple.

Cadres de détection 
d’autres visages (gris) Cadre de suivi

Curseur de sélection 
de visage (orange)

[Conseils]
ˎˎ Vous pouvez également changer de cible à suivre lors 

de l’AF de suivi en temps réel.
ˎˎ Si une touche personnalisable (page 48) attribuée 

avec la fonction Focus Magnifier est enfoncée lors de 
l’AF de suivi en temps réel, l’état de suivi est conservé 
et la mise au point est agrandie. Cependant, vous 
ne pouvez pas spécifier de cible à suivre lors de 
l’agrandissement de la mise au point.

[Remarque]
Lors de la mise au point manuelle, le suivi ne peut pas 
être démarré par la sélection de cadre de détection des 
visages.

Arrêt de l’AF de suivi en temps réel

Arrêt par une opération tactile
Appuyez sur la touche  (arrêt de l’AF de 
suivi en temps réel) affichée en haut à gauche 
du panneau tactile.

[Conseils]
ˎˎ L’AF de suivi en temps réel s’arrêtera dans les cas 

suivants :
 – Lorsque le commutateur FOCUS ou la commande 

AUTO/MAN sur l’objectif est commuté
 – Lorsque le mode de mise au point est modifié
 – Lorsque l’aide pour la mise au point automatique 

est exécutée
 – Lorsque le réglage de la zone de mise au point ou 

l’action de l’AF de détection des visages/yeux est 
modifié

 – Lorsqu’une touche personnalisable attribuée avec 
Push AF/Push MF est enfoncée

 – Lorsque la cible de suivi n’est pas comprise dans 
l’écran de prise de vue ou que le sujet est flou 
pendant quelques secondes

ˎˎ Lorsqu’un visage de suivi est enregistré (lorsque 
l’icône «   » (visage de suivi enregistré) s’affiche), 
l’AF de suivi en temps réel reprend lorsque le visage 
de suivi enregistré entre dans la zone d’image. Pour 
effacer le visage de suivi, spécifiez un autre visage 
ou arrêtez l’AF de suivi en temps réel comme indiqué 
ci-dessus.
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Vous pouvez régler la luminosité en réglant le 
diaphragme, le gain, la vitesse d’obturateur, 
ainsi qu’en réglant le niveau de luminosité à 
l’aide des filtres ND. Vous pouvez également 
procéder à des réglages automatiques.
Le niveau cible pour le réglage automatique 
de la luminosité se règle à l’aide de Auto 
Exposure (page 89) >Level dans le 
menu Shooting. Vous pouvez également 
attribuer Auto Exposure Level à une touche 
personnalisable (page 48).

[Remarque]
Le gain ne peut pas être réglé en mode Cine EI. La 
sensibilité de base est fixée. De même, la luminosité ne 
peut pas être ajustée automatiquement en utilisant la 
vitesse d’obturation. L’ajustement automatique de la 
luminosité à l’aide du diaphragme et du filtre ND est pris 
en charge.

Sélection de la sensibilité de base

Vous avez le choix entre deux types de 
sensibilité de base sur le caméscope.
En mode SDR/HDR, vous pouvez régler Base 
Sensitivity du menu Shooting sur High ou Low. 
En mode Cine EI, vous pouvez régler Base ISO* 
du menu Shooting sur ISO 4000 ou ISO 800.
* Pouvant également être configurés sur l’écran d’état.

Vous pouvez effectuer la prise de vue 
avec un bon équilibre, sans bruit accru, en 
sélectionnant Low ou ISO 800 en conditions 
d’éclairage normal ou en sélectionnant High 
ou ISO 4000 en conditions d’éclairage faible.

[Conseil]
Vous pouvez également attribuer Base ISO/Sensitivity à 
une touche personnalisable (page 48).

Réglage du diaphragme

Vous pouvez régler le diaphragme pour régler 
la luminosité.

Réglage automatique du diaphragme

Cette fonction règle la luminosité en fonction 
du sujet. Un objectif prenant en charge le 
diaphragme automatique est requis.

1 Si un objectif avec commutateur Auto Iris 
est fixé, placez le commutateur sur AUTO.

2 Maintenez enfoncée la touche de fonction 
IRIS (F) pour afficher le menu direct 
(page 48) et sélectionnez Auto.

 [Conseil]
Vous pouvez également attribuer Auto Iris à une 
touche personnalisable (page 48).

 [Remarque]
Le diaphragme peut être ajusté automatiquement 
sur un objectif monté en A.

Réglage manuel du diaphragme

1 Maintenez enfoncée la touche de fonction 
IRIS (F) pour afficher le menu direct 
(page 48) et sélectionnez Manual.

2 Appuyez sur la touche de fonction IRIS (F) 
pour afficher la valeur du diaphragme sur 
un arrière-plan blanc.

3 Tournez la molette multifonction pour 
régler la valeur.

 [Conseils]
ˎˎ Vous pouvez aussi utiliser la molette 

multifonction comme molette IRIS (page 48) 
en affectant la fonction IRIS à la molette 
multifonction.
ˎˎ Vous pouvez également affecter la fonction IRIS à 

une molette personnalisable (page 48).

Réglage automatique temporaire

Appuyez sur la touche PUSH AUTO IRIS (E) 
pour effectuer un réglage automatique 
temporaire du diaphragme lorsque vous 
appuyez sur la touche.
Le diaphragme revient au réglage précédent 
quand vous relâchez la touche.

[Conseil]
Vous pouvez également attribuer Push Auto Iris à une 
touche personnalisable (page 48).

[Remarque]
Quand le commutateur Auto Iris de l’objectif est réglé 
sur MANUAL, les fonctions Auto Iris et Push Auto Iris 
du caméscope n’ont aucun effet. Les réglages manuels 
de diaphragme sur le caméscope ne fonctionnent 
également pas.

Réglage du gain

En mode SDR/HDR, vous pouvez régler le gain 
pour régler la luminosité.

Réglage automatique du gain

Maintenez enfoncée la touche de fonction 
ISO/GAIN (I) pour afficher le menu direct 
(page 48) et sélectionnez Auto.

[Conseils]
ˎˎ Vous pouvez aussi effectuer la même action en 

réglant Auto Exposure (page 89) >AGC sur On dans 
le menu Shooting.
ˎˎ Vous pouvez également attribuer AGC à une touche 

personnalisable (page 48).

Réglage manuel du gain

Vous pouvez surveiller le gain lorsque vous 
souhaitez ajuster l’exposition tout en utilisant 
un réglage de diaphragme fixe ou lorsque 
vous souhaitez éviter que le gain n’augmente 
à cause de l’AGC.

1 Maintenez enfoncée la touche de fonction 
ISO/GAIN (I) pour afficher le menu direct 
(page 48) et sélectionnez Manual.

2 Réglez le commutateur ISO/GAIN (J) sur H, 
M ou L.

[Conseil]
Vous pouvez également attribuer Push AGC à une 
touche personnalisable et régler AGC sur On de 
manière temporaire en appuyant sur la touche et en la 
maintenant enfoncée.

Contrôle du gain (réglage précis)

1 Appuyez sur la touche de fonction ISO/
GAIN (I) pour afficher la valeur de gain sur 
un arrière-plan blanc.

Réglage de la luminosité
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2 Tournez la molette multifonction pour 
régler la valeur.

[Conseil]
Passez sur une valeur de gain préréglée en fonction du 
réglage du commutateur ISO/GAIN (J).

Contrôle temporaire du gain (réglage 
précis)

Tournez la molette personnalisable 
(page 48) à laquelle la fonction ISO/Gain/
EI est attribuée pour ajuster la valeur de gain 
définie par le commutateur ISO/GAIN (J).
Cela est utile lorsque vous souhaitez régler 
l’exposition d’un seul incrément sans changer 
la profondeur de champ.
La valeur de gain réglée est annulée lors de la 
commutation du commutateur ISO/GAIN (J), 
de la modification de la sensibilité de base, 
du réglage d’AGC sur On ou de la mise hors 
tension.

[Conseil]
Vous pouvez aussi affecter cette fonction à la molette 
multifonction (page 48).

Réglage d’Exposure Index

En mode Cine EI, il est considéré que la sortie 
vidéo avec MLUT réglé sur Off est enregistrée 
comme signal principal. Lorsque vous changez 
la luminosité de l’image avec MLUT On 
pour adapter à une valeur EI, vous pouvez 
vérifier le résultat du réglage de la sensibilité 
d’exposition postproduction pendant la prise 
de vue.
Vous pouvez changer la valeur EI en réglant le 
commutateur ISO/GAIN (J) sur H, M ou L.

[Conseil]
Vous pouvez modifier la valeur EI de chaque position 
de commutateur avec ISO/Gain/EI >Exposure 
Index<H>/<M>/<L> (page 88) dans le menu Shooting 
ou à l’aide de l’écran Camera Status (page 15).

Réglage précis de l’indice de pose

1 Appuyez sur la touche de fonction ISO/
GAIN (I) pour afficher la valeur EI sur un 
arrière-plan blanc.

2 Tournez la molette multifonction pour 
régler la valeur.

[Conseil]
Passez sur une valeur EI préréglée en fonction du 
réglage du commutateur ISO/GAIN (J).

Réglage de l’obturateur

Vous pouvez régler l’obturateur pour régler la 
luminosité.

Réglage automatique de l’obturateur

Maintenez enfoncée la touche de fonction 
SHUTTER (G) pour afficher le menu direct 
(page 48) et sélectionnez Auto pour régler 
automatiquement la vitesse d’obturation 
ou l’angle d’obturation en fonction de la 
luminosité de l’image.

[Conseil]
Vous pouvez aussi effectuer la même action en réglant 
Auto Exposure (page 90) >Auto Shutter sur On dans le 
menu Shooting.

Réglage manuel de l’obturateur

1 Maintenez enfoncée la touche de fonction 
SHUTTER (G) pour afficher le menu direct 
(page 48) et sélectionnez Speed ou 
Angle.

2 Appuyez sur la touche de fonction 
SHUTTER (G) pour afficher la valeur de 
l’obturateur sur un arrière-plan blanc.

3 Tournez la molette multifonction pour 
régler la valeur de l’obturateur.

[Conseils]
ˎˎ Pour régler la durée d’exposition afin qu’elle 

corresponde à l’intervalle d’image, sélectionnez Off 
à l’étape 1.
ˎˎ Vous pouvez également définir l’angle et régler la 

fréquence (page 88).

Réglage du niveau de luminosité 
(ND Filter)

Lorsque l’éclairage est trop fort, vous pouvez 
régler la luminosité appropriée en changeant 
le filtre ND.
Le caméscope comporte deux modes de 
filtre ND. Vous pouvez basculer entre les 
deux modes en utilisant le commutateur ND 
PRESET/VARIABLE.

Réglage en mode prédéfini

Placez le commutateur ND PRESET/VARIABLE 
(A) en position PRESET et réglez les touches 
haut/bas ND FILTER POSITION (B) sur l’un des 
réglages suivants.
Clear : pas de filtre ND
1 : transmittance définie par ND Filter >Preset1 
(page 88) dans le menu Shooting.
2 : transmittance définie par ND Filter >Preset2 
(page 88) dans le menu Shooting.
3 : transmittance définie par ND Filter >Preset3 
(page 88) dans le menu Shooting.

Réglage en mode variable

Réglez le commutateur ND PRESET/VARIABLE 
(A) en position VARIABLE. Basculez les touches 
haut/bas ND FILTER POSITION (B) entre CLEAR 
et On.

Réglage automatique du niveau de luminosité
Vous pouvez régler Auto ND Filter sur On pour 
activer l’ajustement d’exposition automatique 
à l’aide du filtre ND.

1 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.
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2 Maintenez enfoncée la touche ND 
VARIABLE AUTO (C) jusqu’à sélectionner 
Auto.

Réglage manuel du niveau de luminosité

1 Appuyez sur la touche [+] des touches 
haut/bas ND FILTER POSITION (B) pour 
activer le fonctionnement du filtre ND.

2 Maintenez enfoncée la touche ND 
VARIABLE AUTO (C) jusqu’à sélectionner 
Manual.

3 Tournez la molette ND VARIABLE (D) pour 
régler la transmittance du filtre.

[Conseil]
Vous pouvez également affecter la fonction ND Filter à 
une molette personnalisable (page 48).

Réglage automatique temporaire
Vous pouvez attribuer Push Auto ND à une 
touche personnalisable (page 48), et 
régler de manière temporaire Auto ND Filter 
sur On en appuyant sur cette touche et en 
la maintenant enfoncée. Auto ND Filter sera 
de nouveau réglé sur Off si vous relâchez la 
touche.
Appuyez sur la touche [+] des touches haut/
bas ND FILTER POSITION (B) pour activer le 
fonctionnement du filtre ND.

[Remarque]
Lorsque le filtre ND est basculé sur ou depuis CLEAR 
lors de la prise de vue, le cadre de filtre ND s’affiche sur 
l’image et le son de fonctionnement est inclus dans 
l’audio.

[Conseils]
ˎˎ Vous pouvez régler sur CLEAR en tournant la molette 

ND VARIABLE (D) vers le bas depuis ND1/4. Si depuis 
CLEAR vous tournez la molette vers le haut, vous 
configurez ND1/4. Vous pouvez désactiver cette action 
à l’aide de ND Dial >CLEAR with Dial (page 119) dans 
le menu Technical.
ˎˎ Vous pouvez également attribuer ND Filter Position à 

une touche personnalisable (page 48) et appuyer 

sur la touche au lieu d’utiliser les touches haut/bas 
ND FILTER POSITION pour changer le réglage.  
Mode prédéfini : Clear  Preset1  Preset2  
Preset3  Clear… 
Mode variable : Clear  On  Clear…
ˎˎ Vous pouvez également attribuer Auto ND Filter à une 

touche personnalisable (page 48) et appuyer sur la 
touche pour commuter Auto ND filter entre On et Off.
ˎˎ Lorsque vous filmez un sujet lumineux, une fermeture 

trop importante du diaphragme peut provoquer un 
flou de diffraction, qui crée une image commençant à 
perdre sa netteté (phénomène typique des caméras 
vidéo). Vous pouvez supprimer cet effet pour obtenir 
de meilleurs résultats de prise de vue en utilisant le 
filtre ND.
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Vous pouvez sélectionner le mode de réglage 
pour vous adapter aux conditions de prise de 
vue.

ATW (équilibre des blancs à suivi 
automatique)

Cette fonction ajuste l’équilibre des blancs 
automatiquement à un niveau approprié.
L’équilibre des blancs est automatiquement 
ajusté quand la température de couleur de la 
source de lumière change.
Maintenez enfoncée la touche de fonction 
WHT BAL (H) pour afficher le menu direct 
(page 48) et sélectionnez ATW.
Vous pouvez sélectionner la vitesse de réglage 
(cinq incréments) à l’aide de White Setting 
>ATW Speed (page 92) dans le menu 
Shooting.

[Conseil]
Vous pouvez geler le réglage d’équilibre des blancs 
actuel en assignant la fonction ATW Hold à une touche 
personnalisable (page 48) et en appuyant sur la 
touche personnalisable pour mettre temporairement le 
mode ATW en pause.

[Remarques]
ˎˎ ATW ne peut pas être utilisé en mode Cine EI.
ˎˎ Il peut ne pas être possible de s’ajuster sur la couleur 

appropriée à l’aide d’ATW, en fonction des conditions 
d’éclairage et de sujet. 
Exemples :
 – Quand une couleur unique domine le sujet, comme 

par exemple le ciel, la mer, la terre ou des fleurs.
 – Quand la température de couleur est extrêmement 

élevée ou faible.
 Si l’effet approprié ne peut pas être obtenu parce que 

la vitesse de suivi automatique d’ATW est lente ou 
pour d’autres raisons, utilisez l’équilibre des blancs 
automatique.

Réglage manuel de l’équilibre des 
blancs

1 Lorsque l’équilibre des blancs est réglée 
sur le mode ATW, maintenez enfoncée la 
touche de fonction WHT BAL (H) pour 
afficher le menu direct (page 48) et 
sélectionnez Manual.

2 Sélectionnez B, A ou PRESET à l’aide du 
commutateur WHT BAL (K).
B : mode de mémoire B
A : mode de mémoire A
PRESET : mode prédéfini

[Conseil]
Vous pouvez activer ATW pour la mémoire B en réglant 
White Setting >White Switch<B> (page 92) sur ATW 
dans le menu Shooting.

Mode de mémoire A/mémoire B
Ce mode ajuste l’équilibre des blancs au 
réglage sauvegardé sous la mémoire A ou la 
mémoire B, respectivement.

Mode prédéfini
Ce mode ajuste la température de couleur sur 
une valeur préréglée (la valeur par défaut est 
3200K).

Modification de la valeur prédéfinie par 
défaut

En mode prédéfini, vous pouvez modifier 
directement une valeur prédéfinie existante.
Maintenez enfoncée la touche de fonction 
WHT BAL (H) et sélectionnez l’un des 
paramètres suivants dans le menu direct.
Mode SDR/HDR : ˎ3200K, ˎ4300K, ˎ

5600K, ˎ6300K
Mode Cine EI : ˎ3200K, ˎ4300K, ˎ

5500K

[Conseil]
Vous pouvez également attribuer Preset White Select à 
une touche personnalisable (page 48) et appuyer sur 
la touche pour changer le réglage.
Mode SDR/HDR : 3200K  4300K  5600K  6300K 
 3200K…

Mode Cine EI : 3200K  4300K  5500K  3200K…

Modification de la température de 
couleur

1 Appuyez sur la touche de fonction WHT 
BAL (H) pour afficher la valeur de la 
température de couleur sur un arrière-
plan blanc.

2 Tournez la molette multifonction pour 
régler la valeur.

[Conseils]
ˎˎ En mode prédéfini, vous pouvez régler la valeur par 

unités de 100K.
ˎˎ En mode mémoire, vous pouvez régler la valeur par 

unités de 20K. Vous pouvez aussi régler la valeur de 
teinte à l’aide de White (page 91) >Tint dans le 
menu Shooting.

Utilisation de l’équilibre des blancs 
automatique

L’équilibre des blancs à enregistrer dans le 
mode de mémoire A/mémoire B est configuré 
automatiquement.

1 Sélectionnez le mode de mémoire A ou 
de mémoire B.

2 Placez une feuille de papier blanc (ou tout 
autre objet) dans un lieu présentant la 
même source et les mêmes conditions de 
lumière que le sujet, puis effectuez un 
zoom avant sur le papier pour montrer la 
zone blanche sur l’écran.

3 Réglez la luminosité.
Ajustez le diaphragme à l’aide de la 
procédure dans « Réglage manuel du 
diaphragme » (page 42).

4 Appuyez sur la touche WB SET 
(page 4).
ˎˎ Si l’équilibre des blancs automatique 
est utilisé en mode mémoire, la valeur 
de réglage est sauvegardée dans la 
mémoire (A ou B) sélectionnée à l’étape 
1.
ˎˎ Si l’équilibre des blancs automatique 
est utilisé en mode ATW, le réglage 
de l’équilibre des blancs repasse à 
l’équilibre des blancs du mode ATW à la 
fin du réglage.

[Remarque]
Si l’ajustement échoue, un message d’erreur s’affiche sur 
l’écran pendant environ trois secondes. Si le message 
d’erreur persiste après plusieurs tentatives de réglage 
de l’équilibre des blancs, contactez votre technicien 
Sony.
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Vous pouvez spécifier l’audio à enregistrer à 
l’aide des connecteurs, des commutateurs et 
des molettes d’entrée du caméscope.

Connecteurs et commutateurs d’entrée 
audio externe

Connecteur INPUT1 (page 8)
Connecteur INPUT2 (page 8)
Griffe à interfaces multiples (page 4)
Commutateur de sélection CH1 INPUT 
(page 7)
Commutateur de sélection CH2 INPUT 
(page 7)
Commutateur INPUT1 (LINE/MIC/MIC+48V) 
(page 4)
Commutateur INPUT2 (LINE/MIC/MIC+48V) 
(page 4)

Commutateurs permettant de régler le 
niveau audio

Commutateur CH1 (AUTO/MAN) (page 7)
Commutateur CH2 (AUTO/MAN) (page 7)
Molette AUDIO LEVEL (CH1) (page 7)
Molette AUDIO LEVEL (CH2) (page 7)
Molette AUDIO LEVEL (CH3) (page 7)
Molette AUDIO LEVEL (CH4) (page 7)

Sélection du dispositif d’entrée 
audio

1 Sélectionnez le connecteur d’entrée 
audio.
Pour CH1/CH2, sélectionnez l’entrée audio 
à l’aide du commutateur de sélection CH1 
INPUT ou CH2 INPUT.
Réglez sur EXT pour utiliser le connecteur 
INPUT1 ou INPUT2.
Si vous utilisez un microphone à griffe, un 
adaptateur XLR, un dispositif UWP 
(système de microphone UHF sans fil) ou 
un tuner sans fil portatif, spécifiez MI 
SHOE de la même manière. Pour plus de 
détails sur l’adaptateur XLR, voir « Ajout 
de connecteurs d’entrée audio » 
(page 47).
Pour plus de détails sur les tuners sans fil 
portatifs, consultez « Utilisation d’un tuner 
sans fil portatif » (page 47).
Pour CH3/CH4, sélectionnez l’entrée audio 
à l’aide de Audio Input >CH3 Input Select* 
(page 115) et de CH4 Input Select* 
(page 115) dans le menu Audio.
* Pouvant également être configurés sur l’écran 

d’état.

 [Conseil]
Pour CH2, vous pouvez aussi sélectionner INPUT1 
à l’aide de Audio Input >CH2 EXT Input Select* 
(page 115) dans le menu Audio.
* Pouvant également être configurés sur l’écran 

d’état.

 [Remarque]
Le caméscope comporte un microphone de 
narration intégré pour l’enregistrement du 
son d’ambiance. Il peut être utilisé pour la 
synchronisation avec d’autres appareils. Dans ce 
cas, spécifiez INT ou Internal MIC.

2 Sélectionnez la source audio d’entrée.
Réglez les commutateurs INPUT1/INPUT2 
(LINE/MIC/MIC+48V) sur les dispositifs 

raccordés aux connecteurs INPUT1/
INPUT2, respectivement.

Dispositif raccordé Position de 
commutateur

Source audio externe (p. 
ex., table de mixage)

LINE

Microphone dynamique, 
microphone à piles

MIC

Microphone à alimentation 
fantôme de +48 V

MIC+48V

ˎˎ Le fait de sélectionner MIC+48V et de 
connecter un microphone qui n’est 
pas compatible avec une source de 
+48 V peut endommager le dispositif 
connecté. Vérifiez le réglage avant de 
connecter le dispositif.
ˎˎ Si le bruit est un problème sur des 
connecteurs sur lesquels aucun 
dispositif n’est connecté, réglez les 
commutateurs INPUT1/INPUT2 (LINE/
MIC/MIC+48V) correspondants sur LINE.

Réglage automatique du niveau 
d’enregistrement audio

Réglez les commutateurs CH1/CH2 (AUTO/
MAN) des canaux sur AUTO pour qu’ils 
s’ajustent automatiquement.
Pour CH3/CH4, réglez Audio Input >CH3 Level 
Control* et CH4 Level Control* dans le menu 
Audio sur Auto (page 115).
* Pouvant également être configurés sur l’écran d’état.

Réglage manuel du niveau 
d’enregistrement audio

Utilisez la procédure suivante pour régler le 
niveau d’enregistrement audio pour CH1/CH2.

1 Réglez les commutateurs CH1/CH2 
(AUTO/MAN) des canaux sur MAN pour 
pouvoir les ajuster manuellement.

2 Pendant la prise de vue ou la veille, 
tournez les molettes AUDIO LEVEL (CH1)/
(CH2) des canaux correspondants pour 
régler le niveau audio.
ˎˎ Pour CH3/CH4, réglez Audio Input >CH3 
Level Control* et CH4 Level Control* dans 
le menu Audio sur Manual, puis réglez le 
niveau d’enregistrement audio à l’aide 
des molettes AUDIO LEVEL(CH3)/(CH4).
ˎˎ Vous pouvez régler les niveaux de CH1 
à CH4 en tant que groupe. Vous pouvez 
ajuster le niveau d’enregistrement en 
utilisant la molette personnalisable 
(page 48), à laquelle la fonction Audio 
Input Level est attribuée, ou à l’aide de 
Audio Input >Audio Input Level* dans le 
menu Audio.

* Pouvant également être configurés sur l’écran 
d’état.

[Conseil]
L’écran Audio Status est utile pour vérifier le niveau de 
l’entrée audio (page 15).

[Remarques]
ˎˎ Les réglages du niveau d’entrée audio peuvent être 

désactivés, en fonction de la combinaison de réglages 
dans le menu Audio. Pour en savoir plus, reportez-
vous au diagramme dans page 156.
ˎˎ Si le commutateur de sélection CH1 INPUT ou 

CH2 INPUT est réglé sur INT, CH2 est commuté 
sur automatic/manual en conjonction avec le 
commutateur CH1 (AUTO/MAN). De même, le niveau 
d’enregistrement audio CH2 est réglé en conjonction 
avec la molette AUDIO LEVEL (CH1).

Réglage de l’audio à enregistrer
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ˎˎ Le caméscope prend en charge des combinaisons de 
plusieurs réglages. Pour en savoir plus, reportez-vous 
au diagramme dans page 156.

Ajout de connecteurs d’entrée 
audio

Vous pouvez connecter simultanément jusqu’à 
quatre canaux de dispositifs audio XLR au 
caméscope en utilisant un adaptateur XLR-
K2M XLR (non fourni) ou XLR-K3M XLR (non 
fourni).
Fixez l’adaptateur XLR à la griffe à interfaces 
multiples, et réglez Audio Input >CH3 Input 
Select* sur Shoe CH1 et CH4 Input Select sur 
Shoe CH2 dans le menu Audio.
Les fonctions du caméscope qui se 
superposent seront désactivées pour les 
canaux sur lesquels l’adapatateur XLR est 
sélectionné comme entrée. Utilisez les 
commutateurs et les molettes sur l’adaptateur 
XLR pour effectuer les réglages.
* Pouvant également être configurés sur l’écran d’état.

[Remarques]
ˎˎ Le caméscope prend en charge l’interface audio 

numérique du XLR-K3M.
ˎˎ Si Audio Input >CH3 Level et CH4 Level dans le menu 

Audio sont réglés sur Audio Input Level, Audio 
Input Level sur le caméscope sera alors réglé pour 
correspondre au niveau réglé sur l’adaptateur XLR.  
Audio Input Level est également activé lorsque le 
commutateur de l’adaptateur XLR est réglé sur AUTO.  
Lorsque « Through » est spécifié, l’audio sera 
enregistré au niveau réglé avec l’adaptateur XLR 
(page 157).
ˎˎ Pour fixer un adaptateur XLR-K2M XLR (non fourni) ou 

XLR-K3M XLR (non fourni) sur le caméscope, retirez le 
support de microphone du caméscope.

Utilisation d’un tuner sans fil 
portatif

Un module d’extension XDCA-FX9 (en option) 
est nécessaire. Pour plus de détails sur la 
fixation d’un XDCA-FX9, consultez page 26.
Avec un tuner sans fil portatif fixé au 
XDCA-FX9, réglez Audio Input (page 115) 
>CH1 MI SHOE Input Select*, CH2 MI SHOE 
Input Select*, CH3 Input Select* ou CH4 Input 
Select* dans le menu Audio sur Wireless.
* Pouvant également être configurés sur l’écran d’état.
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Utilisation du menu Direct

Vous pouvez vérifier l’état et les réglages du 
caméscope affichés sur l’écran du viseur, ainsi 
que sélectionner et modifier directement les 
réglages.
Les éléments suivants peuvent être 
configurés.
ˎˎ Face/Eye Detection AF
ˎˎ Steady Shot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ EI Gain Value
ˎˎ Auto Shutter
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1 Appuyez sur la molette multifonction ou 
sur une touche personnalisable à laquelle 
la fonction Direct Menu est attribuée.
Sur l’écran, vous pouvez uniquement 
sélectionner avec le curseur orange les 
éléments pouvant être configurés à l’aide 
du menu direct.

2 Tournez la molette multifonction pour 
déplacer le curseur vers l’élément de 
menu à régler, puis appuyez sur la 
molette multifonction.
Un menu s’affiche ou l’élément s’affiche 
sur un arrière-plan blanc.

3 Tournez la molette multifonction pour 
sélectionner un réglage, puis appuyez sur 
la molette multifonction.
Le menu ou l’arrière-plan blanc disparaît 
et le nouveau réglage s’affiche avec un 
curseur orange.
Appuyez à nouveau sur la touche 
personnalisable à laquelle la fonction 
Direct Menu est affectée ou attendez 
3 secondes sans réaliser d’action pour 
fermer menu direct.

 [Conseils]
ˎˎ Vous pouvez aussi configurer les réglages directs 

en maintenant enfoncée chacune des touches de 
fonction (page 6).
ˎˎ Lorsque des éléments s’affichent sur un arrière-

plan blanc, vous pouvez utiliser la molette 
multifonction comme molette personnalisable.
ˎˎ Vous pouvez aussi utiliser le sélecteur multiple 

(page 9) pour les opérations de sélection.

Touches/molettes 
personnalisables

Le caméscope comporte dix touches 
personnalisables (page 6, 9) 
auxquelles vous pouvez assigner des 
fonctions.
Vous pouvez aussi affecter des fonctions à 
la molette personnalisable (page 9) sur 
la télécommande de poignée et à la molette 
multifonction du caméscope.
Les touches personnalisables 1 à 3 et 7 à 9 
possèdent une LED intégrée qui s’allume/
s’éteint (orange quand elle est allumée) en 
fonction de l’état de la fonction attribuée.

Changement de la fonction d’une 
touche

Utilisez Assignable Button (page 100) dans le 
menu Project.
Vous pouvez visionner les fonctions attribuées 
sur l’écran d’état de touches attribuables 
(page 16).

Fonctions attribuées à chaque touche 
assignable par défaut
Touche 1 S&Q Motion
Touche 2 Off
Touche 3 Off
Touche 4 Focus Magnifier x3/x6
Touche 5 Direct Menu
Touche 6 Off
Touche 7 Off
Touche 8 Off
Touche 9 Off
Touche 10 Focus Magnifier x3/x6
Touche Focus Hold Focus Hold

Fonctions attribuables
Selon la fonction, les numéros de touche 
personnalisable (1 à 3, 7 à 9) s’illuminent en 
correspondance avec l’état de la fonction.
– : Ne s’allume pas

Fonction État allumé/éteint de 
la LED

Off –

Base ISO/Sensitivity –

AGC S’allume si activé

Push AGC S’allume uniquement 
lorsque la fonction est 
en cours d’utilisation

ND Filter Position –

Auto ND Filter S’allume si activé

Push Auto ND S’allume uniquement 
lorsque la fonction est 
en cours d’utilisation

Auto Iris S’allume si activé

Fonction État allumé/éteint de 
la LED

Push Auto Iris S’allume uniquement 
lorsque la fonction est 
en cours d’utilisation

Auto Shutter S’allume si activé

Auto Exposure Level –

Backlight S’allume en mode 
rétroéclairage

Spotlight S’allume en mode spot

Preset White Select –

ATW S’allume si activé

ATW Hold S’allume si activé

AF Speed/Sens. –

Focus Zero Marker –

Focus Setting –

Focus Area –

Focus Area(AF-S) –

Face/Eye Detection AF S’allume lorsque la 
détection des visages/
yeux AF est activée

Push AF Mode –

Push AF/Push MF S’allume uniquement 
lorsque la fonction est 
en cours d’utilisation

Focus Hold S’allume uniquement 
lorsque la fonction est 
en cours d’utilisation

Focus Magnifier x3/x6 S’allume si non 
désactivé 
(x3/x6)

Focus Magnifier x3 S’allume si activé

Focus Magnifier x6 S’allume si activé

S&Q Motion S’allume si activé

SteadyShot S’allume si non 
désactivé (Active/
Standard)

Crop Select –

Fonctions utiles
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Fonction État allumé/éteint de 
la LED

Rec S’allume ou clignote 
en association avec le 
témoin 
d’enregistrement/de 
signalisation

Picture Cache Rec S’allume si activé

Rec Review S’allume durant la 
revue de 
l’enregistrement

Last Clip Del. –

Shot Mark1 –

Shot Mark2 –

Clip Flag OK –

Clip Flag NG –

Clip Flag Keep –

Color Bars S’allume si activé

Tally [Front] S’allume si activé

CALL S’allume si activé

DURATION/TC/U-BIT –

Display –

Lens Info S’allume si non 
désactivé (Meter/Feet)

Video Signal Monitor S’allume si non 
désactivé (Waveform/
Vector/Histogram)

Marker S’allume si activé

VF Adjust –

VF Mode S’allume en mode noir 
et blanc

Gamma Display Assist S’allume si activé

Peaking S’allume si activé

Zebra S’allume si activé

Audio Monitor CH –

Audio Mon. CH Switch –

Thumbnail –

Touch Operation S’allume si activé

Handle Zoom –

NFC –

Fonction État allumé/éteint de 
la LED

Network Client Mode Clignote si activé
S’allume lorsque 
connecté à Connection 
Control Manager (CCM)

Auto Upload (Proxy) S’allume si activé ou 
en mode Chunk

Direct Menu –

User Menu –

Menu –

Changement de la fonction d’une 
molette

Vous pouvez modifier la fonction de la molette 
multifonction sur le caméscope et de la 
molette personnalisable sur la télécommande 
de poignée.
Pour la molette multifonction, réglez à l’aide 
de Multi Function Dial (page 102) >Default 
Function dans le menu Project.
Off est attribué par défaut.

Fonctions attribuables à la molette 
multifonction
ˎˎ Off
ˎˎ IRIS
ˎˎ ISO/Gain/EI
ˎˎ Audio Input Level

[Remarque]
Le réglage est désactivé lorsque le menu est affiché.

Pour la molette personnalisable, réglez avec 
Assignable Dial (page 102) dans le menu 
Project.
IRIS est assigné par défaut.

Fonctions attribuables à la molette 
personnalisable
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Audio Input Level

Vous pouvez visionner les fonctions attribuées 
sur l’écran d’état de touches attribuables 
(page 16).
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Slow & Quick Motion

Quand le format d’enregistrement (page 96) est réglé sur les valeurs suivantes, vous pouvez 
spécifier différentes valeurs pour la fréquence d’images de prise de vue et la fréquence d’images 
de lecture.

Format d’enregistrement Fréquence d’images

Fréquence du système Mode Imager Scan Codec Format vidéo

59.94/50 FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 180*1

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

S16 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 180*1

XAVC-L 1920×1080P 1–60, 100, 120

29.97/25/23.98 FF 6K XAVC-I 4096×2160P 1-30

3840×2160P 1–30

1920×1080P 1–30

XAVC-L 3840×2160P 1–30

1920×1080P 1–30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

3840×2160P 1–60

1920×1080P 1–60

XAVC-L 3840×2160P 1–60

1920×1080P 1–60

FF 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 180*2

XAVC-L 1920×1080P 1–60, 100, 120

S35 2K XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

S16 2K XAVC-I 1920×1080P 1–60, 100, 120, 150, 180*2

XAVC-L 1920×1080P 1–60, 100, 120

24 FF 6K XAVC-I 4096×2160P 1-30

FFcrop 5K/S35 4K XAVC-I 4096×2160P 1–60

*1 Peut être sélectionné lorsque la fréquence du système est de 59.94.
*2 Peut être sélectionné lorsque la fréquence du système est de 29.97/23.98.

Format d’enregistrement Fréquence d’images

Fréquence du 
système

Mode Imager Scan Codec Format RAW

59.94/50 FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/RAW&XAVC-I*3 2048×1080 1–60, 100, 120, 150, 180*1

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

S16 2K RAW/RAW&XAVC-I*3 2048×1080 1–60, 100, 120, 150, 180*1

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

29.97/25/23.98 FF 6K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–30

FFcrop 5K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

S35 4K RAW 4096×2160 1–60

3840×2160 1–60, 100, 120

RAW&XAVC-I*3/
RAW&XAVC-L*3

4096×2160 1–60

FF 2K RAW/RAW&XAVC-I*3 2048×1080 1–60, 100, 120, 150, 180*2

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

S35 2K RAW/
RAW&XAVC-I*3/
RAW&XAVC-L*3

2048×1080 1–60, 100, 120

S16 2K RAW/RAW&XAVC-I*3 2048×1080 1–60, 100, 120, 150, 180*2

RAW&XAVC-L*3 2048×1080 1–60, 100, 120

24 FF 6K RAW 4096×2160 1–30

FFcrop 5K/S35 4K RAW 4096×2160 1–60

*1 Peut être sélectionné lorsque la fréquence du système est de 59.94.
*2 Peut être sélectionné lorsque la fréquence du système est de 29.97/23.98.

*3 Le format vidéo devient 1920×1080.
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Vous pouvez activer/désactiver le mode Slow 
& Quick Motion en appuyant sur une touche 
personnalisable (page 48) à laquelle la 
fonction S&Q Motion est attribuée.
Vous pouvez régler la fréquence d’images 
pour la prise de vue en maintenant la touche 
enfoncée.

[Conseil]
Pouvant également être configuré à l’aide de S&Q 
Motion dans le menu Shooting, S&Q Frame Rate dans 
l’écran Main Status et Rec Function dans l’écran Project 
Status.

[Remarques]
ˎˎ Le mode Slow & Quick Motion ne peut pas être réglé 

pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.
ˎˎ L’enregistrement audio n’est pas pris en charge en 

mode ralenti et accéléré.
ˎˎ La fonction de mise au point automatique, la 

fonction de diaphragme automatique et la fonction 
d’obturation automatique sont désactivées en mode 
Slow & Quick Motion.
ˎˎ Pour plus de détails sur l’utilisation de la sortie RAW, 

consultez page 60.

Enregistrement de la vidéo par 
intermittence (Interval Rec)

La fonction Interval Rec du camésope permet 
de capturer une vidéo en accéléré dans 
la mémoire interne du caméscope. Cette 
fonction est un moyen efficace pour la prise 
de vue de sujets en mouvement lent.
Lorsque vous commencez l’enregistrement, 
le caméscope enregistre automatiquement 
un nombre spécifique d’images (Number of 
Frames) à intervalles (Interval Time) spécifiés.

Intervalle de prise de vue (Interval Time)

Nombre d’images en une prise
(Number of Frames)

Lorsque Interval Rec est activé, la lumière 
de la vidéo HVL-LBPC (en option) s’allume 
automatiquement avant le début de 
l’enregistrement, ce qui vous permet 
d’enregistrer des images sous des conditions 
de lumière stable et de température de 
couleur (fonction de pré-éclairage).

[Remarques]
ˎˎ Il est possible d’utiliser une seule fonction 

d’enregistrement spéciale, tel que l’enregistrement en 
mode Interval Rec.
ˎˎ Si un autre mode d’enregistrement spécial est activé 

alors que Interval Rec est en cours d’utilisation, ce 
dernier est automatiquement annulé.

ˎˎ Le mode Interval Rec est automatiquement activé 
après avoir modifié les réglages système tel que le 
format vidéo.
ˎˎ Les réglages Interval Rec ne peuvent pas être 

modifiés pendant l’enregistrement ou la lecture ou 
lorsque l’écran de miniatures s’affiche.

Pour régler Interval Rec

Réglez Interval Rec (page 98) >Setting dans 
le menu Project sur On et réglez Number of 
Frames et Interval Time.
Si vous utilisez la lampe vidéo HVL-LBPC 
(en option), réglez la durée d’intervalle pour 
allumer la lampe vidéo avant le démarrage de 
l’enregistrement à l’aide de Interval Rec >Pre-
Lighting dans le menu Project, tel que requis.

[Conseil]
Pouvant également être configuré à l’aide de Rec 
Function dans l’écran Project Status.

[Remarques]
ˎˎ Si vous voulez allumer la lampe vidéo avant le début 

de l’enregistrement, mettez l’interrupteur de lampe 
vidéo sur AUTO. La lampe vidéo s’allume et s’éteint 
automatiquement en fonction du réglage de Video 
Light Set (page 121) dans le menu Technical.
ˎˎ Si vous mettez l’interrupteur de la lampe vidéo sur 

On, la lampe reste toujours allumée (la lumière vidéo 
ne s’allume pas et ne s’éteint pas automatiquement).
ˎˎ Si la lampe vidéo est configurée pour s’éteindre 

pendant 5 secondes ou moins, la lampe vidéo ne 
s’éteint pas.

Le caméscope quitte le mode Interval Rec 
lorsqu’il est mis hors tension mais les réglages 
de nombre d’images (Number of Frames), de 
durée d’intervalle (Interval Time) et de pré-
éclairage (Pre-Lighting) sont maintenus. Vous 
n’aurez pas besoin de les régler de nouveau la 
fois suivante lorqque vous effectuez une prise 
de vue en mode Interval Rec.

Prise de vue en mode Interval Rec

Appuyez sur la touche d’enregistrement 
START/STOP pour démarrer l’enregistrement. 

« Int Rec » et « Int Stby » s’affichent 
alternativement dans le viseur.
Si vous utilisez la fonction de pré-éclairage, la 
lampe de la vidéo s’allume avant le démarrage 
de l’enregistrement.

Pour arrêter la prise de vue

Arrêtez l’enregistrement.
A la fin de la prise de vue, les données vidéo 
enregistrées dans la mémoire à ce point sont 
enregistrées sur le support.

Pour quitter le mode Interval Rec

Effectuez l’une des actions suivantes.
ˎˎ Réglez le commutateur POWER sur Off.
ˎˎ En mode d’attente d’enregistrement, réglez 
Interval Rec >Setting dans le menu Project 
sur Off.

De même, le mode Interval Rec est 
automatiquement relâché lorsque le 
caméscope est redémarré.

Limitations pendant l’enregistrement

ˎˎ L’audio n’est pas enregistré.
ˎˎ Le passage en revue de l’enregistrement 
(Rec Review) n’est pas possible.
ˎˎ Genlock n’est pas appliqué.

Si le caméscope est mis hors tension 
pendant l’enregistrement

ˎˎ Si le commutateur POWER du caméscope 
est réglé sur la position Off, l’accès au 
support s’effectue pendant plusieurs 
secondes pour enregistrer les images 
sauvegardées dans la mémoire jusqu’à 
ce moment, puis l’appareil se met 
automatiquement hors tension.
ˎˎ Si l’alimentation est coupée car la batterie 
est retirée, le cordon d’alimentation CD 
débranché ou l’alimentation coupée à partir 
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de l’adaptateur CA, les données vidéo et 
audio prises jusqu’à ce point peuvent être 
perdues (maximum 10 secondes). Faites 
attention en remplaçant la batterie.

Enregistrement d’images en cache 
(Picture Cache Rec)

La fonction Picture Cache Rec vous permet 
de tourner des vidéos à posteriori lorsque 
vous démarrez l’enregistrement, puis de les 
enregistrer sur des cartes mémoire XQD en 
maintenant une mémoire cache interne d’une 
durée déterminée lors du tournage. Réglez 
Picture Cache Rec >Setting* (page 99) 
dans le menu Project sur On. La durée 
d’enregistrement en mode de cache d’image 
est réglée grâce à Picture Cache Rec >Cache 
Rec Time (page 99) dans le menu Project.
* Pouvant également être configurés sur l’écran d’état.

Formats d’enregistrement pris en charge

Codec Format 
vidéo

Fréquence 
du système

Durée de 
cache [s]

XAVC-I 4096×2160P 59.94 0–4 s

50

29.97

25 0–4/ 
4–8 s23.98

24

3840×2160P 59.94 0–4 s

50

29.97

25 0–4/ 
4–8 s23.98

Codec Format 
vidéo

Fréquence 
du système

Durée de 
cache [s]

XAVC-I 1920×1080P 59.94 0–4/ 
4–8 s50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 s

25

23.98 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

1920×1080i 59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20 s

1920×1080i 50 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24 s

XAVC-L 3840×2160P 59.94 0–4/ 
4–8/ 
8–12/ 
12–16 s

50

29.97 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

25

23.98

Codec Format 
vidéo

Fréquence 
du système

Durée de 
cache [s]

XAVC-L 1920×1080P 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98

1920×1080P 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

1920×1080i 
35

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

1920×1080i 
25

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

MPEG 
HD422

1920×1080i 
50

59.94 0–4/ 
4–8/ 
8–12/ 
12–16/ 
16–20/ 
20–24/ 
24–28 s

50

29.97

25

23.98
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[Remarques]
ˎˎ Picture Cache Rec ne peut pas être réglé sur On 

en même temps que Interval Rec, ou Slow & Quick 
Motion. Lorsque Picture Cache Rec est réglé sur On, 
ces autres modes d’enregistrement sont réglés sur 
Off de force.
ˎˎ Le mode Picture Cache Rec ne peut pas être 

sélectionné lorsqu’un enregistrement ou Rec Review 
est en cours.
ˎˎ Lorsque Picture Cache Rec est réglé sur On, le code 

temporel est enregistré en mode Free Run, quel que 
soit le réglage dans le menu TC/Media (page 109).
ˎˎ Le réglage Output Format ne peut pas être configuré 

en mode Picture Cache Rec. Si celà se produit, 
désactivez temporairement Picture Cache Rec, puis 
modifiez le réglage.

Configuration avant la prise de vue

Configurez Picture Cache Rec (page 99) 
dans le menu Project avant la prise de vue.
Vous pouvez également attribuer la 
fonction Picture Cache Rec à une touche 
personnalisable (page 48) et commuter 
Picture Cache Rec >Setting entre On et Off en 
utilisant cette touche.
Lorsqu’il est configuré, l’indicateur «  » ( 
vert) apparaît dans le viseur.

Démarrage de l’enregistrement en 
mode de cache d’image

Lorsque vous appuyez sur la touche 
d’enregistrement START/STOP, celui-ci 
démarre et la vidéo est inscrite sur les cartes 
mémoire XQD, en commençant par la vidéo 
stockée dans la mémoire cache.

Pour annuler Picture Cache Rec

Réglez Picture Cache Rec >Setting dans 
le menu Project sur Off ou appuyez sur 
une touche personnalisable à laquelle est 
attribuée la fonction Picture Cache Rec.

[Remarques]
ˎˎ Si vous modifiez le format d’enregistrement, la vidéo 

dans la mémoire cache stockée jusqu’à présent est 
effacée, et la mise en cache d’une nouvelle vidéo 
démarre. Ainsi, il est impossible d’enregistrer des 
images en mode d’enregistrement de cache d’image 
avant le changement de format, même si vous 
commencez immédiatement à enregistrer après avoir 
changé le format.
ˎˎ Si Picture Cache Rec est réglé sur On ou Off 

immédiatement après avoir inséré une carte mémoire 
XQD, les données de cache peuvent ne pas être 
enregistrées sur la carte.
ˎˎ La vidéo est stockée dans la mémoire cache lorsque 

la fonction Picture Cache Rec est réglée sur On. La 
vidéo précédant le réglage de la fonction sur On n’est 
pas mise en cache.
ˎˎ La vidéo n’est pas stockée dans la mémoire cache 

tant qu’une carte mémoire XQD est en cours d’accès, 
comme lors de la lecture, de Rec Review ou de 
l’affichage de l’écran de miniatures. Il est impossible 
d’enregistrer des vidéos en mode d’enregistrement 
de cache d’image pendant cet intervalle.

Enregistrement simultané sur les 
cartes mémoire A et B (2-slot 
Simul Rec)

Vous pouvez enregistrer simultanément sur 
la carte mémoire A et la carte mémoire B en 
réglant Simul Rec >Setting* dans le menu 
Project sur On.
* Pouvant également être configurés sur l’écran d’état.

[Remarque]
L’enregistrement simultané n’est pas pris en charge 
en mode Slow & Quick Motion (page 93) ou en 
mode Picture Cache Rec (page 99). En outre, 
l’enregistrement simultané n’est pas pris en charge pour 
les formats d’enregistrement suivants (page 96).

XAVC-I
Format vidéo
4096×2160P, 3840×2160P

XAVC-L
Format vidéo
4096×2160P, 3840×2160P

Changement des réglages des 
touches d’enregistrement START/
STOP sur le caméscope et la 
poignée

Lorsque l’enregistrement simultané (Simul 
Rec) est activé, vous pouvez démarrer/
arrêter l’enregistrement vers chaque carte 
mémoire indépendamment à l’aide des 
touches d’enregistrement START/STOP sur le 
caméscope et la poignée.
Par défaut, les deux touches sont réglées 
pour démarrer/arrêter simultanément 
l’enregistrement vers les deux cartes mémoire 
A et B.
ˎˎ « Rec Button [SlotA SlotB] Handle Rec Button 
[SlotA SlotB] »

Lorsque les touches sont réglées pour 
contrôler l’enregistrement de différentes 
cartes mémoire, SDI/HDMI Rec Control suit 
l’état d’enregistrement de la fente A.

Pour modifier le réglage

Sélectionnez Simul Rec >Rec Button Set dans 
le menu Project.

Rec Button Set Touches et cartes 
mémoire

« Rec Button [SlotA 
SlotB] Handle Rec 
Button [SlotA SlotB] »

Démarrez/arrêtez 
simultanément 
l’enregistrement vers 
les cartes mémoire A et 
B à l’aide de l’une des 
touches.

Rec Button Set Touches et cartes 
mémoire

« Rec Button [SlotA] 
Handle Rec Button 
[SlotB] »

La touche 
d’enregistrement 
START/STOP démarre/
arrête l’enregistrement 
vers la carte mémoire A 
et la touche 
d’enregistrement 
START/STOP de la 
poignée démarre/arrête 
l’enregistrement vers la 
carte mémoire B.

« Rec Button [SlotB] 
Handle Rec Button 
[SlotA] »

La touche 
d’enregistrement 
START/STOP démarre/
arrête l’enregistrement 
vers la carte mémoire B 
et la touche 
d’enregistrement 
START/STOP de la 
poignée démarre/arrête 
l’enregistrement vers la 
carte mémoire A.

Enregistrement 4K & HD (Sub)

Vous pouvez enregistrer simultanément une 
vidéo 4K (QFHD) comme plan principal et une 
vidéo MPEG HD422 comme sous-plan, que 
vous pouvez utiliser pour l’édition, sur une 
seule carte mémoire XQD.
Vous pouvez utiliser les formats 
d’enregistrement de carte mémoire XQD 
suivants pour l’enregistrement 4K & HD (Sub).
Le format d’enregistrement du sous-plan varie 
en fonction de la fréquence du système du 
plan principal.
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Format 
d’enregistrement 
du plan principal

Fréquence 
du 
système

Format 
d’enregistrement 
du sous-plan

 ˎ XAVC-I 
4096×2160P

 ˎ XAVC-I 
3840×2160P

 ˎ XAVC-L 
3840×2160P

29.97/25/ 
23.98

MPEG HD422 
1920×1080P

59.94/50 MPEG HD422 
1920×1080i

[Conseil]
Vous pouvez copier les sous-plans sur d’autres supports 
que les plans principaux à l’aide de Copy Sub Clip 
(page 117) dans le menu Thumbnail.

Moniteur de signal vidéo

Vous pouvez régler le type de signal vidéo 
à afficher sur l’écran du viseur sur forme 
d’onde, vecteurscope ou histogramme en 
utilisant Display On/Off >Video Signal Monitor 
(page 113) dans le menu Monitoring.
Le moniteur du signal vidéo du caméscope 
mesure le signal vidéo dans l’étape de sortie 
vidéo. En conséquence, si la sortie vidéo 
est coupée aux bords par rapport à la vidéo 
enregistrée, le composant du signal rogné 
ne sera pas mesuré. Lorsque ceci se produit, 
« EC » s’affiche en haut à gauche du moniteur 
du signal vidéo.

Affichage de la cible de surveillance

En mode Cine EI, les informations du réglage 
d’espace de couleur (page 28) ou du 
réglage Monitor LUT (page 93) s’affichent 

en haut à droit du moniteur de signal vidéo 
pour indiquer la cible de surveillance.

Prise de vue High Dynamic Range 
(HDR)

Vous pouvez régler le mode de plage 
dynamique élevée (HDR) pour enregistrer 
et émettre des images avec un espace 
colorimétrique équivalent à BT.2020 et une 
plage dynamique supérieure.

Réglage du mode de plage dynamique 
élevé

Réglez Base Setting >Shooting Mode* 
(page 96) dans le menu Project sur HDR.

* Pouvant également être configurés sur l’écran d’état.

Réglage du type de HLG

Réglez le type de HLG pour le mode HDR 
à l’aide de HDR Paint Setting >HLG Look 
(page 105) dans le menu Paint.

Réglage HLG 
Look

Description

Natural Caractéristique conforme à 
ITU-R BT.2100(HLG).

Réglage HLG 
Look

Description

Live Caractéristique conforme 
à ITU-R BT.2100(HLG) qui 
délivre des performances 
HDR améliorées. 
Cependant, l’utilisation de 
ce réglage peut augmenter 
le niveau de bruit.

Réglage de la fonction d’aide 
d’affichage du gamma

Réglez Gamma Display Assist >Setting 
(page 114) dans le menu Monitoring sur 
On pour voir un affichage d’assistance dans 
le viseur qui facilite la prise de vue en mode 
HDR.
* Pouvant également être configurés sur l’écran d’état.

Sélection de l’affichage du viseur 
lorsque la fonction d’aide pour 
l’affichage gamma est activée

Il existe deux méthodes d’affichage prises 
en charge pour l’affichage d’images HDR 
dans le viseur lorsque la fonction d’aide pour 
l’affichage gamma est activée.

Affichage HDR avec un contraste conservé 
entre les zones à faible luminance et les zones 
à forte luminance
Cette méthode tire parti de l’expressivité 
HDR pour afficher l’image dans le viseur sans 
provoquer des noirs cassés ou des réhauts 
accentués, même lors de la prise de vue avec 
une exposition lumineuse ou sombre. En 
revanche, le contraste général est légèrement 
réduit.
Pour utiliser cette méthode d’affichage, réglez 
HDR Setting >VF SDR Preview (page 98) 
dans le menu Project sur Off.

Affichage SDR par simple conversion de HDR 
vers SDR
Cette méthode prend en charge le 
fonctionnement de la caméra avec la même 
approche que le SDR conventionnel.
Vous pouvez régler la luminosité de l’image 
HDR en réglant la différence de gain entre 
HDR et SDR à l’aide de SDR Gain.
Pour utiliser cette méthode d’affichage, 
effectuez les configurations selon la procédure 
suivante.

1 Réglez HDR Setting >VF SDR Preview 
(page 98) dans le menu Project sur On.

2 Réglez la valeur de gain SDR en mode 
HDR à l’aide de HDR Setting >SDR Gain 
(page 98) dans le menu Project.

[Conseil]
Lors de la conversion de l’affichage d’une image HDR 
vers SDR à l’aide de SR Live Metadata après la prise de 
vue, SDR Gain est appliqué à la conversion de sorte que 
l’affichage d’image SDR ait la même exposition que ce 
qui était visualisé dans le viseur au moment de la prise 
de vue.
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LUT 3D utilisateur

En mode Cine EI, vous pouvez charger un 
fichier CUBE (*.cube) pour un LUT 3D à 
17 points ou 33 points créé avec RAW Viewer 
ou DaVinci Resolve (de Blackmagic Design Pty. 
Ltd.) depuis une carte SD ou un service Cloud.

[Remarque]
Enregistrez le fichier utilisateur 3D LUT dans le répertoire 
suivant sur la carte SD.
\PRIVATE\SONY\PRO\LUT\

La procédure suivante est nécessaire pour 
utiliser l’utilisateur 3D LUT.

Chargement depuis une carte SD

1 Insérez la carte SD dans le logement de 
carte UTILITY SD/MS (page 8) avec 
l’étiquette orientée vers la droite.

2 Sélectionnez Monitor 3D LUT >Load from 
Utility SD/MS (page 94) dans le menu 
Shooting.

3 Sélectionnez une destination de 
chargement.
Vous pouvez enregistrer jusqu’à 16 fichiers 
dans la mémoire interne de l’appareil.

4 Sélectionnez un fichier à charger.

5 Sélectionnez OK.
Le fichier sélectionné est chargé.

6 Sélectionnez OK.

7 Sélectionnez Monitor LUT >Category 
(page 93) >User 3D LUT dans le menu 
Shooting.

8 Sélectionnez l’utilisateur 3D LUT souhaité 
à l’aide de Monitor LUT >User 3D LUT 
Select (page 94) dans le menu 
Shooting.

Chargement depuis un service Cloud

1 Connectez-vous à l’appareil depuis 
l’application pour smartphone « C3 Portal 
App » (page 71).

2 Sélectionnez Monitor 3D LUT >Load from 
Cloud(Private) ou Load from Cloud(Share) 
(page 94) dans le menu Shooting.

3 Sélectionnez une destination de 
chargement.
Vous pouvez enregistrer jusqu’à 16 fichiers 
dans la mémoire interne de l’appareil.

4 Sélectionnez un fichier à charger.

5 Sélectionnez OK.
Le fichier sélectionné est chargé.

6 Sélectionnez OK.

7 Réglez Monitor LUT >Category 
(page 93) dans le menu Shooting sur 
User 3D LUT.

8 Sélectionnez l’utilisateur 3D LUT souhaité 
à l’aide de Monitor LUT >User 3D LUT 
Select (page 94) dans le menu 
Shooting.

Configuration de l’affichage de 
décompression

Un objectif anamorphoseur peut être 
utilisé pour créer du contenu vidéo en taille 
cinémascopique.
En réglant l’affichage de décompression selon 
l’agrandissement de l’objectif anamorphoseur 
utilisé, vous pouvez afficher l’image ajustée 
au même rapport d’aspect que lorsque vous 
voyez directement le sujet sur l’écran du 
viseur.
L’affichage de décompression est configuré à 
l’aide de VF Setting >De-Squeeze (page 114) 
dans le menu Monitoring.

[Remarque]
Un marqueur s’affiche dans le viseur uniquement 
lorsque De-Squeeze est réglé sur 1.3x ou 2.0x. Il ne 
s’affiche pas dans la sortie d’image. De plus, Marker 
>Aspect Select (page 113) dans le menu Monitoring 
est réglé sur 2.39:1 (fixe).

Modification des canaux audio à 
l’aide des touches

Vous pouvez modifier la combinaison 
des canaux audio configurés à l’aide de 
Audio Output >Monitor CH (page 116) 
dans le menu Audio à l’aide des touches 
personnalisables.
Vous pouvez sélectionner un canal audio à 
écouter depuis le haut-parleur intégré ou le 
casque et vérifier l’audio enregistré sur chacun 
des canaux d’enregistrement.

Appuyez sur une touche personnalisable 
(page 48) à laquelle la fonction Audio 
Monitor CH est attribuée et commutez le canal 
audio comme décrit ci-dessous.
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Réglage Monitor CH 
actuel

Réglage après 
commutation à l’aide 
de Audio Monitor CH

CH1/CH2 CH1

CH3/CH4 CH3

MIX ALL Non concerné

CH1 CH2

CH2 CH1/CH2

CH3 CH4

CH4 CH3/CH4

Appuyez sur une touche personnalisable à 
laquelle la fonction Audio Mon. CH Switch est 
attribuée et commutez le canal audio comme 
décrit ci-dessous.

Réglage Monitor CH 
actuel

Réglage après 
commutation à l’aide 
de Audio Mon. CH 
Switch

CH1/CH2 CH3/CH4

CH3/CH4 CH1/CH2

MIX ALL Non concerné

CH1 CH3

CH2 CH4

CH3 CH1

CH4 CH2

[Conseils]
ˎˎ Lors de l’utilisation d’une touche personnalisable à 

laquelle Audio Monitor CH ou Audio Mon. CH Switch 
est attribué, un message précisant le réglage Monitor 
CH actuel s’affiche.
ˎˎ Pour modifier le réglage Monitor CH, appuyez sur la 

touche personnalisable Audio Monitor CH ou Audio 
Mon. CH Switch pendant que le réglage Monitor CH 
actuel s’affiche.
ˎˎ Lorsque Monitor CH est réglé sur MIX ALL, le canal 

audio ne commute pas.

Obtention d’informations de lieu 
(GPS)

Lorsque GPS dans le menu Technical est réglé 
sur On,  s’affiche lorsque le caméscope 
recherche des satellites GPS. Lorsque la 
géolocalisation est établie, les informations de 
lieu sont enregistrées lors du tournage d’une 
vidéo.

[Remarques]
ˎˎ Le réglage GPS ne peut pas être réglé sur On dans le 

menu Technical lorsque la poignée n’est pas fixée car 
le récepteur GPS est inclus dans la poignée.
ˎˎ L’icône affichée varie, en fonction de la réception du 

signal des satellites GPS.
ˎˎ Lors de l’utilisation de la fonction GPS, le fait de 

saisir la poignée peut affecter la précision du 
positionnement.

Etat de 
géolocalisation

Affichage Etat de réception 
GPS

Off Pas 
d’affichage

GPS est réglé sur 
Off ou une erreur 
s’est produite.

Géolocalisation 
non disponible

Les informations 
de lieu n’ont pas 
pu être obtenues 
car aucun signal 
GPS n’a pu être 
reçu. Déplacez-
vous vers un lieu 
présentant une 
vision dégagée 
du ciel.

Recherche de 
satellites

Recherche de 
satellites GPS. 
L’acquisition des 
satellites peut 
prendre plusieurs 
minutes.

Etat de 
géolocalisation

Affichage Etat de réception 
GPS

Géolocalisation Un signal GPS 
faible est reçu.

Un signal GPS est 
reçu. Les 
informations de 
lieu peuvent être 
acquises.

Un signal GPS 
fort est reçu. Les 
informations de 
lieu peuvent être 
acquises.

[Conseils]
ˎˎ GPS est réglé sur On par défaut. Lorsque la 

géolocalisation est activée, les informations de lieu et 
d’heure de la vidéo tournée sont enregistrées par le 
caméscope.
ˎˎ Si une icône de positionnement ne s’affiche pas au 

bout de plusieurs minutes, il se peut qu’il y ait un 
problème de réception du signal. Commencez à filmer 
sans informations de lieu ou déplacez-vous vers un 
endroit disposant d’une vision dégagée du ciel. Le fait 
de filmer quand l’icône de géolocalisation n’est pas 
affichée signifie que les informations de lieu ne sont 
pas enregistrées.
ˎˎ Le signal de GPS peut ne pas être reçu en intérieur à 

proximité de structures élevées. Déplacez-vous vers 
un lieu présentant une vision dégagée du ciel.
ˎˎ L’enregistrement des informations de lieu peut être 

interrompu, en fonction de la force du signal reçu, 
même si une icône de positionnement est affichée.

Métadonnées de planification

Les métadonnées de planification sont des 
informations sur les plans de prise de vue et 
d’enregistrement, enregistrées dans un fichier 
XML.
Vous pouvez filmer à l’aide de noms de 
plan et de noms de repère de prise de vue 
préalablement définis dans un fichier de 
métadonnées de planification.
Vous pouvez envoyer et recevoir les 
métadonnées de planification via un réseau 
à l’aide de l’application « Content Browser 
Mobile ».

[Remarques]
ˎˎ L’ouverture du cache du logement de support 

interrompt le transfert des métadonnées de 
planification via le réseau. Vous ne pouvez pas 
transférer les métadonnées de planification lorsque 
le cache est ouvert. Le transfert reprend lorsque vous 
avez refermé le cache.
ˎˎ Pour définir des noms de plans ou de repères de 

prise de vue, utilisez une police définie pour la langue 
spécifiée à l’aide de Language >Select (page 129) 
dans le menu Maintenance. Les caractères de texte 
risquent de ne pas s’afficher correctement si vous 
utilisez une langue différente de celle réglée pour le 
caméscope.
ˎˎ Si vous définissez des noms de plan et de repère 

de prise de vue en français, en néerlandais ou en 
finnois, certains caractères s’affichent dans une police 
différente, mais similaire.

Chargement d’un fichier de 
métadonnées de planification

Pour enregistrer des métadonnées de 
planification avec des plans, il est nécessaire 
de charger au préalable un fichier de 
métadonnées de planification dans la 
mémoire du caméscope.
Insérez la carte mémoire XQD avec le fichier 
de métadonnées de planification (.xml) 
enregistré dans le répertoire ci-dessous dans 
la fente du caméscope, puis sélectionnez 
et chargez le fichier à l’aide de Planning 
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Metadata (page 103) >Load from Media(A) 
ou Load from Media(B) dans le menu Project.
exFAT : XDROOT/General/Sony/Planning

Vérification des informations détaillées dans 
les métadonnées de planification
Après avoir chargé les métadonnées de 
planification dans le caméscope, vous pouvez 
vérifier les informations détaillées qu’elles 
contiennent, telles que les noms de fichier, la 
date et l’heure de création et les titres.
Sélectionnez Planning Metadata (page 103) 
>Properties >Execute dans le menu Project.

Effacement des métadonnées de planification 
chargées
Vous pouvez effacer les données de 
planification chargées dans la mémoire du 
caméscope.
Sélectionnez Planning Metadata (page 103) 
>Clear Memory >Execute dans le menu Project.

Définition d’un nom de plan dans les 
métadonnées de planification

Les deux types de chaînes de noms de plan 
suivants peuvent être écrits dans un fichier de 
métadonnées de planification.
ˎˎ Nom au format ASCII s’affichant sur l’écran 
du viseur
ˎˎ Nom au format UTF-8 enregistré comme 
nom de plan

Lorsque vous spécifiez un nom de plan 
dans les métadonnées de planification, le 
nom s’affiche sous l’indication de l’état de 
fonctionnement, sur l’écran du viseur.

Exemple de chaînes de noms de plan
Utilisez un éditeur de texte pour modifier la 
description de la balise de métadonnées de 
planification <Title>.
Les champs ombrés dans l’exemple sont des 
chaînes de noms de plan.

« Typhoon » est décrit au format ASCII (jusqu’à 
44 caractères). « Typhoon_Strikes » est décrit 
au format UTF-8 (jusqu’à 44 octets).
« sp » indique une espace et  indique un 
retour chariot.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata" spassignId="
P0001" spcreationDate="
2011-08-20T17:00:00+09:00"sp

lastUpdate="
2011-09-28T10:30:00+09:00"sp

version="1.00">
<Properties sppropertyId="
assignment" spupdate="
2011-09-28T10:30:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhoon"sp

xml:lang="en">Typhoon_Strikes
</Title>

</Properties>
</PlanningMetadata>

[Remarques]
ˎˎ Lorsque vous créez un fichier, saisissez chaque 

énoncé sur une seule ligne, en changeant de ligne 
avec un seul retour de chariot après le dernier 
caractère de la ligne, et ne saisissez pas d’espaces 
sauf aux endroits spécifiés par « sp ».
ˎˎ Une chaîne contenant jusqu’à 44 octets (ou 44 

caractères) est valide comme nom de plan.  
Si la chaîne au format UTF-8 dépasse 44 octets, les 
44 premiers octets sont utilisés comme nom de plan.  
Si une seule chaîne au format ASCII est spécifiée, le 
nom au format ASCII jusqu’au 44e caractère est utilisé 
comme nom de plan.  
S ni la chaîne de noms au format ASCII, ni la chaîne de 
noms au format UTF-8 n’est valide, un nom de plan 
au format standard est utilisé.
ˎˎ Vous ne pouvez pas utiliser les caractères suivants 

pour les noms de plans. Ils sont remplacés par un tiret 
bas (_).  
Caractères non acceptés : "*/:<>?\|

Utilisation d’un nom de plan défini dans les 
métadonnées de planification
Chargez un fichier de métadonnées de 
planification contenant le nom de plan dans 
la mémoire du caméscope, puis sélectionnez 
Clip Name Format >Auto Naming (page 109) 
>Plan dans le menu TC/Media.
Les noms de plan sont générés en ajoutant un 
tiret bas (_) et un numéro de série à 5 chiffres 
(00001 à 99999).
Exemple : Typhoon_Strikes_00001, Typhoon_
Strikes_00002, …
[Remarques]
ˎˎ Si le numéro de série atteint 99999, il revient à 00001 

dès l’enregistrement suivant.
ˎˎ Lorsque vous chargez un autre fichier de 

métadonnées de planification, le numéro de série à 5 
chiffres revient à 00001.

Définition des noms de repères de prise 
de vue dans les métadonnées de 
planification

Lorsque vous enregistrez le repère de prise 
de vue 1 ou le repère de prise de vue 2, vous 
pouvez appliquer un nom au repère de prise 
de vue à l’aide d’une chaîne définie dans les 
métadonnées de planification.

Exemple de chaînes de noms de repère de 
prise de vue
Utilisez un éditeur de texte pour modifier la 
description de la balise de métadonnées de 
planification <Meta name>.
Les champs ombrés dans l’exemple sont des 
chaînes de noms de repère de prise de vue.
Les noms peuvent être au format ASCII 
(jusqu’à 32 caractères) ou au format UTF-8 
(jusqu’à 16 caractères).
« sp » indique une espace et  indique un 
retour chariot.

[Remarque]
Si une chaîne de noms contient un caractère non ASCII, 
même un seul, la longueur maximale de cette chaîne est 
limitée à 16 caractères.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2011-04-15T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 15/04/2011
</Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
</Properties>

</PlanningMetadata>

[Remarque]
Lorsque vous créez un fichier, saisissez chaque énoncé 
sur une seule ligne, en changeant de ligne avec un seul 
retour de chariot après le dernier caractère de la ligne, 
et ne saisissez pas d’espaces sauf aux endroits spécifiés 
par « sp » hors des chaînes de noms de repère de prise 
de vue.

Transfert de fichiers de métadonnées de 
planification

Vous pouvez transférer un fichier de 
métadonnées de planification avec les fichiers 
originaux ou les fichiers proxy.
Lorsque Proxy Rec >Setting (page 98) 
dans le menu Project est réglé sur On, 
l’enregistrement proxy sur une carte SD est 
activé.
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Pour plus de détails sur l’enregistrement proxy, 
consultez « Enregistrement et téléchargement 
d’un fichier proxy par fragments » 
(page 59). Pour plus de détails sur le 
transfert de fichiers originaux et de fichiers 
proxy, consultez « Téléchargement de fichiers » 
(page 67).

[Remarque]
Les fichiers de métadonnées de planification ne sont 
pas transférés dans les cas suivants.
ˎˎ L’enregistrement s’arrête en raison d’une erreur 

Media Full
ˎˎ SLOT SELECT est appuyé durant l’enregistrement ou 

un changement de carte mémoire se produit car une 
carte mémoire est pleine
ˎˎ Lorsqu’un plan atteignant la durée maximale se divise
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Vous pouvez enregistrer des données 
proxy sur une carte SD simultanément à 
l’enregistrement sur une carte mémoire XQD.

Pour plus de détails sur les cartes SD compatibles, le 
formatage des cartes SD et la vérification de la capacité 
restante, consultez « Utilisation d’une carte UTILITY SD/
MS » (page 33).

Configuration avant la prise de 
vue

1 Réglez Proxy Rec* >Setting dans le menu 
Project sur On.
* Pouvant également être configurés sur l’écran 

d’état.

2 Insérez la carte SD dans le logement de 
carte UTILITY SD/MS (page 8) avec 
l’étiquette orientée vers la droite.

[Remarque]
Proxy Rec ne peut pas être réglé sur On en même temps 
que S&Q Motion, Interval Rec, Picture Cache Rec, 2-slot 
Simul Rec ou 4K & HD (Sub) Rec. Lorsque Proxy Rec est 
réglé sur On, les fonctions d’enregistrement autres que 
S&Q Motion sont obligatoirement réglés sur Off.
Lorsque Proxy Rec est réglé sur On et S&Q Motion est 
réglé sur On, Proxy Rec est réglé temporairement sur Off. 
Lorsque S&Q Motion est réglé sur Off, Proxy Rec est de 
nouveau réglé sur On.

Enregistrement d’un proxy

Appuyez sur la touche d’enregistrement 
START/STOP pour lancer l’enregistrement 
lorsque vous avez terminé les réglages 
nécessaires pour la prise de vue.

[Remarques]
ˎˎ Si le caméscope est arrêté ou la carte SD enlevée 

pendant que le système accède à la carte SD, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
peuvent être supprimées. Assurez-vous toujours 
que l’indicateur d’accès est éteint avant d’arrêter le 
caméscope ou d’enlever la carte SD.
ˎˎ Prenez des précautions pour éviter que la carte SD ne 

soit expulsée lors de l’insertion/éjection de la carte.

Pour quitter, arrêtez l’enregistrement.
Lorsque l’enregistrement sur une carte 
mémoire XQD s’arrête, l’enregistrement des 
données proxy s’arrête également.

Modification des réglages 
d’enregistrement proxy

Réglage de la taille d’image

Sélectionnez Proxy Rec >Proxy Format 
(page 98) dans le menu Project, puis réglez 
la taille de l’image.

Réglage du canal audio

Sélectionnez Proxy Rec >Audio Channel 
(page 98) dans le menu Project et réglez le 
canal audio pour l’enregistrement de données 
proxy.

Enregistrement et téléchargement 
d’un fichier proxy par fragments

Lorsque le réglage de téléchargement 
automatique est réglé sur Chunk et qu’un 
fichier proxy est enregistré par fragments, le 
fichier proxy peut être téléchargé pendant que 
l’enregistrement principal est en cours.
Pour plus de détails sur le téléchargement 
d’un fichier proxy enregistré par fragments, 
consultez « Téléchargement automatique des 
fichiers » (page 68).

1 Sélectionnez Proxy Rec (page 98) dans 
le menu Project.

2 Sélectionnez l’intervalle d’enregistrement 
par fragments dans Chunk.

30s : enregistrez le fichier proxy par 
fragments de 30 secondes (réglage par 
défaut).

1min : enregistrez le fichier proxy par 
fragments de 1 minute.

2min : enregistrez le fichier proxy par 
fragments de 2 minutes.

3 Réglez File Transfer >Auto Upload (Proxy) 
(page 127) dans le menu Network sur 
Chunk.

4 Démarrez l’enregistrement proxy.
Le fichier proxy est enregistré par 
fragments à l’intervalle spécifié et chaque 
fragment est enregistré dans la liste des 
tâches en tant que tâche de transfert.

[Remarque]
Lorsque Auto Upload (Proxy) n’est pas réglé sur Chunk, 
l’enregistrement proxy par fragments ne se produit pas.

À propos du fichier enregistré

L’extension du nom de fichier est « .mp4 ».
Le code temporel est enregistré 
simultanément aussi.

Destination de stockage du fichier 
enregistré

Le fichier enregistré est stocké dans le 
répertoire « /PRIVATE/PXROOT/Clip ».

À propos du nom de fichier

Le nom de fichier comprend le nom de plan 
enregistré sur la carte mémoire XQD et un 
suffixe de numéro consécutif.
En mode d’enregistrement simultané sur 
2 fentes, le nom du plan de la fente A est 
prioritaire.
Le numéro consécutif est conservé même si 
le caméscope est hors tension. Le numéro 
consécutif redevient 0001 si vous exécutez All 
Reset.
Pour plus de détails sur les noms de plans, 
consultez Clip Name Format (page 109) dans 
le menu TC/Media.

Enregistrement du proxy
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Vous pouvez enregistrer la sortie du signal 
vidéo RAW du connecteur RAW OUT d’un 
XDCA-FX9 (en option) attaché au caméscope 
sur un enregistreur externe.

1 Branchez un enregistreur RAW externe sur 
le connecteur RAW OUT du XDCA-FX9 fixé 
au caméscope.

2 Réglez Base Setting >Shooting Mode* 
dans le menu Project sur Cine EI.

3 Réglez le codec à l’aide de Rec Format 
>Codec* dans le menu Project sur RAW.
La sélection de RAW & XAVC-I permet 
d’enregistrer simultanément la vidéo RAW 
sur l’enregistreur RAW externe et la vidéo 
HD sur les cartes mémoire XQD dans le 
caméscope.

4 Sélectionnez le mode de balayage et la 
résolution à l’aide de Rec Format >Imager 
Scan Mode* dans le menu Project.

5 Vérifiez que l’enregistreur externe est 
activé, puis appuyez sur la touche 
d’enregistrement START/STOP sur le 
caméscope. 

 [Remarque]
Lorsque l’enregistrement est démarré sur un 
enregistreur externe sans utiliser la touche 
d’enregistrement sur le caméscope, il est possible 
que les clips ne soient pas correctement enregistrés.

[Conseil]
Les fonctions marquées d’un astérisque (*) peuvent 
également être configurées sur l’écran d’état.

Les formats de sortie RAW pris en charge sont 
indiqués ci-dessous.

Project >Rec Format

Frequency Codec Imager 
Scan 
Mode

RAW 
Output 
Format

59.94/50 RAW FFcrop 5K 4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K/
S16 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG HD 
422

FFcrop 
5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K/
S16 2K

2048×1080

29.97/25/ 
23.98

RAW FF 6K/
FFcrop 5K

4096×2160

S35 4K 4096×2160/ 
3840×2160

FF 2K/ 
S35 2K/
S16 2K

2048×1080

RAW & 
XAVC-I/
RAW & 
XAVC-L/
RAW & 
MPEG HD 
422

FF 6K/
FFcrop 
5K/ 
S35 4K

4096×2160

FF 2K/ 
S35 2K/
S16 2K

2048×1080

24 RAW FF 6K/
FFcrop 
5K/ 
S35 4K

4096×2160

Affichage de l’état du contrôle 
d’enregistrement

Si Display On/Off (page 112) >RAW Output 
Control Status dans le menu Monitoring 
est réglé sur On, l’état du contrôle 
d’enregistrement RAW est affiché dans le 
viseur à l’aide d’une icône.

[Remarque]
Le signal de contrôle d’enregistrement est émis par le 
connecteur RAW OUT du caméscope, mais il n’est pas 
possible d’obtenir l’état de l’enregistreur externe. En 
conséquence, le caméscope pourrait indiquer qu’un 
enregistrement vidéo RAW est en cours alors que 
l’enregistreur externe n’enregistre pas réellement. 
Vérifiez l’indicateur sur l’enregistreur externe pour 
connaître l’état de fonctionnement réel.

[Conseil]
La valeur de réglage de RAW Output Format est 
également affichée.

Enregistrement en ralenti et 
accéléré

Si S&Q Motion >Setting dans le menu 
Shooting est réglé sur On, la vidéo RAW est 
enregistrée en mode Slow & Quick Motion.
Pour plus de détails sur la fréquence d’images 
prises en charge pour la prise de vue, 
consultez page 50.

Enregistrement d’une vidéo au format RAW



61 4. Fonctions réseau

Connexion à d’autres dispositifs via le LAN
Le caméscope peut se connecter à des 
smartphones, des tablettes et d’autres 
dispositifs à l’aide d’une connexion LAN.
L’établissement d’une connexion LAN entre 
un dispositif et un caméscope vous permet 
d’effectuer les opérations suivantes à l’aide 
de la télécommande Web (page 73) ou de 
l’application « Content Browser Mobile ».
ˎˎ Métadonnées de planification (page 56) 
Envoyez et recevez des métadonnées de 
planification à l’aide d’un dispositif et du 
caméscope.  
Vous pouvez envoyer au caméscope les 
métadonnées de planification créées au 
préalable pour spécifier les noms de plan.
ˎˎ Télécommande via un réseau LAN 
Vous pouvez contrôler le caméscope à 
partir d’un smartphone, d’une tablette, 
d’un ordinateur ou d’un panneau de 
télécommande connectés au caméscope via 
le réseau LAN.
ˎˎ Transfert de fichiers via un réseau LAN 
Vous pouvez transférer au serveur via 
un réseau LAN un fichier proxy (basse 
résolution) qui est enregistré sur une carte 
SD dans le caméscope ou un fichier original 
(haute résolution) qui a été enregistré par le 
caméscope.
ˎˎ Surveillance vidéo via un réseau LAN 
Vous pouvez créer un flux (H.264) à partir 
de la caméra ou de la vidéo de lecture du 
caméscope, et surveiller la vidéo à l’aide 
de l’application « Content Browser Mobile » 
depuis un dispositif via un réseau LAN.

Application « Content Browser Mobile »

Vous pouvez utiliser le caméscope à 
distance sur l’écran du dispositif pendant la 
surveillance de la vidéo depuis le caméscope, 
puis configurer les réglages du caméscope 
à l’aide de l’application « Content Browser 
Mobile ».

Pour plus de détails sur l’application « Content Browser 
Mobile », contactez un représentant commercial ou un 
technicien Sony.

Diffusion continue de vidéos de haute 
qualité à l’aide de la technologie Sony 
QoS (page 69)

Vous pouvez diffuser des vidéos de haute 
qualité à l’aide d’une station réseau 
Sony RX (vendue séparément) ou de C3 
Portal* Connection Control Manager (CCM) 
connecté(e) au caméscope en mode client 
réseau.
* C3 Portal est un service Cloud fourni par Sony.  

Une inscription est requise pour utiliser ce service.  
C3 Portal n’est pas fourni dans certaines régions. Pour 
plus de détails sur les zones dans lesquelles le service 
est fourni, rendez-vous sur le site suivant.  
https://www.c3p.sony.net 
En outre, consultez les sites suivants pour connaître la 
politique de confidentialité de C3 Portal.
 – Modalités de service 

https://www.c3p.sony.net/site/tos_eu.html
 – Politique de confidentialité de C3 Portal 

https://www.c3p.sony.net/site/c3p_privacy_policy.
html

 – Politique de confidentialité de l’ID professionnel 
https://www.pro-id.sony.net/#/privacyPolicy

 Pour plus de détails, contactez un représentant 
commercial Sony Professional.

Configuration du nom d’utilisateur 
et du mot de passe

Configurez le nom d’utilisateur et le mot de 
passe du caméscope pour utiliser la fonction 
réseau.

1 Configurez Access Authentication >User 
Name (page 123) dans le menu Network.

2 Configurez Access Authentication 
>Password (page 123) dans le menu 
Network.

 [Conseil]
Sélectionnez l’entrée manuelle (Input Password) ou 
la génération automatique (Generate Password).

Connexion à l’aide du mode de 
point d’accès de LAN sans fil

Le caméscope sert de point d’accès et se 
connecte à un dispositif via un réseau local 
sans fil.

Smartphone/
tablette

Ordinateur

Connexion à un dispositif compatible 
NFC par simple contact

Les dispositifs prenant en charge la 
technologie NFC peuvent être connectés 
(connexion une touche) à l’aide de la NFC.

1 Ouvrez [Settings] sur le dispositif, 
sélectionnez [More], et cochez la case 
NFC.

2 Mettez le caméscope sous tension.

3 Activez la fonction NFC.
Maintenez pressée (pendant 3 secondes) 
une touche personnalisable à laquelle la 
fonction NFC est affectée ou sélectionnez 
Wireless LAN >NFC dans le menu Network 
pour activer le mode de connexion NFC.
La fonction NFC est uniquement 
disponible tant que  apparaît sur l’écran.

4 Touchez le caméscope avec le dispositif.
Le dispositif se connecte au caméscope et 
« Content Browser Mobile » démarre.

 [Remarques]
ˎˎ Désactivez le mode de veille et le verrouillage 

d’écran à l’avance.
ˎˎ Touchez et maintenez le dispositif immobile 

jusqu’à ce que l’application « Content Browser 
Mobile » démarre (1 à 2 secondes).

https://www.c3p.sony.net
https://www.c3p.sony.net/site/tos_eu.html
https://www.c3p.sony.net/site/c3p_privacy_policy.html
https://www.c3p.sony.net/site/c3p_privacy_policy.html
https://www.pro-id.sony.net/#/privacyPolicy
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Connexion à un dispositif compatible 
WPS

Les dispositifs qui prennent en charge le WPS 
peuvent être connectés à l’aide du WPS.

1 Sélectionnez Wireless LAN >Setting 
>Access Point Mode dans le menu 
Network.

2 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network.

3 Ouvrez les réglages réseau ou les 
réglages Wi-Fi sur le dispositif et activez le 
Wi-Fi.

4 Sélectionnez le SSID du caméscope dans 
la liste des SSID sous Wi-Fi Network sur le 
dispositif, puis sélectionnez WPS Push 
Button sous Option pour connecter le 
dispositif.

 [Remarques]
ˎˎ La méthode de fonctionnement diffère selon le 

dispositif.
ˎˎ Pour le SSID et le mot de passe du caméscope, 

vérifiez AP Mode Settings >Camera SSID & 
Password (page 123) dans le menu Network.

5 Affichez la télécommande Web 
(page 73). Ou connectez-vous en 
utilisant l’application Content Browser 
Mobile.

Connexion par saisie d’un SSID et d’un 
mot de passe sur un dispositif

Vous pouvez connecter le caméscope à un 
dispositif, en saisissant le SSID et le mot de 
passe sur un dispositif.

1 Sélectionnez Wireless LAN >Setting 
>Access Point Mode dans le menu 
Network.

2 Ouvrez les réglages réseau ou les 
réglages Wi-Fi sur le dispositif et activez le 
Wi-Fi.

3 Connectez le dispositif au caméscope en 
sélectionnant le SSID du caméscope dans 
la liste des SSID sous Wi-Fi Network et en 
saisissant le mot de passe.
Pour le SSID et le mot de passe du 
caméscope, vérifiez AP Mode Settings 
>Camera SSID & Password (page 123) 
dans le menu Network.

 [Remarque]
La méthode de fonctionnement diffère selon le 
dispositif.

4 Affichez la télécommande Web 
(page 73). Ou connectez-vous en 
utilisant l’application Content Browser 
Mobile.

Connexion à l’aide du mode de 
station de LAN sans fil

Le caméscope se connecte à un point d’accès 
existant du réseau local sans fil en tant 
que client. Le caméscope et le dispositif se 
connectent via le point d’accès.
Les 10 derniers points d’accès où une 
connexion s’est produite sont affichés dans 
l’historique.
L’historique de connexion est sauvegardé 
dans un fichier ALL file mais les mots de passe 
d’accès ne sont pas enregistrés. La saisie d’un 
mot de passe sera requise à la prochaine 
connexion après le chargement du fichier ALL.

Smartphone/
tablette

Point 
d’accès

Ordinateur

Connexion à un point d’accès à l’aide de 
la fonction WPS

Si le point d’accès est compatible avec la 
fonction WPS, vous pouvez vous connecter au 
point d’accès avec des réglages simples.

1 Activez le point d’accès.

2 Mettez le caméscope sous tension.

3 Sélectionnez Wireless LAN >Setting 
>Station Mode dans le menu Network.

4 Sélectionnez Wireless LAN >WPS >Execute 
dans le menu Network.

5 Appuyez sur la touche WPS du point 
d’accès.
Pour les détails sur le fonctionnement de 
la touche WPS, consultez le mode 
d’emploi du point d’accès.
Une fois la connexion réussie, l’icône 
d’indicateur d’état du réseau affiche une 
puissance de 1 ou plus sur l’écran du 
viseur.

 [Remarque]
Si la connexion échoue, recommencez toutes les 
étapes à partir de l’étape 1.

6 Connectez le dispositif au point d’accès.
Pour plus de détails sur la connexion, 
consultez le mode d’emploi du dispositif.

7 Affichez la télécommande Web 
(page 73). Ou connectez-vous en 
utilisant l’application Content Browser 
Mobile.
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Connexion à un point d’accès à l’aide de 
la détection automatique ou manuelle 
du réseau

Vous pouvez configurer la connexion à un 
point d’accès souhaité depuis le menu de 
configuration.
Vous pouvez configurer la connexion à un 
point d’accès souhaité à l’aide de la fonction 
de détection automatique du réseau.

Connexion à l’aide de la fonction de détection 
automatique de réseau

1 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 62).

2 Sélectionnez ST Mode Settings >Scan 
Networks (page 124) >Execute dans le 
menu Network.
Le caméscope lance la détection des 
destinations réseau.
Les destinations possibles ayant été 
détectées s’affichent sous forme de liste.

3 Sélectionnez une destination dans la liste.
L’écran des détails du réseau (point 
d’accès) apparaît. La connexion choisie est 
affichée dans le SSID.

4 Sélectionnez Password, puis définissez le 
mot de passe sur l’écran de saisie du mot 
de passe.
La sélection d’un SSID dans l’historique de 
connexion configure automatiquement 
les réglages, y compris le mot de passe.
Réglez le mot de passe pour revenir à 
l’écran des détails du réseau (point 
d’accès).

5 Configurez les réglages de connexion 
suivants.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  
Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir la passerelle pour le 
point d’accès.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez le serveur DNS principal du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez le serveur DNS secondaire du 
point d’accès.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

6 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

Connexion manuelle

1 Effectuez les étapes 1 à 3 dans 
« Connexion à un point d’accès à l’aide de 
la fonction WPS » (page 62).

2 Sélectionnez ST Mode Settings >Manual 
Register (page 125) >Execute dans le 
menu Network.
L’écran des détails du réseau (point 
d’accès) apparaît momentanément.

3 Configurez les réglages de connexion 
suivants.
ˎˎ SSID 
Saisissez le SSID pour le point d’accès de 
connexion.
ˎˎ Security 
Sélectionnez la méthode de cryptage.
ˎˎ Password 
Saisissez le mot de passe du point 
d’accès de connexion.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  
Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 

automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

4 Lorsque vous avez terminé, sélectionnez 
Connect pour vous connecter au point 
d’accès.

Connexion à un dispositif à l’aide 
d’un câble LAN

Vous pouvez vous connecter à un dispositif en 
connectant le connecteur LAN filaire du XDCA-
FX9 (page 26) fixé au caméscope à un 
commutateur LAN à l’aide d’un câble LAN.
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Ordinateur

Commutateur 
LAN

Connexions à l’aide d’un câble LAN et 
réglages du LAN filaire

1 Connectez le connecteur LAN filaire du 
XDCA-FX9 à un commutateur LAN à l’aide 
d’un câble LAN.

2 Mettez le caméscope sous tension.

3 Réglez Wired LAN >Setting (page 125) 
dans le menu Network sur On.

4 Configurez les réglages de connexion à 
l’aide de Wired LAN >Detail Settings 
(page 125) dans le menu Network.
ˎˎ DHCP 
Définissez le réglage DHCP.  
Lorsque vous réglez sur On, l’adresse 
IP est automatiquement assignée au 
caméscope.  

Pour assigner manuellement l’adresse IP 
au caméscope, réglez sur Off.
ˎˎ IP Address 
Permet de saisir l’adresse IP de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Subnet Mask 
Permet de saisir le masque de sous-
réseau de l’unité.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ Gateway 
Permet de saisir l’adresse de passerelle.  
Ce réglage n’est disponible que si DHCP 
est réglé sur Off.
ˎˎ DNS Auto 
Permet de régler s’il faut acquérir 
automatiquement ou non le DNS.  
Avec ce réglage sur On, l’adresse 
du serveur DNS est acquise 
automatiquement. Ce réglage n’est 
disponible que si DHCP est réglé sur On.
ˎˎ Primary DNS Server 
Saisissez l’adresse du serveur DNS 
principal.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.
ˎˎ Secondary DNS Server 
Saisissez l’adresse du serveur DNS 
secondaire.  
Ce réglage n’est disponible que si DNS 
Auto est réglé sur Off.

5 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.

[Remarque]
Sélectionnez toujours Set après avoir modifié les 
réglages de connexion. Les réglages ne sont pas 
appliqués si Set n’est pas sélectionné.
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Vous pouvez connecter le caméscope à 
Internet à l’aide d’un modem, d’un LAN filaire 
ou d’un LAN sans fil.

Connexion par l’intermédiaire 
d’un modem

Vous pouvez connecter le caméscope à 
Internet via un réseau 3G/4G en connectant 
un XDCA-FX9 (page 26) au caméscope et 
un modem en option au XDCA-FX9.
La connexion et l’utilisation de plus d’un 
modem en même temps permettent une 
diffusion continue de haute qualité en mode 
client réseau, en utilisant deux lignes pour une 
diffusion continue de meilleure qualité et une 
redondance du périphérique.
Pour plus de détails sur les modems 
compatibles, contactez votre revendeur Sony 
ou un technicien Sony.

[Remarque]
Un modem ne peut pas être utilisé en même temps 
qu’un LAN filaire.

Raccordement d’un XDCA-FX9 à 
l’appareil

Installez un modem compatible avec la norme 
USB sur le connecteur USB (type A) du XDCA-
FX9. Deux modems peuvent être utilisés 
simultanément en connectant les modems à 
deux connecteurs.

[Remarque]
Fixez ou retirez le modem lorsque le caméscope est hors 
tension.

Connexion à un réseau

1 Mettez le caméscope sous tension.

2 Réglez Modem >Setting dans le menu 
Network sur On.
Si d’autres réglages doivent être modifiés 
pour activer ce réglage, un écran de 
sélection de fonctions apparaît. 
Sélectionnez les réglages en fonction des 
instructions à l’écran.

 [Remarque]
La connexion à un réseau 3G/4G peut prendre du 
temps (environ 1 minute). Attendez que l’icône 
modem de l’indicateur d’état du réseau (page 11) 
affiche une puissance de 1 ou plus sur l’écran du 
viseur.

Connexion à l’aide d’un 
raccordement modem USB

Vous pouvez connecter un smartphone via 
un câble USB à un XDCA-FX9 attaché au 
caméscope, puis vous connecter à Internet à 
l’aide du smartphone.

Fixation d’un smartphone au caméscope

Connectez un smartphone via un câble USB 
au connecteur USB (type A) (page 4) d’un 
XDCA-FX9 attaché au caméscope.

[Remarques]
ˎˎ Fixez/retirez le smartphone lorsque le caméscope est 

hors tension.
ˎˎ Le raccordement modem USB ne peut pas être utilisé 

si le smartphone est connecté via un concentrateur 
USB.

Connexion à un réseau

1 Mettez le caméscope sous tension.

2 Réglez Modem >Setting dans le menu 
Network sur On.

Si d’autres réglages doivent être modifiés 
pour activer ce réglage, un écran de 
sélection de fonctions apparaît. 
Sélectionnez les réglages en fonction des 
instructions à l’écran.

Connexion à l’aide du mode de 
station de LAN sans fil

Vous pouvez connecter le caméscope à 
Internet en mode de station Wi-Fi via un 
routeur LAN sans fil en option ou par partage 
de la connexion avec un dispositif.

Smartphone/
tablette

Routeur LAN 
sans fil

Ordinateur

Internet

Smartphone/
tablette

Internet

Connectez-vous au routeur LAN sans fil ou au 
dispositif comme indiqué dans « Connexion 
à l’aide du mode de station de LAN sans fil » 
(page 62).

Connexion à Internet
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Connexion à l’aide d’un câble LAN

Vous pouvez vous connecter à un dispositif 
en connectant le connecteur LAN filaire du 
XDCA-FX9 (page 26) fixé au caméscope à 
un routeur Internet à l’aide d’un câble LAN.

Ordinateur

Routeur

Internet

Connectez-vous au routeur Internet comme 
indiqué dans « Connexion à un dispositif à 
l’aide d’un câble LAN » (page 63).
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Téléchargement de fichiers
Vous pouvez télécharger un fichier proxy ou 
un fichier original enregistré sur le caméscope 
vers un serveur sur Internet ou un serveur sur 
un réseau local via un réseau 3G/4G ou un 
point d’accès.

[Remarques]
ˎˎ L’ouverture du cache du logement de support 

interrompt le transfert des fichiers via le réseau. Vous 
ne pouvez pas transférer les fichiers lorsque le cache 
est ouvert. Le transfert reprend lorsque vous avez 
refermé le cache.
ˎˎ Si la lecture est effectuée pendant le transfert de 

fichier, l’écran de lecture risque d’être déformé.

Préparatifs

Connexion à un réseau

Connectez le caméscope à Internet ou au 
réseau local comme indiqué dans « Connexion 
à Internet » (page 65) ou « Connexion à 
d’autres dispositifs via le LAN » (page 61).

Enregistrement d’une destination de 
transfert de fichier

Enregistrez au préalable le serveur pour le 
téléchargement.

1 Sélectionnez File Transfer >Server 
Settings1 (ou Server Settings2, Server 
Settings3) dans le menu Network.
L’écran de configuration de la destination 
de transfert s’affiche.

2 Réglez chaque élément sur l’écran de 
configuration de la destination de 
transfert.
Display Name
Saisissez le nom du serveur à afficher 
dans la liste de destinations de transfert.

Service
Affiche le type de serveur.
« FTP » : serveur FTP
Host Name
Saisissez l’adresse du serveur.
Port
Saisissez le numéro de port du serveur 
pour effectuer la connexion.
User Name
Saisissez le nom d’utilisateur.
Password
Saisissez le mot de passe.
Passive Mode
Activez/désactivez le mode passivité.
Destination Directory
Saisissez le nom de répertoire sur le 
serveur de destination.

 [Remarques]
ˎˎ Lors de la modification, «  » indique des 

caractères ne pouvant pas être modifiés. Le 
fonctionnement correct n’est pas garanti lors de 
la modification d’un nom de répertoire contenant 
ces caractères.  
Si la modification est nécessaire, supprimez tous 
les caractères et saisissez à nouveau une valeur.
ˎˎ Si des caractères non valides sur le serveur de 

destination sont saisis dans Destination Directory, 
les fichiers seront transférés dans le répertoire 
original de l’utilisateur. Les caractères non valides 
varient en fonction du serveur.

Using Secure Protocol
Indiquez si vous exécutez ou non le 
téléchargement sur FTP sécurisé.
Root Certificate
Chargez/effacez un certificat.
ˎˎ Load 
Sélectionnez Set à l’étape 3 pour 
importer un certificat CA.

* Le certificat à charger doit être au format PEM et 
doit être enregistré dans le répertoire racine de la 
carte Utility SD avec « certification.pem » comme 
nom de fichier.

ˎˎ Clear 
Sélectionnez Set à l’étape 3 pour effacer 
un certificat CA.

ˎˎ None 
Vous ne pouvez ni charger ni effacer un 
certificat.

 [Remarques]
ˎˎ Réglez l’horloge du caméscope sur l’heure 

correcte avant d’importer un certificat CA.
ˎˎ Lors de l’enregistrement en XAVC-I 3840×2160P 

59.94/50P, Load ne peut pas être sélectionné.
ˎˎ En état de tension faible, Load/Clear ne peut pas 

être sélectionné pour un certificat CA.

Root Certificate Status
Affiche l’état de chargement du certificat.
Reset
Réinitialisez les réglages de Server 
Settings aux réglages par défaut.

3 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.
Sélectionnez toujours Set après avoir 
modifié les réglages. Les réglages ne sont 
pas appliqués si Set n’est pas sélectionné.

Vous pouvez également enregistrer un 
serveur en utilisant la télécommande Web 
« Enregistrement d’un serveur de destination » 
(page 74).

Sélection d’un fichier et 
téléchargement

Téléchargez vers un serveur un fichier qui 
est enregistré sur une carte SD ou un fichier 
original qui est enregistré sur une carte 
mémoire XQD.
Les fichiers peuvent également être 
téléchargés via une télécommande Web. 
Pour plus de détails, consultez « Transfert 
de fichiers (Slot A, Slot B, Slot SD/MS) » 
(page 75).

Téléchargement d’un fichier proxy sur 
une carte SD à partir d’un écran de 
miniatures

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2 Sélectionnez Transfer Clip (Proxy) >Select 
Clip dans le menu Thumbnail.
L’affichage passe du menu de 
configuration à l’écran des miniatures.
Les plans peuvent être transférés de 
l’écran des miniatures ou de l’écran des 
miniatures de plans filtrés.

3 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4 Sélectionnez Execute.
Le fichier proxy correspondant au fichier 
sélectionné est enregistré comme tâche 
de transfert et le chargement commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.

5 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip 
à l’étape 2 pour transférer les fichiers proxy 
correspondant à tous les fichiers.

[Remarque]
Jusqu’à 200 fichiers peuvent être transférés.
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Téléchargement d’un fichier original sur 
une carte mémoire XQD à partir de 
l’écran de miniatures

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2 Sélectionnez Transfer Clip >Select Clip 
dans le menu Thumbnail.
L’affichage passe du menu de 
configuration à l’écran des miniatures.
Les plans peuvent être transférés de 
l’écran des miniatures ou de l’écran des 
miniatures de plans filtrés.

3 Sélectionnez le plan à transférer et 
appuyez sur la touche MENU.
Un écran de confirmation de transfert 
apparaît.

4 Sélectionnez Execute.
Le fichier sélectionné est enregistré 
comme tâche de transfert et le 
chargement commence.
Si l’enregistrement de la tâche de transfert 
réussit, l’écran des résultats du transfert 
s’affiche.

5 Sélectionnez OK.

Pour télécharger tous les fichiers
Sélectionnez All Clips au lieu de Select Clip à 
l’étape 2 pour transférer tous les fichiers.

[Remarque]
Jusqu’à 200 fichiers peuvent être transférés.

Vérification du transfert de fichiers

Vous pouvez vérifier l’état du transfert de 
fichier en sélectionnant File Transfer >View Job 
List (page 127) dans le menu Network.

Vous pouvez vérifier l’état du chargement 
dans l’écran Job List affiché en sélectionnant 
Job List dans l’écran SD Card, Slot A ou Slot B 
(page 76).

[Conseils]
ˎˎ Vous pouvez aussi vérifier l’état du transfert de fichier 

depuis l’écran de télécommande Web.
ˎˎ Si File Transfer >Auto Upload (page 127) ou Auto 

Upload (Proxy) (page 127) dans le menu Network 
est réglé sur On et qu’une connexion réseau existe, 
les fichiers originaux et les fichiers proxy sont 
automatiquement téléchargés sur le serveur spécifié 
à l’aide de Default Upload Server (page 127) à la fin 
de l’enregistrement. Si les fichiers originaux et proxy 
sont tous deux configurés pour le téléchargement 
automatique, le téléchargement automatique des 
fichiers proxy est prioritaire.

[Remarques]
ˎˎ Un maximum de 200 tâches de transfert peuvent être 

enregistrées.
ˎˎ La liste des tâches est conservée lorsque le 

caméscope est mis hors tension, mais vous pouvez 
perdre jusqu’à 10 minutes d’informations de 
progression récente si le pack batterie est retiré ou si 
le caméscope est mis hors tension sans avoir placé au 
préalable le commutateur POWER sur STANDBY.
ˎˎ Les tâches ajoutées après l’état de tension faible de 

la batterie ne sont pas enregistrées dans la liste des 
tâches.
ˎˎ Si une erreur se produit lors du transfert de fichiers, 

le transfert d’un plan ayant le même nom qu’un plan 
transféré peut ne pas se poursuivre en fonction des 
paramètres et de l’état du serveur de destination du 
transfert. Si cela se produit, vérifiez les paramètres et 
l’état du serveur de destination du transfert.

Téléchargement automatique des 
fichiers

Téléchargement automatique d’un 
fichier original

Les fichiers originaux peuvent être 
téléchargés sur le serveur spécifié à la fin de 
l’enregistrement. Pour activer cette fonction, 
réglez File Transfer >Auto Upload (page 127) 
sur On dans le menu Network.

Téléchargement automatique d’un 
fichier proxy

Les fichiers proxy peuvent être téléchargés sur 
le serveur spécifié à la fin de l’enregistrement. 
Pour activer cette fonction, réglez File Transfer 
>Auto Upload (Proxy) (page 127) sur On dans 
le menu Network.
Ou bien, lorsque Auto Upload (Proxy) est réglé 
sur Chunk, vous pouvez enregistrer un fichier 
proxy par fragments, puis télécharger les 
fragments sur un serveur spécifié pendant que 
l’enregistrement continue. Le téléchargement 
d’un fichier proxy enregistré par fragments est 
prioritaire sur les autres tâches de transfert de 
fichiers.
Pour plus de détails sur la configuration, 
consultez « Enregistrement et téléchargement 
d’un fichier proxy par fragments » 
(page 59).

[Conseil]
Si Auto Upload et Auto Upload (Proxy) sont réglés 
sur On, le téléchargement des fichiers proxy prévaut. 
Cependant, l’ordre peut changer en fonction de l’état du 
réseau.

Téléchargement à l’aide d’un FTP 
sécurisé

Vous pouvez télécharger des fichiers cryptés 
à l’aide de FTPS en mode Explicit (FTPES) pour 
la connexion avec le serveur de fichiers de 
destination.

Réglage d’un transfert FTP sécurisé

Pour un transfert FTP sécurisé, réglez Using 
Secure Protocol sur ON dans les réglages du 
serveur du fichier de destination puis importez 
un certificat.
Pour plus de détails sur la configuration, 
consultez « Enregistrement d’une destination 
de transfert de fichier » (page 67).
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La diffusion continue haute qualité est prise 
en charge en activant le mode client réseau 
et en connectant une station réseau Sony 
RX (optionnelle) comme Connection Control 
Manager (CCM) ou une connexion via C3 
Portal.

Réglage de la connexion en mode 
client réseau

Il est possible de configurer jusqu’à trois 
connexions en mode client réseau en tant que 
réglages NCM.

1 Sélectionnez Network Client Mode >NCM 
Settings1 (ou NCM Settings2, NCM 
Settings3) dans le menu Network.
L’écran de configuration de la destination 
de connexion en mode client réseau 
apparaît.

2 Réglez chaque élément sur l’écran de 
configuration de la destination de 
connexion.
Display Name
Réglez le nom d’affichage dans le menu 
NCM Settings.
CCM Address
Saisissez l’adresse IP du CCM pour 
effectuer la connexion (nom de l’hôte ou 
adresse IP).
CCM Port
Saisissez le numéro de port du CCM pour 
effectuer la connexion.
User Name
Saisissez le nom d’utilisateur.
Password
Saisissez le mot de passe.
CCM Certificate
Un certificat racine CCM est requis pour la 
connexion à un CCM ou à C3 Portal. Le 

caméscope contient un certificat racine 
CCM intégré, qui peut également être mis 
à jour. Pour mettre à jour le certificat 
racine CCM, enregistrez le certificat sur 
une carte mémoire, puis importez le 
certificat depuis la carte mémoire.
ˎˎ Load 
Sélectionnez Set à l’étape 3 pour 
importer un certificat.

* Le certificat à charger doit être au format PEM et 
doit être enregistré dans le répertoire racine de la 
carte SD avec « CCM_certification.pem » comme 
nom de fichier.

ˎˎ Clear 
Sélectionnez Set à l’étape 3 pour effacer 
un certificat.
ˎˎ None 
Vous ne pouvez ni charger ni effacer un 
certificat.

 [Remarques]
ˎˎ Réglez l’horloge du caméscope sur l’heure 

correcte avant de charger les certificats de 
connexion CCM et C3 Portal.
ˎˎ Lors de l’enregistrement en XAVC-I 3840×2160P 

59.94/50P ou XAVC-I 4096×2160P 59.94/50P, 
Load ne peut pas être sélectionné.
ˎˎ En état de tension faible, les certificats de 

connexion CCM et C3 Portal ne peuvent pas être 
chargés ni effacés.

CCM Certificate Status
Affiche l’état de chargement du certificat.
Camera Control
Activez/désactivez le contrôle de la 
caméra lors d’une connexion avec un 
CCM.
Camera Setting
Active/désactive les opérations du fichier 
ALL lors d’une connexion avec un CCM.
Reset
Réinitialisez les réglages de NCM Settings 
aux réglages par défaut.

3 Lorsque vous avez terminé, sélectionnez 
Set pour appliquer les réglages.

Sélectionnez toujours Set après avoir 
modifié les réglages. Les réglages ne sont 
pas appliqués si Set n’est pas sélectionné.

4 Sélectionnez Network Client Mode >NCM 
Settings Select dans le menu Network, 
puis les réglages NCM (NCM Settings1, 
NCM Settings2, NCM Settings3) spécifiés 
aux étapes 1 à 3.

Réglage de la qualité de 
streaming

Configurez Network Client Mode >Streaming 
Quality (page 127) sur High dans le menu 
Network pour obtenir un streaming de haute 
qualité. Configurez Streaming Quality sur 
Normal si vous souhaitez une qualité normale.

[Remarques]
ˎˎ Vous ne pouvez pas régler Streaming Quality sur High 

dans les cas suivants.
 – Lorsque Proxy Rec >Setting (page 98) dans le 

menu Project est réglé sur On
 – Lorsque 4K & HD (Sub) Rec >Setting (page 98) 

dans le menu Project est réglé sur On
 – Lorsque Focus >Face Eye Detection AF (page 93) 

dans le menu Shooting n’est pas réglé sur Off
ˎˎ Lorsque Network Client Mode >Setting (page 126) 

dans le menu Network est réglé sur On, vous ne 
pouvez pas modifier Streaming Quality.

Connexion en mode client réseau

1 Connectez le caméscope à Internet 
comme indiqué dans « Connexion à 
Internet » (page 65).

2 Réglez Network Client Mode >Setting du 
menu Network sur On.

Le mode client réseau est activé et le 
caméscope est connecté à la station de 
réception réseau RX ou à C3 Portal.
La diffusion continue en direct démarre 
en réponse au fonctionnement de la 
station réseau RX. Pour plus de détails sur 
son fonctionnement, consultez le mode 
d’emploi de la station réseau RX ou le 
fichier d’aide pour C3 Portal.
Vous pouvez également régler Setting sur 
On ou Off en appuyant sur une touche 
attribuable (page 48) à laquelle 
Network Client Mode est affecté.

[Remarques]
ˎˎ Il est impossible de démarrer la diffusion continue 

avec les réglages de menu suivants.
 – Lorsque S&Q Motion >Setting dans le menu 

Shooting est réglé sur On
 – Lorsque Interval Rec >Setting dans le menu Project 

est réglé sur On
 – Lorsque Simul Rec >Setting dans le menu Project 

est réglé sur On
ˎˎ Après le passage au mode client réseau, la 

surveillance (page 74) n’est pas disponible.
ˎˎ Le passage au mode client réseau pendant la 

surveillance arrêtera la surveillance.
ˎˎ Le transfert de fichiers n’est pas pris en charge 

pendant la diffusion continue en mode client réseau. 
Le transfert de fichiers est pris en charge après l’arrêt 
de la diffusion continue.
ˎˎ Si la diffusion continue en mode client réseau est 

lancée pendant le transfert de fichiers, le transfert 
de fichiers s’arrête. Le transfert de fichiers redémarre 
après l’arrêt de la diffusion continue.
ˎˎ Les éléments User Name, Password et les certificats 

ne sont pas sauvegardés dans un fichier ALL et, par 
conséquent, ils doivent être à nouveau configurés 
après le chargement d’un fichier ALL.
ˎˎ Si Setting est réglé sur Off pendant la diffusion 

continue en mode client réseau, la diffusion continue 
s’arrête.
ˎˎ Lors de la diffusion continue en mode client réseau, 

vous ne pouvez pas modifier les NCM Settings Select 
et NCM Settings sélectionnés à l’aide de NCM Settings 
Select.
ˎˎ Pendant la diffusion continue, la fréquence de mise à 

jour des informations à l’écran est réduite, mais cela 
n’affecte pas le fonctionnement.
ˎˎ Les réglages d’enregistrement ne peuvent pas être 

modifiés pendant la diffusion continue en mode 
client réseau.

Utilisation du mode client réseau
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ˎˎ Les réglages LAN filaire ne peuvent pas être modifiés 
pendant la diffusion en mode client réseau.
ˎˎ L’image peut s’arrêter de manière temporaire lors du 

basculement vers l’écran de miniatures ou l’écran de 
lecture pendant la diffusion continue QoS.
ˎˎ Les formats de distribution disponibles pour la 

diffusion continue varient en fonction du réglage Rec 
Format du caméscope.
ˎˎ Lors de la connexion à l’aide d’un raccordement 

modem USB, l’image peut subir des perturbations 
si le smartphone est utilisé pendant la diffusion 
continue QoS.

Transfert de fichiers en mode 
client réseau

Vous pouvez transférer des fichiers vers 
un serveur défini par l’intermédiaire du 
CCM en connectant une station réseau RX 
fonctionnant comme un CCM et le caméscope 
en mode client réseau.

1 Sélectionnez le fichier à charger depuis le 
CCM ou une autre source.
ˎˎ Pour transférer un fichier proxy 
Suivez les étapes 1 à 4 dans 
« Téléchargement d’un fichier proxy sur 
une carte SD » (page 75).
ˎˎ Pour transférer un fichier original 
Suivez les étapes 1 à 4 dans 
« Téléchargement d’un fichier 
original sur une carte mémoire XQD » 
(page 75).

[Remarque]
La destination peut également être réglée sur « NCM: RX 
Server » si le mode client réseau n’est pas activé. Dans 
ce cas, le transfert est mis en attente puis le transfert 
vers le serveur spécifié sur le CCM démarre après la 
connexion au CCM en mode client réseau.
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Utilisation de C3 Portal App
Vous pouvez facilement transférer des fichiers 
sur le service Cloud C3 Portal en reliant 
l’appareil à l’application pour smartphone « C3 
Portal App ».
D’abord, créez un compte C3 Portal et installez 
C3 Portal App sur un smartphone.
Pour plus de détails sur la création d’un 
compte de service Cloud C3 Portal, contactez 
l’administrateur de votre organisation.

[Remarques]
ˎˎ Un XDCA-FX9 (en option) est nécessaire.
ˎˎ Le service peut ne pas être fourni, en fonction de la 

région où vous vivez.
ˎˎ Pour plus de détails sur l’utilisation de C3 Portal App, 

reportez-vous au C3 Portal App Help Guide.

Connexion de l’appareil à C3 Portal

1 Sélectionnez Setup for Mobile App >Setup 
(page 123) dans le menu Network.
Un écran de sélection de codec apparaît.
Si Rec Format >Codec (page 96) dans le 
menu Project n’est pas réglé sur RAW, 
l’écran de l’étape 4 apparaît.

2 Sélectionnez un codec et sélectionnez 
Next.
Si Rec Format >Codec dans le menu 
Project est réglé sur RAW, la connexion à 
un réseau à l’aide d’un raccordement 
modem USB n’est pas possible. Modifiez 
les réglages de codec et de format vidéo 
aux étapes 2 à 3.

3 Sélectionnez un format vidéo et 
sélectionnez Next.

Un écran de confirmation de la 
configuration apparaît.

4 Vérifiez les réglages et sélectionnez OK.
La configuration démarre. Un message 
« Changing… » apparaît pendant que la 
configuration est en cours.
Lorsque la configuration est terminée, 
l’écran suivant apparaît dans le viseur.

 [Conseil]
Cet écran n’est pas émis dans la sortie vidéo.

 [Remarque]
Veillez à ce que le mot de passe ne puisse pas être 
visualisé et que l’image du code QR ne puisse pas 
être copiée par d’autres personnes.

5 Lancez C3 Portal App sur le smartphone et 
connectez-vous au service Cloud.

6 Connectez le smartphone via un câble 
USB au connecteur USB (type A) d’un 
XDCA-FX9 fixé au caméscope.

7 Activez le raccordement modem USB sur 
l’écran du smartphone.
L’opération diffère en fonction de votre 
smartphone. Reportez-vous au manuel 
d’utilisation du smartphone.

8 Scannez le code QR dans le viseur 
conformément aux instructions sur l’écran 
de C3 Portal App.
Les informations de configuration du 
transfert de fichiers sont envoyées du 
smartphone à l’appareil et le message 
suivant apparaît.

 [Conseil]
Pour la deuxième connexion et les suivantes, le 
message de transfert de fichier n’apparaîtra plus.

9 Sélectionnez OK.
Les informations de configuration 
commencent à charger.
Lorsque la configuration est chargée avec 
succès, un message « Network File 
loaded. » apparaît.

[Conseils]
ˎˎ Les fichiers envoyés par l’appareil sont mis en cache 

dans C3 Portal App et transférés dans C3 Portal. 
L’affichage d’état du transfert de fichiers sur l’appareil 
indique l’état de transfert de C3 Portal App.
ˎˎ Lorsque le transfert de fichiers de l’appareil sur C3 

Portal App sur le smartphone est terminé, vous 
pouvez mettre l’appareil hors tension, mais notez que 
le transfert de fichiers depuis le smartphone peut 
encore continuer. Soyez attentif à la charge restante 
de la batterie sur le smartphone.

[Remarques]
ˎˎ C3 Portal App écrase le réglage File Transfer 

(page 127) dans le menu Network de l’appareil.
ˎˎ Root Certificate ne peut pas être réglé 

automatiquement. Configurez-le manuellement.

Téléchargement d’un fichier original

Réglez File Transfer >Auto Upload (page 127) 
dans le menu Network sur On pour activer le 
téléchargement des fichiers originaux sur C3 
Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.

Téléchargement d’un fichier proxy

Réglez File Transfer >Auto Upload (Proxy) 
(page 127) dans le menu Network sur On 
pour activer le téléchargement de fichiers 
proxy sur C3 Portal.
Chaque fois qu’un enregistrement se termine, 
le fichier est téléchargé sur l’emplacement 
associé à votre compte C3 Portal.
Lorsque Auto Upload (Proxy) est réglé sur 
Chunk, le fichier proxy est divisé en fragments 
et téléchargé à intervalles réguliers depuis le 
démarrage de l’enregistrement.

Téléchargement de fichiers arbitraires

Consultez « Sélection d’un fichier et 
téléchargement » (page 67).

Autres fonctions qui utilisent C3 
Portal

Gestion des fichiers 3D LUT

Vous pouvez charger des fichiers 3D LUT 
stockés dans C3 Portal vers l’appareil. 
Consultez « Chargement depuis un service 
Cloud » (page 55).
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Gestion de fichiers ALL

Vous pouvez enregistrer un fichier ALL créé 
par l’appareil dans C3 Portal et charger un 
fichier ALL depuis C3 Portal.
Consultez « Enregistrement d’un fichier 
ALL sur un service Cloud » (page 131) et 
« Chargement d’un fichier ALL depuis un 
service Cloud » (page 131).
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Utilisation de la télécommande Web
Vous pouvez accéder à la télécommande Web 
intégrée dans le caméscope à partir d’une 
tablette ou d’un ordinateur par l’intermédiaire 
d’une connexion réseau.
L’utilisation de la télécommande Web vous 
permet de commander le caméscope à 
distance. Vous pouvez démarrer/arrêter 
l’enregistrement et procéder aux réglages 
de l’enregistrement avec un dispositif 
connecté. Cette fonction peut être utile lors 
de l’installation du caméscope à un endroit 
distant, par exemple en haut d’une grue, etc.

Écran Camera Control

Écran principal

ˎˎ Affichage de l’état
ˎˎ Touche de démarrage/arrêt 
d’enregistrement
ˎˎ Curseur du filtre ND
ˎˎ Curseur Iris
ˎˎ Curseur Focus
ˎˎ Curseur Zoom
ˎˎ Réglages Shooting (mode de prise de vue 
SDR ou HDR (page 28)) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 

Gain, Gamma, Shutter Category, White 
Mode, Base Sensitivity, Auto ND Filter, Auto 
Iris, AGC, Color Bars, Focus Mode, Auto 
White
ˎˎ Réglages Shooting (mode de prise de vue 
Cine EI) 
S&Q Frame Rate, Shutter, Color Temp/Tint, 
Exposure Index, Color Gamut/Gamma, 
Shutter Category, White Mode, Base ISO, 
Auto ND Filter, Auto Iris, AGC, Color Bars, 
Focus Mode, Monitor LUT, Auto White

Écran Playback

ˎˎ Affichage de l’état
ˎˎ Touches de commande de lecture 
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Écran Cursor

ˎˎ Affichage de l’état
ˎˎ Touches de commande de curseur, 
affichage de menu/d’état 

Haut, gauche, Set, droite, bas, Cancel/Back, 
Menu, User Menu, Thumbnail, Status

Écran Assign

ˎˎ Affichage de l’état
ˎˎ Affichage de touche personnalisable 
Touches personnalisables 1 à 10, touche 
Focus Hold

Affichage de la télécommande 
Web

1 Connectez le caméscope et le dispositif 
via une connexion réseau (page 61).

2 Lancez un navigateur sur le dispositif, puis 
accédez à « http://adresse IP du 
caméscope/rm.html ».
Par exemple, si l’adresse IP est 
192.168.122.1, saisissez 
« http://192.168.122.1/rm.html » dans la 
barre d’adresse.
Vous pouvez vérifier l’adresse IP du 
caméscope sur l’écran d’état du réseau 
(page 17).

3 Saisissez le nom d’utilisateur et le mot de 
passe (Access Authentication >User Name 
et Password dans le menu Network).

Une fois la connexion est réussie, l’écran 
de télécommande Web apparaît sur le 
dispositif.
Vous utilisez l’écran Wi-Fi Remote pour 
commander le caméscope.
Les touches ne sont plus disponibles 
lorsque le commutateur de verrouillage 
est glissé vers la droite.

[Remarques]
ˎˎ L’écran de télécommande Web peut ne pas 

correspondre aux réglages du caméscope dans les 
circonstances suivantes. Si ceci se produit, rechargez 
la fenêtre du navigateur.
 – Si le caméscope est remis en marche alors qu’il est 

connecté
 – Si le caméscope est utilisé directement alors qu’il 

est connecté
 – Si le dispositif a été reconnecté
 – Si les touches Avance/Retour du navigateur ont été 

utilisées
ˎˎ La télécommande Web peut ne pas fonctionner si la 

force du signal sans fil est faible.

Appareils compatibles avec une 
télécommande Web

Vous pouvez utiliser une tablette ou un 
ordinateur pour configurer et utiliser le 
caméscope.
Les dispositifs, le système d’exploitation et les 
navigateurs pris en charge sont affichés dans 
le tableau suivant.

Dispositif Système 
d’exploitation

Navigateur

Tablette Android 7/8 Chrome

iOS 
12/13.3/14/15

Safari

Ordinateur Windows 
7/8.1/10

Chrome

macOS 
10.13/10.14

Safari

http://adresse IP du caméscope/rm.html
http://adresse IP du caméscope/rm.html
http://192.168.122.1/rm.html
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Pour plus de détails sur les dispositifs 
pris en charge à l’aide de l’application 
« Content Browser Mobile », contactez votre 
représentant commercial ou un technicien 
Sony.

Menu de télécommande Web

Touchez  en haut à gauche de l’écran 
pour afficher le menu de sélection d’écran. 
Sélectionnez Monitoring Settings pour afficher 
l’écran Monitoring Settings.
Touchez  en haut à gauche de l’écran 
Monitoring Settings pour afficher le menu 
de configuration des tâches, telles que le 
transfert de fichiers.

Éléments de menu
ˎˎ Remote Control 
Camera Control
ˎˎ Monitoring 
Monitoring Settings
ˎˎ File Transfer 
Slot A 
Slot B 
Slot SD/MS 
Job List 
Upload Settings

Réglages de la surveillance vidéo 
(Monitoring Settings)

Vous pouvez définir le format de surveillance 
sur un dispositif.

Size
Règle la taille de l’image et le débit binaire de 
la vidéo pour la surveillance.
ˎˎ 480×270(1Mbps)
ˎˎ 480×270(0.5Mbps)

Frame Rate
Affiche la fréquence d’images de la vidéo pour 
la surveillance.

Réglages de transfert de fichiers 
(Upload Settings)

Vous pouvez modifier les réglages du serveur 
pour télécharger un fichier proxy ou un fichier 
original enregistré sur le caméscope.

Enregistrement d’un serveur de destination
Sélectionnez un serveur dans la liste Upload 
Server puis appuyez sur Edit pour afficher 
l’écran de configuration du serveur, puis réglez 
chaque élément pour enregistrer un serveur.

Vous pouvez également enregistrer un serveur 
à l’aide de File Transfer (page 127) dans le 
menu Network.
Un serveur configuré sera affiché dans la liste 
de transfert de fichiers sur les écrans Slot A, 
Slot B et Slot SD/MS lors du téléchargement 
d’un fichier.

Écran Upload Server Edit

Appuyez sur OK pour appliquer les réglages. 
Appuyez sur Cancel pour annuler les réglages.
Service
Affiche le type de serveur.
« FTP » : serveur FTP
Display Name
Saisissez le nom du serveur à afficher dans la 
liste.
Host Name
Saisissez l’adresse du serveur.
Port
Saisissez le numéro de port du serveur pour 
effectuer la connexion.
User Name
Saisissez le nom d’utilisateur.
Password
Saisissez le mot de passe.

[Remarques]
ˎˎ Le mot de passe est effacé lorsque l’écran Edit est 

ouvert pour des raisons de sécurité. Saisissez-le à 
nouveau si les réglages du serveur ont changé.
ˎˎ Du point de vue de la sécurité, il est recommandé 

de définir un mot de passe avec une chaîne de 
caractères suffisamment longue, difficile à deviner par 
les autres, et de le stocker en toute sécurité.

Display Password
Affiche/masque le mot de passe.
Avec le réglage sur Off, le mot de passe 
configuré n’est pas affiché. Lors de la saisie 
d’un mot de passe, tous les caractères du 
mot de passe saisi s’affichent sous la forme 
d’astérisques.
Avec le réglage sur On, le mot de passe 
configuré n’est pas affiché. Lors de la saisie 
d’un mot de passe, tous les caractères du mot 
de passe s’affichent.
Passive Mode
Activez/désactivez le mode passivité.
Destination Directory
Saisissez le répertoire sur le serveur de 
destination.

[Remarque]
Si des caractères non valides sur le serveur de 
destination sont saisis dans le répertoire de destination, 
les fichiers seront transférés dans le répertoire original 
de l’utilisateur. Les caractères non valides varient en 
fonction du serveur.

Using Secure Protocol
Indiquez si vous exécutez ou non le 
téléchargement sur FTP sécurisé. Le réglage 
sur ON affiche l’état du certificat.
Pour importer ou effacer un certificat, appuyez 
sur Select Function et sélectionnez une tâche 
dans le menu affiché.
ˎˎ Load 
Charger un certificat CA.

* Le certificat à charger doit être au format PEM et 
doit être enregistré dans le répertoire racine de la 
carte SD avec « certification.pem » comme nom 
de fichier.

ˎˎ Clear 
Effacer le certificat CA.
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ˎˎ None 
Vous ne pouvez ni charger ni effacer un 
certificat.

[Remarque]
Réglez l’horloge du caméscope sur l’heure correcte 
avant d’importer un certificat CA.

Modification des réglages de serveur 
enregistrés
Sélectionnez le serveur dont vous souhaitez 
modifier les réglages sur l’écran Upload 
Settings, puis appuyez sur Edit. Modifiez les 
réglages en fonction de ce qu’indique l’écran 
affiché.
Vous pouvez également régler un serveur 
à l’aide de File Transfer (page 127) dans le 
menu Network.

Téléchargement automatique d’un fichier 
proxy
Auto Upload On/Off
Auto Upload (Proxy) On/Off/Chunk
Lorsque Auto Upload et Auto Upload (Proxy) 
est réglé sur On et que le caméscope est 
connecté à Internet, le caméscope télécharge 
automatiquement un fichier original ou un 
fichier proxy vers la destination de transfert 
définie via Default Upload Server à la fin de 
l’enregistrement. Lorsque Auto Upload (Proxy) 
est réglé sur Chunk, le caméscope télécharge 
automatiquement un fichier proxy vers la 
destination de transfert définie via Default 
Upload Server après chaque intervalle défini 
dans Proxy Rec >Chunk.
Default Upload Server
Sélectionnez le serveur de destination pour le 
transfert de fichiers par défaut.

[Conseil]
Consultez « Téléchargement automatique des fichiers » 
(page 68).

Gestion du transfert de fichiers (File 
Transfer)

Vous pouvez transférer des fichiers originaux 
enregistrés sur une carte mémoire XQD ou 
des fichiers proxy enregistrés sur une carte SD, 
gérer le transfert de fichiers et configurer la 
destination de transfert de fichiers.

Transfert de fichiers (Slot A, Slot B, Slot SD/
MS)
Vous pouvez afficher une liste de plans 
enregistrée sur un support inséré dans la 
fente A/fente B ou une liste de fichiers proxy 
enregistrée sur un support inséré dans la fente 
UTILITY SD/MS.

[Remarque]
En utilisant la télécommande Web, un fichier proxy 
enregistré par fragments s’affiche sous la forme de plan 
individuel. Ces plans ne peuvent pas être supprimés. 
Lorsque ces plans sont transférés en utilisant la 
télécommande Web, les plans ne peuvent pas être 
fusionnés automatiquement sur le serveur.

Vous pouvez sélectionner un fichier affiché 
pour télécharger le fichier dans un serveur sur 
Internet.

Téléchargement d’un fichier proxy sur une 
carte SD

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2 Démarrez un navigateur sur le dispositif et 
affichez la télécommande Web 
(page 73).

3 Affichez l’écran de la liste des fichiers pour 
sélectionner un fichier.
Touchez  >File Transfer >Slot SD/MS.
Un écran de liste des fichiers pour le 
support inséré dans le logement de carte 
UTILITY SD/MS apparaît.

4 Sélectionnez le fichier à télécharger.
Appuyez sur le fichier pour le sélectionner. 
Pour annuler, appuyez à nouveau sur le 
fichier.
Vous pouvez appuyer deux fois sur le 
fichier pour le lire et vérifier son contenu 
(carte SD uniquement).

5 Appuyez sur Transfer.
Le serveur que vous avez défini via 
Default Upload Server dans 
« Enregistrement d’un serveur de 
destination » (page 74) apparaît.
Pour changer de serveur, appuyez sur le 
serveur pour afficher la liste des serveurs, 
puis sélectionnez un serveur.
Saisissez le nom de répertoire sur le 
serveur dans Directory, si nécessaire.

6 Appuyez sur Transfer.
Le caméscope démarre le téléchargement 
du fichier sélectionné.
Pour annuler le transfert, appuyez sur 
Cancel.

 [Conseil]
Vous pouvez appuyer sur  en haut à droite de 
l’écran et sélectionner Transfer pour démarrer le 
téléchargement d’un fichier.

Téléchargement d’un fichier original sur une 
carte mémoire XQD

[Conseil]
Vous devez fermer le couvercle du logement de la carte 
XQD pour voir les informations concernant les fichiers de 
la carte mémoire XQD.

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN (page 61).

2 Démarrez un navigateur sur le dispositif et 
affichez la télécommande Web 
(page 73).

3 Affichez l’écran de la liste des fichiers pour 
sélectionner un fichier.
Touchez  >File Transfer >Slot A ou Slot 
B.
Un écran de la liste des fichiers pour le 
support inséré dans la fente A ou B 
apparaît.
Exemple : écran Slot A
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4 Sélectionnez le fichier à télécharger.
Appuyez sur le fichier pour le sélectionner. 
Pour annuler, appuyez à nouveau sur le 
fichier.

5 Appuyez sur Transfer.
Le serveur que vous avez défini via 
Default Upload Server dans 
« Enregistrement d’un serveur de 
destination » (page 74) apparaît.
Pour changer de serveur, appuyez sur le 
serveur pour afficher la liste des serveurs, 
puis sélectionnez un serveur.
Saisissez le nom de répertoire sur le 
serveur dans Directory, si nécessaire.

6 Appuyez sur Transfer.
Le caméscope démarre le téléchargement 
du fichier sélectionné.
Pour annuler le transfert, appuyez sur 
Cancel.

 [Conseil]
Vous pouvez appuyer sur  en haut à droite de 
l’écran et sélectionner Transfer pour démarrer le 
téléchargement d’un fichier.

Vérification du transfert de fichiers (Job List)
Vous pouvez vérifier la liste des fichiers 
à télécharger, vérifier le fichier en cours 
de téléchargement, annuler ou démarrer 
le téléchargement du fichier, et encore 
supprimer le fichier de la liste des fichiers.

Le caméscope est compatible avec la fonction 
de reprise de FTP (reprise du téléchargement 
pour un fichier dont le transfert a été 
suspendu).

ˎˎ Total : progression de tous les fichiers à 
télécharger.
ˎˎ Status : progression du fichier en cours de 
téléchargement.
ˎˎ Remain Time : estimation du temps de 
téléchargement restant.
ˎˎ Transfer data rate : indication de la vitesse 
de téléchargement.

Pour annuler ou démarrer le téléchargement, 
ou bien supprimer un fichier de la liste des 
fichiers

1 Sélectionnez un fichier.

2 Touchez  en haut à droite de l’écran, 
puis sélectionnez un élément.
ˎˎ Abort selected : annule le 
téléchargement du fichier sélectionné.
ˎˎ Delete from list : supprime de la liste le 
fichier sélectionné.
ˎˎ Start selected : démarre le 
téléchargement du fichier sélectionné.
ˎˎ Clear completed : supprime de la liste 
tous les fichiers téléchargés.

[Remarque]
Si une tâche de fragment de plan est supprimée 
pendant l’enregistrement par fragments, les 
fragments de plan qui suivent ne sont pas 
téléchargés.

ˎˎ Select All : permet de sélectionner tous 
les fichiers de la liste.
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Ecran de miniatures
L’écran de miniatures apparaît si vous appuyez sur la touche THUMBNAIL (page 7). L’écran de miniatures affiche les plans stockés sur les cartes mémoire XQD sous forme de miniatures (images 
d’index).
Vous pouvez sélectionner un plan dans l’écran de miniatures et démarrer la lecture de ce plan. L’image de lecture peut être affichée sur le viseur et sur un moniteur externe.
Appuyer à nouveau sur la touche THUMBNAIL ferme l’écran de miniatures et revient à l’image de caméra.

[Remarque]
Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans l’écran de miniatures. Si un plan enregistré que vous vous attendiez à voir n’est pas affiché, vérifiez le format d’enregistrement. Gardez ceci à 
l’esprit avant de formater (initialiser) le support.

Disposition de l’écran

Les informations du plan à la position du curseur sont affichées au bas de l’écran.

4 5

6

3

1

2

Indicateur de la carte mémoire XQD actuellement sélectionnée
(Une icône de verrou s’affiche si la carte est protégée.)

Curseur (jaune)

Numéro de plan/Nombre total de plans

1. Miniature (image d’index)
Affiche l’image d’index d’un plan. Lorsqu’un 
plan est enregistré, sa première image est 
automatiquement définie comme image 
d’index.
Les informations du plan/de l’image sont 
affichées sous la miniature. Vous pouvez 
changer les informations affichées en utilisant 

Customize View (page 118) >Thumbnail 
Caption dans le menu Thumbnail.

2. Nom de plan
Affiche le nom du plan sélectionné.

3. Format vidéo pour l’enregistrement
Affiche le format de fichier du plan 
sélectionné.

4. Informations d’enregistrement spécial
Affiche le mode d’enregistrement uniquement 
si le plan a été enregistré à l’aide d’un mode 
d’enregistrement spécial.
Pour les plans en ralenti et accéléré, la 
fréquence d’images est affichée à droite.

5. Durée du plan

6. Date de création
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Lecture de plans

Lecture de plans enregistrés

Lorsque le caméscope est en mode de veille 
d’enregistrement (Stby), vous pouvez lire les 
plans enregistrés.

1 Insérez une carte mémoire XQD pour la 
lecture.

2 Appuyez sur la touche THUMBNAIL.

3 Utilisez les touches fléchées (page 7) 
ou la molette multifonction (page 4) 
pour déplacer le curseur vers la miniature 
du plan que vous souhaitez lire.

4 Appuyez sur la touche SET ou la molette 
multifonction.
La lecture commence au début du plan 
sélectionné.

Vous pouvez contrôler la lecture en appuyant 
sur l’une des touches suivantes.
Appuyez sur la touche SET ou la molette 

multifonction : 
La lecture se met en pause.  
Appuyez de nouveau sur la molette pour 
revenir à la lecture normale.

Appuyez sur les touches fléchées gauche/
droite : 
Passe au début du plan/du plan suivant.

Maintenez les touches fléchées gauche/
droite enfoncées : 
Lecture accélérée arrière/avant.  
Revient en lecture normale lorsque vous 
relâchez la touche.

Touche CANCEL/BACK : 
Arrête la lecture et revient en mode de 
veille d’enregistrement.

[Remarques]
ˎˎ Il peut y avoir une interruption temporaire de l’image 

ou une image fixe entre les plans. Vous ne pouvez 
pas utiliser le caméscope durant cette période.

ˎˎ Lorsque vous sélectionnez un plan dans l’écran de 
miniatures et commencez la lecture, il peut y avoir 
une interruption temporaire de l’image au début 
du plan. Pour démarrer la lecture sans déformation 
depuis le début du plan, mettez la lecture en pause 
une fois après son démarrage, appuyez sur la touche 
fléchée gauche pour revenir au début du plan, puis 
redémarrez la lecture.
ˎˎ Vous pouvez aussi utiliser le sélecteur multiple 

(page 9).
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Sur l’écran de miniatures, vous pouvez utiliser 
des plans ou vérifier les propriétés d’un plan 
en utilisant le menu Thumbnail.
Le menu Thumbnail (page 117) apparaît 
lorsque vous appuyez sur la touche MENU et 
sélectionnez Thumbnail.

Opérations sur le menu de 
miniatures

Avec les touches fléchées (page 7) 
ou la molette multifonction (page 4), 
sélectionnez une fonction, puis appuyez sur la 
touche SET ou sur la molette multifonction.
Appuyez sur la touche CANCEL/BACK 
(page 7) pour retourner à l’écran 
précédent.

[Conseil]
Vous pouvez aussi utiliser le sélecteur multiple 
(page 9).

[Remarque]
Certains éléments ne peuvent pas être sélectionnés, 
selon l’état lorsque le menu a été affiché.

Éléments de menu destinés aux 
opérations sur les plans

ˎˎ Display Clip Properties
ˎˎ Set Shot Mark
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Copy Clip
ˎˎ Copy Sub Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Set Index Picture
ˎˎ Thumbnail View
ˎˎ Filter Clips
ˎˎ Customize View

Pour plus de détails concernant les éléments 
de menu d’opérations sur les plans, voir le 
menu Thumbnail (page 117).

Affichage des propriétés de plan

Sélectionnez Display Clip Properties 
(page 117) dans le menu de miniatures pour 
afficher l’écran de propriétés de plan.

Affichage de l’écran de miniatures de 
repères

Sélectionnez Thumbnail View (page 118) 
>Essence Mark Thumbnail dans le menu 
Thumbnail et sélectionnez le type de repère 
pour afficher un affichage en miniature des 
images possédant le repère spécifié.
Pour afficher tous les plans, sélectionnez 
Thumbnail View >Essence Mark Thumbnail 
dans le menu Thumbnail sur All.

Affichage de l’écran de miniatures de 
plans filtré

Sélectionnez Filter Clips (page 118) dans le 
menu Thumbnail et sélectionnez un type de 
balise de plan pour afficher uniquement les 
plans qui possèdent la balise spécifiée.
Pour afficher tous les plans, sélectionnez All.

[Conseil]
Vous pouvez également commuter les filtres dans 
l’ordre à l’aide de la touche DISPLAY.

Suppression de plans

Vous pouvez supprimer des plans sur les 
cartes mémoire XQD.
Sélectionnez Delete Clip >Select Clip ou All 
Clips dans le menu Thumbnail.
Select Clip : 

Supprime le plan sélectionné. Il est 
possible de sélectionner plusieurs plans.

All Clips : 
Supprime tous les plans affichés.

Modification des informations affichées 
sur l’écran de miniatures

Vous pouvez modifier les informations de 
plans/images affichées sous la miniature.
Sélectionnez Customize View >Thumbnail 
Caption dans le menu Thumbnail et 
sélectionnez les informations à afficher.
Date Time : 

Affiche la date et l’heure à laquelle le plan 
a été créé et modifié pour la dernière fois.

Time Code : 
Affiche le code temporel.

Duration : 
Affiche la durée du plan.

Sequential Number : 
Affiche un numéro séquentiel sur chaque 
miniature.

Opérations sur les plans
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Configuration et hiérarchie du menu de configuration
Appuyez sur la touche MENU pour afficher le 
menu de configuration dans le viseur pour 
spécifier divers éléments pour la prise de 
vue, l’enregistrement et la lecture (le menu 
peut également être affiché sur un moniteur 
externe). Le menu de configuration se 
compose des menus suivants.

Configuration du menu

Menu User
Contient des éléments de menu 
configurés par l’utilisateur depuis le menu 
Edit User.

Menu Edit User
Contient des éléments de menu pour 
éditer le menu User.

Menu Shooting
Contient des réglages liés à la prise de 
vue.

Menu Project
Contient des réglages de base du projet.

Menu Paint
Contient des réglages liés à la qualité 
d’image.

Menu TC/Media
Contient des réglages liés aux codes 
temporels et au support d’enregistrement.

Menu Monitoring
Contient des réglages liés à la sortie vidéo 
et à l’affichage du viseur.

Menu Audio
Contient des réglages liés à l’audio.

Menu Thumbnail
Contient des réglages liés à l’affichage de 
miniatures.

Menu Technical
Contient des réglages liés aux éléments 
techniques.

Menu Network
Contient des réglages liés aux réseaux.

Menu Maintenance
Contient des réglages liés aux appareils, 
par exemple l’horloge et la langue.

Hiérarchie du menu Setup

User 
(réglages par 
défaut)

Base Setting

Rec Format

ISO/Gain/EI

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Picture Cache Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

Output Format

VF Setting

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

Monitor LUT

Monitor LUT Setting

Monitor 3D LUT

Noise Suppression

Flicker Reduce

SteadyShot

Auto Black Balance

Project Base Setting

Rec Format

Cine EI Setting

HDR Setting

Simul Rec

4K & HD (Sub) Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Planning Metadata
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Paint HDR Paint Setting

Black

Gamma

Black Gamma

Knee

White Clip

Detail(4K/QFHD)

Detail(HD)

Skin Detail

Aperture

Matrix

Multi Matrix

Scene File

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Setting

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Copy Clip

Copy Sub Clip

Transfer Clip

Transfer Clip (Proxy)

Set Index Picture

Thumbnail View

Filter Clips

Customize View

Technical Color Bars

Test Saw

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Handle Zoom

GPS

Menu Settings

Status Page On/Off

RCP

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

Network Setup for Mobile App

Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

Network Client Mode

File Transfer

Network Reset

Maintenance Language

Clock Set

Network Public Key

All Reset

Hours Meter

Version
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Opérations du menu de configuration
Appuyez sur la touche MENU pour afficher le 
menu de configuration dans le viseur pour 
spécifier divers éléments pour la prise de 
vue, l’enregistrement et la lecture (le menu 
peut également être affiché sur un moniteur 
externe).

Commandes de menu

Touche MENU (page 7)
Active/désactive le mode de menu pour 
les commandes du menu de 
configuration.

Touche ////SET (page 7)
Appuyez sur les touches fléchées pour 
déplacer le curseur vers le haut/bas/la 
gauche/droite et sélectionner des 
éléments ou des réglages de menu.
Appuyez sur la touche SET pour appliquer 
l’élément sélectionné.

 [Conseil]
Vous pouvez aussi utiliser le sélecteur multiple 
(page 9) de la même manière.

Molette multifonction (page 4)
Tournez la molette multifonction pour 
déplacer le curseur vers le haut/bas et 
sélectionner des éléments ou des 
réglages de menu.
Appuyez sur la molette multifonction pour 
appliquer l’élément sélectionné.

Touche CANCEL/BACK (page 7)
Appuyez pour revenir au menu précédent. 
Toute modification incomplète est 
annulée.

[Remarques]
ˎˎ Le menu de configuration ne peut pas être actionné 

en mode Focus magnifier (page 36).
ˎˎ Certains éléments ne peuvent pas être sélectionnés, 

selon l’état lorsque le menu a été affiché.
ˎˎ Les opérations tactiles ne sont pas prises en charge.

Réglage d’éléments de menu

Appuyez sur les touches fléchées ou tournez 
la molette multifonction pour déplacer le 
curseur vers l’élément de menu à régler, 
puis appuyez sur la touche SET ou la molette 
multifonction pour sélectionner l’élément.
ˎˎ La zone de sélection d’élément de menu 
affiche jusqu’à huit lignes. Si les options 
disponibles pour un élément ne peuvent 
pas être affichées en même temps, faites 
défiler l’affichage en déplaçant le curseur 
vers le haut/bas.
ˎˎ Pour les sous-éléments avec une grande 
plage de réglages (par exemple –99 à +99), 
la zone des réglages n’est pas affichée. Le 
paramètre actuel est mis en surbrillance 
pour indiquer que la valeur peut être 
changée.
ˎˎ Le fait de sélectionner [Execute] pour une 
fonction permet d’exécuter la fonction 
correspondante.
ˎˎ Le fait de sélectionner un élément qui 
nécessite confirmation avant exécution 
cache temporairement le menu et affiche 
un message de confirmation. Vérifiez le 
message, puis sélectionnez l’exécution ou 
l’annulation de la fonction.

Saisie d’une chaîne de caractères

Quand vous sélectionnez un élément, tel 
qu’un nom de fichier, qui exige la saisie de 
caractères, l’écran de saisie de caractères 
s’affiche.

1

2 3

1 Appuyez sur les touches fléchées ou 
tournez la molette multifonction pour 
sélectionner un type de caractère, puis 
appliquez le réglage.
ABC : lettres majuscules
abc : lettres minuscules
123 : caractères numériques
!#$ : caractères spéciaux

2 Sélectionnez un caractère dans le type de 
caractère sélectionné, puis appliquez le 
réglage.
Le curseur passe au champ suivant.

Space : permet de saisir un espace au 
niveau du curseur.

/ : permet de déplacer le curseur.
BS : permet de supprimer le caractère à 

gauche du curseur (espacement 
arrière).

3 Lorsque vous avez terminé, sélectionnez 
[Done] et appliquez le réglage.
La chaîne de caractères est confirmée et 
l’écran de saisie de caractères disparaît.

Verrouillage et déverrouillage du 
menu

Vous pouvez verrouiller le menu de 
configuration de sorte que seul le menu User 
s’affiche.
Les réglages sur l’écran d’état ne peuvent pas 
être modifiés.

Verrouillage du menu

1 Maintenez la molette multifonction 
enfoncée et appuyez sur la touche MENU.

2 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu Technical.

 [Remarque]
Lorsque vous appuyez uniquement sur la touche 
MENU pour afficher le menu de configuration 
normale, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et appuyez sur la 
touche MENU pour afficher User Menu with Lock.

3 Réglez sur On et appuyez sur la touche 
SET ou la molette multifonction.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4 Saisissez un numéro arbitraire.
Saisissez un numéro à 4 chiffres compris 
entre 0000 et 9999. La valeur par défaut 
est 0000.
Saisissez un numéro et appuyez sur la 
touche SET ou la molette multifonction 
pour déplacer le curseur sur le chiffre 
suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur SET.

5 Appuyez sur la touche SET ou la molette 
multifonction.
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La saisie s’applique.
Un message de confirmation apparaît, et 
l’écran bascule sur l’affichage du menu 
User.

Déverrouillage du menu

1 Maintenez la molette multifonction 
enfoncée et appuyez sur la touche MENU.

2 Sélectionnez Menu Settings >User Menu 
with Lock dans le menu User.

 [Remarque]
Lorsque vous appuyez uniquement sur la touche 
MENU pour afficher le menu de configuration 
normale, User Menu Only s’affiche sous Menu 
Settings dans le menu Technical. Maintenez la 
molette multifonction enfoncée et appuyez sur la 
touche MENU pour afficher User Menu with Lock.

3 Réglez sur Off et appuyez sur la touche 
SET ou la molette multifonction.
L’affichage de l’écran du viseur bascule 
sur l’écran de saisie du numéro de code.

4 Saisissez le numéro de code utilisé pour 
verrouiller le menu.
Saisissez un numéro et appuyez sur la 
touche SET ou la molette multifonction 
pour déplacer le curseur sur le chiffre 
suivant.
Une fois tous les chiffres saisis, déplacez 
le curseur sur Set.

5 Appuyez sur la touche SET ou la molette 
multifonction.
La saisie s’applique.
Si le numéro de code saisi correspond au 
numéro de code utilisé pour verrouiller le 
menu, le menu se déverrouille et s’affiche.

[Remarques]
ˎˎ Si le numéro de code saisi ne correspond pas au 

numéro de code utilisé pour verrouiller le menu, le 
menu n’est pas déverrouillé.

ˎˎ Il est recommandé de prendre note du numéro 
de code et le laisser à proximité, au cas où vous 
l’oublieriez. Si vous oubliez votre numéro de code, 
contactez votre représentant du service à la clientèle 
Sony.
ˎˎ Si le menu est verrouillé avant l’enregistrement 

des éléments du menu de configuration depuis 
les tableaux suivants dans le menu User, ces 
fonctions ne pourront pas être affectées aux touches 
personnalisables.
ˎˎ Si ces fonctions ont déjà été affectées aux touches 

attribuables, le réglage affecté est forcément 
désactivé lorsque le menu est verrouillé.

Élément du menu de 
configuration

Sélection de la 
touche 
personnalisable

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

Shooting >Auto 
Exposure >Auto ND 
Filter

Auto ND Filter

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Élément du menu de 
configuration

Sélection de la 
touche 
personnalisable

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Monitor CH

Audio Monitor CH

Audio >Audio Output 
>Monitor CH

Audio Mon. CH 
Switch

Technical >Touch 
Operation >Setting

Touch Operation

Élément du menu de 
configuration

Sélection de la 
touche 
personnalisable

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >Network 
Client Mode >Setting

Network Client 
Mode

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menu User
Cette section décrit la fonction et les réglages des éléments de chaque menu.

User

Élément Description

Base Setting Élément Project >Base Setting

Rec Format Élément Project >Rec Format

ISO/Gain/EI Élément Shooting >ISO/Gain/EI

Focus Élément Shooting >Focus

S&Q Motion Élément Shooting >S&Q Motion

Monitor LUT Élément Shooting >Monitor LUT

Monitor LUT Setting Élément Shooting >Monitor LUT Setting

Simul Rec Élément Project >Simul Rec

4K & HD (Sub) Rec Élément Project >4K & HD (Sub) Rec

Proxy Rec Élément Project >Proxy Rec

Picture Cache Rec Élément Project >Picture Cache Rec

Assignable Button Élément Project >Assignable Button

Assignable Dial Élément Project >Assignable Dial

Multi Function Dial Élément Project >Multi Function Dial

All File Élément Project >All File

Clip Name Format Élément TC/Media >Clip Name Format

Format Media Élément TC/Media >Format Media

Output Format Élément Monitoring >Output Format

VF Setting Élément Monitoring >VF Setting

Menu Settings Élément Technical >Menu Settings

Edit User Menu Affiche l’écran de menu Edit User.

[Remarque]
Vous pouvez ajouter et supprimer des éléments de menu dans le menu User à l’aide du menu Edit User. Jusqu’à 
20 éléments peuvent être configurés. Par défaut, le caméscope est configuré avec 20 éléments. Pour ajouter un 
élément, vous devez d’abord en supprimer un existant à l’aide de Delete dans le menu Edit User, puis en ajouter un à 
l’aide d’Add Item.



6. Affichage et réglages de menu85

Menu Edit User
Le menu Edit User est affiché au niveau supérieur quand Edit User Menu est sélectionné dans le 
menu User.

Edit User

Élément Réglage de sous-éléments Description

Add Item
Ajouter un élément au 
menu User

Ajoute un élément de menu au 
menu User.

Customize Reset
Réinitialiser les 
éléments dans le menu 
User

Restaure les éléments de menu 
enregistrés dans le menu User aux 
réglages par défaut.

Elément de menu 
sélectionné pendant 
l’édition

Delete Supprime l’élément de menu 
enregistré du menu User.

Move Réorganise les éléments de menu 
enregistrés du menu User.

Edit Sub Item Édite (enregistrer/supprimer) les 
sous-éléments de menu enregistrés 
dans le menu User.
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Menu Shooting
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Mode ISO/dB Sélectionne le mode de réglage du gain.

ISO/Gain<H> Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur High :

ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur Low :

ISO 320 / ISO 400 / ISO 500 / ISO 640 / 
ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur High :

ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur Low :

ISO 500 / ISO 640 / ISO 800 / ISO 1000 / 
ISO 1250 / ISO 1600 / ISO 2000 /  
ISO 2500 / ISO 3200 / ISO 4000 /  
ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000

Règle la valeur prédéfinie de gain <H>.

[Conseil]
La plage dynamique est déterminée par 
gamma. Le gamma en mode HDR est HLG.

Gamma Plage dynamique

STD / HG1 / HG2 /  
HG3 / HG4 / 
S-Cinetone

460%

HG7 / HG8 800%

S-Log3 / HLG 1300%

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

ISO/Gain<H> Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur High :

ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur Low :

ISO 800 / ISO 1000 / ISO 1250 /  
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Quand le mode est réglé sur dB :
–3dB à 27dB (12dB) (incréments de 
1dB)
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Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

ISO/Gain<M> (Mêmes réglages que ISO/Gain<H>)
Les valeurs par défaut sont données 
ci-dessous.
Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur High :

ISO 3200
Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur Low :

ISO 640
Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur High :

ISO 5000
Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur Low :

ISO 1000
Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur High :

ISO 8000
Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur Low :

ISO 1600
Quand le mode est réglé sur dB :

6dB

Règle la valeur prédéfinie de gain <M>.

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

ISO/Gain<L> (Mêmes réglages que ISO/Gain<H>)
Les valeurs par défaut sont données 
ci-dessous.
Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur High :

ISO 1600
Quand le mode est réglé sur ISO avec une 
plage dynamique de 460% et que Base 
Sensitivity est réglé sur Low :

ISO 320
Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur High :

ISO 2500
Quand le mode est réglé sur ISO avec une 
plage dynamique de 800% et que Base 
Sensitivity est réglé sur Low :

ISO 500
Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur High :

ISO 4000
Quand le mode est réglé sur ISO avec une 
plage dynamique de 1300% et que Base 
Sensitivity est réglé sur Low :

ISO 800
Quand le mode est réglé sur dB :

0dB

Règle la valeur prédéfinie de gain <L>.
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Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Exposure 
Index<H>

Lorsque Base ISO est réglé sur ISO 800 :
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Lorsque Base ISO est réglé sur ISO 4000 :
1000EI / 4.0E
1250EI / 4.3E
1600EI / 4.7E
2000EI / 5.0E
2500EI / 5.3E
3200EI / 5.7E
4000EI / 6.0E
5000EI / 6.3E
6400EI / 6.7E
8000EI / 7.0E
10000EI / 7.3E
12800EI / 7.7E
16000EI / 8.0E

Règle la valeur d’indice de pose <H>.
Disponible en mode Cine EI uniquement.

Exposure 
Index<M>

(Mêmes réglages qu’Exposure Index<H>)
Lorsque Base ISO est réglé sur ISO 800 :

1000EI / 6.3E
Lorsque Base ISO est réglé sur ISO 4000 :

5000EI / 6.3E

Règle la valeur d’indice de pose <M>.

Exposure 
Index<L>

(Mêmes réglages qu’Exposure Index<H>)
Lorsque Base ISO est réglé sur ISO 800 :

800EI / 6.0E
Lorsque Base ISO est réglé sur ISO 4000 :

4000EI / 6.0E

Règle la valeur d’indice de pose <L>.

Shockless 
Gain

On / Off Active/désactive la fonction Shockless 
gain.

Base 
Sensitivity

High / Low Règle la sensibilité de base pour le mode 
SDR/HDR.

Shooting >ISO/Gain/EI
Définit les réglages de gain.

Élément Réglage de sous-éléments Description

Base ISO ISO 4000 / ISO 800 Règle la sensibilité ISO de base pour le 
mode Cine EI.

Shooting >ND Filter
Règle les valeurs prédéfinies pour le filtre ND.

Élément Réglage de sous-éléments Description

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 1 pour le filtre 
ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 2 pour le filtre 
ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Règle la valeur prédéfinie 3 pour le filtre 
ND.

Shooting >Shutter
Définit les réglages de condition de fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

Mode Speed / Angle Sélectionne le mode de fonctionnement 
de l’obturateur électronique.
Utilisé pour filmer de manière nette des 
sujets se déplaçant rapidement. 
Sélectionne le mode pour régler la 
vitesse d’obturateur en secondes (Speed) 
ou comme angle d’obturateur (Angle).

Shutter 
Speed On/
Off

On / Off Définit si, lorsque le mode Speed est 
sélectionné, la durée d’exposition suit la 
valeur de Shutter Speed ou est réglée 
pour l’exposition totale.
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Shooting >Shutter
Définit les réglages de condition de fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

Shutter 
Speed

64F à 1/8000
Les réglages disponibles varient en 
fonction de la fréquence d’images du 
format vidéo sélectionné.
59.94P / 59.94i : 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P / 50i : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 /1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P : 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Règle la vitesse d’obturateur quand 
Mode est réglé sur Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /  
3F / 2F / 360.0° / 300.0° / 270.0° /  
240.0° / 216.0° / 210.0° / 180.0° / 172.8° / 
150.0° / 144.0° / 120.0° / 90.0° / 86.4° / 
72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

Règle l’angle d’obturateur quand Mode 
est réglé sur Angle.

ECS On/Off On / Off Permet d’activer/de désactiver la 
fonction d’atténuation de balayage 
étendue.

Shooting >Shutter
Définit les réglages de condition de fonctionnement de l’obturateur électronique.

Élément Réglage de sous-éléments Description

ECS 
Frequency

23.99 à 8000
Les réglages disponibles varient en 
fonction de la fréquence d’images du 
format vidéo sélectionné.
Les valeurs par défaut sont données 
ci-dessous.
59.94P : 60.00
59.94i : 60.00
50P : 50.00
50i : 50.00
29.97P : 30.00
23.98P : 23.99
25P : 25.02
24P : 24.02

Règle la fréquence d’ECS quand Mode 
est réglé sur ECS.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 /  
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Règle le niveau de luminosité pour 
l’exposition détectée de manière 
automatique.

Mode Backlight / Standard / Spotlight Règle le mode de fonctionnement du 
réglage d’exposition automatique.
Backlight : 

Mode Backlight (mode qui atténue 
l’obscurité d’un sujet lorsque le sujet 
est rétroéclairé)

Standard : 
Mode Standard

Spotlight : 
Mode Spotlight (mode qui atténue 
les blancs écrêtés lorsque le sujet est 
éclairé par la lumière d’un spot)

Speed –99 à +99 (±0) Règle la vitesse de réglage du réglage 
d’exposition automatique.

AGC On / Off Active/désactive la fonction AGC 
(commande de gain automatique).
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Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

AGC Limit Quand ISO/Gain/EI >Mode est réglé sur 
dB :

3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 
21dB / 24dB / 27dB

Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 460% et 
que Base Sensitivity est réglé sur High :

ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000 / ISO 25600 /  
ISO 32000 / ISO 40000 / ISO 51200 /  
ISO 64000 / ISO 80000 / ISO 102400

Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 460% et 
que Base Sensitivity est réglé sur Low :

ISO 400 / ISO 500 / ISO 640 / ISO 800 / 
ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 800% et 
que Base Sensitivity est réglé sur High :

ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000 /  
ISO 25600 / ISO 32000 / ISO 40000 /  
ISO 51200 / ISO 64000 / ISO 80000 /  
ISO 102400

Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 800% et 
que Base Sensitivity est réglé sur Low :

ISO 640 / ISO 800 / ISO 1000 / ISO 1250 / 
ISO 1600 / ISO 2000 / ISO 2500 /  
ISO 3200 / ISO 4000 / ISO 5000 /  
ISO 6400 / ISO 8000 / ISO 10000 /  
ISO 12800 / ISO 16000 / ISO 20000

Règle le gain maximum de la fonction 
AGC.

Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

AGC Limit Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 1300% 
et que Base Sensitivity est réglé sur High :

ISO 5000 / ISO 6400 / ISO 8000 /  
ISO 10000 / ISO 12800 / ISO 16000 /  
ISO 20000 / ISO 25600 / ISO 32000 /  
ISO 40000 / ISO 51200 / ISO 64000 /  
ISO 80000 / ISO 102400

Quand ISO/Gain/EI >Mode est réglé sur 
ISO avec une plage dynamique de 1300% 
et que Base Sensitivity est réglé sur Low :

ISO 1000 / ISO 1250 / ISO 1600 /  
ISO 2000 / ISO 2500 / ISO 3200 /  
ISO 4000 / ISO 5000 / ISO 6400 /  
ISO 8000 / ISO 10000 / ISO 12800 /  
ISO 16000 / ISO 20000

AGC Point Lorsque Lens >Iris Display dans le menu 
Technical est réglé sur F-Number, ou 
lorsque Iris Display est réglé sur Auto et les 
informations de la valeur T ne peuvent pas 
être obtenues de l’objectif attaché :

F2.8 / F4 / F5.6
Lorsque Lens >Iris Display dans le menu 
Technical est réglé sur Auto et les 
informations de la valeur T peuvent être 
obtenues de l’objectif attaché :

T2.8 / T4 / T5.6

Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande de 
gain automatique lorsque la fonction 
AGC est réglée sur On.

Auto Shutter On / Off Active/désactive la fonction de 
commande d’obturateur automatique.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Règle la vitesse d’obturateur la plus 
rapide de la fonction d’obturateur 
automatique.
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Shooting >Auto Exposure
Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Description

A.SHT Point Lorsque Lens >Iris Display dans le menu 
Technical est réglé sur F-Number, ou 
lorsque Iris Display est réglé sur Auto et les 
informations de la valeur T ne peuvent pas 
être obtenues de l’objectif attaché :

F5.6 / F8 / F11 / F16
Lorsque Lens >Iris Display dans le menu 
Technical est réglé sur Auto et les 
informations de la valeur T peuvent être 
obtenues de l’objectif attaché :

T5.6 / T8 / T11 / T16

Règle la valeur F-stop du diaphragme là 
où démarre l’opération de commande 
d’obturateur automatique.

Clip High 
light

On / Off Active/désactive la fonction qui ignore 
les zones les plus lumineuses pour 
fournir une réponse plus plate avec une 
luminance élevée.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Règle la plage d’intégrateur de lumière 
pour l’ajustement automatique de 
l’exposition en fonction de la luminosité 
du sujet. (Non disponible en cas de 
réglage manuel de la pose)

Detect 
Window 
Indication

On / Off Active/désactive l’indication de la plage 
d’intégrateur de lumière.

Average Peak 
Level Ratio

–99 à +99 (±0) Règle le ratio entre la valeur moyenne et 
la crête du signal vidéo utilisé pour la 
détection Auto Exposure.

Custom 
Width

40 à 999 (500) Permet de régler la largeur de la plage 
d’intégrateur de lumière.

Custom 
Height

70 à 999 (500) Permet de régler la hauteur de la plage 
d’intégrateur de lumière.

Custom H 
Position

–479 à +479 (±0) Permet de régler la position horizontale 
de la plage d’intégrateur de lumière.

Custom V 
Position

–464 à +464 (±0) Permet de régler la position verticale de 
la plage d’intégrateur de lumière.

Shooting >White
Définit les réglages de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Preset White 2000K à 15000K (3200K) Règle la valeur prédéfinie de l’équilibre 
des blancs.

Color Temp 
<A>

2000K à 15000K (3200K) Règle la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire A.

[Remarque]
Comme Color Temp est écrêté à 2000K et 
15000K pendant l’opération R/B Gain, il n’est 
pas possible d’afficher la valeur correcte de 
Color Temp pour la valeur R/B Gain.

Tint<A> –99 à +99 (±0) Permet de régler la valeur de teinte de la 
balance des blancs stockée dans la 
mémoire des blancs A.

[Remarque]
Comme Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte de Tint pour la 
valeur R/B Gain.

R Gain <A> –99.0 à +99.0 (±0.0) Règle la valeur de gain R de l’équilibre 
des blancs stockée dans la mémoire A.

B Gain <A> –99.0 à +99.0 (±0.0) Règle la valeur de gain B de l’équilibre 
des blancs stockée dans la mémoire A.

Color Temp 
<B>

2000K à 15000K (3200K) Règle la température de couleur de 
l’équilibre des blancs stockée dans la 
mémoire B.

[Remarque]
Comme Color Temp est écrêté à 2000K et 
15000K pendant l’opération R/B Gain, il n’est 
pas possible d’afficher la valeur correcte de 
Color Temp pour la valeur R/B Gain.

Tint<B> –99 à +99 (±0) Permet de régler la valeur de teinte de la 
balance des blancs stockée dans la 
mémoire des blancs B.

[Remarque]
Comme Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte de Tint pour la 
valeur R/B Gain.

R Gain <B> –99.0 à +99.0 (±0.0) Règle la valeur de gain R de l’équilibre 
des blancs stockée dans la mémoire B.

B Gain <B> –99.0 à +99.0 (±0.0) Règle la valeur de gain B de l’équilibre 
des blancs stockée dans la mémoire B.
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Shooting >White Setting
Définit les réglages de balance des blancs.

Élément Réglage de sous-éléments Description

Shockless 
White

Off / 1 / 2 / 3 Règle la vitesse de réaction d’équilibre 
des blancs en cas de commutation du 
mode d’équilibre des blancs.
Off : commute instantanément.
1 à 3 : plus la valeur est élevée, plus la 

commutation est lente.

ATW Speed 1 / 2 / 3 / 4 / 5 Règle la vitesse de réaction en mode 
ATW.
1 : vitesse de réaction la plus rapide

White 
Switch<B>

Memory / ATW Sélectionne le mode de réglage 
d’équilibre des blancs sélectionné quand 
le commutateur WHT BAL est réglé sur B.

Filter White 
Memory

On / Off Active/désactive la fonction de réglage 
de la zone de mémoire d’équilibre des 
blancs pour chaque filtre ND.
On : règle la mémoire d’équilibre des 

blancs pour chaque filtre ND.

 [Conseil]
En mode prédéfini, quatre réglages 
existent (CLEAR / 1 / 2 / 3). En mode 
variable, deux réglages existent (CLEAR /  
On).

Off : règle la mémoire d’équilibre des 
blancs commune à tous les filtres ND.

Shooting >Offset White
Définit les réglages de correction de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Offset White 
<A>

On / Off Choisit d’ajouter (On) ou non (Off) une 
valeur de décalage à l’équilibre des 
blancs dans la mémoire A.

Offset Color 
Temp<A>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
dans la mémoire A quand Offset White 
<A> est réglé sur On.

[Remarque]
Comme Offset Color Temp est écrêté à ±99 
pendant l’opération R/B Gain, il n’est pas 
possible d’afficher la valeur correcte d’Offset 
Color Temp pour la valeur R/B Gain.

Shooting >Offset White
Définit les réglages de correction de l’équilibre des blancs.

Élément Réglage de sous-éléments Description

Offset 
Tint<A>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs dans la 
mémoire A quand Offset White <A> est 
réglé sur On.

[Remarque]
Comme Offset Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte d’Offset Tint pour 
la valeur R/B Gain.

Offset White 
<B>

On / Off Permet de choisir d’ajouter (On) ou de ne 
pas ajouter (Off) une valeur de correction 
à l’équilibre des blancs dans la mémoire 
B.

Offset Color 
Temp<B>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
dans la mémoire B quand Offset White 
<B> est réglé sur On.

[Remarque]
Comme Offset Color Temp est écrêté à ±99 
pendant l’opération R/B Gain, il n’est pas 
possible d’afficher la valeur correcte d’Offset 
Color Temp pour la valeur R/B Gain.

Offset 
Tint<B>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs dans la 
mémoire B quand Offset White <B> est 
réglé sur On.

[Remarque]
Comme Offset Tint est écrêté à ±99 pendant 
l’opération R/B Gain, il n’est pas possible 
d’afficher la valeur correcte d’Offset Tint pour 
la valeur R/B Gain.

Offset White 
<ATW>

On / Off Permet de choisir d’ajouter (On) ou de ne 
pas ajouter (Off) une valeur de correction 
à l’équilibre des blancs ATW.

Offset Color 
Temp<ATW>

–99 à +99 (±0) Règle la correction de température de 
couleur à ajouter à l’équilibre des blancs 
ATW quand Offset White <ATW> est réglé 
sur On.

Offset 
Tint<ATW>

–99 à +99 (±0) Règle la correction de valeur Tint à 
ajouter à l’équilibre des blancs ATW 
quand Offset White <ATW> est réglé sur 
On.
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Shooting >Focus
Définit les réglages de mise au point.

Élément Réglage de sous-éléments Description

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Permet de régler la vitesse 
d’entraînement de la mise au point pour 
le changement de sujet lors de la mise 
au point automatique.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Permet de régler la sensibilité de la mise 
au point en cas de changement de sujet 
pendant la mise au point automatique.

Focus Area Wide / Zone / Flexible Spot Règle la zone cible pour la mise au point 
automatique et la mise au point 
automatique par pression (AF) 
(page 37).
Wide : 

Recherche un sujet dans un grand 
angle de l’image lors de la mise au 
point.

Zone : 
Recherche automatiquement un 
point de mise au point dans la zone 
spécifiée.

Flexible Spot : 
Effectue la mise au point sur une 
position spécifique dans l’image.

Focus Area 
(AF-S)

Flexible Spot Règle la zone cible pour la mise au point 
automatique par pression (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Active/Désactive la détection des 
visages/yeux AF.

Push AF 
Mode

AF / Single-shot AF(AF-S) Règle le mode de mise au point 
automatique par pression pendant la 
mise au point manuelle.

Touch 
Function in 
MF

Tracking AF/Spot Focus Règle l’action qui se produit lorsque vous 
appuyez sur l’écran tactile pendant la 
mise au point manuelle.

AF Assist On / Off Quand ce réglage est réglé sur On, il est 
possible de changer temporairement la 
mise au point automatique et d’effectuer 
la mise au point manuellement.

Shooting >S&Q Motion
Définit les réglages du mode Slow & Quick Motion (page 50).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement ralenti et accéléré.
Lorsqu’il est activé, les fonctions 
suivantes sont désactivées.

 ˎ Diaphragme automatique
 ˎ Mise au point automatique

Frame Rate 1fps à 60fps / 100fps / 120fps / 150fps / 
180fps

Règle la fréquence d’images pour la prise 
de vue au ralenti et accéléré.

[Remarque]
Les réglages disponibles varient en fonction 
de la fréquence du système, du codec et du 
format vidéo sélectionnés.

Shooting >Monitor LUT
Définit les réglages du moniteur LUT. Disponible uniquement lors de la prise de vue en mode Cine 
EI.

Élément Réglage de sous-éléments Description

Category LUT / User 3D LUT Permet de sélectionner la catégorie de 
moniteur LUT.
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Shooting >Monitor LUT
Définit les réglages du moniteur LUT. Disponible uniquement lors de la prise de vue en mode Cine 
EI.

Élément Réglage de sous-éléments Description

LUT Select 709(800%) /  HG8009G40 / 
 HG8009G33 / S-Log3 / s709

[Conseil]
«   » dans  HG8009G40 et  HG8009G33 
indique les options HG8009G40 et HG8009G33 
pour lesquelles les données LUT ne peuvent pas 
être enregistrées en tant que métadonnées (pas 
de données Cube).

Permet de sélectionner le type de 
moniteur LUT.
709(800%) : 

Signal avec courbe de base ITU-R709 
avec gamme dynamique étendue 
jusqu’à 800%.

 HG8009G40 : 
Signal utilisant HyperGamma avec 
gamme dynamique de 800%, limite 
blanche de 109% et carte grise de 
18% à 40% de sortie vidéo.

 HG8009G33 : 
Signal utilisant HyperGamma avec 
gamme dynamique de 800%, limite 
blanche de 109% et carte grise de 
18% à 33% de sortie vidéo.

S-Log3 : 
Signal de journalisation avec gamme 
dynamique de 1300% qui reproduit 
des caractéristiques de film, proche 
de la courbe Cineon Log.

s709 : 
Couleur cinéma équivalente à 
709(800%).

[Remarque]
Configurable uniquement lorsque Category est 
réglé sur LUT.

User 3D LUT 
Select

Nom de fichier (01 à 16) des fichiers 
utilisateur 3D LUT stockés dans la mémoire 
interne

Sélectionne le fichier utilisateur 3D LUT.

[Remarques]
ˎˎ Configurable uniquement lorsque Category 

est réglé sur User 3D LUT.
ˎˎ Les fichiers utilisateur 3D LUT chargés dans 

un appareil fonctionnant avec une version 
du microgiciel antérieure à 4.0 afficheront 
«   » devant le nom des fichiers. Après la 
mise à jour du microgiciel de l’appareil à la 
version 4.0, chargez à nouveau les fichiers 
utilisateur 3D LUT.

Shooting >Monitor LUT Setting
Permet de définir les réglages du moniteur LUT. Disponible uniquement lors de la prise de vue en 
mode Cine EI.

Élément Réglage de sous-éléments Description

Internal Rec MLUT On / MLUT Off Sélectionne l’application ou non de 
Monitor LUT à la vidéo principale 
enregistrée sur des cartes mémoire XQD.

Monitor Out MLUT On / MLUT Off Sélectionne l’application ou non de 
Monitor LUT à la vidéo enregistrée et à la 
sortie vidéo, autres que la vidéo 
principale enregistrée sur des cartes 
mémoire XQD.

HD(Sub) Rec/
Proxy

Affichage uniquement Indique si Monitor LUT est appliqué ou 
non à la vidéo HD (Sub) et à la vidéo 
d’enregistrement proxy pendant 
l’enregistrement 4K & HD (Sub).

SDI1 Affichage uniquement Indique si Monitor LUT est appliqué ou 
non à la sortie vidéo SDI1.

SDI2 Affichage uniquement Indique si Monitor LUT est appliqué ou 
non à la sortie vidéo SDI2.

HDMI Affichage uniquement Indique si Monitor LUT est appliqué ou 
non à la sortie vidéo HDMI.

VF/Streaming Affichage uniquement Indique si Monitor LUT est appliqué ou 
non au viseur et à la sortie vidéo en 
continu.

Shooting >Monitor 3D LUT
Définit les réglages utilisateur 3D LUT.

Élément Réglage de sous-éléments Description

Load from 
Utility SD/MS

Charge les données utilisateur 3D LUT 
depuis une carte SD.

Load from 
Cloud(Private)

Execute / Cancel Charge les données 3D LUT téléchargées 
depuis le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Load from 
Cloud(Share)

Execute / Cancel Charge les données 3D LUT téléchargées 
depuis le service Cloud C3 Portal 
(partagé).
Execute : fonction Execute.

Reset Réinitialise un réglage de données 
utilisateur 3D LUT.

Reset All Execute / Cancel Réinitialise tous les réglages de données 
utilisateur 3D LUT.
Execute : fonction Execute.
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Shooting >Noise Suppression
Définit les réglages de suppression de bruit.

Élément Réglage de sous-éléments Description

Setting 
(SDR/HDR)

On / Off Active/désactive la fonction de 
suppression de bruit en mode SDR et 
HDR.

Level 
(SDR/HDR)

Low / Mid / High Permet de régler le niveau de 
suppression de bruit en mode SDR et 
HDR.

Setting 
(Cine EI)

On / Off Active/désactive la fonction de 
suppression de bruit en mode Cine EI.

Level 
(Cine EI)

Low / Mid / High Permet de régler le niveau de 
suppression de bruit en mode Cine EI.

Shooting >Flicker Reduce
Définit les réglages de correction de scintillement.

Élément Réglage de sous-éléments Description

Mode Auto / On / Off Règle le mode de correction de 
scintillement.

Frequency 50Hz / 60Hz Règle la fréquence de la source 
d’alimentation qui fournit l’éclairage qui 
cause le scintillement.

Shooting >SteadyShot
Définit les réglages de stabilisation d’image.

Élément Réglage de sous-éléments Description

Setting Active / Standard / Off Active/désactive la fonction de 
stabilisation d’image.

[Remarque]
Activé lorsqu’un objectif compatible est fixé.

Shooting >Auto Black Balance
Définit les réglages automatiques de l’équilibre des noirs.

Élément Réglage de sous-éléments Description

Auto Black 
Balance

Execute / Cancel Exécute la fonction de balance des noirs 
automatique.

[Remarques]
ˎˎ Exécutez la fonction automatique d’équilibre 

des noirs avec le capuchon d’objectif fixé.
ˎˎ Ne peut pas être exécutée pendant 

l’enregistrement ou l’affichage de la barre 
de couleur.
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Menu Project
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Project >Base Setting
Définit les réglages de base.

Élément Réglage de sous-éléments Description

Shooting 
Mode

SDR / HDR / Cine EI Règle le mode de prise de vue 
(page 28).

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Sélectionne la fréquence du système.

Imager Scan 
Mode

FF 6K / FFcrop 5K / S35 4K / FF 2K /  
S35 2K / S16 2K

Permet de régler la combinaison de 
méthode de lecture d’imageur (tout en 
pixels/stockage de pixels) et de réglage 
de la taille de l’imageur.

Codec RAW / RAW & XAVC-I / RAW & XAVC-L / 
RAW & MPEG HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422

Règle le mode d’enregistrement/de 
lecture.

[Remarque]
Les réglages RAW s’affichent uniquement 
lorsqu’un module d’extension est attaché.

RAW Output 
Format

Les réglages disponibles varient selon les 
réglages Frequency, Imager Scan Mode et 
Codec (page 60).

Règle le format d’enregistrement pour un 
enregistreur RAW externe.

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format Les réglages disponibles varient selon les 
réglages Frequency et Codec.

Règle le format d’enregistrement.

Frequency Codec Options de 
sélection

59.94 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50
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Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format 50 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080i 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P
1920×1080i

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35
1920×1080i 50
1920×1080i 35
1920×1080i 25

MPEG 
HD422

1920×1080i 50

29.97 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

Project >Rec Format
Définit les réglages du format d’enregistrement.

Élément Réglage de sous-éléments Description

Video Format 25 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50

24 RAW –

XAVC-I 4096×2160P

23.98 RAW –

RAW & 
XAVC-I

1920×1080P

RAW & 
XAVC-L

1920×1080P 50

RAW & 
MPEG 
HD422

1920×1080P 50

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 50
1920×1080P 35

MPEG 
HD422

1920×1080P 50
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Project >Cine EI Setting
Définit les réglages de mode Cine EI.

Élément Réglage de sous-éléments Description

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Permet de régler l’espace de couleur en 
mode Cine EI.
S-Gamut3/SLog3 : 

Permet de régler l’espace de couleur 
en mode Cine EI sur S-Gamut3.

S-Gamut3.Cine/SLog3 : 
Permet de régler l’espace de couleur 
en mode Cine EI sur S-Gamut3.Cine.

Embed LUT 
File

On / Off Active/désactive la fonction 
d’enregistrement des données LUT 
(données Cube) en tant que 
métadonnées dans un plan.

Project >HDR Setting
Règle les réglages du mode HDR.

Élément Réglage de sous-éléments Description

VF SDR 
Preview

On / Off En mode HDR, active/désactive la 
fonction qui convertit l’image du viseur 
de HDR vers SDR lorsque l’aide pour 
l’affichage gamma est activée.

[Conseil]
Avec ce réglage sur On, SDR Gain est appliqué 
à l’image du viseur.

SDR Gain 0dB à –15dB (–6dB) En mode HDR, règle le réglage SDR Gain 
qui est appliqué au viseur lorsque VF SDR 
Preview est réglé sur On.

Project >Simul Rec
Permet de configurer les réglages du mode d’enregistrement simultané (page 53).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction 
d’enregistrement simultané et définit le 
support de destination d’enregistrement.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Assigne les touches d’enregistrement 
utilisées pour contrôler chaque support 
d’enregistrement.

Project >4K & HD (Sub) Rec
Permet de configurer les réglages du mode d’enregistrement 4K & HD (Sub).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement 4K & HD (Sub).

Project >Proxy Rec
Permet de configurer les réglages du mode d’enregistrement proxy.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement proxy.

[Remarque]
Ne peut pas être réglé sur On lorsque S&Q 
Motion >Setting (page 93) dans le menu 
Shooting est réglé sur On.

Proxy Format 1920×1080(9Mbps) / 1280×720(9Mbps) / 
1280×720(6Mbps) / 640×360(3Mbps)

Permet de régler la taille d’image du 
fichier de proxy.
Lorsqu’il est réglé sur 1920×1080(9Mbps) 
et que la fréquence système est de 23.98, 
l’enregistrement utilise le balayage 
progressif. Pour les fréquences système 
autres que 23.98, l’enregistrement utilise 
le balayage entrelacé.
Pour les réglages autres que 
1920×1080(9Mbps), l’enregistrement 
utilise toujours le balayage progressif 
quel que soit la fréquence système.

Audio 
Channel

CH1/CH2 / CH3/CH4 Sélectionne le canal audio pour 
enregistrer les données proxy.

Chunk 30s / 1min / 2min Sélectionne l’intervalle d’enregistrement 
par fragments pour les fichiers proxy.

Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 51).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement à intervalle. (Le réglage 
de ce mode sur On met tous les autres 
modes spéciaux sur Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /  
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Règle l’intervalle entre les 
enregistrement en mode 
d’enregistrement Interval Rec (lorque 
Interval Rec est réglé sur On).
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Project >Interval Rec
Permet de configurer les réglages du mode d’enregistrement par intervalles (page 51).

Élément Réglage de sous-éléments Description

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Les réglages disponibles varient en 
fonction de la fréquence d’images du 
format vidéo sélectionné.
50P/59.94P : 

2frames / 6frames / 12frames
23.98P/25P/29.97P/50i/59.94i : 

1frame / 3frames / 6frames / 9frames

Règle le nombre d’images à enregistrer 
par prise en mode d’enregistrement 
Interval Rec (lorque Interval Rec est réglé 
sur On).

Pre-Lighting Off / 2s / 5s / 10s Règle le nombre de secondes après 
lesquelles la lampe vidéo s’allume avant 
le démarrage de l’enregistrement en 
mode d’enregistrement Interval Rec.

[Conseil]
Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Project >Picture Cache Rec
Définit les réglages du mode d’enregistrement en cache d’image (page 52).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive le mode 
d’enregistrement de cache d’image.

Cache Rec 
Time

Les réglages varient selon le réglage du 
format d’enregistrement.

Règle le temps pour l’accumulation 
d’images dans la mémoire de cache 
d’image (temps d’enregistrement de 
cache d’image).

Project >SDI/HDMI Rec Control
Définit les réglages de contrôle d’enregistrement SDI/HDMI.

Élément Réglage de sous-éléments Description

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Permet de configurer le contrôle de 
démarrage/d’arrêt d’enregistrement d’un 
dispositif externe via le signal de sortie 
SDI/HDMI.
Off : 

Ne pas utiliser la télécommande.
SDI/HDMI Remote I/F : 

Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand aucun 
support n’est inséré dans le 
caméscope. Pas de synchronisation 
avec la précision d’images pour le 
support du caméscope.

Parallel Rec : 
Contrôle d’arrêt/de démarrage 
d’enregistrement d’un dispositif 
externe connecté, quand un support 
est inséré dans le caméscope. 
Synchronisation avec la précision 
d’images pour le support du 
caméscope.



6. Affichage et réglages de menu : Menu Project100

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <10>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC /  
Push AGC / ND Filter Position /  
Auto ND Filter / Push Auto ND / Auto Iris / 
Push Auto Iris / Auto Shutter /  
Auto Exposure Level / Backlight /  
Spotlight / Preset White Select / ATW / 
ATW Hold / AF Speed/Sens. /  
Focus Zero Marker / Focus Setting /  
Focus Area / Focus Area(AF-S) /  
Face/Eye Detection AF / Push AF Mode / 
Push AF/Push MF / Focus Hold /  
Focus Magnifier x3/x6 /  
Focus Magnifier x3 / Focus Magnifier x6 / 
S&Q Motion / SteadyShot / Crop Select / 
Rec / Picture Cache Rec / Rec Review / 
Last Clip Del. / Shot Mark1 / Shot Mark2 / 
Clip Flag OK / Clip Flag NG /  
Clip Flag Keep / Color Bars / Tally [Front] / 
CALL / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Audio Monitor 
CH / Audio Mon. CH Switch / Thumbnail / 
Touch Operation / Handle Zoom / NFC / 
Network Client Mode /  
Auto Upload (Proxy) / Direct Menu /  
User Menu / Menu

Attribue des fonctions aux touches 
personnalisables.
Base ISO/Sensitivity : 

Permet de changer la sensibilité de 
base du capteur d’image.

AGC : 
Active/désactive la fonction AGC.

Push AGC : 
Active la fonction AGC pendant 
l’activation de la touche.

ND Filter Position : 
Commute entre les filtres ND.

Auto ND Filter : 
Active/désactive la fonction Auto ND 
Filter.

Push Auto ND : 
Active la fonction Auto ND Filter 
pendant l’activation de la touche.

Auto Iris : 
Active/désactive la fonction de 
diaphragme.

Push Auto Iris : 
Active la fonction de diaphragme 
automatique pendant l’activation de 
la touche.

Auto Shutter : 
Active/désactive la fonction 
d’obturation automatique.

Auto Exposure Level : 
Affiche/ferme le menu direct Auto 
Exposure Level.

Backlight : 
Bascule entre les fonctions Backlight 
et Standard.

Spotlight : 
Bascule entre les fonctions Spotlight 
et Standard.

Preset White Select : 
Change la valeur de mode prédéfinie 
de l’équilibre des blancs.

ATW : 
Active/désactive la fonction ATW.

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <10>, 
Focus Hold 
Button

ATW Hold : 
Met la fonction ATW en pause.

AF Speed/Sens. : 
Commute le réglage de la vitesse de 
transition AF et le réglage de la 
sensibilité de changement de sujet 
AF.

Focus Zero Marker : 
Règle la position de mise au point 
actuelle en tant que position de 
référence.

Focus Setting : 
Permet de régler la zone de mise au 
point.

Focus Area : 
Permet de régler la zone de mise au 
point pour AF et Push AF.

Focus Area(AF-S) : 
Permet de régler la zone de mise au 
point pour Push AF (AF-S).

Face Eye Detection AF : 
Commute les réglages de la 
détection des visages/yeux AF.

Push AF Mode : 
Commute le réglage du mode Push 
AF.

Push AF/Push MF : 
En mode de mise au point MF, active 
AF tant que la touche est enfoncée. 
En mode de mise au point AF, active 
MF tant que la touche est enfoncée.

Focus Hold : 
En mode de mise au point AF, la mise 
au point est fixée tant que la touche 
est enfoncée.

Focus Magnifier x3/x6 :
Focus Magnifier x3 :
Focus Magnifier x6 : 

Active/désactive la fonction 
d’agrandissement de la mise au 
point.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <10>, 
Focus Hold 
Button

S&Q Motion : 
Active/désactive le mode ralenti et 
accéléré. 
Règle la fréquence d’images 
d’enregistrement si elle est 
maintenue appuyée.

SteadyShot : 
Commute entre Active, Standard et Off.

Crop Select : 
Commute le réglage du mode Imager 
Scan.

Rec : 
Démarre/arrête l’enregistrement.

Picture Cache Rec : 
Active/désactive le mode 
d’enregistrement de cache d’image.

Rec Review : 
Active/désactive la fonction Rec 
Review.

Last Clip Del. : 
Exécute la fonction de suppression 
du dernier plan (pour reprise).

Shot Mark1 : 
Exécute la fonction Add Shot Mark1.

Shot Mark2 : 
Exécute la fonction Add Shot Mark2.

Clip Flag OK : 
Exécute la fonction Add OK. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag NG : 
Exécute la fonction Add NG. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Clip Flag Keep : 
Exécute la fonction Add Keep. 
Appuyez deux fois pour exécuter 
Delete Clip Flag.

Color Bars : 
Active/désactive les barres de 
couleur.

Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <10>, 
Focus Hold 
Button

Tally [Front] : 
Active/désactive la fonction 
d’éclairage continu/de clignotement 
du témoin d’enregistrement/de 
signalisation (avant).

CALL : 
Affiche un appel sur le témoin de 
signalisation du panneau de 
télécommande connecté à l’appareil 
pendant que le bouton est enfoncé.

DURATION/TC/U-BIT : 
Commute entre Time Code, Users Bit 
et Duration.

Display : 
Active/désactive les indicateurs de 
l’écran.

Lens Info : 
Commute l’indicateur de profondeur 
de champ.

Video Signal Monitor : 
Commute le moniteur de signal vidéo 
(tel que le moniteur de forme d’onde).

Marker : 
Active/désactive la fonction de 
marqueur.

VF Adjust : 
Affiche les barres de niveau pour 
l’ajustement de la luminosité de 
l’écran du viseur.

VF Mode : 
Commute l’affichage du viseur entre 
couleur et noir et blanc.

Gamma Display Assist : 
Commute la fonction d’aide pour 
l’affichage gamma.

Peaking : 
Active/désactive la fonction de 
réglage du contour.

Zebra : 
Active/désactive la fonction des 
zébrures.
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Project >Assignable Button
Règle les attributions de fonction des touches personnalisables.

Élément Réglage de sous-éléments Description

<1> à <10>, 
Focus Hold 
Button

Audio Monitor CH : 
Commute la combinaison des canaux 
audio (page 55).

Audio Mon. CH Switch : 
Commute la combinaison des canaux 
audio (page 55).

Thumbnail : 
Affiche/ferme l’écran de miniatures.

Touch Operation : 
Active/désactive les opérations 
tactiles.

Handle Zoom : 
Commute le zoom de la poignée.

NFC : 
Exécute la fonction NFC.

Network Client Mode : 
Active/désactive le mode client 
réseau.

Auto Upload (Proxy) : 
Active/désactive le transfert 
automatique de fichiers proxy ou 
règle le mode par fragments.

Direct Menu : 
Affiche/ferme le menu direct.

User Menu : 
Affiche/ferme le menu User.

Menu : 
Affiche/ferme le menu de 
configuration.

Project >Assignable Dial
Règle les attributions de fonction de la molette personnalisable et règle la direction de rotation.

Élément Réglage de sous-éléments Description

Assignable 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Audio Input Level

Assigne des fonctions à la molette 
personnalisable.
ISO/Gain/EI : 

Ajuste le gain ou EI.
ND Filter : 

Règle le filtre ND.
IRIS : 

Ajuste le diaphragme.
Audio Input Level : 

Règle le niveau d’enregistrement 
audio.

Assignable 
Dial Direction

Normal / Opposite Règle le sens de rotation de la molette 
personnalisable.
Normal : tourne dans le sens normal.
Opposite : tourne dans le sens opposé.

Project >Multi Function Dial
Affecte des fonctions à la molette multifonction.

Élément Réglage de sous-éléments Description

Default 
Function

Off / IRIS / ISO/Gain/EI / Audio Input Level Affecte la fonction par défaut à la 
molette multifonction.
IRIS : 

Ajuste le diaphragme.
ISO/Gain/EI : 

Ajuste le gain ou EI.
Audio Input Level : 

Règle le niveau d’enregistrement 
audio.
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Project >User File
Définit les réglages relatifs aux opérations sur les fichiers utilisateur.

Élément Réglage de sous-éléments Description

Load from 
Utility SD/MS

Execute / Cancel Charge les réglages de fichiers utilisateur 
depuis une carte SD.
Execute : fonction Execute.

Save to Utility 
SD/MS

Execute / Cancel Enregistre les réglages de fichiers 
utilisateur sur une carte SD.
Execute : fonction Execute.

File ID Affiche un écran pour l’affichage/l’édition 
de l’identifiant de fichier des fichiers 
utilisateur.

Load 
Customize 
Data

On / Off Définit le chargement ou non des 
informations personnalisées du menu 
User lorsque Load from Utility SD/MS est 
exécuté.

Load White 
Data

On / Off Définit le chargement ou non des 
informations de balance des blancs 
lorsque Load from Utility SD/MS est 
exécuté.

Project >All File
Définit les réglages liés aux fichiers ALL.

Élément Réglage de sous-éléments Description

Load from 
Utility SD/MS

Execute / Cancel Charge un fichier ALL.
Execute : fonction Execute.

Load from 
Cloud(Private)

Execute / Cancel Charge un fichier ALL téléchargé depuis 
le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Load from 
Cloud(Share)

Execute / Cancel Charge un fichier ALL depuis le service 
Cloud C3 Portal (partagé).
Execute : fonction Execute.

Save to Utility 
SD/MS

Execute / Cancel Sauvegarde un fichier ALL.
Execute : fonction Execute.

Save to 
Cloud(Private)

Execute / Cancel Enregistre les réglages du fichier ALL sur 
le service Cloud C3 Portal (privé).
Execute : fonction Execute.

Save to 
Cloud(Share)

Execute / Cancel Enregistre les réglages du fichier ALL sur 
le service Cloud C3 Portal (partagé).
Execute : fonction Execute.

File ID Attribue un nom au fichier.

Project >All File
Définit les réglages liés aux fichiers ALL.

Élément Réglage de sous-éléments Description

Load Network 
Data

On / Off Définit le chargement ou non des 
informations des réglages du menu 
Network lorsque Load from Utility SD/MS, 
Load from Cloud(Private) ou Load from 
Cloud(Share) est exécuté.

Project >Planning Metadata
Définit les réglages relatifs aux opérations des métadonnées de planification.

Élément Réglage de sous-éléments Description

Load from 
Media(A) ou 
Load from 
Media(B)

Execute / Cancel Charge les métadonnées de planification 
de la carte mémoire insérée dans la fente 
A ou B.
Sélectionnez Execute pour afficher la liste 
des fichiers de métadonnées de 
planification stockés sur la carte mémoire 
insérée dans la fente A ou B. Sélectionnez 
un fichier à l’aide de Load, puis 
sélectionnez Execute pour charger le 
fichier.

[Remarques]
ˎˎ  La liste des fichiers affiche jusqu’à 64 

fichiers. Même si le nombre total de 
fichiers de métadonnées de planification 
est au maximum de 64, les fichiers de 
métadonnées de planification risquent de 
ne pas tous s’afficher si le répertoire dans 
lequel ils se trouvent sur la carte mémoire 
(XDROOT/General/Sony/Planning) contient 
au moins 512 fichiers.
ˎˎ  Après le démarrage du chargement, évitez 

de retirer la carte mémoire avant l’affichage 
du message indiquant la fin de l’opération.
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Project >Planning Metadata
Définit les réglages relatifs aux opérations des métadonnées de planification.

Élément Réglage de sous-éléments Description

Properties Execute / Cancel Sélectionnez Execute pour afficher les 
propriétés des métadonnées de 
planification chargées dans la mémoire 
du caméscope.
File Name : 

Nom du fichier
Assign ID : 

Identifiant affecté
Created : 

Heure et date auxquelles le fichier a 
été créé

Modified : 
Heure et date de la dernière 
modification du fichier

Modified by : 
Nom de la personne qui a modifié le 
fichier

Title1 : 
Title1 spécifié dans le fichier (nom du 
plan au format ASCII)

Title2 : 
Title2 spécifié dans le fichier (nom du 
plan au format UTF-8)

Material Group : 
Nombre de groupes matériels 
(groupes de plans enregistrés avec 
les mêmes métadonnées de 
planification)

Shot Mark0 à 9 : 
Noms définis pour les repères de 
prise de vue 0 à 9

Clear 
Memory

Execute / Cancel Sélectionnez Execute pour effacer les 
métadonnées de planification chargées 
dans la mémoire du caméscope.

Clip Name 
Display

Title1(ASCII) / Title2(UTF-8) Sélectionne le mode d’affichage du nom 
de plan spécifié dans les métadonnées 
de planification.
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Menu Paint
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Paint >HDR Paint Setting
Définit les réglages High Dynamic Range (HDR).

Élément Réglage de sous-éléments Description

HLG Look Natural / Live Règle le type de HLG lorsque Shooting 
Mode est réglé sur HDR.
Natural : 

Caractéristique conforme à ITU-R 
BT.2100(HLG).

Live : 
Caractéristique conforme à ITU-R 
BT.2100(HLG) qui délivre des 
performances HDR améliorées.

[Remarque]
L’utilisation du réglage Live peut augmenter le 
niveau de bruit.

HDR Black 
Offset

–95 à +103 (±0) Règle le décalage noir HDR relatif au 
réglage SDR (Master Black) lorsque 
Shooting Mode est réglé sur HDR.

HDR Knee On / Off Active/désactive la fonction de correction 
de courbe (Knee) du signal HDR lorsque 
Shooting Mode est réglé sur HDR.

HDR Knee 
Point

–99 à +99 (±0) Définit le point de courbe pour les 
signaux HDR lorsque HDR Knee est réglé 
sur On.

HDR Knee 
Slope

–99 à +99 (±0) Définit la pente de courbe pour les 
signaux HDR lorsque HDR Knee est réglé 
sur On.

Paint >Black
Définit les réglages des noirs.

Élément Réglage de sous-éléments Description

Master Black –99.0 à +99.0 (±0.0) Règle le niveau de noir maître.

R Black –99.0 à +99.0 (±0.0) Règle le niveau de noir R.

B Black –99.0 à +99.0 (±0.0) Règle le niveau de noir B.

Paint >Gamma
Définit les réglages de correction gamma.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
gamma.

Paint >Gamma
Définit les réglages de correction gamma.

Élément Réglage de sous-éléments Description

Step Gamma 0.35 à 0.45 à 0.90 Définit une valeur de correction gamma 
par incréments de 0.05.

Master 
Gamma

–99 à +99 (±0) Définit le niveau gamma maître.

R Gamma –99 à +99 (±0) Définit le niveau gamma R.

G Gamma –99 à +99 (±0) Définit le niveau gamma V.

B Gamma –99 à +99 (±0) Définit le niveau gamma B.

Gamma 
Category

Original / STD / HG / S-Log3 Permet de sélectionner le gamma 
d’origine (Original), le gamma standard 
(STD), l’hypergamma (HG) ou S-Log3.

Gamma 
Select

Quand la catégorie Gamma est réglée sur 
STD :
STD1 DVW / STD2 ×4.5 / STD3 ×3.5 / STD4 
240M / STD5 R709 / STD6 ×5.0
Quand la catégorie Gamma est réglée sur 
HG :
HG1 3250G36 / HG2 4600G30 / HG3 
3259G40 / HG4 4609G33 / HG7 8009G40 / 
HG8 8009G33
Quand la catégorie Gamma est réglée sur 
S-Log3 :
S-Log3
Quand la catégorie Gamma est réglée sur 
Original :
S-Cinetone

Sélectionne le tableau gamma utilisé 
pour la correction gamma.
Consultez le tableau ci-dessous pour les 
détails sur l’hypergamma et S-Log3.

Nom Plage 
dynamique

Limite 
blanche

Sortie vidéo 
de carte 
grise 18% 
(20% entrée 
vidéo)

HG1 3250G36 325% 100% 36%

HG2 4600G30 460% 100% 30%

HG3 3259G40 325% 109% 40%

HG4 4609G33 460% 109% 33%

HG7 8009G40 800% 109% 40%

HG8 8009G33 800% 109% 33%

S-Log3 1300% – 41%

Paint >Black Gamma
Définit les réglages de correction gamma du noir.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
gamma du noir.
(Activé quand Gamma >Gamma Category 
est réglé sur STD)

[Remarque]
Les fonctions Black Gamma et Knee >Knee 
Saturation ne peuvent pas être utilisées en 
même temps.
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Paint >Black Gamma
Définit les réglages de correction gamma du noir.

Élément Réglage de sous-éléments Description

Range Low / L.Mid / H.Mid Sélectionne la plage effective de la 
correction gamma du noir.

Master Black 
Gamma

–99 à +99 (±0) Règle le niveau de gamma du noir 
maître.

Paint >Knee
Définit les réglages de correction de courbe.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
de courbe.
(Activé quand Gamma >Gamma Category 
est réglé sur STD)

Auto Knee On / Off Active/désactive la fonction de courbe 
automatique.

Point 75% à 109% (90%) Règle le point de courbe.

Slope –99 à +99 (±0) Règle la pente de courbe.

Knee 
Saturation

On / Off Active/désactive le réglage de saturation 
de courbe (ajuste la coloration au-dessus 
du point de courbe).

[Remarque]
Les fonctions Black Gamma et Knee >Knee 
Saturation ne peuvent pas être utilisées en 
même temps.

Knee 
Saturation 
Level

–99 à +99 (±0) Règle le niveau d’ajustement de la 
coloration au-dessus du point de courbe 
(saturation de courbe).

Paint >White Clip
Définit les réglages d’ajustement d’écrêtage du blanc.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction réglage de 
l’écrêtage des blancs.
(Activé quand Gamma >Gamma Category 
est réglé sur STD)

[Remarque]
Le réglage est réinitialisé sur On lorsque le 
caméscope est mis hors tension. Pour que le 
réglage soit sur Off en permanence, réglez 
Level sur 109%.

Level 90.0% à 109.0% Règle le niveau d’écrêtage du blanc.

Paint >Detail(4K/QFHD)
Définit les réglages d’ajustement des détails (4K/QFHD).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction d’ajustement 
de détail.

Level –99 à +99 (±0) Règle le niveau de détail.

H/V Ratio –99 à +99 (±0) Règle le rapport de mélange entre le 
niveau de détail H et le niveau de détail 
V.

Crispening –99 à +99 (±0) Règle le niveau de netteté.

Frequency –99 à +99 (±0) Règle la fréquence centrale du détail 
(épaisseur de détail).
Le détail est plus mince lorsque la 
fréquence centrale est plus élevée et plus 
épais lorsque la fréquence centrale est 
plus basse.

Knee 
Aperture

On / Off Active/désactive la fonction de correction 
d’ouverture de courbe.

Knee 
Aperture 
Level

–99 à +99 (±0) Règle le niveau d’ouverture de courbe.

White Limit –99 à +99 (±0) Règle la limite de détail pour le côté 
blanc.

Black Limit –99 à +99 (±0) Règle la limite de détail pour le côté noir.

V Detail 
Creation

NAM / Y / G / G+R Règle la source de signal pour créer le 
détail V sur NAM (G ou R, en fonction de 
celui qui est le plus élevé), Y, G ou G+R.

Paint >Detail(HD)
Définit les réglages d’ajustement des détails (HD).

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction d’ajustement 
de détail.

Level –99 à +99 (±0) Règle le niveau de détail.

H/V Ratio –99 à +99 (±0) Règle le rapport de mélange entre le 
niveau de détail H et le niveau de détail 
V.

Crispening –99 à +99 (±0) Règle le niveau de netteté.
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Paint >Detail(HD)
Définit les réglages d’ajustement des détails (HD).

Élément Réglage de sous-éléments Description

Frequency –99 à +99 (±0) Règle la fréquence centrale du détail 
(épaisseur de détail).
Le détail est plus mince lorsque la 
fréquence centrale est plus élevée et plus 
épais lorsque la fréquence centrale est 
plus basse.

Knee 
Aperture

On / Off Active/désactive la fonction de correction 
d’ouverture de courbe.

Knee 
Aperture 
Level

–99 à +99 (±0) Règle le niveau d’ouverture de courbe.

White Limit –99 à +99 (±0) Règle la limite de détail pour le côté 
blanc.

Black Limit –99 à +99 (±0) Règle la limite de détail pour le côté noir.

V Detail 
Creation

NAM / Y / G / G+R Règle la source de signal pour créer le 
détail V sur NAM (G ou R, en fonction de 
celui qui est le plus élevé), Y, G ou G+R.

Paint >Skin Detail
Définit les réglages de correction des détails du teint.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
des détails du teint.

Area 
Detection

Execute / Cancel Détecte la couleur utilisée pour la 
correction des détails du teint.
Execute : fonction Execute.

Area 
Indication

On / Off Active/désactive la fonction affichant la 
mire zébrée dans la zone de couleur cible 
pour la correction des détails du teint.

Level –99 à +99 (±0) Règle le niveau des détails du teint.

Saturation –99 à +99 (±0) Règle la saturation de la couleur cible 
pour la correction des détails du teint.

Hue 0 à 359 Règle la teinte de la couleur cible pour la 
correction des détails du teint.

Width 0 à 90 (40) Règle la plage de la teinte de la couleur 
cible de la correction des détails du teint.

Paint >Aperture
Définit les réglages de correction d’ouverture.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la correction 
d’ouverture (traitement qui améliore la 
résolution en ajoutant des signaux 
d’ouverture haute fréquence au signal 
vidéo, ce qui corrige la détérioration due 
aux caractéristiques de haute fréquence).

Level –99 à +99 (±0) Règle le niveau de correction d’ouverture.

Paint >Matrix
Définit les réglages de correction de matrice.

Élément Réglage de sous-éléments Description

Setting On / Off Active ou désactive la fonction de 
correction de matrice.

Adaptive 
Matrix

On / Off Active/désactive la fonction de matrice 
d’adaptation.

Preset Matrix On / Off Active/désactive la fonction de matrice 
prédéfinie.

Preset Select S-Cinetone / Standard / FL Light /  
Cinema / BT.709 / BT.2020

Sélectionne une matrice prédéfinie.

User Matrix On / Off Active ou désactive la fonction de 
correction de matrice utilisateur.

User Matrix 
Level

–99 à +99 (±0) Ajuste la saturation de couleur de l’image 
entière.

User Matrix 
Phase

–99 à +99 (±0) Ajuste la nuance de couleur (phase) de 
l’image entière.

User Matrix 
R-G

–99 à +99 (±0) Règle une matrice utilisateur R-V définie 
par l’utilisateur.

User Matrix 
R-B

–99 à +99 (±0) Règle une matrice utilisateur R-B définie 
par l’utilisateur.

User Matrix 
G-R

–99 à +99 (±0) Règle une matrice utilisateur V-R définie 
par l’utilisateur.

User Matrix 
G-B

–99 à +99 (±0) Règle une matrice utilisateur V-B définie 
par l’utilisateur.

User Matrix 
B-R

–99 à +99 (±0) Règle une matrice utilisateur B-R définie 
par l’utilisateur.

User Matrix 
B-G

–99 à +99 (±0) Règle une matrice utilisateur B-V définie 
par l’utilisateur.
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Paint >Multi Matrix
Définit les réglages de correction de matrice multiple.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de correction 
de matrice multiple.

Area 
Indication

On / Off Active/désactive la fonction d’indication 
de zone.

Color 
Detection

Execute / Cancel Détecte la couleur utilisée pour la 
correction de matrice multiple.

Reset Execute / Cancel Réinitialise la teinte et la saturation de 
chaque couleur d’axe aux valeurs par 
défaut.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Sélectionne l’axe.

Hue –99 à +99 (±0) Règle la teinte de la couleur utilisée pour 
la correction de matrice multiple.

Saturation –99 à +99 (±0) Règle la saturation de la couleur utilisée 
pour la correction de matrice multiple.

Paint >Scene File
Définit les réglages liés aux fichiers de scène.

Élément Réglage de sous-éléments Description

Recall 
Internal 
Memory

Charge un fichier de scène depuis la 
mémoire interne.

Store Internal 
Memory

Execute / Cancel Sauvegarde un fichier de scène dans la 
mémoire interne.
Execute : fonction Execute.

Load from 
Utility SD/MS

Execute / Cancel Charge un fichier de scène depuis une 
carte SD.
Execute : fonction Execute.

Save to Utility 
SD/MS

Execute / Cancel Sauvegarde un fichier de scène sur une 
carte SD.
Execute : fonction Execute.

File ID Attribue un nom au fichier.

Scene White 
Data

On / Off Règle l’application ou non des données 
d’équilibre des blancs lors du 
chargement de fichiers de scène.
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Menu TC/Media
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

TC/Media >Timecode
Définit les réglages de code temporel.

Élément Réglage de sous-éléments Description

Mode Preset / Regen / Clock Règle le mode de fonctionnement du 
code temporel.
Preset : 

Commence à fonctionner à partir 
d’une valeur préréglée.

Regen : 
Commence à fonctionner à partir du 
code temporel de la fin du plan 
précédent.

Clock : 
Utilise l’horloge interne comme code 
temporel.

Run Rec Run / Free Run Rec Run : fonctionne uniquement en 
cours d’enregistrement.

Free Run : fonctionne en permanence, 
quelle que soit l’opération réalisée 
par le caméscope.

Setting Règle le code temporel sur une valeur 
arbitraire.
SET : règle la valeur.

Reset Execute / Cancel Réinitialise le code temporel sur 
00:00:00:00.
Execute : fonction Execute.

TC Format DF / NDF Règle le format de code temporel.
DF : mode temps réel
NDF : mode temps non réel

TC/Media >TC Display
Définit les réglages d’affichage des données temporelles.

Élément Réglage de sous-éléments Description

Display Select Timecode / Users Bit / Duration Commute l’affichage des données 
temporelles.

TC/Media >Users Bit
Définit les réglages liés aux bits d’utilisateur.

Élément Réglage de sous-éléments Description

Mode Fix / Time Règle le mode de bit d’utilisateur.
Fix : utilise une valeur fixe arbitraire dans 

les bits d’utilisateur.
Time : utilise l’heure actuelle dans les bits 

d’utilisateur.

Setting Règle les bits d’utilisateur sur une valeur 
arbitraire.

TC/Media >HDMI TC Out
Définit les réglages liés à la sortie du code temporel lors de l’utilisation de HDMI.

Élément Réglage de sous-éléments Description

Setting On / Off Règle s’il faut envoyer le code temporel 
vers des dispositifs à d’autres fins à l’aide 
de la sortie HDMI.

TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Auto Naming Cam ID + Reel# / Title / Plan Sélectionne le format d’attribution de 
nom de plan.
Cam ID + Reel# : 

Camera ID + Reel Number + numéro 
de prise de vue + date + chaîne de 
caractères aléatoires

Title : 
Chaîne de caractères arbitraires 
spécifiée dans Title Prefix + numéro 
de plan

Plan : 
Utilise un nom de plan spécifié dans 
les métadonnées de planification, si 
disponible. Ou utilise le nom spécifié 
dans Title Prefix + le numéro de plan, 
si non disponible.

Camera ID A à Z Règle l’identifiant de caméra utilisé pour 
la création de noms de plans.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.
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TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Reel Number 001 à 999 Règle la portion numérique du numéro 
de bobine utilisé pour la création de 
noms de plans.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.

Camera 
Position

C / L / R Règle le caractère du préfixe de Shot 
Number utilisé pour la création de noms 
de plans.

[Remarque]
Configurable uniquement lorsque Auto Naming 
est réglé sur Cam ID + Reel#.

TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Title Prefix nnn_ (nnn correspond aux 3 derniers 
chiffres du numéro de série)
(Affichage de 7 caractères max.)

Règle la partie de titre (4 à 46 caractères) 
du nom de plan.
Ouvre un écran de saisie de chaîne de 
caractères.

Structure de l’écran de saisie des 
chaînes de caractères
Zone de sélection de caractère (3 lignes) : 

Sélectionne les caractères à insérer à 
la position du curseur de la zone Title 
Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Zone d’opération du curseur (1 ligne) : 
Space : insère une espace à la 
position du curseur.  
 : déplace le curseur vers la 
gauche.  
 : déplace le curseur vers la droite.  
BS : permet de supprimer le caractère 
à gauche de la position du curseur.

Zone de préfixe de titre (1 ligne) : 
Zone de saisie du titre.

Pour définir le titre
1. Sélectionnez le caractère à insérer à 

la position du curseur de la zone Title 
Prefix depuis la zone de sélection des 
caractères à l’aide des touches 
fléchées puis appuyez sur la touche 
SET. (Le caractère sélectionné est 
inséré et le curseur se déplace vers la 
droite.)

2. Recommencez l’étape 1 pour définir 
le titre. (Utilisez BS, selon les besoins.)

3. Après avoir défini le titre, 
sélectionnez Done pour fermer 
l’écran de saisie de caractères.
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TC/Media >Clip Name Format
Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.

Élément Réglage de sous-éléments Description

Number Set Lorsque Auto Naming est réglé sur Title : 
0001 à 9999

Lorsque Auto Naming est réglé sur Plan : 
00001 à 99999

Règle le suffixe numérique à 4 chiffres du 
nom de plan.
Règle un nombre à 5 chiffres si vous 
utilisez un fichier de métadonnées de 
planification.

TC/Media >Update Media
Met à jour le fichier de gestion sur les cartes mémoire.

Élément Réglage de sous-éléments Description

Media(A) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire XQD dans la fente A.
Execute : fonction Execute.

Media(B) Execute / Cancel Met à jour le fichier de gestion sur la 
carte mémoire XQD dans la fente B.
Execute : fonction Execute.

TC/Media >Format Media
Initialise les cartes mémoire.

Élément Réglage de sous-éléments Description

Media(A) Execute / Cancel Initialise la carte mémoire XQD dans la 
fente A.
Execute : fonction Execute.

Media(B) Execute / Cancel Initialise la carte mémoire XQD dans la 
fente B.
Execute : fonction Execute.

Utility SD/MS Execute / Cancel Initialise la carte UTILITY SD.
Execute : fonction Execute.
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Menu Monitoring
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Monitoring >Output On/Off
Définit les réglages de sortie vidéo.

Élément Réglage de sous-éléments Description

SDI1 On / Off Active/désactive la sortie SDI1.

SDI2 On / Off Active/désactive la sortie SDI2.

HDMI On / Off Active/désactive la sortie HDMI.

Monitoring >Output Format
Définit les réglages du format de sortie.

Élément Réglage de sous-éléments Description

SDI1 Pour plus de détails sur les réglages, 
consultez « Formats de sortie et limites » 
(page 139).

Règle la résolution de sortie SDI et HDMI.

[Remarque]
Le réglage Output Format ne peut pas être 
configuré en mode Picture Cache Rec. Si celà 
se produit, désactivez temporairement Picture 
Cache Rec, puis modifiez le réglage.

SDI2

HDMI

REF

Monitoring >Output Setting
Définit les réglages de mode de conversion de sortie.

Élément Réglage de sous-éléments Description

RAW to HD 
Conv.

Edge Crop / Letter Box Règle le mode de conversion pour la 
sortie vidéo HD de la vidéo 17:9.

Monitoring >Output Display
Définit les réglages du signal de sortie.

Élément Réglage de sous-éléments Description

Setting On / Off Sélectionne la superposition ou non des 
menus et des états sur le signal de sortie 
SDI et le signal de sortie HDMI.

SDI1 Les réglages varient selon le réglage 
d’Output Format. Pour plus de détails, 
consultez « Formats de sortie et limites » 
(page 139).

Indique si les informations de menu et 
d’état sont intégrées ou non dans le 
signal de sortie SDI1.

SDI2 Indique si les informations de menu et 
d’état sont intégrées ou non dans le 
signal de sortie SDI2.

HDMI Indique si les informations de menu et 
d’état sont intégrées ou non dans le 
signal de sortie HDMI.

Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément Réglage de sous-éléments Description

Network 
Status

On / Off Sélectionne les éléments à afficher dans 
le viseur.

File Transfer 
Status

On / Off

NCM/
Streaming 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Marker On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

GPS On / Off

SteadyShot On / Off
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Monitoring >Display On/Off
Définit les réglages de l’élément d’affichage.

Élément Réglage de sous-éléments Description

Gamma/LUT On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Définit les réglages d’affichage de repère.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive l’affichage de tous les 
repères.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Sélectionne la couleur du signal de 
repère.

Center Marker 1 / 2 / 3 / 4 / Off Sélectionne le repère central.

Safety Zone On / Off Active/désactive le repère de la zone de 
sécurité.

Safety Area 80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité (en tant que pourcentage de 
la taille totale de l’écran).

Aspect 
Marker

Line / Mask / Off Sélectionne le type de marqueur de 
format.

Aspect Mask 0 à 15 (12) Règle le niveau du signal vidéo en 
dehors du marqueur.

Aspect Safety 
Zone

On / Off Active/désactive le repère de la zone de 
sécurité.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Sélectionne la taille du repère de la zone 
de sécurité de format (en tant que 
pourcentage de la taille totale de l’écran).

Aspect Select 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 /  
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1

Règle le mode en affichant le marqueur 
de format.

[Remarque]
Lorsque VF Setting >De-Squeeze (page 114) 
dans le menu Monitoring n’est pas réglé sur 
Off(1.0x) ce réglage est réglé sur 2.39:1 (fixe).

Guide Frame On / Off Active/désactive l’affichage du cadre 
guide.

100% Marker On / Off Active/désactive le repère 100%.

User Box On / Off Active/désactive l’affichage du marqueur 
de cadre utilisateur.

User Box 
Width

3 à 479 (240) Règle la largeur du marqueur de cadre 
utilisateur (distance du centre aux bords 
gauche et droit).

User Box 
Height

3 à 269 (135) Règle la hauteur du marqueur de cadre 
utilisateur (distance du centre aux bords 
haut et bas).

User Box H 
Position

–476 à +476 (0) Définit la position horizontale du centre 
du marqueur de cadre utilisateur.

User Box V 
Position

–266 à +266 (0) Définit la position verticale du centre du 
marqueur de cadre utilisateur.
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Monitoring >VF Setting
Définit les réglages du viseur.

Élément Réglage de sous-éléments Description

Contrast –99 à +99 (±0) Règle le contraste (différence entre le 
clair et le sombre) de l’image du viseur.

Brightness –99 à +99 (±0) Permet d’ajuster la luminosité de l’image 
du viseur.

Color Mode Color / B&W Sélectionne le mode d’affichage du 
viseur dans le mode E-E/enregistrement.

De-Squeeze Off(1.0x) / 1.3x / 2.0x Sélectionne le facteur de décompression 
pour l’affichage d’une image dans le 
viseur lors de la prise de vue avec un 
objectif anamorphoseur.

Monitoring >Gamma Display Assist
Configure les réglages de l’aide pour l’affichage gamma.

Élément Réglage de sous-éléments Description

Setting En mode SDR ou Cine EI :
On / Off

En mode HDR :
On / Off

Active/désactive la fonction d’aide 
d’affichage du gamma.

Monitoring >Peaking
Définit les réglages du contour.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de réglage 
du contour.

Type Normal / Color Sélectionne le type de réglage du 
contour.
Normal : réglage du contour normal
Color : réglage de contour de couleur

Normal 
Peaking 
Frequency

Normal / High Sélectionne la fréquence de réglage du 
contour.

Normal 
Peaking Level

0 à 99 (50) Règle le niveau normal de réglage du 
contour.

Color B&W / Red / Yellow / Blue Sélectionne la couleur du signal de 
réglage du contour de couleur.

Color Peaking 
Level

0 à 99 (50) Règle le niveau de réglage du contour de 
couleur.

Monitoring >Zebra
Définit les réglages du motif de zébrures.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction de mire 
zébrée.

Zebra Select 1 / 2 / Both Sélectionne le type de motif de zébrures 
(Zebra 1, Zebra 2, Both).

Zebra1 Level 0% à 107% (70%) Définit le niveau d’affichage de Zebra 1.

Zebra1 
Aperture 
Level

1% à 20% (10%) Définit le niveau d’ouverture de Zebra 1.

Zebra2 Level 0% à 109% (100%) Définit le niveau d’affichage de Zebra 2.



6. Affichage et réglages de menu115

Menu Audio
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).
Reportez-vous à « Diagrammes bloc » (page 156).

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH1 MI SHOE 
Input Select

Shoe CH1 / Wireless Règle la fonction d’entrée externe 
lorsque le commutateur de sélection CH1 
INPUT (page 7) est réglé sur MI SHOE.

[Remarque]
« Wireless » s’affiche uniquement lorsqu’un 
module d’extension est attaché.

CH2 EXT 
Input Select

INPUT1 / INPUT2 Commute la source d’entrée externe pour 
l’enregistrement sur le canal 2.

CH2 MI SHOE 
Input Select

Shoe CH2 / Wireless Règle la fonction d’entrée externe 
lorsque le commutateur de sélection CH2 
INPUT (page 7) est réglé sur MI SHOE.

[Remarque]
« Wireless » s’affiche uniquement lorsqu’un 
module d’extension est attaché.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 / 
Wireless

Commute la source d’entrée pour 
l’enregistrement sur le canal 3.

[Remarque]
« Wireless » peut être sélectionné uniquement 
lorsqu’un module d’extension est attaché.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2 / Wireless

Commute la source d’entrée pour 
l’enregistrement sur le canal 4.

[Remarque]
« Wireless » peut être sélectionné uniquement 
lorsqu’un module d’extension est attaché.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Règle le niveau d’enregistrement de 
référence pour l’entrée du microphone 
XLR à partir d’INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Sélectionne le niveau d’entrée de 
référence quand le commutateur INPUT1/
INPUT2 est réglé sur LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Sélectionne le niveau d’enregistrement 
du signal de tonalité de référence de 
1 kHz.

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH1 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 1.

CH2 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 2.

CH3 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 3.

CH4 Wind 
Filter

On / Off Active/désactive le filtre de réduction 
anti-vent pour l’enregistrement sur le 
canal 4.

CH3 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 3.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec ce réglage.

CH4 Level 
Control

Auto / Manual Sélectionne le réglage du niveau d’entrée 
audio ou le réglage manuel pour le canal 
d’enregistrement 4.

[Remarque]
Si CH3 Input Select et CH4 Input Select 
sont tous deux réglés sur Internal MIC, CH4 
est commuté sur automatic/manual en 
conjonction avec le réglage CH3 Level Control.

Audio Input 
Level

0 à 99 Règle le niveau d’entrée audio maître.
Peut être utilisé comme volume principal 
en fonction des réglages de CH1 Level à 
CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique du limiteur 
pour les forts signaux d’entrée lors du 
réglage manuel du niveau d’entrée 
audio.

CH1&2 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
1 et canal 2. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.
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Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH3&4 AGC 
Mode

Mono / Stereo Règle le mode de réglage automatique 
de niveau pour le canal d’enregistrement 
3 et canal 4. Lorsque vous réglez sur 
Stereo, AGC est relié entre les canaux.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Sélectionne la caractéristique AGC.

1kHz Tone on 
Color Bars

On / Off Active/désactive le signal de tonalité de 
référence de 1 kHz lors de l’affichage des 
barres de couleur.

[Remarque]
Lorsqu’il est activé, le signal de tonalité 
de référence de 1 kHz est réglé pour 
l’enregistrement sur le canal 3 et canal 4, 
même si CH3 Input Select et CH4 Input Select 
sont désactivés.

CH1 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 47)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 1.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH1) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 156).

CH2 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 47)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 2.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH2) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 156).

CH3 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 47)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 3.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH3) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 157).

Audio >Audio Input
Définit les réglages d’entrée audio.

Élément Réglage de sous-éléments Description

CH4 Level Entrée sans adaptateur XLR
Audio Input Level / Side / Level+Side

Entrée avec adaptateur XLR (page 47)
Audio Input Level / Through

Règle la combinaison des ajustements 
de niveau d’entrée audio activés pour le 
canal d’enregistrement 4.

[Remarque]
« Side » se rapporte à la molette AUDIO 
LEVEL (CH4) sur le côté du caméscope. 
Lorsque Level+Side est sélectionné, le niveau 
d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et 
dial (page 157).

Audio >Audio Output
Définit les réglages de sortie audio.

Élément Réglage de sous-éléments Description

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 /  
CH2 / CH3 / CH4

Sélectionne la sortie du canal audio vers 
la prise casque et le haut-parleur intégré.

[Remarque]
Si l’audio pour plusieurs canaux est réglée sur 
la sortie simultanée, le niveau de sortie pour 
chaque canal est réduit pour la sortie pour 
éviter le détourage.

Headphone 
Out

Mono / Stereo Sélectionne le mode de sortie de la prise 
casque : monaural (Mono) ou stéréo 
(Stereo).

Alarm Level 0 à 7 (4) Ajuste le volume de l’alarme.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Règle la combinaison des canaux audio 
sur la sortie HDMI.
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Menu Thumbnail
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Thumbnail

Élément Réglage de sous-éléments Description

Display Clip 
Properties

Affiche l’écran de propriétés de plans.

Thumbnail >Set Shot Mark
Définit les réglages de repère de prise de vue.

Élément Réglage de sous-éléments Description

Delete Shot 
Mark1

Supprime le repère Shot Mark1.

Delete Shot 
Mark2

Supprime le repère Shot Mark2.

Thumbnail >Set Clip Flag
Définit les réglages de balise de plan.

Élément Réglage de sous-éléments Description

Add OK Ajoute une balise OK.

Add NG Ajoute une balise NG.

Add KEEP Ajoute une balise KEEP.

Delete Clip 
Flag

Supprime toutes les balises.

Thumbnail >Lock/Unlock Clip
Définit les réglages de protection de plan.

Élément Réglage de sous-éléments Description

Select Clip Sélectionne et verrouille/déverrouille un 
plan.

Lock All Clips Verrouille tous les plans.

Unlock All 
Clips

Déverrouille tous les plans.

Thumbnail >Delete Clip
Supprime les plans.

Élément Réglage de sous-éléments Description

Select Clip Supprime le plan sélectionné.

All Clips Supprime tous les plans.

Thumbnail >Copy Clip
Copie des plans.

Élément Réglage de sous-éléments Description

Select Clip Copie les plans sélectionnés.

Thumbnail >Copy Clip
Copie des plans.

Élément Réglage de sous-éléments Description

All Clips Copie tous les plans.

Thumbnail >Copy Sub Clip
Copie des sous-plans.

Élément Réglage de sous-éléments Description

All Clips Copie tous les sous-plans enregistrés en 
mode d’enregistrement 4K & HD (Sub) 
sur un autre support en tant que plans 
principaux.

Thumbnail >Transfer Clip
Transfère des plans.

[Remarque]
Transfer Clip ne peut pas être configuré lorsque Access Authentication >Password dans le menu Network est 
indéfini.

Élément Réglage de sous-éléments Description

Select Clip Transfert les plans sélectionnés.

All Clips Transfert tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Thumbnail >Transfer Clip (Proxy)
Transfère des plans proxy.

[Remarque]
Transfer Clip (Proxy) ne peut pas être configuré lorsque Access Authentication >Password dans le menu Network 
est indéfini.

Élément Réglage de sous-éléments Description

Select Clip Transfère les plans proxy correspondant 
aux plans sélectionnés.

All Clips Transfère les plans proxy correspondant à 
tous les plans.

[Remarque]
Jusqu’à 200 plans peuvent être transférés.

Thumbnail >Set Index Picture
Règle l’image d’index d’un plan.

Élément Réglage de sous-éléments Description

Set Index 
Picture

Règle l’image d’index d’un plan.
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Thumbnail >Thumbnail View
Définit les réglages de format d’affichage de l’écran de miniatures.

Élément Réglage de sous-éléments Description

Essence Mark 
Thumbnail

All / Rec Start / Shot Mark1 / Shot Mark2 / 
Shot Mark3 / Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / Shot Mark8 / 
Shot Mark9 / Shot Mark0

Affiche des miniatures d’images 
marquées de repères.

Clip 
Thumbnail

Affiche des miniatures de plans 
enregistrés.

Thumbnail >Filter Clips
Définit les réglages des plans à afficher.

Élément Réglage de sous-éléments Description

OK Affiche uniquement les plans comportant 
une balise OK.

NG Affiche uniquement les plans comportant 
une balise NG.

KEEP Affiche uniquement les plans comportant 
une balise KEEP.

None Affiche uniquement les plans ne 
comportant pas de balise.

All Affiche tous les plans, que des balises 
soient présentes ou non.

Thumbnail >Customize View
Bascule l’affichage de l’écran de miniatures.

Élément Réglage de sous-éléments Description

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Commute l’information affichée sous les 
miniatures.
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Menu Technical
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Technical >Color Bars
Définit les réglages de barres de couleur.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive les barres de couleur.

[Remarque]
Ne peut pas être réglé sur On lorsque S&Q 
Motion >Setting (page 93) dans le menu 
Shooting est réglé sur On.

Type ARIB / 100% / 75% / SMPTE Sélectionne le type de barres de couleur.

Technical >Test Saw
Définit les réglages du signal de test.

Élément Réglage de sous-éléments Description

Test Saw On / Off Active/désactive le signal test.

Technical >ND Dial
Configure les réglages relatifs aux opérations de la molette ND VARIABLE.

Élément Réglage de sous-éléments Description

CLEAR with 
Dial

On / Off Permet d’autoriser ou d’interdire la 
commutation d’état ND (CLEAR  On) 
en utilisant la molette ND VARIABLE.

Technical >Tally
Configure les réglages du témoin d’enregistrement/de signalisation.

Élément Réglage de sous-éléments Description

Front Tally 
Lamp

On / Off Active/désactive le témoin 
d’enregistrement/de signalisation (avant).

Rear Tally 
Lamp

On / Off Active/désactive le témoin 
d’enregistrement/de signalisation 
(arrière).

Tally Control REMOTE / RCP / Internal Spécifie la cible pour la réception des 
informations de commande Tally/Call.

Technical >HOLD Switch Setting
Définit les réglages du commutateur Hold.

Élément Réglage de sous-éléments Description

with Rec 
Button

On / Off Règle s’il faut verrouiller la touche 
d’enregistrement.

with Hand 
Grip Remote

On / Off Règle s’il faut verrouiller le 
fonctionnement de la télécommande à 
poignée.

Technical >Touch Operation
Définit les réglages relatifs aux opérations tactiles.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive les opérations tactiles.

Technical >Rec Review
Définit les réglages du passage en revue de l’enregistrement.

Élément Réglage de sous-éléments Description

Setting 3s / 10s / Clip Sélectionne le temps pour la lecture de 
plans venant d’être enregistrés pour le 
passage en revue de l’enregistrement.

Technical >Handle Zoom
Définit les réglages de zoom à poignée.

Élément Réglage de sous-éléments Description

Setting Off / Low / High / Variable Règle la vitesse du zoom à poignée.

High 1 à 8 (8) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée High est 
sélectionnée.

Low 1 à 8 (3) Règle la vitesse de zoom du levier de 
zoom de la poignée lorsque la vitesse de 
zoom de la poignée Low est 
sélectionnée.

[Remarque]
Une vitesse de zoom réglée sur une faible 
valeur peut provoquer un zoom irrégulier.

Technical >GPS
Définit les réglages GPS.

Élément Réglage de sous-éléments Description

GPS On / Off Active/désactive la fonction GPS.

[Remarque]
Le module GPS est intégré à la poignée.

Technical >Menu Settings
Définit les réglages liés au menu.

Élément Réglage de sous-éléments Description

User Menu 
Only

On / Off Configure s’il faut afficher le menu User 
uniquement (On) ou afficher la liste des 
menus (Off) lorsque le caméscope 
affiche le menu.
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Technical >Menu Settings
Définit les réglages liés au menu.

Élément Réglage de sous-éléments Description

User Menu 
with Lock

On / Off Règle le verrouillage ou non de 
l’affichage du menu, affichant le menu 
User uniquement.

[Remarque]
En cas d’affichage normal du menu, cet 
élément ne s’affiche pas. Pour plus de détails 
sur l’affichage du menu, consultez page 82.

Technical >Status Page On/Off
Règle les réglages relatifs à l’affichage d’écrans d’état.

Élément Réglage de sous-éléments Description

Main On / Off Active/désactive l’affichage de l’écran 
Main Status.

Camera On / Off Active/désactive l’affichage de l’écran 
Camera Status.

Audio On / Off Active/désactive l’affichage de l’écran 
Audio Status.

Project On / Off Active/désactive l’affichage de l’écran 
d’état Project.

Monitoring On / Off Active/désactive l’affichage de l’écran 
Monitoring Status.

Assignable 
Button

On / Off Active/désactive l’affichage de l’écran 
Assignable Button Status.

Battery On / Off Active/désactive l’affichage de l’écran 
Battery Status.

Media On / Off Active/désactive l’affichage de l’écran 
Media Status.

GPS On / Off Active/désactive l’affichage de l’écran 
GPS Status.

Network On / Off Active/désactive l’affichage de l’écran 
Network Status.

NCM/
Streaming

On / Off Active/désactive l’affichage de l’écran 
NCM/Streaming Status.

File Transfer On / Off Active/désactive l’affichage de l’écran 
File Transfer Status.

Technical >RCP
Règle les réglages relatifs aux panneaux de télécommande.

Élément Réglage de sous-éléments Description

CNS Mode Off / Bridge Règle si la connexion en mode pont avec 
un panneau de télécommande est 
autorisée.

Detail 
Control(RCP)

4K/QFHD / HD Règle si l’ajustement de détail du 
panneau de télécommande correspond à 
4K/QFHD ou HD dans le menu de détail.

Technical >Fan Control
Définit les réglages de mode de commande du ventilateur.

Élément Réglage de sous-éléments Description

Setting Auto / Minimum / Off in Rec Règle le mode de commande du 
ventilateur du caméscope.

[Remarque]
Même lorsque Off in Rec est sélectionné, le 
ventilateur fonctionnera si la température 
interne du caméscope dépasse une certaine 
valeur.

Technical >Lens
Définit les réglages liés aux objectifs.

Élément Réglage de sous-éléments Description

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Règle la direction du fonctionnement de 
la bague de zoom.

[Remarque]
Activé uniquement lors de l’utilisation d’un 
objectif à monture E prenant en charge le 
changement de direction de la bague de zoom.

Shading 
Compensation

Auto / Off Active/désactive la compensation 
automatique d’ombrage.

[Remarque]
La compensation d’ombrage n’est pas 
appliquée lorsque Imager Scan Mode est réglé 
sur S35 2K.

Chroma 
Aberration 
Comp.

Auto / Off Active/désactive la compensation 
automatique d’aberrations chromatiques.

[Remarque]
La compensation d’aberrations chromatiques 
n’est pas appliquée lorsque Imager Scan Mode 
est réglé sur S35 2K.
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Technical >Lens
Définit les réglages liés aux objectifs.

Élément Réglage de sous-éléments Description

Distortion 
Comp.

Auto / Off Active/désactive la compensation 
automatique de distorsion.

[Remarque]
La compensation de distorsion n’est pas 
appliquée lorsque Imager Scan Mode est réglé 
sur S35 ou S16.

Distance 
Display

Meter / Feet Configure les unités d’affichage pour les 
informations d’objectif et la position de 
mise au point.

Zoom 
Position 
Display

Focal Length / Number / Bar Définit le format d’affichage de position 
de zoom.

Iris Display Auto / F-Number Définit les unités d’affichage du 
diaphragme.
Auto : 

Affiche la valeur T si des informations 
sur la valeur T peuvent être obtenues 
à partir de l’objectif attaché. Sinon, la 
valeur F est affichée.

F-Number : 
Affiche toujours la valeur F.

Technical >Video Light Set
Règle la méthode d’éclairage de la lampe vidéo. Disponible uniquement lors de l’utilisation du 
HVL-LBPC (optionnel).

Élément Réglage de sous-éléments Description

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Règle la méthode de contrôle d’éclairage 
pour la lumière vidéo fixée à la griffe 
d’interface multiple.
Power Link : 

Allume/éteint la lampe vidéo quand 
le caméscope est en marche/à l’arrêt.

Rec Link : 
Allume/éteint la lampe vidéo quand 
le caméscope commence/arrête 
l’enregistrement.

Rec Link + Stby : 
Allume/met en veille la lampe vidéo 
quand le caméscope commence/
arrête l’enregistrement.

Technical >APR
Exécute l’APR.

Élément Réglage de sous-éléments Description

APR Execute / Cancel Exécute l’APR (restauration automatique 
des pixels) pour l’ajustement 
automatique du capteur d’images.
Execute : fonction Execute.

[Remarque]
Fixez toujours le capuchon de l’objectif avant 
d’exécuter l’APR.

Technical >Camera Battery Alarm
Définit les réglages d’alarme de basse tension de batterie.

Élément Réglage de sous-éléments Description

Low Battery 5% / 10% / 15% / … / 45% / 50% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de basse tension de batterie (par 
incréments de 5%).

Battery 
Empty

3% à 7% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de batterie vide.

Technical >Camera DC IN Alarm
Définit les réglages d’alarme de tension en entrée.

Élément Réglage de sous-éléments Description

DC Low 
Voltage1

16.0V à 19.0V (16.5V) Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
basse tension en entrée DC IN.

DC Low 
Voltage2

15.5V à 18.5V Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
tension insuffisante en entrée DC IN.

Technical >Ext. Unit Battery Alarm
Définit les réglages de la batterie du XDCA-FX9.

Élément Réglage de sous-éléments Description

Near End:Info 
Battery

5% à 100% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de basse tension de batterie Sony Info 
(par incréments de 5%).

End:Info 
Battery

0% à 5% Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de fin de vie de batterie Sony Info et 
arrêter l’accès au support.
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Technical >Ext. Unit Battery Alarm
Définit les réglages de la batterie du XDCA-FX9.

Élément Réglage de sous-éléments Description

Near 
End:Sony 
Battery

11.5V à 17.0V Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de basse tension de batterie pour une 
batterie autre que Sony Info.

End:Sony 
Battery

11.0V à 14.0V Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de fin de vie de batterie pour une 
batterie autre que Sony Info et pour 
arrêter l’accès au support.

Near 
End:Other 
Battery

11.5V à 17.0V (11.8V) Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de basse tension de batterie pour une 
batterie Anton/Bauer.

End:Other 
Battery

11.0V à 14.0V Règle le niveau de batterie devant rester 
pour déclencher l’affichage d’une alarme 
de batterie vide pour une batterie Anton/
Bauer et pour arrêter l’accès au support.

Detected 
Battery

Affiche le type de source d’alimentation 
connectée au module XDCA-FX9.
Si une batterie est connectée au module 
XDCA-FX9, « Info Battery », « Sony 
Battery » ou « Other Battery » s’affiche. Si 
une source CC est connectée, « DC IN » 
s’affiche.
En cas d’alimentation par batterie ou 
source CC raccordée au caméscope, 
« --- » s’affiche.

Technical >Ext. Unit DC IN Alarm
Définit les réglages d’alarme de tension en entrée du XDCA-FX9.

Élément Réglage de sous-éléments Description

DC Low 
Voltage1

11.5V à 17.0V Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
basse tension en entrée DC IN.

DC Low 
Voltage2

11.0V à 14.0V Règle la tension nécessaire pour 
déclencher l’affichage d’une alarme de 
tension insuffisante en entrée DC IN.
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Menu Network
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Network >Setup for Mobile App
Exécute l’outil d’aide pour la configuration réseau.

Élément Réglage de sous-éléments Description

Setup Démarre l’outil d’aide pour la 
configuration réseau.

Network >Access Authentication
Définit les réglages liés à l’authentification.

Élément Réglage de sous-éléments Description

User Name Règle le nom d’utilisateur pour 
l’authentification d’accès.

Input 
Password

Règle le mot de passe pour 
l’authentification d’accès.

[Remarque]
Du point de vue de la sécurité, il est 
recommandé de définir un mot de passe avec 
une chaîne de caractères suffisamment longue, 
difficile à deviner par les autres, et de le stocker 
en toute sécurité.

Generate 
Password

Execute / Cancel Génère automatiquement un mot de 
passe pour l’authentification d’accès.
Execute : fonction Execute.

Show 
Settings

Affiche le nom d’utilisateur, le mot de 
passe et le numéro de série pour 
l’authentification d’accès sous forme de 
texte et de code QR.

[Remarque]
Veillez à ce que le mot de passe ne puisse pas 
être visualisé et que l’image du code QR ne 
puisse pas être copiée par d’autres personnes.

Network >Wireless LAN
Définit les réglages liés aux connexions LAN sans fil.

Élément Réglage de sous-éléments Description

Setting Access Point Mode / Station Mode / Off Sélectionne le mode d’utilisation de la 
connexion au réseau local sans fil.

WPS Execute / Cancel Établit une connexion à l’aide d’un WPS 
(Wi-Fi Protected Setup).
Execute : fonction Execute.

NFC Execute / Cancel Établit une connexion à l’aide d’un NFC 
(Near Field Communication).
Execute : fonction Execute.

Network >Wireless LAN
Définit les réglages liés aux connexions LAN sans fil.

Élément Réglage de sous-éléments Description

MAC Address Affiche l’adresse MAC de l’interface LAN 
sans fil du caméscope.

Network >AP Mode Settings
Définit les réglages liés aux connexions du mode de point d’accès.

Élément Réglage de sous-éléments Description

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 /  
CH10 / CH11

Définit le canal LAN sans fil.
Auto(5GHz) est uniquement disponible 
avec le PXW-FX9V/VK.

Camera SSID 
& Password

Affiche le SSID et le mot de passe du 
caméscope.

Regenerate 
Password

Execute / Cancel Crée un nouveau mot de passe.
Execute : fonction Execute.

IP Address Affiche l’adresse IP du caméscope en 
mode de point d’accès.

Subnet Mask Affiche le masque de sous-réseau du 
caméscope en mode de point d’accès.
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Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif connecté au 
caméscope par LAN sans fil en mode de 
station.

Connected 
Network

Affiche le réseau LAN sans fil connecté 
(point d’accès).

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Affiche le mot de passe du point d’accès 
pour la connexion.
Lorsque Security est réglé sur WEP ou 

WPA : *******
Lorsque Security est réglé sur None : 

(vide)

DHCP Affiche l’état d’activation/désactivation 
du DHCP.

IP Address Affiche l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Affiche le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Affiche la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto Affiche l’état d’activation/désactivation 
d’acquisition du DNS.

Primary DNS Server Affiche le serveur DNS principal du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Secondary DNS Server Affiche le serveur DNS secondaire du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Scan 
Networks

Détecte les réseaux LAN sans fil (points 
d’accès) et affiche une liste.
Sélectionnez une destination depuis la 
liste pour la connexion.

SSID Affiche le SSID du point d’accès pour la 
connexion.

Security Affiche le type de sécurité du point 
d’accès pour la connexion.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal du 
caméscope lorsque DNS Auto est réglé 
sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire du 
caméscope lorsque DNS Auto est réglé 
sur Off.
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Network >ST Mode Settings
Définit les réglages liés aux connexions du mode de station.

Élément Réglage de sous-éléments Description

Manual 
Register

Enregistre les réglages pour la connexion 
manuelle à un point d’accès.

SSID Saisissez le SSID du point d’accès pour la 
connexion.

Security 
None / WEP / WPA

Configurez le type de sécurité du point 
d’accès pour la connexion. Sélectionnez 
WPA si le type de sécurité du point 
d’accès de destination est WPA ou WPA2.

Password Saisissez le mot de passe du point 
d’accès pour la connexion.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.

Network >Wired LAN
Définit les réglages liés aux connexions LAN filaires.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la fonction du LAN 
filaire.

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif connecté au 
caméscope par LAN filaire.

Detail 
Settings

Configure les propriétés de la connexion 
par LAN filaire.

DHCP 
On / Off

Active/désactive DHCP.

IP Address Saisissez l’adresse IP du caméscope 
lorsque DHCP est réglé sur Off.

Subnet Mask Saisissez le masque de sous-réseau du 
caméscope lorsque DHCP est réglé sur 
Off.

Gateway Saisissez la passerelle par défaut du 
caméscope lorsque DHCP est réglé sur 
Off.

DNS Auto 
On / Off

Active/désactive la fonction d’acquisition 
automatique de DNS.

Primary DNS Server Saisissez le serveur DNS principal lorsque 
DNS Auto est réglé sur Off.

Secondary DNS Server Saisissez le serveur DNS secondaire 
lorsque DNS Auto est réglé sur Off.
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Network >Modem
Définit les réglages liés aux modems.

Élément Réglage de sous-éléments Description

Setting On / Off Active/désactive la connexion modem.

Camera 
Remote 
Control

Enable / Disable Règle si la télécommande doit être 
activée depuis un dispositif connecté au 
caméscope par LAN sans fil via un 
modem/smartphone.

[Remarque]
Lorsque cet appareil est connecté à C3 
Portal, ce réglage est commuté sur Enable 
(page 71).

Modem1 IP 
Address

Affiche l’adresse IP du modem 1.

Modem1 
Subnet Mask

Affiche le masque de sous-réseau du 
modem 1.

Modem2 IP 
Address

Affiche l’adresse IP du modem 2.

Modem2 
Subnet Mask

Affiche le masque de sous-réseau du 
modem 2.

Network >Network Client Mode
Définit les réglages relatifs au mode client réseau.

Élément Réglage de sous-éléments Description

Setting On / Off Démarre (On) ou arrête (Off) le mode 
client réseau.

NCM Settings 
Select

Sélectionne les réglages prédéfinis (NCM 
Settings1/NCM Settings2/NCM Settings3), 
dont les réglages de connexion en mode 
client réseau configurés au préalable.

Network >Network Client Mode
Définit les réglages relatifs au mode client réseau.

Élément Réglage de sous-éléments Description

NCM 
Settings1

Display Name Configure le nom d’affichage dans le 
menu NCM Settings.

CCM Address Règle l’adresse du CCM de destination 
pour la connexion.
Nom de l’hôte ou adresse IP

CCM Port (1 à 65535 (8443)) Règle le numéro de port du CCM de 
destination pour effectuer la connexion.

User Name Règle le nom d’utilisateur pour 
l’authentification de la connexion CCM.

Password Règle le mot de passe d’authentification 
de la connexion CCM.

CCM Certificate 
Load / Clear / None

Charge un certificat lors de la connexion 
au CCM ou à C3 Portal et supprime les 
réglages.

CCM Certificate Status 
Loaded / Default

Affiche l’état de chargement du certificat 
lors de la connexion au CCM ou à C3 
Portal.

Camera Control 
Enable / Disable

Active/désactive la contrôle de la caméra 
à partir d’un appareil CCM, lorsqu’un 
appareil CCM est connecté, ou à partir 
d’un appareil C3 Portal.

Camera Setting 
Always / Onetime / Off

Active/désactive les opérations All File à 
partir d’un appareil CCM, lorsqu’un 
appareil CCM est connecté, ou à partir 
d’un appareil C3 Portal.
Always : 

Active les opérations All File à partir 
d’un appareil CCM ou C3 Portal tout 
le temps.

Onetime : 
Active les opérations All File à partir 
d’un appareil CCM ou C3 Portal une 
seule fois.

Off : 
Désactive les opérations All File à 
partir d’un appareil CCM ou C3 Portal.

Reset 
Execute / Cancel

Réinitialise les réglages de NCM Settings 
aux réglages par défaut. Execute : 
fonction Execute.
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Network >Network Client Mode
Définit les réglages relatifs au mode client réseau.

Élément Réglage de sous-éléments Description

NCM 
Settings2

Identique à NCM Settings1.

NCM 
Settings3

Identique à NCM Settings1.

Streaming 
Quality

Normal / High Définit la qualité de diffusion continue.

[Remarque]
Ce réglage est également réinitialisé lorsque 
All Reset >Reset without Network (page 129) 
du menu Maintenance est exécuté.

Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément Réglage de sous-éléments Description

Auto Upload On / Off Active/désactive le téléchargement 
automatique des fichiers originaux.

[Remarque]
Lorsque Simul Rec >Setting (page 98) dans 
le menu Project est réglé sur On, les plans 
enregistrés sur le support dans la fente B ne 
sont pas téléchargés automatiquement.

Auto Upload 
(Proxy)

On / Off / Chunk On : 
Active le transfert automatique de 
fichiers proxy.

Off : 
Désactive le transfert automatique de 
fichiers proxy.

Chunk : 
Télécharge un fichier proxy enregistré 
par fragments automatiquement.

Default 
Upload 
Server

Sélectionne le serveur de téléchargement 
pour les fichiers. Le serveur sélectionné 
ici devient la destination de 
téléchargement automatique pour les 
fichiers proxy et la destination de 
téléchargement pour les fichiers à partir 
de l’écran des miniatures.
Affiche le nom d’affichage configuré 
dans Server Settings (NCM) et Server 
Settings 1 à 3.

Clear 
Completed 
Jobs

Execute / Cancel Supprime de la liste les tâches de 
transfert terminées.
Execute : fonction Execute.

Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément Réglage de sous-éléments Description

Clear All Jobs Execute / Cancel Supprime de la liste toutes les tâches de 
transfert.
Execute : fonction Execute.

View Job List Affiche la liste des tâches de transfert.

Server 
Settings 
(NCM)

Affiche le nom d’affichage du serveur 
NCM et du service (CCM).

Display Name Affiche le nom d’affichage du serveur 
NCM.

Service Affiche le service.

Server 
Settings1

Display Name Règle le nom d’affichage indiqué dans le 
menu de configuration de destination de 
transfert.

Service 
FTP

Permet d’afficher le type de serveur.

Host Name Règle le nom d’hôte du serveur de 
destination de transfert.

Port (1 à 65535 (21)) Règle le numéro de port du serveur de 
destination de transfert.

User Name Règle le nom d’utilisateur pour 
l’authentification de la connexion au 
serveur de destination de transfert.

Password Règle le mot de passe d’authentification 
de la connexion au serveur de 
destination de transfert.

Passive Mode 
On / Off

Active/désactive le mode PASV.

Destination Directory Saisissez le nom du répertoire de 
destination de transfert.

Using Secure Protocol 
On / Off

Règle l’utilisation (On) ou non (Off) d’un 
transfert FTP sécurisé (Mode FTPS 
Explicit : FTPES).

Root Certificate 
Load / Clear / None

Charge un certificat racine pour un 
transfert FTP sécurisé et supprime les 
réglages.

Root Certificate Status 
Loaded / No Certificate

Affiche l’état de chargement du certificat 
racine pour un transfert FTP sécurisé.

Reset 
Execute / Cancel

Réinitialise les réglages de Server 
Settings aux réglages par défaut.
Execute : fonction Execute.



6. Affichage et réglages de menu : Menu Network128

Network >File Transfer
Définit les réglages liés aux transferts de fichiers.

Élément Réglage de sous-éléments Description

Server 
Settings2

Identique à Server Settings1.

Server 
Settings3

Identique à Server Settings1.

Network >Network Reset
Réinitialise les réglages de réseau.

Élément Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise les réglages de réseau.
Execute : fonction Execute.
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Menu Maintenance
Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Maintenance >Language
Règle la langue d’affichage.

Élément Réglage de sous-éléments Description

Select Règle la langue d’affichage.
SET : règle la langue.

Maintenance >Clock Set
Définit les réglages de l’horloge interne.

Élément Réglage de sous-éléments Description

Time Zone UTC – 12:00 à UTC + 14:00 Règle le décalage horaire par rapport au 
temps universel, par incréments de 30 
minutes.

Date Mode YYMMDD / MMDDYY / DDMMYY Sélectionne le format d’affichage pour 
les dates.
YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

12h/24h 12h / 24h Sélectionne le format d’affichage de 
l’horloge.
12h : mode 12 heures
24h : mode 24 heures

Date Règle la date actuelle.
SET : règle la valeur.

Time Règle l’heure actuelle.
SET : règle la valeur.

Maintenance >Network Public Key
Règle les réglages relatifs aux clés publiques.

Élément Réglage de sous-éléments Description

Key Creation Execute / Cancel Génère une clé publique.
Execute : fonction Execute.

Key Clear Execute / Cancel Supprime la clé publique enregistrée sur 
l’appareil.
Execute : fonction Execute.

Maintenance >Network Public Key
Règle les réglages relatifs aux clés publiques.

Élément Réglage de sous-éléments Description

Create Key 
Date

Affiche la date de génération de la clé 
publique dans le format suivant.

Année en 4 chiffres + mois en 
2 chiffres + jour en 2 chiffres + heures 
en 2 chiffres (24 heures) + minutes en 
2 chiffres + secondes en 2 chiffres
Exemple d’affichage : pour le 
01/12/2020 à 12:34:56  
20201201123456

Maintenance >All Reset
Réinitialise les réglages aux valeurs par défaut.

Élément Réglage de sous-éléments Description

Reset Execute / Cancel Réinitialise tous les réglages à leurs 
valeurs par défaut.
Execute : fonction Execute.

Reset without 
Network

Execute / Cancel Réinitialise les réglages du menu, à 
l’exception des réglages du menu 
Network, à l’état d’usine par défaut.

[Remarque]
Network Client Mode >Streaming Quality 
(page 127) dans le menu Network est 
réinitialisé au réglage d’usine par défaut.

Maintenance >Hours Meter
Affiche la durée de fonctionnement cumulée.

Élément Réglage de sous-éléments Description

Hours 
(System)

Affiche les heures d’utilisation cumulées 
(ne peut pas être réinitialisé).

Hours (Reset) Affiche les heures d’utilisation cumulées 
(peut être réinitialisé).

Reset Execute / Cancel Réinitialise l’affichage de Hours (Reset) à 
0.
Execute : fonction Execute.
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Maintenance >Version
Affiche les informations de version.

Élément Réglage de sous-éléments Description

Version 
Number

Vx.xx Affiche la version du logiciel du 
caméscope.

Ext. Unit 
Version 
Number

Vx.xx Affiche la version du logiciel du module 
XDCA-FX9.

Version Up Execute / Cancel Met à jour le caméscope.*

Execute : fonction Execute.
* Cette fonction met le logiciel du caméscope 

à jour.

Lens Version 
Number

Vxx Affiche le numéro de version du logiciel 
d’un objectif à monture E.
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Enregistrement et chargement des données de configuration

Données de configuration

Vous pouvez sauvegarder les réglages du 
menu de configuration dans la mémoire 
interne du caméscope ou sur des cartes SD 
et un support « Memory Stick ». Vous pouvez 
également sauvegarder un fichier All sur un 
service Cloud. Cela vous permet de rappeler 
rapidement un ensemble de réglages de 
menu approprié à la situation actuelle.
Les données de configuration sont 
sauvegardées dans les catégories suivantes.

Fichiers utilisateur
Les fichiers utilisateur enregistrent les 
éléments et les données de réglage du menu 
User personnalisable.
Vous pouvez sauvegarder jusqu’à 64 fichiers 
sur une carte SD ou un support « Memory 
Stick ».
En chargeant ce fichier dans la mémoire du 
caméscope, vous pouvez personnaliser la 
configuration du menu User.

Les fichiers ALL (tous les réglages)
Les fichiers ALL sauvegardent les données de 
configuration de tous les menus. Vous pouvez 
sauvegarder jusqu’à 64 fichiers sur une carte 
SD ou un support « Memory Stick ». Jusqu’à 
120 fichiers peuvent être enregistrés sur C3 
Portal (service Cloud), comprenant jusqu’à 
60 fichiers privés et 60 fichiers partagés.

[Remarque]
Les données spécifiques à un dispositif (ombrage, 
niveaux de sortie et autres données nécessitant un 
réglage pour le dispositif spécifique) ne sont pas 
sauvegardées.

Fichiers de scène
Les fichiers de scène sauvegardent des 
réglages pour les éléments du menu Paint 
configurés pour des scènes. Vous pouvez 
sauvegarder jusqu’à 5 fichiers dans la 

mémoire interne du caméscope et jusqu’à 
64 fichiers sur une carte SD ou un support 
« Memory Stick ».

Sauvegarde d’un fichier 
utilisateur/fichier ALL

Enregistrement sur une carte mémoire

1 Insérez la carte SD ou le support 
« Memory Stick » dans le logement de 
carte UTILITY SD/MS (page 8) avec 
l’étiquette orientée vers la droite.

2 Pour un fichier utilisateur, sélectionnez 
User File >Save to Utility SD/MS 
(page 103) dans le menu Project.
Pour un fichier ALL, sélectionnez All File 
>Save to Utility SD/MS (page 103) dans 
le menu Project.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
File ID est généré automatiquement, mais 
vous pouvez le modifier.

4 Sélectionnez Execute sur l’écran de 
confirmation.

Enregistrement d’un fichier ALL sur un 
service Cloud

1 Connectez-vous à l’appareil depuis 
l’application pour smartphone « C3 Portal 
App » (page 71).

2 Sélectionnez All File >Save to 
Cloud(Private) ou Save to Cloud(Share) 
(page 103) dans le menu Project.
Un écran de destination de sauvegarde de 
fichiers apparaît.

3 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
File ID est généré automatiquement, mais 
vous pouvez le modifier.

4 Sélectionnez Execute sur l’écran de 
confirmation.

Chargement d’un fichier 
utilisateur/fichier ALL

Chargement depuis une carte mémoire

1 Insérez la carte SD ou le support 
« Memory Stick » sur laquelle ou lequel le 
fichier est sauvegardé dans le logement 
de carte UTILITY SD/MS (page 8) avec 
l’étiquette orientée vers la droite.

2 Pour un fichier utilisateur, sélectionnez 
User File >Load from Utility SD/MS 
(page 103) dans le menu Project.
Pour un fichier ALL, sélectionnez All File 
>Load from Utility SD/MS (page 103) 
dans le menu Project.
Un écran de liste de fichiers s’affiche.

3 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4 Sélectionnez Execute.

[Remarques]
ˎˎ L’appareil redémarrera automatiquement après avoir 

chargé les données de configuration.
ˎˎ Lorsque All File >Load Network Data dans le menu 

Project est réglé sur Off, tous les réglages du fichier 
ALL sont chargés à l’exception des réglages du menu 
Network.

Chargement d’un fichier ALL depuis un 
service Cloud

1 Connectez-vous à l’appareil depuis 
l’application pour smartphone « C3 Portal 
App » (page 71).

2 Sélectionnez All File >Load from 
Cloud(Private) ou Load from Cloud(Share) 
(page 103) dans le menu Project.
Un écran de liste de fichiers s’affiche.

3 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4 Sélectionnez Execute.
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Enregistrement d’un fichier de 
scène

Pour sauvegarder dans la mémoire 
interne

1 Sélectionnez Scene File >Store Internal 
Memory dans le menu Paint (page 108).
Un écran avec la liste des fichiers de scène 
apparaît.
Si File ID est réglé sur la destination 
« Standard », les réglages standard 
préconfigurés sont sauvegardés.

2 Sélectionnez une destination 
d’enregistrement.
Le fichier de scène est sauvegardé, et 
écrase tout fichier existant, dans le fichier 
de destination sélectionné.

3 Sélectionnez Execute sur l’écran de 
confirmation.

Pour sauvegarder sur une carte SD ou 
un support « Memory Stick »

1 Insérez la carte SD ou le support 
« Memory Stick » dans le logement de 
carte UTILITY SD/MS (page 8) avec 
l’étiquette orientée vers la droite.

2 Sélectionnez Scene File >Save to Utility 
SD/MS dans le menu Paint (page 108).
Un écran de destination de sauvegarde de 
fichiers de scène apparaît.

3 Sélectionnez une rangée « No File » dans 
l’écran de destination d’enregistrement.
Sélectionner une rangée avec la saisie File 
ID écrasera le fichier sélectionné.
File ID est généré automatiquement, mais 
vous pouvez le modifier.

4 Sélectionnez Execute sur l’écran de 
confirmation.

Chargement d’un fichier de scène

Pour charger depuis la mémoire interne

1 Sélectionnez Scene File >Recall Internal 
Memory dans le menu Paint (page 108).
Un écran avec la liste des fichiers de scène 
apparaît.

2 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

3 Sélectionnez Execute.

 [Conseil]
Les fichiers de scène peuvent également être 
chargés en utilisant Direct Menu (page 48).

Pour charger depuis une carte SD ou un 
support « Memory Stick »

1 Insérez la carte SD ou le support 
« Memory Stick » sur laquelle ou lequel le 
fichier scène est sauvegardé dans le 
logement de carte UTILITY SD/MS 
(page 8) avec l’étiquette orientée vers 
la droite.

2 Sélectionnez Scene File >Load from Utility 
SD/MS dans le menu Paint (page 108).
Un écran avec la liste des fichiers de scène 
apparaît.

3 Sélectionnez un fichier à charger.
Un écran de confirmation apparaît.

4 Sélectionnez Execute.

Modification de l’identifiant de 
fichier

1 Pour un fichier utilisateur, sélectionnez 
User File >File ID dans le menu Project 
(page 103).
Pour un fichier ALL, sélectionnez All File 
>File ID dans le menu Project (page 103).
Pour un fichier de scène, sélectionnez 
Scene File >File ID dans le menu Paint 
(page 108).
Un écran permettant de modifier 
l’identifiant de fichier apparaît.

2 Avec les touches fléchées (page 7) ou 
la molette multifonction (page 4), 
sélectionnez un caractère, puis appuyez 
sur la touche SET (page 7) ou sur la 
molette multifonction.

3 Répétez l’étape 2 si nécessaire.

4 Lorsque vous avez saisi tous les 
caractères, sélectionnez Done.
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Connexion d’un panneau de télécommande
La connexion d’un panneau de télécommande 
RCP1500/1501/1530/3100/3500/3501 ou 
similaire à l’appareil à l’aide d’un câble LAN 
permet de contrôler certaines fonctions de 
l’appareil à partir de ce dispositif distant.

Connexion d’un panneau de 
télécommande

1 Configurez les réglages du réseau LAN 
filaire comme indiqué dans « Connexion à 
un dispositif à l’aide d’un câble LAN » 
(page 63).

2 Réglez Wired LAN >Camera Remote 
Control (page 125) dans le menu 
Network sur Enable.

3 Réglez RCP >CNS Mode (page 120) dans 
le menu Technical sur Bridge.

4 Réglez le panneau de télécommande sur 
le mode BRIDGE.

5 Réglez l’adresse IP de cet appareil sur le 
panneau de télécommande.
Pour plus de détails sur la configuration, 
reportez-vous au mode d’emploi de 
chaque panneau de télécommande.

6 Connectez-vous à un panneau de 
télécommande en connectant le 
connecteur LAN filaire du XDCA-FX9 
(page 26) fixé au caméscope à un 
commutateur LAN à l’aide d’un câble LAN.

Panneau de 
télécommande

Concentrateur de 
commutation compatible 
PoE

7 Mettez l’appareil sous tension.
L’appareil passe en mode de 
télécommande, ce qui permet de 
contrôler les opérations de prise de vue 
de l’appareil à partir du panneau de 
télécommande.

[Remarques]
ˎˎ La connexion par LAN sans fil n’est pas possible.
ˎˎ La connexion via Internet n’est pas possible.
ˎˎ D’autres fonctions réseau ne peuvent pas être 

utilisées en même temps.

Sortie du mode de télécommande

Mettez l’appareil hors tension et déconnectez 
le panneau de télécommande.
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Connexion des moniteurs externes et des dispositifs d’enregistrement
Pour afficher les images enregistrées/lues sur 
un moniteur externe, sélectionnez le signal 
de sortie du caméscope et utilisez un câble 
approprié pour le moniteur à raccorder.
Vous pouvez également raccorder des 
dispositifs d’enregistrement, tels qu’un 
magnétoscope, et enregistrer le signal de 
sortie depuis le caméscope.
Vous pouvez afficher les mêmes informations 
qui sont visibles dans le viseur, telles que 
les informations d’état et les menus, sur un 
moniteur externe. Réglez Output Display 
(page 112) dans le menu Monitoring sur 
On pour le type de signal correspondant à 
émettre vers le moniteur.

Connecteur SDI OUT (de type BNC)

Définissez le réglage d’activation/de 
désactivation de la sortie, ainsi que le 
format de sortie dans le menu Monitoring 
(page 112).
Utilisez un câble coaxial de 75 Ω disponible 
dans le commerce pour le branchement.

[Remarque]
Vérifiez que le branchement entre le caméscope et le 
dispositif externe est mis à la terre avant d’allumer les 
dispositifs.

(Il est recommandé d’allumer le caméscope 
et le dispositif externe après avoir branché le 
câble coaxial de 75 Ω.)
Si le dispositif externe doit être raccordé au 
caméscope pendant que le caméscope est 
allumé, raccordez d’abord le câble coaxial de 
75 Ω au dispositif externe, puis raccordez-le au 
caméscope.

Pour commencer l’enregistrement sur le 
caméscope et sur le dispositif externe 
de manière simultanée

Lorsque la sortie de signal SDI est activée, 
réglez SDI/HDMI Rec Control (page 99) 
>Setting dans le menu Project sur SDI/HDMI 
Remote I/F ou Parallel Rec pour activer la 
sortie d’un signal de déclenchement REC vers 
le dispositif externe raccordé au connecteur 
SDI OUT. Cela permettra de synchroniser 
l’enregistrement sur le dispositif externe avec 
le caméscope.

[Remarques]
ˎˎ Si un dispositif externe raccordé ne prend pas en 

charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.
ˎˎ Lorsque la touche d’enregistrement START/STOP et 

celle d’enregistrement START/STOP de la poignée 
sont réglées pour commander un support différent, le 
signal de déclenchement REC est émis en fonction de 
l’opération de la fente A.

Connecteur HDMI OUT (connecteur 
de type A)

Définissez le réglage d’activation/de 
désactivation de la sortie, ainsi que le 
format de sortie dans le menu Monitoring 
(page 112).
Utilisez un câble HDMI haute vitesse 
disponible dans le commerce pour le 
branchement.
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Synchronisation externe
Pendant une prise de vue avec plusieurs 
caméscopes, ces derniers peuvent être 
synchronisés sur un signal de référence 
spécifique ou un code temporel via le 
connecteur de verrouillage de synchronisation 
des caméscopes.

Synchronisation de la phase des 
signaux vidéo (synchronisation)

Configurez le commutateur de sélection 
IN/OUT (page 8) du caméscope sur la 
position IN et envoyez un signal de référence 
au connecteur GENLOCK IN/REF OUT 
(page 8) afin d’activer le verrouillage de 
synchronisation.
Les signaux de référence pouvant être 
utilisés varient en fonction de la fréquence 
du système du format d’enregistrement 
sélectionné.

Fréquence du 
système du 
format 
d’enregistrement

Signaux de référence 
valides

59.94P 1920×1080 59.94i 
720×486 59.94i 
1280×720 59.94P

50P 1920×1080 50i 
720×576 50i 
1280×720 50P

29.97P 1920×1080 59.94i 
720×486 59.94i

25P 1920×1080 50i 
720×576 50i

24P 1920×1080 48i(24PsF)

23.98P 1920×1080 47.95i (23.98PsF)

59.94i 1920×1080 59.94i 
720×486 59.94i

50i 1920×1080 50i 
720×576 50i

[Remarques]
ˎˎ Si le signal de référence est instable, la 

synchronisation ne peut pas être achevée.
ˎˎ La sous-porteuse n’est pas synchronisée.

Verrouillage du code temporel sur 
d’autres dispositifs

Réglez l’appareil fournissant le code temporel 
sur un mode dans lequel la sortie de code 
temporel continue à défiler (comme Free Run 
ou Clock).

1 Réglez Timecode (page 109) dans le 
menu TC/Media de la manière suivante.
Mode : Preset
Run : Free Run

2 Appuyez sur la touche personnalisable 
(page 48) à laquelle la fonction 
DURATION/TC/UBIT consistant à afficher 
le code temporel sur l’écran est attribuée.

3 Vérifiez que le commutateur de sélection 
IN/OUT (page 8) est positionné sur IN, 
puis envoyez un signal vidéo de référence 
HD ou SD au connecteur GENLOCK IN/REF 
OUT et le code temporel de référence au 
connecteur TC IN/OUT.

Le générateur de code temporel du 
caméscope acquiert le verrou avec le code 
temporel de référence et « EXT-LK » apparaît à 
l’écran.
Une fois que 10 secondes environ se sont 
écoulées après le verrouillage du code 
temporel, l’état de verrouillage externe 
est maintenu, même si la source de 
code temporel de référence externe est 
déconnectée.

[Remarques]
ˎˎ Vérifiez que le code temporel de référence et le signal 

vidéo de référence fournis sont en relation de phase 
conforme à la norme de code temporel SMPTE.
ˎˎ Lors de l’utilisation d’un verrou externe, le code 

temporel acquiert instantanément le verrou avec 
le code temporel externe et la valeur de code 
temporel externe apparaît dans la zone d’affichage 
des données. Cependant, ne commencez pas 
immédiatement l’enregistrement. Patientez quelques 
secondes le temps que le générateur de code 
temporel se stabilise avant l’enregistrement.
ˎˎ Si la fréquence du signal vidéo de référence et la 

fréquence d’images sur le caméscope ne sont pas 
les mêmes, un verrou ne peut pas être acquis et le 
caméscope ne fonctionnera pas correctement. Si cela 
se produit, le code temporel n’acquerra pas de verrou 
correctement avec le code temporel externe.
ˎˎ Si la source de code temporel externe est 

déconnectée, le code temporel peut changer d’une 
image par heure, par rapport au code temporel de 
référence.

Pour déverrouiller le verrou externe

Changez le réglage Timecode dans le menu 
TC/Media.
La synchronisation externe se déclenche 
également en cas de modification de la 
fréquence du système et lorsque vous 
démarrez un enregistrement en mode 
d’enregistrement spécial (Slow & Quick Motion 
ou Interval Rec).

Synchronisation du code temporel 
d’un autre dispositif avec le code 
temporel du caméscope

Réglez l’appareil fournissant le code temporel 
sur un mode dans lequel la sortie de code 
temporel continue à défiler (comme Free Run 
ou Clock).

1 Réglez le code temporel du caméscope en 
utilisant Timecode (page 109) dans le 
menu TC/Media.

2 Vérifiez que le commutateur de sélection 
IN/OUT (page 8) est réglé sur la 
position OUT et connectez le connecteur 
TC IN/OUT et le connecteur GENLOCK IN/
REF OUT sur l’entrée de code temporel et 
l’entrée de signal de référence, 
respectivement, du dispositif que vous 
souhaitez synchroniser.
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Gestion/Edition de plans grâce à un ordinateur

Connexion à l’aide d’un câble USB

Utilisation d’un lecteur de carte XQD (en 
option)

Raccordez un lecteur de cartes XQD à l’aide 
d’un câble USB et insérez une carte mémoire 
dans le logement. La carte mémoire est 
reconnue comme un lecteur d’extension de 
l’ordinateur. Sur les ordinateurs compatibles, 
vous pouvez importer des plans à haute 
vitesse à l’aide du mode de stockage de 
masse du caméscope.

Utilisation du mode de stockage de 
masse

Raccordez le caméscope à l’aide d’un câble 
USB et insérez une carte mémoire dans le 
logement de carte XQD A ou B. La carte 
mémoire est reconnue comme un lecteur 
d’extension de l’ordinateur.

1 Retirez la télécommande de poignée du 
caméscope et raccordez le connecteur 
Multi/USB (page 4) à l’ordinateur à 
l’aide d’un câble USB.

2 Placez le commutateur POWER du 
caméscope sur ON.
Un message apparaît sur l’écran du viseur, 
vous demandant si vous souhaitez activer 
la connexion USB.

 [Remarque]
Le message de confirmation de connexion USB 
n’est pas affiché tant qu’un autre message de 
confirmation ou de progression est affiché, par 
exemple, lors du formatage ou de la restauration 
d’une carte mémoire XQD.
Le message de confirmation est affiché lorsque 
l’exécution du formatage ou de la restauration est 
terminée. Le message de confirmation USB n’est 
pas non plus affiché lorsque l’écran des propriétés 

du plan est affiché. Le message est affiché lorsque 
le traitement se termine ou lorsque vous revenez à 
l’écran de miniatures.

3 Tournez la molette multifonction pour 
sélectionner Execute.

4 Sous Windows, vérifiez que la carte est 
ajoutée en tant que disque amovible dans 
la fenêtre « Poste de travail ».
Sous Mac, vérifiez que le dossier appelé 
« NO NAME » ou « Untitled » (éditable) est 
créé sur le bureau.

[Remarques]
ˎˎ N’effectuez pas les opérations suivantes si l’indicateur 

d’accès est allumé en rouge.
 – Mise hors tension. Déconnexion du cordon 

d’alimentation
 – Retrait de la carte mémoire XQD
 – Déconnexion du câble USB

ˎˎ Le fonctionnement n’est pas garanti avec tous les 
ordinateurs.

Utilisation d’un système de 
montage non linéaire

Dans un système de montage non linéaire, 
un logiciel de montage (en option) qui prend 
en charge les formats enregistrés par le 
caméscope est nécessaire.
Utilisez un logiciel d’application dédié pour 
enregistrer au préalable les plans que vous 
souhaitez éditer sur le disque dur de votre 
ordinateur.
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Précautions d’utilisation
Concernant la condensation

Si l’appareil est soudainement déplacé 
d’un endroit froid à un endroit chaud, ou 
si la température ambiante augmente 
brusquement, de l’humidité peut se former 
sur la surface externe de l’appareil et/ou à 
l’intérieur de l’appareil. Ce phénomène est 
connu sous le nom de condensation. Si de 
la condensation se produit, mettez l’appareil 
hors tension et patientez le temps que la 
condensation disparaisse avant d’utiliser 
l’appareil. L’utilisation de l’appareil avec de la 
condensation pourrait endommager l’appareil.

Concernant les écrans LCD

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, 
ce qui permet d’obtenir un taux d’au moins 
99,99% de pixels qui fonctionnent. Ainsi, 
un infime pourcentage de pixels peut être 
« bloqué », c’est-à-dire toujours éteint (noir), 
toujours éclairé (rouge, vert ou bleu), ou 
clignotant. En outre, après une longue période 
d’utilisation, en raison des caractéristiques 
physiques de l’afficheur à cristaux liquides, 
de tels pixels « bloqués » peuvent apparaître 
spontanément. Ces problèmes ne sont pas 
graves. Notez que ces problèmes n’ont aucun 
effet sur les données enregistrées.

Phénomènes spécifiques aux capteurs 
d’images CMOS de caméra

[Remarque]
Les phénomènes suivants, qui peuvent se produire 
sur les images, sont propres aux capteurs d’images. Ils 
n’indiquent en aucun cas un dysfonctionnement.

Taches blanches
Bien que les capteurs soient fabriqués à 
l’aide de technologies de haute précision, 
il peut arriver (dans de rares cas) que des 

petites taches blanches apparaissent sur 
l’écran, celles-ci sont causées par les rayons 
cosmiques, etc.
Ce phénomène est inhérent à la technologie 
des capteurs d’images et ne signale en aucun 
cas un dysfonctionnement.
Les taches blanches sont surtout visibles dans 
les cas suivants :
ˎˎ Lors du fonctionnement à haute 
température ambiante
ˎˎ Lorsque vous avez augmenté le gain (la 
sensibilité)

Scintillement
Si l’enregistrement est effectué sous un 
éclairage fluorescent, des lampes au sodium, 
à vapeur de mercure ou LED, l’écran peut 
scintiller ou les couleurs peuvent varier.

Concernant les pièces consommables

ˎˎ Le ventilateur et la batterie sont 
des consommables qui doivent être 
régulièrement remplacés.  
Lorsque vous utilisez l’appareil à 
température ambiante, le cycle de 
remplacement est d’environ 5 ans. Mais, 
ce cycle de remplacement ne représente 
qu’une indication et ne garantit pas la durée 
de vie de ces consommables. Pour plus de 
détails sur le remplacement de ces pièces, 
veuillez contacter votre revendeur.
ˎˎ La durée de vie l’adaptateur CA et du 
condensateur électrolytique est de 5 
ans environ, sous des températures de 
fonctionnement normales et pour un usage 
normal (8 heures par jour, 25 jours par 
mois). Si l’utilisation dépasse la fréquence 
d’utilisation normale, la durée de vie peut 
être réduite en conséquence.
ˎˎ La borne de batterie de cet appareil 
(le connecteur pour les packs batterie 
et les adaptateurs CA) est une pièce 
consommable.  

L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de 
batterie sont cintrées ou déformées par 
les chocs ou les vibrations, ou si elles sont 
touchées par la corrosion en raison d’une 
utilisation prolongée en extérieur.  
Des inspections périodiques sont 
recommandées pour que l’appareil 
continue à fonctionner correctement et 
pour prolonger la durée de son utilisation. 
Contactez un vendeur ou un technicien Sony 
pour plus d’informations sur les inspections.

A propos de la batterie rechargeable 
intégrée

Le caméscope possède une batterie 
rechargeable intégrée afin de stocker la 
date, l’heure et d’autres réglages, même 
lorsque le caméscope est éteint. La batterie 
rechargeable intégrée sera chargée après 
24 h si l’unité est connectée à une prise 
électrique grâce à l’adaptateur CA, ou si un 
pack batterie complètement chargé est fixé, 
que le caméscope soit allumé ou éteint. 
La batterie rechargeable sera entièrement 
déchargée après environ 3 mois si l’adaptateur 
CA n’est pas branché ou si le caméscope 
est utilisé sans que le pack batterie ne soit 
fixé. Utilisez votre caméscope après avoir 
chargé la batterie. Néanmoins, même si la 
batterie rechargeable n’est pas chargée, le 
fonctionnement du caméscope n’est pas 
affecté tant que vous n’avez pas besoin 
d’enregistrer la date.

Réglage automatique du capteur 
d’image

Si l’APR n’a pas été exécuté depuis qu’une 
durée définie s’est écoulée après le réglage de 
la date et de l’heure, un message vous invitant 
à exécuter l’APR s’affiche.

Emplacements d’utilisation et de 
stockage

Stockez dans un lieu aéré et de niveau.
Évitez d’utiliser ou de stocker l’unité dans les 
endroits suivants.
ˎˎ Les endroits excessivement chauds ou froids 
(plage de température de fonctionnement : 
0 °C à 40 °C (32 °F à 104 °F))  
N’oubliez pas qu’en été, dans les climats 
chauds, la température à l’intérieur d’un 
véhicule aux vitres fermées peut facilement 
dépasser 50 °C (122 °F).
ˎˎ Lieux humides ou poussiéreux
ˎˎ Lieux où l’unité risque d’être exposée à la 
pluie
ˎˎ Lieux soumis à de violentes vibrations
ˎˎ À proximité de puissants champs 
magnétiques
ˎˎ À proximité d’émetteurs radio ou de 
télévision générant de puissants champs 
magnétiques
ˎˎ Sous la lumière directe du soleil ou à 
proximité de chauffages pendant de 
longues périodes

Pour empêcher les interférences 
électromagnétiques dues aux dispositifs 
de communication portables

L’utilisation des téléphones portables et 
d’autres dispositifs de communication à 
proximité de la caméra peut provoquer des 
dysfonctionnements et des interférences avec 
les signaux audio et vidéo. Il est recommandé 
de désactiver les dispositifs de communication 
portables à proximité de la caméra.

Remarque sur les faisceaux laser

Les faisceaux laser peuvent endommager le 
capteur d’image CMOS. Si vous filmez une 
scène comprenant un faisceau laser, veillez à 
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ce que celui-ci ne soit pas dirigé directement 
vers l’objectif de l’appareil. En particulier, les 
faisceaux laser haute puissance provenant de 
dispositifs médicaux ou d’autres dispositifs 
peuvent causer des dommages dus à la 
lumière réfléchie et à la lumière diffuse.

Mesures de sécurité

ˎˎ Utilisez avec un pare-feu sécurisé. Ne 
connectez pas l’unité à un réseau où des 
appareils non fiables peuvent se connecter.
ˎˎ Si FTPS est disponible, utilisez-le. Les 
contenus, noms d’utilisateur et mots de 
passe ne sont pas cryptés lorsque vous 
utilisez le FTP normal.
ˎˎ SONY NE PEUT ÊTRE TENUE RESPONSABLE 
DE TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, RÉSULTANT D’UNE INCAPACITÉ 
À METTRE EN PLACE DES MESURES DE 
SÉCURITÉ ADAPTÉES POUR LES DISPOSITIFS 
DE TRANSMISSION, DE FUITES DE DONNÉES 
INÉVITABLES DUES AUX SPÉCIFICATIONS 
DE TRANSMISSION OU DE TOUT AUTRE 
PROBLÈME DE SÉCURITÉ.
ˎˎ Selon l’environnement d’exploitation, il est 
possible que des tiers non autorisés sur le 
réseau puissent accéder à l’appareil. Avant 
de connecter l’appareil au réseau, vérifiez 
que le réseau est bien protégé.
ˎˎ Le contenu des communications peut être 
intercepté à votre insu par des tiers non 
autorisés à proximité des signaux. Lors de 
communications LAN sans fil, appliquez des 
mesures de sécurité adaptées pour protéger 
le contenu des communications.
ˎˎ Pour des raisons de sécurité, lors de 
l’utilisation de cet appareil connecté au 
réseau, il est fortement recommandé de 
modifier la limitation d’accès des valeurs 
d’usine préréglées (page 123). En 
particulier, soyez prudent lorsque vous êtes 
connecté à un réseau ouvert.  
Du point de vue de la sécurité, il est 
recommandé de définir un mot de passe 

avec une chaîne de caractères suffisamment 
longue, difficile à deviner par les autres, et 
de le stocker en toute sécurité.
ˎˎ Ne consultez aucun autre site Web dans 
le navigateur Web pendant ou après la 
configuration.  
Étant donné que l’état de connexion est 
conservé dans le navigateur Web, fermez 
ce dernier lorsque la configuration est 
terminée pour empêcher tout tiers non 
autorisé d’utiliser l’appareil ou d’exécuter 
des programmes malveillants.
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Les réglages par défaut sont affichés en gras (par exemple, 1920×1080P (Level A)).

[Remarques]
ˎˎ La résolution du format de sortie est limitée par les réglages Rec Format >Frequency, Video Format et d’autres 

réglages dans le menu Project (page 96).
ˎˎ Aucune image de lecture n’est émise si la résolution de sortie vidéo est plus élevée que celle de l’image.

Formats de sortie du connecteur SDI OUT/HDMI OUT

Fréquence du 
système 
(Rec Format 
>Frequency dans 
le menu Project)

Format vidéo 
(Rec Format 
>Video Format 
dans le menu 
Project)

Format de sortie (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i

Fréquence du 
système 
(Rec Format 
>Frequency dans 
le menu Project)

Format vidéo 
(Rec Format 
>Video Format 
dans le menu 
Project)

Format de sortie (Monitoring >Output Format)

SDI1 SDI2 HDMI

59.94 / 50 1920×1080P /  
RAW uniquement1)

1920×1080P 
(Level A)

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level B)

1920×1080P 
(Level B)

–

1920×1080P 
(Level A)

1920×1080i 1920×1080i

1920×1080P 
(Level B)

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i

– – 720×480P/ 
720×576P

29.97 / 25 4096×2160P 4096×2160P – 4096×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

3840×2160P 3840×2160P – 3840×2160P

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

1920×1080P /  
RAW uniquement1)

1920×1080i(PsF) 1920×1080i(PsF) 1920×1080i(PsF)

24 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

RAW uniquement1) 1920×1080P 1920×1080P 1920×1080P

23.98 4096×2160P 4096×2160P – 4096×2160P

1920×1080P 1920×1080P 1920×1080P

3840×2160P 3840×2160P – 3840×2160P

1920×1080P 1920×1080P 1920×1080P

1920×1080P /  
RAW uniquement1)

1920×1080P 1920×1080P 1920×1080P

1) Sans enregistrement interne

Formats de sortie et limites
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Limites pour Monitor LUT

La fonction Monitor LUT est disponible en mode Cine EI lorsque la résolution d’enregistrement 
est de 4096×2160 ou 3840×2160.
Lorsque Monitor LUT Setting >Monitor Out du menu Shooting est réglé sur MLUT On et que la 
résolution de sortie d’image est de 1920×1080, la fonction Monitor LUT est appliquée à l’image 
émise.
Lorsque la résolution de sortie d’image est de 4096×2160 ou 3840×2160, l’image émise est 
identique à celle enregistrée.

Limites d’Output Display

L’intégration du menu et de l’état dans chaque signal de sortie (SDI1, SDI2, HDMI) est déterminée 
par la résolution de sortie d’Output Format et le réglage Output Display >Setting dans le menu 
Monitoring.

Résolution 
de sortie

Output Display 
>Setting

Output Display 
>SDI1

Output Display 
>SDI2

Output Display 
>HDMI

4K On On – (sortie Off) On

Off Off – (sortie Off) Off

HD On Off On On

Off Off Off Off
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Alimentation

Symptôme Cause Solution

Le caméscope ne se met pas 
sous tension.

Le pack batterie n’est pas 
mis en place et aucune 
alimentation n’est fournie au 
connecteur DC IN.

Mettez en place un pack batterie 
(page 19) ou connectez-vous à une 
source d’alimentation CA à l’aide d’un 
adaptateur CA (page 20).

Le pack batterie est 
totalement déchargé.

Remplacez-le par un pack batterie 
totalement chargé (page 19).

L’alimentation est 
interrompue pendant le 
fonctionnement.

Le pack batterie se décharge. Remplacez-le par un pack batterie 
totalement chargé (page 19).

Le pack batterie se décharge 
très rapidement.

La température ambiante est 
très basse.

Cela est dû aux caractéristiques de la 
batterie et ne constitue pas une 
anomalie.

La charge du pack batterie 
est inadéquate.

Rechargez le pack batterie (page 19).
Si le pack batterie se décharge 
rapidement même après avoir été 
totalement chargé, il se peut que sa 
durée de vie en service touche à sa fin. 
Remplacez-le par un neuf.

Enregistrement/lecture

Symptôme Cause Solution

L’enregistrement ne démarre 
pas lorsque vous appuyez 
sur la touche 
d’enregistrement.

La carte mémoire XQD est 
pleine.

Remplacez la carte mémoire XQD par 
une autre possédant suffisamment 
d’espace.

La carte mémoire XQD 
nécessite une restauration.

Restaurez la carte mémoire XQD 
(page 32).

L’enregistrement audio est 
impossible.

Les molettes AUDIO LEVEL 
(CH1/CH2/CH3/CH4) sont 
réglées sur le niveau 
minimum.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2/CH3/CH4) (page 46).

Le son enregistré est 
déformé.

Le niveau sonore est trop 
élevé.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2/CH3/CH4) (page 46).

Symptôme Cause Solution

L’enregistrement audio 
présente un niveau sonore 
élevé.

Le niveau sonore est trop 
bas.

Ajustez les niveaux d’enregistrement 
audio avec les molettes AUDIO LEVEL 
(CH1/CH2/CH3/CH4) (page 46).
Ajustez également le réglage INPUT 
MIC Reference sous Audio Input dans le 
menu Audio (page 115) lorsqu’un 
microphone externe est sélectionné.

Impossible de lire les plans. Le plan est en cours de 
modification.

La lecture des plans est impossible si 
vous avez modifié les noms de fichiers 
ou les dossiers ou si le plan est en cours 
d’utilisation sur un ordinateur. Il ne 
s’agit pas d’un dysfonctionnement.

Le plan est en cours 
d’enregistrement sur un 
autre appareil.

Il se peut que les plans enregistrés sur 
d’autres appareils soient illisibles ou 
s’affichent dans une taille incorrecte. Il 
ne s’agit pas d’un dysfonctionnement.

Dispositifs externes

Symptôme Solution

L’ordinateur ne reconnaît pas le 
caméscope.

Débranchez le câble USB de l’ordinateur, puis rebranchez-le 
correctement.

Débranchez le câble USB de l’ordinateur, redémarrez votre 
ordinateur, et suivez de nouveau les étapes dans le bon ordre.

Le chargement de plans sur 
l’ordinateur est impossible.

Débranchez le câble USB de l’ordinateur, redémarrez le caméscope, 
puis rebranchez-le.

Il faut installer un logiciel d’application pour charger des plans sur 
votre ordinateur (page 136).

Dépannage
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Connexion LAN sans fil

[Remarque]
Les obstructions et les interférences électromagnétiques entre le caméscope et le point d’accès au réseau LAN 
sans fil ou le terminal, ou l’environnement ambiant (comme les matériaux muraux) pourraient raccourcir la plage 
de communication ou empêcher complètement les connexions. Si vous rencontrez ces problèmes, vérifiez l’état 
de la connexion/communication après avoir déplacé le caméscope vers un nouvel emplacement ou rapproché le 
caméscope et le point d’accès/terminal.

Symptôme Solution

Un terminal ne peut pas accéder 
au caméscope.

 ˎ Vérifiez la connexion LAN sans fil (adresse IP, etc.).
 ˎ Il se peut que le réglage de la communication entre le point 
d’accès et le client soit invalide. Pour plus de détails, consultez le 
mode d’emploi du point d’accès.

Vous ne pouvez pas vous 
connecter au caméscope.

Vérifiez le nom d’utilisateur et le mot de passe que vous avez 
définis.

La télécommande Web 
n’apparaît pas.

Vérifiez le réglage de l’adresse IP.

Connexion Internet

Symptôme Solution

Échec de téléchargement du 
fichier.

Il se peut que le nom d’utilisateur et le mot de passe du serveur ne 
soient pas corrects.
Saisissez le nom d’utilisateur et le mot de passe corrects.

Le téléchargement du fichier 
n’est pas disponible.

Il se peut que l’état du signal 3G/4G soit mauvais.
Déplacez-vous vers un autre emplacement, et réessayez.

Lors de l’utilisation du filtre ND

Symptôme Solution

Le filtre ND ne se déplace pas. Vous pouvez positionner manuellement le filtre sur la position 
Clear à l’aide de la procédure suivante.

1 Placez le commutateur POWER du caméscope en position off.

2 Retirez le capuchon rond situé sur le côté inférieur.

3 Insérez un tournevis dans l’orifice et tournez-le dans le sens contraire des aiguilles d’une 
montre.
ˎˎ Le filtre ND se place en position Clear lorsque vous tournez dans le sens contraire des 
aiguilles d’une montre. Continuez à tourner jusqu’à atteindre la position Clear.
ˎˎ Utilisez un tournevis de ø2,4 mm ou moins de diamètre. La profondeur d’insertion du 
tournevis est d’environ 3,0 cm (1 3/16 po.).

Orifice de tournevis
(avec le capuchon retiré)

4 Placez le commutateur ND PRESET/VARIABLE(page 6) en position PRESET et réglez les 
touches haut/bas ND FILTER POSITION (page 6) sur la position CLEAR.

[Remarques]
ˎˎ N’utilisez pas la procédure ci-dessus pendant le fonctionnement normal. Utilisez uniquement cette procédure 

si le filtre ND ne se déplace pas. Le filtre ND peut être endommagé si cette procédure est utilisée pendant le 
fonctionnement normal.
ˎˎ Après avoir utilisé la procédure ci-dessus, consultez un centre de service Sony pour faire réparer le caméscope.
ˎˎ Si un message d’erreur apparaît toujours après avoir utilisé la procédure ci-dessus, la prise de vue est toujours 

possible.
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Si le caméscope détecte un avertissement, une précaution ou une opération qui nécessite une 
confirmation, un message s’affiche dans le viseur, le témoin d’enregistrement/de signalisation 
commence à clignoter et un avertissement sonore est émis.
Le son d’avertissement est émis depuis le haut-parleur intégré et les écouteurs connectés au 
connecteur pour casque.

Messages d’erreur

Le caméscope arrêtera l’opération si l’un des écrans suivants s’affiche.

Message du 
viseur

Avertissement 
sonore

Témoin 
d’enregistrement/
de signalisation

Cause et solution

E + code 
d’erreur

Continu Clignotement 
rapide

Indique une anomalie dans le caméscope. 
L’enregistrement s’arrête, même lorsque 
REC est affiché dans le viseur.
Mettez le caméscope hors tension, et vérifiez 
si vous détectez un problème au niveau des 
dispositifs, des câbles ou du support 
raccordés. Si l’erreur persiste après avoir remis 
le caméscope sous tension, contactez votre 
technicien Sony.
(Si le caméscope ne peut pas être mis hors 
tension en réglant le commutateur POWER 
sur OFF, retirez la batterie ou débranchez 
l’alimentation DC IN.)
Il se peut qu’aucun affichage d’erreur ni 
aucune alerte sonore d’avertissement ne 
survienne selon l’état du caméscope.

Messages d’avertissement

Suivez les instructions fournies si l’écran suivant s’affiche.

Message du 
viseur

Avertissement 
sonore

Témoin 
d’enregistrement/
de signalisation

Cause et solution

Battery Near 
End

Intermittent Clignotement La capacité restante du pack batterie est 
faible.
Rechargez-le dès que possible.

Message du 
viseur

Avertissement 
sonore

Témoin 
d’enregistrement/
de signalisation

Cause et solution

Battery End Continu Clignotement 
rapide

Le pack batterie est vide. L’enregistrement est 
désactivé.
Arrêtez les opérations et remplacez le pack 
batterie.

Temperature 
High

Intermittent Clignotement La température interne est élevée.
Mettez le caméscope hors tension et laissez-
le refroidir avant de le faire fonctionner à 
nouveau.

Voltage Low Intermittent Clignotement La tension DC IN est faible (niveau 1). Vérifiez 
la source d’alimentation.

Insufficient 
Voltage

Continu Clignotement 
rapide

La tension DC IN est trop faible (niveau 2). 
L’enregistrement est désactivé.
Raccordez une source d’alimentation 
différente.

Media Near 
Full

Intermittent Clignotement La capacité restante de la carte mémoire XQD 
est faible.
Remplacez-la dès que possible.

Media Full Continu Clignotement 
rapide

Les plans n’ont pas pu être enregistrés ni 
copiés car la capacité restante de la carte 
mémoire XQD n’est pas suffisante.
Remplacez-la immédiatement.

Clips Near 
Full

Intermittent Clignotement Le nombre de plans supplémentaires pouvant 
être enregistrés sur la carte mémoire XQD 
diminue.
Remplacez-la dès que possible.

Clips Full Continu Clignotement 
rapide

Le nombre maximum de plans pouvant être 
enregistrés sur la carte mémoire XQD a été 
atteint.
L’enregistrement ou la copie de plus de plans 
est impossible. Remplacez-la immédiatement.

Last Clip 
Recording

Intermittent Clignotement Le plan en cours d’enregistrement est le 
dernier plan qui peut être enregistré, étant 
donné que le nombre maximum de plans a 
été atteint.
Préparez une nouvelle carte mémoire XQD.

Media(A)1) 
Near Full

Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A)1) 
Full

Continu Clignotement 
rapide

Lorsque vous utilisez la fonction Simul Rec

Avertissements de fonctionnement
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Message du 
viseur

Avertissement 
sonore

Témoin 
d’enregistrement/
de signalisation

Cause et solution

Media(A)1) 
Clips Near 
Full

Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A)1) 
Clips Full

Continu Clignotement 
rapide

Lorsque vous utilisez la fonction Simul Rec

Media(A) 1) 
Last Clip Rec

Intermittent Clignotement Lorsque vous utilisez la fonction Simul Rec

Transfer Jobs 
Near Full

– – Le nombre de tâches de transfert de fichiers 
FTP pouvant être enregistrées diminue.

Transfer Jobs 
Full

– – Le nombre de tâches de transfert de fichiers 
FTP pouvant être enregistrées a atteint la 
limite supérieure. Pour ajouter une autre 
tâche, supprimez d’abord toute tâche non 
désirée.2)

1) « (B) » s’affiche pour la carte située dans le logement B.
2) Vous pouvez sélectionner et supprimer des tâches à l’aide de File Transfer >View Job List (page 127) dans le menu 

Network. Vous pouvez également supprimer des tâches depuis la liste de tâche CBM.

Messages de précaution concernant l’opération

Les messages de précaution et d’opération suivants peuvent apparaître au centre de 
l’écran. Suivez les instructions fournies pour résoudre le problème.

Message du viseur Cause et solution

Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Rechargez la batterie de secours.

Unknown Media (A) 1)

Please Change
Une carte mémoire qui a été divisée en plusieurs parties ou une 
carte mémoire non prise en charge par le caméscope a été 
insérée.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée.

Cannot Use Media (A) 1)

Unsupported File System
Une carte utilisant un système de fichiers différent ou une carte 
non formatée a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée ou formatée à l’aide du caméscope.

Message du viseur Cause et solution

Media Needs to be Restored Une erreur s’est produite avec la carte mémoire et la carte doit être 
restaurée.
Restaurez la carte mémoire.

Media Error
Cannot Record to Media(A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer une 
copie et de remplacer la carte mémoire.

Media Error
Cannot Use Media (A) 1)

La carte mémoire peut être endommagée et ne peut plus être 
utilisée pour l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée.

Media (A) 1) Error
Recording Halted
Playback Halted

L’enregistrement et la lecture se sont arrêtés parce qu’une erreur 
s’est produite pendant l’utilisation de la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit
Change Media (A) 1)

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte 
immédiatement. Si vous continuez à utiliser la carte, la carte risque 
de ne plus pouvoir enregistrer ou lire.
Pour plus de détails, reportez-vous au mode d’emploi de la carte 
mémoire.

Copy All Sub Clips
NG: Reached Clip Number Limit
NG: Same File Already Exists
NG: Not Enough Capacity

La copie de tous les sous-plans à l’aide de Copy All Sub Clips a 
échoué pour la raison affichée.

 ˎ Le nombre maximal de plans est atteint.
 ˎ Un fichier porte le même nom.
 ˎ La capacité restante est insuffisante pour effectuer la copie.

Remplacez le support.

The specified address is invalid. L’adresse spécifiée est invalide.
Vérifiez que le réglage est correct.

Cannot Use Specified Port 
Number

Le numéro de port spécifié est invalide.
Vérifiez que le réglage est correct.

Fan Stopped Le ventilateur intégré s’est arrêté.
Evitez l’utilisation à des températures élevées, débranchez 
l’alimentation et prenez contact avec votre technicien Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera 
Position
Please save All File again

Le réglage de format Clip Naming a été réinitialisé car un fichier 
ALL invalide a été chargé.
Configurez les réglages de format désiré, puis tentez à nouveau 
d’enregistrer le fichier ALL.

Lens I/F Error(xx:xx) Une erreur d’objectif a été détectée dans la communication I/F de 
l’objectif lors de la fixation d’un objectif à monture E.
Vérifiez l’état du raccordement à l’objectif à monture E.
Si le problème persiste, contactez votre technicien Sony en vous 
munissant du code d’erreur (cinq caractères entre parenthèses).
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Message du viseur Cause et solution

This Multi Term. acc is not 
supported by the device and 
cannot be used.
Please verify the compatibility.

Un accessoire incompatible a été détecté.
Le seul accessoire à terminaux multiples compatible avec l’unité 
est la télécommande de poignée fournie.

Failed Cette erreur peut apparaître si une adresse ne peut pas être 
obtenue avec DHCP réglé sur On.
Vérifiez les réglages du serveur DHCP.

Addition of auto upload job 
failed.

Le nombre maximum de tâches de transfert a été atteint.
Effacez toute tâche non désirée. Il est possible que le réglage de 
destination de téléchargement automatique pour les fichiers 
originaux ou proxy soit également incorrect. Vérifiez que le réglage 
est correct.

<SSID>Not found. Le réseau (point d’accès) avec le <SSID> spécifié est introuvable.
Vérifiez que le réglage est correct.

<SSID>Authentication Failed L’authentification de connexion sur le réseau (point d’accès) avec 
le <SSID> spécifié a échoué.
Vérifiez que le mot de passe et les autres réglages sont corrects.

An IP address conflict has 
occurred. Please check the 
network settings.

Il y a un conflit entre les adresses réseau des réglages du LAN sans 
fil, du modem, du LAN filaire ou entre les modems.
Changez l’adresse manuellement ou changez les réglages du 
routeur réseau.

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

L’adresse IP du mode de point d’accès de LAN sans fil a été 
modifiée en raison d’un conflit entre les adresses réseau du mode 
de point d’accès de LAN sans fil, du LAN filaire ou du modem.
Vérifiez le réglage de l’adresse IP.

1) « (B) » s’affiche pour la carte située dans le logement B.
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Éléments configurés dans le menu Setup

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Oui Oui

ISO/Gain<H> Oui Oui

ISO/Gain<M> Oui Oui

ISO/Gain<L> Oui Oui

Exposure Index<H> Oui Oui

Exposure Index<M> Oui Oui

Exposure Index<L> Oui Oui

Shockless Gain Oui Oui

Base Sensitivity Oui Oui

Base ISO Oui Oui

ND Filter Preset1 Oui Oui

Preset2 Oui Oui

Preset3 Oui Oui

Shutter Mode Oui Oui

Shutter Speed On/Off Oui Oui

Shutter Speed Oui Oui

Shutter Angle Oui Oui

ECS On/Off Oui Oui

ECS Frequency Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Oui Oui

Mode Oui Oui

Speed Oui Oui

AGC Oui Oui

AGC Limit Oui Oui

AGC Point Oui Oui

Auto Shutter Oui Oui

A.SHT Limit Oui Oui

A.SHT Point Oui Oui

Clip High light Oui Non

Detect Window Oui Non

Detect Window Indication Oui Oui

Average Peak Level Ratio Oui Non

Custom Width Oui Non

Custom Height Oui Non

Custom H Position Oui Non

Custom V Position Oui Non

White Preset White Oui Non

Color Temp <A> Oui Oui*1

Tint<A> Oui Oui*1

R Gain <A> Oui Oui*1

B Gain <A> Oui Oui*1

Color Temp <B> Oui Oui*1

Tint<B> Oui Oui*1

R Gain <B> Oui Oui*1

B Gain <B> Oui Oui*1

White Setting Shockless White Oui Non

ATW Speed Oui Non

White Switch<B> Oui Oui

Filter White Memory Oui Non

Eléments enregistrés dans les fichiers
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Oui Non

Offset Color Temp<A> Oui Non

Offset Tint<A> Oui Non

Offset White <B> Oui Non

Offset Color Temp<B> Oui Non

Offset Tint<B> Oui Non

Offset White<ATW> Oui Non

Offset Color Temp<ATW> Oui Non

Offset Tint<ATW> Oui Non

Focus AF Transition Speed Oui Non

AF Subj. Shift Sens. Oui Non

Focus Area Oui Non

Focus Area (AF-S) Oui Non

Face/Eye Detection AF Oui Non

Push AF Mode Oui Non

Touch Function in MF Oui Non

AF Assist Oui Non

S&Q Motion Setting Oui Non

Frame Rate Oui Non

Monitor LUT Category Oui Non

LUT Select Oui Non

User 3D LUT Select Oui Non

Monitor LUT Setting Internal Rec Oui Non

Monitor Out Oui Non

HD(Sub) Rec/Proxy – –

SDI1 – –

SDI2 – –

HDMI – –

VF/Streaming – –

Monitor 3D LUT Load from Utility SD/MS – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Reset – –

Reset All – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Noise Suppression Setting(SDR/HDR) Oui Oui

Level(SDR/HDR) Oui Oui

Setting(Cine EI) Oui Non

Level(Cine EI) Oui Non

Flicker Reduce Mode Oui Non

Frequency Oui Non

SteadyShot Setting Oui Non

Auto Black Balance Auto Black Balance – –

Project Base Setting Shooting Mode Oui Non

Rec Format Frequency Oui Non

Imager Scan Mode Oui Non

Codec Oui Non

RAW Output Format Oui Non

Video Format Oui Non

Cine EI Setting Color Gamut Oui Non

Embed LUT File Oui Non

HDR Setting VF SDR PreviewOui Oui Non

SDR Gain Oui Non

Simul Rec Setting Oui Non

Rec Button Set Oui Non

4K & HD (Sub) Rec Setting Oui Non

Proxy Rec Setting Oui Non

Proxy Format Oui Non

Audio Channel Oui Non

Chunk Oui Non

Interval Rec Setting Non Non

Interval Time Oui Non

Number of Frames Oui Non

Pre-Lighting Oui Non

Picture Cache Rec Setting Oui Non

Cache Rec Time Oui Non

SDI/HDMI Rec Control Setting Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Assignable Button <1> Oui Non

<2> Oui Non

<3> Oui Non

<4> Oui Non

<5> Oui Non

<6> Oui Non

<7> Oui Non

<8> Oui Non

<9> Oui Non

<10> Oui Non

Focus Hold Button Oui Non

Assignable Dial Assignable Dial Oui Non

Assignable Dial Direction Oui Non

Multi Function Dial Default Function Oui Non

User File Load from Utility SD/MS – –

Save to Utility SD/MS – –

File ID Non Non

Load Customize Data Oui Non

Load White Data Oui Non

All File Load from Utility SD/MS – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to Utility SD/MS – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Oui Non

Load Network Data Non Non

Planning Metadata Load from Media(A) – –

Load from Media(B) – –

Properties – –

Clear Memory – –

Clip Name Display Oui Non

Paint HDR Paint Setting HLG Look Oui Oui

HDR Black Offset Oui Oui

HDR Knee Oui Oui

HDR Knee Point Oui Oui

HDR Knee Slope Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Black Master Black Oui Oui

R Black Oui Oui

B Black Oui Oui

Gamma Setting Oui Oui

Step Gamma Oui Oui

Master Gamma Oui Oui

R Gamma Oui Oui

G Gamma Oui Oui

B Gamma Oui Oui

Gamma Category Oui Oui

Gamma Select Oui Oui

Black Gamma Setting Oui Oui

Range Oui Oui

Master Black Gamma Oui Oui

Knee Setting Oui Oui

Auto Knee Oui Oui

Point Oui Oui

Slope Oui Oui

Knee Saturation Oui Oui

Knee Saturation Level Oui Oui

White Clip Setting Non Oui

Level Oui Oui

Detail(4K/QFHD) Setting Oui Oui

Level Oui Oui

H/V Ratio Oui Oui

Crispening Oui Oui

Frequency Oui Oui

Knee Aperture Oui Oui

Knee Aperture Level Oui Oui

White Limit Oui Oui

Black Limit Oui Oui

V Detail Creation Oui Oui
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Detail(HD) Setting Oui Oui

Level Oui Oui

H/V Ratio Oui Oui

Crispening Oui Oui

Frequency Oui Oui

Knee Aperture Oui Oui

Knee Aperture Level Oui Oui

White Limit Oui Oui

Black Limit Oui Oui

V Detail Creation Oui Oui

Skin Detail Setting Oui Oui

Area Detection – –

Area Indication Non Non

Level Oui Oui

Saturation Oui Oui

Hue Oui Oui

Width Oui Oui

Aperture Setting Oui Oui

Level Oui Oui

Matrix Setting Oui Oui

Adaptive Matrix Oui Oui

Preset Matrix Oui Oui

Preset Select Oui Oui

User Matrix Oui Oui

User Matrix Level Oui Oui

User Matrix Phase Oui Oui

User Matrix R-G Oui Oui

User Matrix R-B Oui Oui

User Matrix G-R Oui Oui

User Matrix G-B Oui Oui

User Matrix B-R Oui Oui

User Matrix B-G Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint Multi Matrix Setting Oui Oui

Area Indication Non Non

Color Detection – –

Reset – –

Axis Non Non

Hue Oui Oui

Saturation Oui Oui

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load from Utility SD/MS – –

Save to Utility SD/MS – –

File ID Non Oui

Scene White Data Oui Non

TC/Media Timecode Mode Oui Non

Run Oui Non

Setting Non Non

Reset – –

TC Format Oui Non

TC Display Display Select Oui Non

Users Bit Mode Oui Non

Setting Non Non

HDMI TC Out Setting Oui Non

Clip Name Format Auto Naming Oui Non

Camera ID Non Non

Reel Number Non Non

Camera Position Non Non

Title Prefix Oui Non

Number Set Non Non

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Utility SD/MS – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Output On/Off SDI1 Oui Non

SDI2 Oui Non

HDMI Oui Non

Output Format SDI1 Oui Non

SDI2 Oui Non

HDMI Oui Non

REF Non Non

Output Setting RAW to HD Conv. Oui Non

Output Display Setting Oui Non

SDI1 Oui Non

SDI2 Oui Non

HDMI Oui Non

Display On/Off Network Status Oui Non

File Transfer Status Oui Non

NCM/Streaming Status Oui Non

Rec/Play Status Oui Non

RAW Output Control Status Oui Non

Tally Oui Non

Battery Remain Oui Non

Focus Mode Oui Non

Focus Position Oui Non

Focus Marker Oui Non

Focus Area Indicator Oui Non

Focus Area Ind.(AF-S) Oui Non

Face/Eye Detection Frame Oui Non

Lens Info Oui Non

Imager Scan Mode Oui Non

Rec Format Oui Non

Frame Rate Oui Non

Zoom Position Oui Non

UWP RF Level Oui Non

GPS Oui Non

SteadyShot Oui Non

Gamma/LUT Oui Non

SDI/HDMI Rec Control Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Gamma Display Assist Oui Non

Proxy Status Oui Non

Base ISO/Sensitivity Oui Non

Media Status Oui Non

Video Signal Monitor Oui Non

Clip Name Oui Non

White Balance Oui Non

Scene File Oui Non

Focus Indicator Oui Non

Auto Exposure Mode Oui Non

Auto Exposure Level Oui Non

Timecode Oui Non

ND Filter Oui Non

Iris Oui Non

ISO/Gain/EI Oui Non

Shutter Oui Non

Level Gauge Oui Non

Audio Level Meter Oui Non

Video Level Warning Oui Non

Clip Number Oui Non

Notice Message Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Marker Setting Oui Non

Color Oui Non

Center Marker Oui Non

Safety Zone Oui Non

Safety Area Oui Non

Aspect Marker Oui Non

Aspect Mask Oui Non

Aspect Safety Zone Oui Non

Aspect Safety Area Oui Non

Aspect Select Oui Non

Guide Frame Oui Non

100% Marker Oui Non

User Box Oui Non

User Box Width Oui Non

User Box Height Oui Non

User Box H Position Oui Non

User Box V Position Oui Non

VF Setting Contrast Oui Non

Brightness Oui Non

Color Mode Oui Non

De-Squeeze Oui Non

Gamma Display Assist Setting Oui Non

Peaking Setting Oui Non

Type Oui Non

Normal Peaking Frequency Oui Non

Normal Peaking Level Oui Non

Color Oui Non

Color Peaking Level Oui Non

Zebra Setting Oui Non

Zebra Select Oui Non

Zebra1 Level Oui Non

Zebra1 Aperture Level Oui Non

Zebra2 Level Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 MI SHOE Input Select Oui Non

CH2 EXT Input Select Oui Non

CH2 MI SHOE Input Select Oui Non

CH3 Input Select Oui Non

CH4 Input Select Oui Non

INPUT1 MIC Reference Oui Non

INPUT2 MIC Reference Oui Non

Line Input Reference Oui Non

Reference Level Oui Non

CH1 Wind Filter Oui Non

CH2 Wind Filter Oui Non

CH3 Wind Filter Oui Non

CH4 Wind Filter Oui Non

CH3 Level Control Oui Non

CH4 Level Control Oui Non

Audio Input Level Oui Non

Limiter Mode Oui Non

CH1&2 AGC Mode Oui Non

CH3&4 AGC Mode Oui Non

AGC Spec Oui Non

1kHz Tone on Color Bars Oui Non

CH1 Level Oui Non

CH2 Level Oui Non

CH3 Level Oui Non

CH4 Level Oui Non

Audio Output Monitor CH Oui Non

Headphone Out Oui Non

Alarm Level Oui Non

HDMI Output CH Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Shot Mark Delete Shot Mark1 – –

Delete Shot Mark2 – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Copy Clip Select Clip – –

All Clips – –

Copy Sub Clip All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Set Index Picture – –

Thumbnail View Essence Mark Thumbnail – –

Clip Thumbnail – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting Non Non

Type Oui Non

Test Saw Test Saw Oui Non

ND Dial CLEAR with Dial Oui Non

Tally Front Tally Lamp Oui Non

Rear Tally Lamp Oui Non

Tally Control Oui Non

HOLD Switch Setting with Rec Button Oui Non

with Hand Grip Remote Oui Non

Touch Operation Setting Oui Non

Rec Review Setting Oui Non

Handle Zoom Setting Oui Non

High Oui Non

Low Oui Non

GPS GPS Oui Non

Menu Settings User Menu Only Oui Non

User Menu with Lock Non Non

Status Page On/Off Main Oui Non

Camera Oui Non

Audio Oui Non

Project Oui Non

Monitoring Oui Non

Assignable Button Oui Non

Battery Oui Non

Media Oui Non

GPS Oui Non

Network Oui Non

NCM/Streaming Oui Non

File Transfer Oui Non

RCP CNS Mode Oui Non

Detail Control(RCP) Oui Non

Fan Control Setting Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Lens Zoom Ring Direction Oui Non

Shading Compensation Oui Non

Chroma Aberration Comp. Oui Non

Distortion Comp. Oui Non

Distance Display Oui Non

Zoom Position Display Oui Non

Iris Display Oui Non

Video Light Set Video Light Set Oui Non

APR APR – –

Camera Battery Alarm Low Battery Oui Non

Battery Empty Oui Non

Camera DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

Ext. Unit Battery Alarm Near End:Info Battery Oui Non

End:Info Battery Oui Non

Near End:Sony Battery Oui Non

End:Sony Battery Oui Non

Near End:Other Battery Oui Non

End:Other Battery Oui Non

Detected Battery Non Non

Ext. Unit DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

Network Setup for Mobile App Setup – –

Access Authentication User Name Non Non

Input Password Non Non

Generate Password Non Non

Show Settings Non Non

Wireless LAN Setting Oui Non

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Oui Non

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Oui Non

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

Manual Register

SSID Oui Non

Security Oui Non

Password Non Non

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Oui Non

Camera Remote Control Oui Non

Detail Settings

DHCP Oui Non

IP Address Oui Non

Subnet Mask Oui Non

Gateway Oui Non

DNS Auto Oui Non

Primary DNS Server Oui Non

Secondary DNS Server Oui Non

Modem Setting Oui Non

Camera Remote Control Oui Non

Modem1 IP Address – –

Modem1 Subnet Mask – –

Modem2 IP Address – –

Modem2 Subnet Mask – –

Network Client Mode Setting Oui Non

NCM Settings Select Oui Non

NCM Settings1/NCM Settings2/NCM Settings3

Display Name Oui Non

CCM Address Oui Non

CCM Port Oui Non

User Name Non Non

Password Non Non

CCM Certificate – –

CCM Certificate Status – –

Camera Control Oui Non

Camera Setting Non Non

Reset – –

Streaming Quality Oui Non

File Transfer Auto Upload Oui Non

Auto Upload (Proxy) Oui Non

Default Upload Server Oui Non

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings(NCM) – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network File Transfer Server Settings1/Server Settings2/Server Settings3

Display Name Oui Non

Service Oui Non

Host Name Oui Non

Port Oui Non

User Name Non Non

Password Non Non

Passive Mode Oui Non

Destination Directory Oui Non

Using Secure Protocol Oui Non

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

Maintenance Language Select Oui Non

Clock Set Time Zone Oui Non

Date Mode Oui Non

12h/24h Oui Non

Date Non Non

Time Non Non

Network Public Key Key Creation – –

Key Clear – –

Create Key Date – –

All Reset Reset – –

Reset without Network – –

Hours Meter Hours (System) – –

Hours (Reset) – –

Reset – –

Version Version Number – –

Ext. Unit Version Number – –

Version Up – –

Lens Version Number – –

*1 Pas de chargement quand Scene File >Scene White Data est réglé sur Off dans le menu Paint.
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Éléments configurés avec les touches personnalisables

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

Sélection de la touche personnalisable All File Scene File

ND Filter Position Oui Oui

Auto Iris Oui Oui

ATW Oui Oui*1

Focus Setting Oui Non

Display Oui Non

VF Adjust Oui Non

*1 Pas de chargement quand Scene File >Scene White Data est réglé sur Off dans le menu Paint.

Éléments configurés avec la molette personnalisable

Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.
– : non enregistré (réglage temporaire)

Sélection de la molette 
personnalisable

All File Scene File

IRIS Oui Oui

ND Filter Oui Oui

Audio Input Level Oui Non
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Consultez les éléments associés dans « Réglage de l’audio à enregistrer » (page 46) et « Menu Audio » (page 115).

Audio Input (CH1&CH2)

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

CH1

[CH2 EXT Input Select]
INPUT1
INPUT2

<CH1 INPUT SELECT>
EXT
INT
MI SHOE

<CH2 INPUT SELECT>
EXT
INT
MI SHOE

[CH2 MI SHOE Input
Select]
Shoe CH2
Wireless

[CH1 MI SHOE Input Select]
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

* Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.

Diagrammes bloc
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Audio Input (CH3&CH4)

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

<CH3 INPUT LEVEL>
0 ~ 10

CH4

<CH4 INPUT LEVEL>
0 ~ 10

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1
Wireless

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2
Wireless

INPUT1

INPUT2

Shoe CH1

Shoe CH2

EXT. Unit CH1

EXT. Unit CH2

Internal MIC
(monaural)

[CH3 Level]
Audio Input Level
Side
Level + Side
Through

[CH4 Level]
Audio Input Level
Side
Level + Side
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
* Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.
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Audio Output

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

<VOLUME>
0 ~ 50

L

R

[Alarm Level]
0 ~ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

QoS
Streaming

CH2

CH3

CH4
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Vous pouvez mettre à jour le logiciel d’un 
objectif à monture E en utilisant le caméscope.
Consultez le site Web pour connaître les 
objectifs qui peuvent être mis à jour, ainsi que 
le logiciel correspondant.

Vérification de la version

1 Fixez un objectif à monture E sur le 
caméscope (page 23).

2 Sélectionnez Version dans le menu 
Maintenance pour afficher Lens Version 
Number (page 130).
Le numéro de version du logiciel de 
l’objectif à monture E est affiché sur le 
côté.

Mise à jour du logiciel

Réglez le caméscope sur le mode de stockage 
de masse (page 136).
Actualisez le logiciel en appliquant la 
procédure fournie avec le logiciel de l’objectif.

Mise à jour du logiciel de l’objectif à monture E
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Licence MPEG-4 AVC Patent 
Portfolio

CE PRODUIT EST SOUS LICENCE AVC 
PATENT PORTFOLIO POUR L’UTILISATION 
PERSONNELLE DU CONSOMMATEUR OU TOUT 
AUTRE UTILISATION N’IMPLIQUANT PAS DE 
REMUNERATION
(i) ENCODAGE VIDEO EN CONFORMITE AVEC LE 
STANDARD AVC (« AVC VIDEO ») ET/OU
(ii) DECODAGE VIDEO AVC ENCODE PAR 
UN CONSOMMATEUR ENGAGE DANS UNE 
ACTIVITE PERSONNELLE ET/OU OBTENU D’UN 
FOURNISSEUR VIDEO AYANT LA LICENCE DE 
DISTRIBUTION AVC VIDEO.
AUCUNE LICENCE N’EST ATTRIBUEE OU 
NE DOIT ETRE DESTINEE POUR TOUT 
AUTRE USAGE. DES INFORMATIONS 
SUPPLEMENTAIRES PEUVENT ETRE OBTENUES 
DE MPEG LA, L.L.C. VOIR  
HTTP://WWW.MPEGLA.COM

Obtention d’un logiciel sous 
licence GPL/LGPL

Ce produit utilise le logiciel auquel s’applique 
la licence GPL/LGPL. Ceci vous informe 
que vous disposez d’un droit d’accès, de 
modification et de redistribution du code 
source de ces logiciels dans les conditions de 
la GPL/LGPL.
Le code source est disponible sur Internet. 
Reportez-vous à l’adresse URL suivante et 
suivez les instructions de téléchargement.
https://oss.sony.net/Products/Linux/

Nous préférerions que vous ne nous 
contactiez pas au sujet du contenu du code 
source.

Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».

CONTRAT DE LICENCE 
D’UTILISATEUR FINAL

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 

will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 

Licences

HTTP://WWW.MPEGLA.COM
https://oss.sony.net/Products/Linux/
www.sony.com/linux
www.sony.com/linux
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limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 

of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
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to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 

of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licences de logiciels libres

Sur la base des contrats de licence entre Sony 
et les détenteurs de copyright des logiciels, ce 
produit utilise des logiciels libres.
Pour répondre aux exigences des détenteurs 
de copyright des logiciels, Sony est dans 
l’obligation de vous informer sur le contenu de 
ces licences.
Les licences (en anglais) sont enregistrées 
dans la mémoire interne de votre produit.
Établissez une connexion de stockage de 
masse entre le produit et un ordinateur pour 
lire les licences du dossier « PMHOME » - 
« LICENSE ».
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Généralités

Poids Environ 2,3 kg (5 lb 1 oz) (boîtier, 

poignée incluse)

Dimensions

  (Unité : mm (pouce), boîtier, (poignée 

incluse))1)

159,5  
(6 3/8)

246  
(9 3/4)

142,5 
(5 5/8)

146  
(5 3/4)

257 (10 1/8)

216 (8 5/8)

229 (9 1/8)  
1) Les valeurs indiquées pour les dimensions sont 

approximatives.

Besoins en alimentation

  CC 19,5 V (18,0 V à 20,5 V)

Consommation électrique

  Environ 35,2 W (boîtier, objectif, 

enregistrement XAVC-I QFHD 

59.94P, viseur activé, aucun 

dispositif externe connecté)

  Environ 36,8 W (boîtier, objectif, 

enregistrement XAVC-I QFHD 

59.94P, viseur activé, 3G-SDI×2, 

HDMI, dispositif externe connecté)

Température de fonctionnement

  0 °C à 40 °C (32 °F à 104 °F)

Température de stockage

  –20 °C à +60 °C (–4 °F à +140 °F)

Durée d’utilisation continue

  Environ 54 minutes (avec BP-U35) 

(boîtier, objectif, enregistrement 

XAVC-I QFHD 59.94P, viseur 

activé, aucun dispositif externe 

connecté)

Format d’enregistrement (vidéo)

 XAVC Intra

  Mode XAVC-I 4K/QFHD : VBR, débit 

binaire 600 Mbps (max), MPEG-4 

AVC/H.264

  Mode XAVC-I HD : CBG, débit 

binaire 223 Mbps (max), MPEG-4 

AVC/H.264

 XAVC Long

  Mode XAVC-L QFHD : VBR, débit 

binaire 150 Mbps (max), MPEG-4 

H.264/AVC

  Mode XAVC-L HD 50 : VBR, débit 

binaire 50 Mbps (max), MPEG-4 

H.264/AVC

  Mode XAVC-L HD 35 : VBR, débit 

binaire 35 Mbps (max), MPEG-4 

H.264/AVC

  Mode XAVC-L HD 25 : VBR, débit 

binaire 25 Mbps (max), MPEG-4 

H.264/AVC

 MPEG-2 Long GOP

  Mode MPEG HD422 : CBR, débit 

binaire 50 Mbps (max), MPEG-2 

422P@HL

Format d’enregistrement (audio)

 LPCM 24 bits, 48 kHz, 4 canaux

Fréquence d’enregistrement élevée

 XAVC Intra

  Mode XAVC-I 4K : 4096×2160/59.94P, 

50P, 29.97P, 25P, 24P, 23.98P

  Mode XAVC-I QFHD : 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

  Mode XAVC-I HD : 1920×1080/59.94P, 

50P, 59.94i, 50i, 29.97P, 23.98P, 

25P

 XAVC Long

  Mode XAVC-L QFHD : 

3840×2160/59.94P, 50P, 29.97P, 

23.98P, 25P

  Mode XAVC-L HD 50 : 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

  Mode XAVC-L HD 35 : 

1920×1080/59.94P, 50P, 59.94i, 

50i, 29.97P, 23.98P, 25P

  Mode XAVC-L HD 25 : 

1920×1080/59.94i, 50i

 MPEG-2 Long GOP

  Mode MPEG HD422 : 

1920×1080/59.94i, 50i, 29.97P, 

23.98P, 25P

Durées d’enregistrement/de lecture

XAVC Intra

 Mode XAVC-I 4K/QFHD :

  59.94P

   Environ 22 minutes  

(avec QD-G128E/QD-G120F)

 Mode XAVC-I HD :

  59.94P

   Environ 57 minutes  

(avec QD-G128E/QD-G120F)

XAVC Long

 Mode XAVC-L QFHD :

  59.94P

   Environ 86 minutes  

(avec QD-G128E/G120F)

 Mode XAVC-L HD 50 :

  59.94P

   Environ 110 minutes  

(avec QD-G64E)

 Mode XAVC-L HD 35 :

  59.94P

   Environ 150 minutes  

(avec QD-G64E)

 Mode XAVC-L HD 25 :

  59.94i

   Environ 200 minutes  

(avec QD-G64E)

MPEG-2 Long GOP

 Mode MPEG HD422 :

  59.94i

   Environ 105 minutes  

(avec QD-G64E)

[Remarque]
La durée d’enregistrement/lecture peut varier 
en fonction des conditions d’utilisation et 
des caractéristiques de mémoire. Les durées 
d’enregistrement et de lecture concernent un 
enregistrement continu en tant que plan unique. Les 
durées réelles peuvent être plus courtes selon le nombre 
de plans enregistrés.

Section de caméra

Imageur (type)

 Capteur d’image CMOS monopuce en plein 

format 35 mm

Nombre de pixels

 20,5M (total)

Auto focus

 Méthode de détection : détection de phase/

détection de contraste

Filtres ND internes

 CLEAR : OFF

 1 : 1/4ND

 2 : 1/16ND

 3 : 1/64ND

 ND variable linéairement : 1/4ND à 1/128ND

Caractéristiques techniques
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Sensibilité ISO

 ISO 800/4000 (mode Cine EI, source 

lumineuse D55)

Monture d’objectif

 Monture E (type verrouillage à levier)

Latitude

 15+ arrêt

S/B vidéo

 57 dB (Y) (typique)

Vitesse d’obturateur

 64F à 1/8000 sec (23.98P)

Angle d’obturateur

 5,6° à 360°, 2 à 64 images

Ralenti et accéléré

 XAVC QFHD : 1 à 60P, XAVC HD : 1 à 180P

Equilibre des blancs

 2000 K à 15000 K

Gain

 –3 dB à +27 dB (incréments de 1 dB)

Courbe gamma

 S-Cinetone, STD1, STD2, STD3, STD4, STD5, 

STD6, HG1, HG2, HG3, HG4, HG7, 

HG8, S-Log3, HLG

Section audio

Fréquence d’échantillonnage

 48 kHz

Quantification

 24 bits

Réponse de fréquence

 Mode MIC entrée XLR : 20 Hz à 20 kHz  

(±3 dB ou moins)

 Mode LINE entrée XLR : 20 Hz à 20 kHz  

(±3 dB ou moins)

Plage dynamique

 Mode MIC entrée XLR : 80 dB (typique)

 Mode LINE entrée XLR : 90 dB (typique)

Distorsion

 Mode MIC entrée XLR : 0,08% ou moins 

(niveau d’entrée –40 dBu)

 Mode LINE entrée XLR : 0,08% ou moins 

(niveau d’entrée +14 dBu)

Haut-parleur intégré

 Monaural

Microphone interne

 Monaural

LAN sans fil

Normes prises en charge

 IEEE 802.11a/b/g/n/ac

Bande de fréquences

 Bande 2,4 GHz

 Bande 5,2/5,3/5,6/5,8 GHz (PXW-FX9V/VK 

uniquement)

Protocoles de sécurité pris en charge

 WEP/WPA-PSK/WPA2-PSK

 Compatible NFC Forum Type 3 Tag

Section entrée/sortie

Entrées
INPUT 1/2 :

 Type XLR, 3 broches, femelle

 Commutable LINE / MIC / MIC+48V

 MIC : référence –30 dBu à –80 dBu

GENLOCK IN :

 Type BNC

TC IN :

 Type BNC

Sorties
SDI OUT1 :

 Type BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level 

A/B), HD-SDI

SDI OUT2 :

 Type BNC, 3G-SDI (Level A/B), HD-SDI

Casque (mini-prise stéréo) :

 –16 dBu (sortie du niveau de référence, 

volume maximal du moniteur, 

charge de 16 Ω)

HDMI :

 Type A, 19 broches

REF OUT :

 Type BNC

TC OUT :

 Type BNC

Autre
DC IN :

 Conforme à la norme EIAJ, 18 V à 20,5 V CC

Connecteur du module d’extension :

 Dédié (144 broches)

Griffe à interfaces multiples :

 Dédié (21 broches)

REMOTE :

 Type mini-sub à 3 pôles de 2,5 mm

Multi/USB :

 Conforme à la norme USB 2.0, type micro B 

pour stockage de masse (1)

VF :

 Dédié (40 broches)

Section d’affichage

Viseur (LCD)
Taille d’écran

 8,8 cm (3,5 pouces) de diagonale

Rapport d’aspect

 16:9

Nombre de pixels

 1280 (H) × 720 (V)

Section de logement de support

Logements de carte XQD pour l’enregistrement 

vidéo (2)

Logement de carte UTILITY SD/MS (1)

Accessoires fournis

Adaptateur secteur (1)

Cordon d’alimentation (1)

Chargeur de batterie (1)

Pack batterie (1)

Moniteur LCD (avec tige et attache)

Oculaire (1)

Câble USB (1)

Télécommande de poignée (1)

Capuchon de la monture d’objectif (1)

Capuchon protecteur du connecteur de la 

poignée (1)

Kit de griffe pour accessoire (griffe pour 

accessoire (1), plaque de griffe (1), vis (4))

Crochet pour mètre à ruban (1)

Entretoise d’attache ronde (2)

Vis (5)

Avant d’utiliser cet appareil (1)

Livret de garantie (1)

La conception et les caractéristiques 
techniques sont sujettes à modification sans 
préavis.
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Remarques
ˎˎ Effectuez toujours un essai 
d’enregistrement pour vérifier que 
l’enregistrement s’est fait correctement. 
SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LES DOMMAGES 
DE QUELQUE SORTE QU’ILS SOIENT, 
INCLUANT MAIS NE SE LIMITANT PAS À LA 
COMPENSATION OU AU REMBOURSEMENT, 
SUITE AU MANQUEMENT DE CET APPAREIL 
OU DE SON SUPPORT D’ENREGISTREMENT, 
DE SYSTÈMES DE MÉMOIRE EXTÉRIEURS 
OU DE TOUT AUTRE SUPPORT OU SYSTÈME 
DE MÉMOIRE À ENREGISTRER UN CONTENU 
DE TOUT TYPE.
ˎˎ Vérifiez toujours que l’appareil fonctionne 
correctement avant utilisation. SONY 
NE PEUT ÊTRE TENUE RESPONSABLE DE 
TOUT DOMMAGE, DE QUELQUE NATURE 
QUE CE SOIT, Y COMPRIS MAIS SANS 
LIMITATION, LA COMPENSATION OU LE 
REMBOURSEMENT SUITE À LA PERTE 
DES BÉNÉFICES PRÉSENTS ET À VENIR 
RÉSULTANT D’UN DYSFONCTIONNEMENT 
DE CET APPAREIL NI PENDANT LA PÉRIODE 
DE GARANTIE OU UNE FOIS LE DÉLAI DE 
GARANTIE EXPIRÉ OU POUR TOUTE AUTRE 
RAISON QUE CE SOIT.
ˎˎ SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LES 
RÉCLAMATIONS, QUELLE QU’ELLES SOIENT, 
EFFECTUÉES PAR LES UTILISATEURS DE CET 
APPAREIL OU PAR DES TIERCES PARTIES.
ˎˎ SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LA PERTE, LA 
RÉPARATION OU LA REPRODUCTION DE 
TOUTES DONNÉES ENREGISTRÉES SUR 
LE SYSTÈME DE MÉMOIRE INTÉRIEUR, 
LE SUPPORT D’ENREGISTREMENT, LES 
SYSTÈMES DE MÉMOIRE EXTÉRIEURS OU 
TOUT AUTRE SUPPORT OU SYSTÈME DE 
MÉMOIRE.

ˎˎ SONY N’ASSUMERA PAS DE 
RESPONSABILITÉ POUR LA CESSATION OU 
L’INTERRUPTION DE TOUT SERVICE LIÉ À 
CET APPAREIL, RÉSULTANT DE QUELQUE 
CIRCONSTANCE QUE CE SOIT.

Téléchargements de logiciels

Lorsque l’appareil est utilisé avec une 
connexion PC, téléchargez tous les pilotes 
du dispositif, les plug-ins et les applications 
logicielles dont avez besoin à partir des sites 
internet suivants.

Site internet Sony produits professionnels :

Japon https://www.sony.jp/professional/
Tous les autres pays 

https://pro.sony/ (cliquez sur [Change 
Country, Region or Language] en bas 
de la page et sélectionnez la région ou 
la langue)

Sony Creative Software, page de 
téléchargement du logiciel
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

Marques commerciales

ˎˎ XDCAM est une marque commerciale de 
Sony Corporation.
ˎˎ XAVC et  sont des marques déposées 
de Sony Corporation.
ˎˎ XQD et  sont des marques 
commerciales de Sony Corporation.
ˎˎ Les termes HDMI et High-Definition 
Multimedia Interface ainsi que le logo 
HDMI sont des marques commerciales ou 
des marques déposées de HDMI Licensing 
Administrator, Inc. aux États-Unis et dans 
d’autres pays.
ˎˎ Microsoft et Windows sont des marques 
déposées ou des marques enregistrées de 
Microsoft Corporation aux États-Unis et/ou 
dans d’autres pays.
ˎˎ Mac et Mac OS sont des marques déposées 
d’Apple Inc. aux États-Unis et dans d’autres 
pays.
ˎˎ « Memory Stick », « Memory Stick Duo », 
« Memory Stick PRO Duo », « Catalyst 
Browse », « Content Browser Mobile » et le 
logo « Content Browser Mobile » sont des 
marques commerciales ou des marques 
déposées de Sony Corporation.
ˎˎ iOS est une marque déposée ou une 
marque commerciale de Cisco Systems, Inc. 
et/ou de ses filiales aux États-Unis et dans 
certains autres pays.
ˎˎ Android et Google Play sont des marques 
commerciales de Google Inc.
ˎˎ Wi-Fi, le logo Wi-Fi et Wi-Fi PROTECTED 
SETUP sont des marques commerciales ou 
des marques déposées de Wi-Fi Alliance.
ˎˎ N-Mark est une marque commerciale ou 
une marque déposée de NFC Forum, Inc., 
aux États-Unis et dans d’autres pays.
ˎˎ QR Code est une marque commerciale de 
Denso Wave Inc.

Tous les autres noms d’entreprises ou de 
produits sont des marques commerciales ou 
des marques déposées de leurs détenteurs 
respectifs. Les éléments de marques 
commerciales ne sont pas indiqués par les 
symboles ™ ou ® dans ce document.

www.sony.com/linux
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
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